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About This User’s Guide
This User’s Guide explains how you can create online stores with the STOREFRONT 
application. It contains all the procedures for working with the StoreCenter web-
browser interface and information to set up auxiliary services.
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14 INTENDED AUDIENCE
Intended Audience

This document is designed for two audiences: 

 Administrators and Operators of print service providers who set up stores for 
their customers (Companies). These roles are referred to as Printer Adminis-
trator and Printer Operator.

 Administrators and Operators of Companies for which one or more stores 
have been created. These roles are referred to as the Company Administrator 
and Company Operator.

Administrators and operators use STOREFRONT to create stores, manage gener-
ated orders, and monitor the interfacing with the Apogee Prepress and Asanti 
systems. The features you can use depend on your role. See “Roles” on page 30.

No prior knowledge of online stores is required but some basic understanding of 
how websites are created is recommended in order to set up storefronts. 

The STOREFRONT software is a hosted service and you do not need to install any 
software on your local computer.

Sections with information mainly for Printer Administrators are indicated with 
a note at the beginning of the section.

NOTE: This documentation does not provide information on how to use the 
website storefronts created with STOREFRONT.

Getting Started with STOREFRONT

The sections in this User’s Guide are arranged in the sequence required to get 
you started with the application, from logging on to creating and managing 
stores.

 Click the steps below to go immediately to the relevant sections and set up 
your first store:

Step 1: Log on to StoreCenter
To set up and manage stores in STOREFRONT, you need to log on to the 
StoreCenter.
StoreFront User’s Guide
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Step 2: Set up a Company 
Companies are the customers or business relations of a printer or print service 
provider. These need to be defined by the Printer Administrator before a store 
can be set up. A Company is assigned one or more stores and optionally a 
Company Administrator who in turn can create Users who are authorized to use 
the storefront.

Step 3: Define Your Resources
The Advanced menu provides access to general settings and preferences that 
need to be defined before you can create templates and set up a store. These 
resources are available for all Companies and Stores.

Step 4: Create Product Templates 
Product Templates allow you to optimize the overall efficiency of your stores by 
defining standard types for all your printed and non-printed products.

Step 5: Create Products
Products are the publications and non-printed items that you want to sell or 
distribute via stores. They are created for a specific Company and can be used in 
all the stores of the Company.

Step 6: Design the Storefront Pages
The Printer Administrator sets up one or more stores in the StoreCenter for 
specific Companies. Every store has a corresponding storefront with a unique 
internet address (URL) and a customized look and feel.

Step 7: Give Access to Users
The visitors of your storefront are referred to as Users.
StoreFront User’s Guide
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Related Documentation

You can also refer to the following documentation:

 Apogee Prepress and Asanti Online Help

 Apogee Prepress and Asanti Tutorials

 PrintSphere Help: instructions on setting up the PrintSphere file-sharing 
application

 SphereCenter Help: instructions on buying PrintSphere licenses and creating 
PrintSphere users

Release Notes and 
Support

For the latest information, known issues and updates for this documentation, 
please visit the Support pages. You can also visit Apogee Network to participate in 
the user forums (requires registration).

Read the release notes in the Product History section of the Support landing 
page.

Videos This documentation includes a selection of videos to complement the 
instructions:

 Access Labels

 Edit the Order Reference dialog (Reference tab)

All available training videos are listed on the Support pages.

Update Checklist

It is recommended that you perform the following actions for the new release:

 Update the STOREFRONT Converter plug-in on all systems running Adobe 
InDesign.

 Check that product kits are properly processed by all systems connected to 
STOREFRONT, such as MIS, billing, or shipping solutions.

 It is recommended to remove any stores that are no longer in use or were 
created for training or testing purposes.
StoreFront User’s Guide
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Navigating the Online Help

 You access the Online Help by clicking the Help link on the StoreCenter 
navigation bar. The Online Help opens in a new browser window.

The Online Help version of this documentation uses a responsive design to 
accommodate a wide range of screen sizes. This means that some navigation 
features are displayed or hidden, depending on the size of the screen you are 
viewing this documentation on. For example, the table of contents may be 
hidden if you are viewing the documentation on a small screen. Use the buttons 
in the top navigation bar to browse through the documentation.

You can view topics in the Online Help by expanding the sections in the 
Contents panel and clicking a heading. You can continue to read in sequence by 
pressing the Next button in the navigation toolbar.

As you progress, the hierarchy of each specific topic is indicated at the top of the 
topic pane in the breadcrumb trail. You can click any one of these levels to go 
back to a higher level in the hierarchy.

You can also jump to Related Topics, to additional information within the 
documentation set and to internet sites. All these links are highlighted in red. In 
these cases you navigate back and forward by clicking the Back and Forward 
buttons on the browser tool bar.

Show/hide the table of contents

Show/hide the list of index terms

Show/hide the search panel

Previous topic

Next topic

Print a PDF of the whole document

Print current topic

Displays a section

Displays collapsible (expandable) text or images
StoreFront User’s Guide
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 Searching

The Online Help has a search feature for finding information. The following 
queries can be made:

 Simple search with a single word: Enter a single word for a list of all topics 
that contain that word.

 Advanced search for all words: For example, enter disk space for a list of all 
topics that contain disk AND space in the same topic. Try to avoid using 
common words such as "a", "the", etc. in your search query.

 Advanced search for an exact phrase: For example, enter “disk space” in 
quotes for a list of topics that only contain this exact phrase.

1 If the search box is not visible, for example if you are working on a small 
screen, click the Search button.

2 Type a word or phrase in the Search box.

3 Click the Go button or press Enter.

The search results are listed.

4 Click a search result to jump to the topic.

You may need to expand sections of the topic to see the word or phrase you 
queried.

Search limitations

 It is not possible to use wild cards in your search query.

 Search is case-insensitive.

 Search queries must be at least 3 characters. For example, searching for "QR" 
will not produce any results; you should search for "QR codes".

 Illustrations and Animations

Large images have been reduced in size to display properly in the Help topics.
StoreFront User’s Guide
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 Hover over an image and if the cursor changes to a hand you can click the 
image to view it full size in an overlay panel. Click the X or click outside the 
image to close the overlay panel and return to the Help topic.

 Expanding topics

Headings with a triangle are collapsed to provide a better overview of the 
information.

 Click the heading or the colored triangle to expand the topic.
StoreFront User’s Guide
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Printing Help Information

If you want to print information from the Online Help, two options are available:

 Print individual topics

 Click the Print button in the navigation bar or choose File > Print from the 
browser menu bar.

 Print the whole document

All the information in the Online Help is also provided in a printer-friendly PDF 
document.

1 Click the PDF button in the navigation bar to open a PDF document.

2 Print the whole document or specific sections as required.

This feature is only available if your browser has the Adobe Acrobat plug-in.

NOTE: You may need to set up browser functionality in Adobe Acrobat.
StoreFront User’s Guide
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22 OVERVIEW
Overview

When visiting storefronts created with STOREFRONT, shoppers can browse 
through a catalog of print and non-print products, order products, and track the 
status of their orders. Secure online payment of orders is also integrated in 
STOREFRONT.

Orders generated through private and/or public storefronts are monitored and 
processed in the back-end application called StoreCenter.

Figure 1.1: Overview of STOREFRONT
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StoreCenter

StoreCenter is the back-end web application of STOREFRONT where administra-
tors and operators work with stores.

A store in STOREFRONT consists of the web-to-print website which has a unique 
URL, referred to as a storefront in this documentation, and the back-end 
functionality set up in the StoreCenter.

1 Navigation bar with links to the Dashboard, Download Plug-in, License Agreement, Help, 
user account, Switch to SphereCenter and Sign In/Out button

2 Menu bar with menus for all Administrators and Operators
3 Menu bar with menus for Printer Administrators and Operators
4 Menu dialogs subdivided in tabs
5 Main toolbar to add, delete, edit and enable/disable a list item
6 Lists (Stores, Products, Users)

NOTE: The available menus and toolbars that you see in the StoreCenter depend 
on your role. See “Roles” on page 30 for more information.

Figure 1.2: StoreCenter
StoreFront User’s Guide



24 STORECENTER
Toolbars, Filters, 
Sorting

As you navigate the various menus in StoreCenter you see additional toolbars to 
add and edit resources, lists that can be sorted alphabetically and search boxes 
for filtering lists.

1 Search boxes for filtering lists
2 Column headers can be clicked to sort the lists
3 Toolbars with tools for adding, editing, deleting and sorting resources
4 Global filter

NOTE: Clicking the Go Back button of your browser always takes you back to the 
logon window. You must use the menus and navigation bar links to navigate in 
StoreCenter

Global Filter

You can apply the Global Filter on certain pages to filter large amounts of data.

 Apply the Global Filter

1 Click the Global Filter icon in the top right corner.

Figure 1.3: Toolbars and filtering in StoreCenter
StoreFront User’s Guide
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A filter bar appears where you can select a Company and/or a Store to filter 
on.

2 Click Company or Store to reveal a drop-down list and select the company 
and/or store that you want to filter on.

If you now go to a page, e.g. product templates, orders, products, the data 
you see is filtered according to the criteria you selected.

3 To remove the filter, click the gray cross (X) in the filter bar.

Now you will see all the data for all companies and stores.

Dashboard The Dashboard is the landing page when you log on to StoreCenter.

It displays the following information:

 Orders overview: Shows the totals for all the stores managed by a Company 
Administrator or Printer Administrator.

 License statistics (only displayed for Printer Administrators): Shows the 
maximum capacity (disk space, number of products, etc.) allowed for the 
Printer Administrator’s type of license and the capacity in use.

 Recent orders: Shows the most recent 12 orders for the stores managed by a 
Company Administrator or Printer Administrator, sorted by creation date.

Figure 1.4: The StoreCenter dashboard (Printer Administrator view)
StoreFront User’s Guide



26 STORECENTER
 System messages: Shows messages sent by the System Administrator. 
Important messages, e.g. products with low or out-of-stock levels, software 
update notifications, are displayed in red or with special icons.

Various links are provided to navigate further in StoreCenter or view additional 
statistics. You can return to the Dashboard at any time by clicking the link in the 
navigation bar.

Common 
Resources

STOREFRONT is designed to maximize the use of resources across the different 
stores and companies that print service providers serve. These common 
resources include:

 Product templates

 Products (only for stores of the same company)

 Price lists

 Media type and sizes

 Shipping, payment gateway and tax

 Translations of common components

 Production Center, Production Settings, Licenses

E-mail Notifications STOREFRONT includes an e-mail service that sends the necessary e-mails to notify 
users and administrators. The Printer or Company Administrator enters the e-
mail address for a user when the user profile is created. E-mails are sent in HTML 
and plain text.

E-mails are sent for the following actions:

 to administrators:

 A user is created with access as administrator to STOREFRONT; e-mail with 
hyperlink to STOREFRONT and an initial password

 New order notifications (if the option selected in Account Profile)

 Order approval request

 One or more of the licensing parameters are exceeded

 to shoppers:
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 A user is created with access as shopper to a private storefront; e-mail 
with hyperlink to the storefront and an initial password

 A user has requested a new password

 To confirm an order has been received/rejected by the Administrator

 To confirm an order has been shipped

NOTE: The signature STOREFRONT Team is no longer used at the end of the e-mails 
to shoppers.

Related topics: • Avoid spam issues with Sender Policy Framework on page 560
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Storefronts

Every store created in STOREFRONT has a corresponding storefront with a unique 
internet address (URL) and a customized look and feel.

This is the actual website where products can be purchased by shoppers. 
Products are displayed with or without prices. The range of products offered on 
the storefront is referred to as the Product Catalog and similar products are 
organized in Categories.

Shoppers can order products and specify quantities, and these are added to their 
shopping cart as order items. If prices apply for these items, they immediately 
see the total price per ordered item and the sub-total for the order.

Figure 1.5: A storefront home page
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A storefront is private if it can only be accessed by users who have been assigned 
a login and password by an administrator. The storefront is public if it can be 
accessed by all visitors.

Figure 1.6: Order items in the shopping cart
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Roles

As a StoreCenter user you will have one of the following roles:

 Printer Administrator: You create the Companies for which stores are set up. 
You have full access to the StoreCenter features and manage the Users, 
Companies and Products for all the stores.

NOTE: This role is not unique. The first printer administrator to access 
StoreCenter must accept the terms and conditions for using STOREFRONT.

 Company Administrator: You have access to the StoreCenter features 
required to manage the Users and Products for the stores of your Company. 
A Company Administrator may also be granted permission to manage orders 
and manage stocks.

 Printer Operator: You can manage all Users and you follow up orders gener-
ated by the stores.

 Approvers: An approval workflow can be set up using approval groups. See 
“Approval Groups” on page 54 for more information.

 Company Operator: You can manage the Users of your Company and follow 
up the stocks for your Company.

Table 1.1 Access to StoreCenter menus by role

Printer
Administrator

full access

Printer
Operator

lim. full read only limited

Company
Administrator

only access to their own data menu not 
visible

limited

Company
Approver

 own 
data

menus not visible

Company
Administrator/
Approver

only access to their own data menu not 
visible

limited

Company 
Operator

only access to their own data menu not 
visible

limited
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Integration with Apogee Prepress and Asanti

STOREFRONT interacts with Apogee Prepress 11.0 or higher and Asanti 
Production 4.0 or higher, via a dedicated service that ensures that print products 
ordered on the storefront are automatically downloaded for processing in these 
prepress workflows. Refer to the Apogee Prepress and Asanti documentation for 
more information on this integration.

Apogee Prepress and Asanti also have an optional task processor that exports 
STOREFRONT orders in a variety of data file formats. The data file can be used in 
Management Information Systems (MIS). Contact your ECO3 representative for 
more information about this feature or read the article on ApogeeNetwork.

Related topics: • Integrating STOREFRONT with Apogee Prepress/Asanti on page 326
• How to export an order summary from Apogee Prepress (YouTube)
• Export Module for MIS Systems (ApogeeNetwork)

Online Editor for Customizable Products

A Customizable Product is a publication that a shopper can edit to personalize 
the content before ordering. Typical examples are business cards, letterheads, 
newsletters, posters, etc. A Variable Data Product (VDP) is a special kind of 
customizable product that allows a shopper to upload variable data such as 
names, addresses, images, etc. and merge these data with a product to create 
multiple publications.

The print service provider’s designer creates the base layout in Adobe InDesign 
and converts them into a StoreFront Package using the StoreFront Converter 
plug-in. The StoreFront Package is uploaded and administrators can use the 
Online Editor integrated in STOREFRONT to fine-tune the base layouts and set 
restrictions on the extent to which the shopper can modify the documents. A 
similar version of the Online Editor is available on the storefront so shoppers can 
add or edit their personal content.

Converter Plug-in

A plug-in is available for Adobe InDesign to convert documents prepared in 
Adobe InDesign to a package that can be used in the STOREFRONT Online Editor. 
This package has a .zxp extension.
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Multilingual Support

The following table gives an overview of the languages supported in the 
different components of STOREFRONT.

See “Multilingual Storefronts” on page 511 for the procedures for creating a 
multilingual storefront.

See “Create a Company” on page 46 to set the language of the Graphic User 
Interface for working in StoreCenter.

Language Storefronts StoreCenter Online Editor

Chinese - Simplified   
Chinese - Traditional   
Czech   
Danish   
Dutch   
English (UK)    (US)
English (US)   
Faroese   
Finnish   
French   
German   
Italian   
Japanese   
Korean   
Norwegian   
Polish   
Portuguese (Brazil)   
Portuguese (Europe)   
Russian   
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Search Engine Optimization (SEO)

Search Engine Optimization (SEO) can help you attract visitors to a public store. 
SEO depends in the first place on the actual content that you publish on the 
storefront. In addition, STOREFRONT adds information in the head element of the 
HTML code and fills the title and meta description elements when gener-
ating your storefront pages.

Title and Meta Description Elements

By default, STOREFRONT uses the store name, category name and product name 
to fill the title element. The first 160 characters of the body text are copied into 
the meta description element. However, you have ample opportunity to fine-
tune this information when creating your store.

 Home page example:

<title>My Store Name</title>

<meta name="description" content="My Webshop for posters and signs" />

 Optional page example:

<title>FAQ</title>

<meta name="description" content="Questions about my webshop" />

 Product category example:

<title>Brochures | My Store Name</title>

<meta name="description" content="full color brochures" />

To make the most of SEO, make sure you complete the relevant fields when 
performing the following tasks:

 when creating a store (see “Meta Tags Tab” on page 254)

 when creating the storefront pages (SEO title and description: see “Pages 
Tab” on page 222)

 when creating products (product name and description: see “Creating 
Products” on page 157)

 when creating product categories (category name and description: see 
“Add a Category and Products” on page 208)
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Sitemaps

STOREFRONT also creates a sitemap file, called sitemap.xml, for each of your 
public stores, so it’s easier for search engines to crawl your storefront website. 
You can see the sitemap file by navigating to your storefront and adding a/
sitemap.xml to the URL as follows:

https://myonlinestore.apogeestorefront.com/a/sitemap.xml

Sitemaps can also be submitted to search engines to improve indexing. If you 
want to do this, you can use Google Webmaster Tools. You’ll need to create a 
special meta name tag that includes the code that verifies you are the owner of 
the storefront. Read how to create the google-site-verification meta tag in 
“Meta Tags Tab” on page 254.

On the other hand, if you do not want your storefront to appear in search results, 
read how you can prevent search engines crawling your storefront with the 
robots meta tag – also in the section “Meta Tags Tab” on page 254.

For more information about SEO in general, read the article Making Public Stores 
Customer and Search-Friendly on ApogeeNetwork.
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System Requirements

STOREFRONT is made available as software-as-a-service (SaaS) and hosted by 
ECO3. This means no extra hardware is required and no software has to be 
installed. All users of STOREFRONT, including administrators, and visitors of the 
private storefront websites log on to ECO3’ central hosting servers. Public store-
fronts are also hosted on the central servers.

The following system requirements apply for storefront shoppers:

 Internet connection

 Any recent browser:

 Edge 14 or higher

 Mozilla FireFox 50 or higher

 Google Chrome 54 or higher

 Apple Safari 9 or higher

 other browsers will work but have not been tested

The following system requirements apply for using the StoreCenter of 
STOREFRONT:

 Internet connection

 Recommended browser: Mozilla Firefox 50 or higher; most other browsers 
can also be used.

 Minimum monitor resolution of 1024 x 768 pixels; recommended resolu-
tion: at least 1680 x 1050 pixels.

The following system requirements apply for integrating STOREFRONT with 
Apogee Prepress or Asanti:

 Apogee Prepress 11.0 or higher (only Manage and Integrate versions) is 
required for automatic downloading and processing of ordered print 
products.

 Other versions of Apogee Prepress or third-party systems can use manually 
downloaded PDF/JDF files.

 Asanti Production 4.0 or higher
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To use the STOREFRONT Converter, you need the following version of Adobe 
InDesign:

 Adobe InDesign 6.0, CC, CC 2014/2015 on Windows or Macintosh

Online Security

Internet security is an essential element for all e-commerce systems and may be 
subject to legal requirements in your country.

Full HTTPS support

STOREFRONT supports Hypertext Transfer Protocol Secure (HTTPS) for all data 
communication. When accessing any page in a store, the browser will show the 
'secure' green lock icon in the address bar. For stores that use a custom domain 
name, there is no need to purchase a separate SSL-certificate as STOREFRONT 
automatically takes care of this using Let's Encrypt certificates.

Payment Gateways

The security of online payments is ensured by payment gateway services 
integrated in STOREFRONT. The supported gateway services depend on your 
location and include Ingenico (Worldline brand), PayPal, Mercado Pago, Stripe, 
Bambora and Inicis. These systems handle all payment aspects and do not 
require that credit card data is stored on the STOREFRONT web servers.

You can download the document Configuring Payment Gateways which has the 
latest information on setting up these services. Always check that you have the 
latest version of this document.

Read the article Infrastructure, Security, Privacy and Confidentiality on the 
ApogeeNetwork for more information.

Related topics: • Configuring Payment Gateways on page 563
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Legal Considerations

Most countries have specific legislation that governs e-commerce practices or 
websites in general. This section provides some general guidelines, however, 
you are responsible and must ensure that the storefronts you set up meet the 
legal requirements of the country or regions it operates in.

Terms & Conditions Depending on local legislation, the following information may need to be 
provided on the Terms & Conditions page. For private stores the requirements 
may be less stringent than for public business-to-consumer stores. See “Add/edit 
legal information (Legal tab)” on page 228 for details on how to create this 
content.

Company specific information

 The name of the service provider: When the trading name is not the same as 
the real name of the company, this should be explained.

 Physical address

 E-mail address

 Registration number: In some countries the place of registration should also 
be stated. 

 VAT number or sales tax information

Privacy policy

STOREFRONT uses a number of features that may concern the privacy of store-
front visitors. Disclaimers should be included on the storefronts to notify visitors 
about these features.

The Users tab in StoreCenter has an option to export a list of users to an Excel 
file. This feature was added to allow companies to use the data in other applica-
tions, such as for instance an e-mail marketing program. Even though you may 
consider sending all customers an e-mail to be a service, legally this can be seen 
as spam. Most countries have very strict legislation regarding the use of such e-
mails. Make sure you are working within the legal framework of your country.
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Complaints procedure

You may need to explain how buyers can report an issue with their purchase and 
indicate the time frame for receiving a response.

Right of withdrawal/Return policy

Consumers in many countries, and particularly in EU member states, have the 
right to withdraw from certain online purchases and return goods within a 
certain period. Traders may need to provide shoppers with a model withdrawal 
form. Certain products are excluded from this rule (e.g. personalized goods) so 
it may only apply to stock products and not to customized products such as 
business cards.

See also the EU Consumer Rights Directive on distance selling (e.g. internet).

Trade and Professional Associations

If the print service provider is a member of a trade or professional association, 
membership details should be provided on the Terms & Conditions page. It may 
be a good idea to become a member of a local e-commerce trade association or 
at least check the recommendations on their web site. For countries in the 
European Union, a list of such organizations and quality labels can be found on 
the EMOTA website.

Cookies Cookies are text files that are saved on a user’s computer each time the user visits 
your website. The websites you create with STOREFRONT use persistent cookies to 
collect information which is essential to the correct functioning of the website. 
For example, a cookie is used to collect data about the products a shopper adds 
to the shopping cart. If such a cookie could not be used, the shopper would have 
to remember all the products he put in his cart. You do not have to inform 
shoppers that these essential cookies are being used.

However, in some countries, e.g. the countries of the European Union, you are 
required to inform visitors of your website about non-essential cookies, such as 
the Google Analytics cookies, which STOREFRONT allows you to add to your 
website. 

To comply with the General Data Protection Regulation (GDPR) cookie regula-
tions, a blocking pop-up window appears (when the cookie check is enabled), 
allowing the user to accept all cookies or only essential cookies. The user must 
select one of the following options to continue using the STOREFRONT website: 

 Allow essential cookies: accept only essential cookies.
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 Allow all: accept all cookies.

If it is legally required and you are using cookies for non-essential services, you 
can add a link in the footer of your storefront pages to your cookies acceptance 
page, or a banner that appears at the bottom of each storefront page. See “Add/
edit legal information (Legal tab)” on page 228 for more information on 
creating a cookies acceptance page or banner.

Related topics: • General Tab on page 196 to add Google Analytics to your storefront.

Shopper 
Notifications

Legislation may require that a shopper is informed automatically about a 
purchase by e-mail or post. STOREFRONT sends an e-mail automatically for each 
order.

Product 
Information

Some countries require that products on sale are clearly described to the 
shopper. STOREFRONT has a description field that can be used for this.

GDPR For information on STOREFRONT compliance with the EU’s General Data Protec-
tion Regulation, see the ECO3 website.

Figure 1.7: An Example of Cookie Consent Pop-up Window
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CHAPTER
2 Logging on and Editing 
Your Account 

To set up and manage stores in STOREFRONT, you need to log on to the 
StoreCenter.

Logging On Your account is set up by an ECO3 Administrator and logon details are sent to 
you by e-mail.

 Log on to StoreCenter the first time

NOTE: Administrators must confirm that they accept the License Agreement 
the first time they log in and each time the agreement is modified. You can 
consult the License Agreement at any time by clicking the link in the 
navigation bar.

1 Click the link in the e-mail you received from your Administrator or copy and 
paste the URL in the address bar of your browser.

This unique link remains valid for 7 days. 

TIP: You can bookmark the 
StoreCenter URL as a 
favorite, just like any other 
website.

2 Enter your e-mail address.

3 Enter a password of your choice in the Password field and enter it a second 
time in the Password Confirmation field.

NOTE: You can change your password later if you want.

4 Click Initialize Password.

The StoreCenter dashboard is displayed.
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 Log on to StoreCenter

1 Click the link in the e-mail you received from your Administrator

OR

Copy and paste the URL https://www.apogeestorefront.com/sfadmin 
in the address bar of your browser. You should use the recommended 
browser.

NOTE: The URL for the Asanti Production StoreCenter is:
https://www.asanti-storefront.com/sfadmin 

2 Enter your e-mail address and your password.

3 Click Sign in.

The StoreCenter dashboard is displayed.

Related topics: • Impersonate a user on page 282

Editing Your 
Account

You can manage your account once you are logged in.

 Change your password

1 Click your name on the navigation bar to open your Account.

2 Enter a password of your choice in the New Password and Repeat New 
Password fields.

3 Click Save.

 Edit your Account Profile

You can change some of the profile settings which are set initially by the 
Administrator.

1 Click your name on the navigation bar to open your Account.

2 Enter your details in the Profile tab.

3 Choose your preferred language in the Language drop-down list.

This is the language used for the StoreCenter.
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4 Select the Notifications check box if you want to receive an e-mail for each 
new order.

NOTE: If the store requires approval of orders before processing, Company 
Administrators should select this option to receive e-mails as the orders are 
placed.

5 Click Save.

 Reset a forgotten password

1 In the StoreCenter logon window, click Forgot Your Password.

2 Enter your e-mail address and click Submit.

You will receive an e-mail inviting you go to the StoreCenter where you can 
set a new password of your choice.

3 Enter a new password of your choice in the Password field and the Password 
Confirmation field, and click Reset Password.

You are now signed in.

Related topics: • Impersonate a user on page 282
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CHAPTER
3 Companies and 
Administrators 

Printer Administrator only

Companies are the customers or business relations of a printer or print service 
provider. These need to be defined by the Printer Administrator before a store 
can be set up. A Company is assigned one or more stores and optionally a 
Company Administrator who in turn can create users and products, and manage 
orders and stocks for his company.

 Companies .................................................................................................................. 46
 Administrators ........................................................................................................... 49
 Approval Groups ....................................................................................................... 54
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Companies

Companies are the highest level in the StoreCenter hierarchy and need to be 
defined before company administrators can be assigned.

NOTE: A print service provider who wants to create his own store must create a 
Company for himself.

 Create a Company

A Company is your customer or business relation for whom you want to create a 
store.

A store in STOREFRONT consists of the web-to-print website which has a unique 
URL, referred to as a storefront in this documentation, and the back-end 
functionality set up in the StoreCenter.

1 On the menu bar, choose Companies and then click the Add button.

2 In the General tab, enter a Company Name and Source Language.

The Source Language is the default language for new Administrators, Stores 
and Products.

NOTE: The source language cannot be changed once you click Save.

3 Optionally enter a location for the Export Folder. This is where orders are 
exported via the PrintSphere service.

4 Choose a Salutation:

 Informal (first name only)

 Informal No Title (first name only)

 Formal (title and last name)

This is the salutation format which is used for e-mails sent for all the stores of 
the company.

5 Enter your Billing Address details (name, etc.) and your MIS ID if appli-
cable. If the company will only be used for billing purposes, select the Use 
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this company only for billing check box. This means the company will only 
show up in lists related to billing.

6 Click Save to confirm your changes.

The Company is displayed in the list.

7 In the Languages tab, add additional supported languages which are 
relevant for this particular Company.

For example: you may need a second language to set up a bilingual 
storefront.

8 In the Access Labels tab, add access labels as required to control which 
products a user can see on the storefront. The maximum number of labels is 
516. See “Access Labels” on page 262 for more information on setting this up.

9 In the Approval Groups tab, add group labels as required to control who can 
approve. See “Approval Groups” on page 54 for more information on setting 
this up.

10 Click Save to confirm your changes.

 Edit a Company

1 On the menu bar, choose Companies and select the company you want to 
edit in the list.

2 Make the changes in the relevant tabs.

NOTE: You cannot change the source language you chose when creating the 
Company.

3 Click Save to confirm your changes.

 Delete a Company

NOTE: You need to delete the products that have been created for the company 
first.

1 On the menu bar, choose Companies and select the company you want to 
delete.
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2 Click the Delete button.

3 Click OK to confirm that you want to delete the selected company.
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Administrators

You can create the following types of administrators:

 Printer Administrator: has full access to all of the functions of StoreCenter. It 
is recommended that a Printer Administrator sets up an additional adminis-
trator as back-up for when the first Printer Administrator is absent or cannot 
access the system for other reasons.

 Printer Operator: has limited rights to perform tasks in StoreCenter, e.g. 
monitoring and processing orders. This step is optional and only required if 
you want to delegate these tasks to a Printer Operator.

 Company Administrator: a role with the rights to perform certain tasks in 
StoreCenter with regard to the specified company and its stores: create 
Users, manage orders and stocks. This step is optional and only required if 
you want to delegate certain tasks to a Company Administrator.

 Company Approver: can approve orders placed by users of a specified 
approval group or groups.

 Company Operator: can manage the stock of his company.

 Company Administrator/Approver: in addition to the company adminis-
trator role, this administrator may also be a dedicated approver for a 
specified approval group or groups.

NOTE: An administrator who wants to view a storefront he created must create a 
User account for himself (see “Create a new user” on page 276) or impersonate 
another User (see “Impersonate a user” on page 282).

 Create Administrators

1 On the menu bar, choose Administrators and then click the Add button.

2 In the Profile tab, enter the person’s name and other personal details:

 E-mail: Enter a valid e-mail address for sending notifications; if you want 
to use a fake or dummy e-mail address for testing purposes, use the 
example.com domain (e.g. fakeuser@example.com) to avoid e-mail 
bouncing and error logs on the StoreCenter server.
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 Language: Choose a language in the drop-down list, preferably a 
language that is supported by the stores.

3 In the Title drop-down list, choose a title for the formal salutation. The 
options depend on the language you just selected for this user.

For example, if you chose English as language, the following title options are 
displayed:

 Mr.

 Ms.

 Ms./Mr.: if you do not know the gender of the person

For example, if you chose German as language, the following title options are 
displayed:

 Frau Dr.

 Herr Dr.

 Frau/Herr: if you do not know the gender of the person

 Frau

 Herr

NOTE: The title is only displayed in e-mails if you selected the formal 
salutation style for the Company.

NOTE: For German, the title is also shown on the storefront when formal is 
enabled.
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4 Choose one of the following Roles:

 Company Administrator

 Company Administrator/Approver

 Company Approver

 Company Operator

 Printer Administrator

 Printer Operator

NOTE: See “Approval Groups” on page 54 for more information on the 
Company Approver and Company Administrator/Approver roles.

5 For Company Administrator, Company Administrator/Approver and Company 
Operator:

You can allow these two roles to manage orders and stocks. This can be useful 
for stores where a third party manages part of the order fulfillment (e.g. non-
print products such as gifts and gadgets).

 Manage Orders: download orders, apply corrections, carry out 
shipments, subscribe to e-mail notifications for new incoming orders

 Manage Stock: change the stock counters in the Product tab, receive 
stock related e-mail notifications when a product is nearly and really out-
of-stock.

Figure 3.8: Example of a formal salutation for a user whose gender is unknown.
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6 For the Company roles, choose a Company from the drop-down list. The 
Printer roles are assigned for all companies.

7 Select the Notifications check boxes so this user receives notification e-
mails:

 Send an e-mail for each new order to approve: can be selected only for 
Approvers

NOTE: If the store requires approval of orders before processing, Company 
Administrators/Approvers should have this option selected to receive e-
mails as the orders are placed.

 Send an e-mail for each new order: can be selected only if Manage 
Orders is selected

 Send an e-mail for each new quote: The shopper receives an e-mail with 
a link to a requested quote.

8 Click Save to confirm your changes.

The new administrator is displayed in the list with the role and company.

A welcome e-mail is sent to the e-mail address entered in the Profile tab. The 
log-on procedure is explained in “Logging on and Editing Your Account” on 
page 41.

 Deleting Administrators

NOTE: You cannot delete yourself as administrator.

1 On the menu bar, choose Administrators and select the person you want to 
delete.

2 Click the Delete button.

3 Click OK to confirm that you want to delete the selected administrator.

 Disable Administrators

An administrator account can be disabled temporarily.
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NOTE: You cannot disable your own account.

1 On the menu bar, choose Administrators and select the person whose 
administrator account you want to disable.

2 Click the Disable button.

3 Click OK to confirm that you want to disable the selected administrator.
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Approval Groups

NOTE: This feature may not be included in your license pack.

A workflow can be set up for the approval/rejection of orders placed by 
shoppers. In its simplest form, approval is performed by the Company Adminis-
trator who can approve/reject orders for all the stores assigned to his company. 

However, in certain scenarios, a dedicated person in a company (e.g. a depart-
ment manager) may need to be designated to approve the orders of a subset of 
users (e.g. a department). In other words, the approver depends on the user who 
places the order.

This approval scenario is covered by the approval group concept whereby users 
are assigned to groups within the company. One or more dedicated approvers 
can then be specified for each approval group.

Setting up an approval group consists of the following steps:

 Step 1: Specify approval groups for a company

1 On the menu bar, choose Companies and select the company you want to 
add/edit approval groups.

2 Go to the Approval Groups tab and click the Add button to add your first 
approval group.

3 Enter a name for the approval group in the Add Group Label dialog and click 
Save

4 The approval group name is added in the left column.

5 Add as many groups as you need; select the Keep dialog open check box to 
work faster.

You now have a selection of approval groups which are currently empty: no 
approvers and no users.
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6 Click Save to confirm your changes.

 Step 2: Assign your users to approval groups

1 On the menu bar, choose Users and sort the list by store so you can see the 
users of the store for which you want to use group approval.

2 Select one of the users and go to the Approval tab.

The approval mode (Using Groups) and default approval group are indicated 
in the Store Default panel.

3 In the Approval panel, you can override the store defaults by clearing the 
Approval: As Specified on Store check box.

You have three options:

 None: orders placed by this user do not require approval

 All approvers can approve: every user with an approval role can approve 
the orders placed by this user

 Using Groups: orders can only be approved by Approvers of the respective 
Approval Group

By choosing the latter option, you can assign the user to a different approval 
group than the default approval group.
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4 Click Save to confirm your changes.

5 Repeat the procedure to populate the different approval groups.

 Step 3: Specify group approvers

One or more administrators or approvers can be assigned to an approval group.

1 On the menu bar, choose Administrators and select the administrator to 
whom you want to assign group approval, or create a new administrator.

NOTE: This must be an administrator of the company for which you created 
the approval groups.

2 In the Profile tab, you can choose from the following roles:

 Company Administrator: This administrator can only approve the orders 
placed by all the users of all the company’s stores. All other operations are 
disabled in the Orders panel.

NOTE: The Company Administrator does not receive e-mail notifications 
for new orders. You can promote him to Company Administrator/
Approver and then indicate whether he must receive e-mail notifications 
for the selected approval groups.

 Company Approver: This administrator can only approve orders placed 
by users who belong to the approval group or groups as specified in the 
Approval Groups tab for this administrator; applies for all stores of the 
company. In the Orders panel, this administrator only sees the Approval 
tab which lists the orders that he is allowed to approve/reject.
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 Company Administrator/Approver: This administrator has two Approval 
tabs in the Orders panel: the My Approval tab lists orders from groups 
assigned to him; the Approval (All) tab lists all the orders of the company 
that need to be approved.

3 In the Approval Groups tab, select the group labels for the groups that this 
administrator is allowed to approve.

The checked labels move to the right-hand panel.

This administrator now belongs to the selected approval groups and is 
allowed to approve/reject orders placed by users in these groups.

4 Click Save to confirm your changes.

 Step 4: Define the approval mode for a store

1 On the menu bar, choose Stores and select a store that is assigned to the 
company you have created group labels for.

2 In the Set Up panel in the General tab, scroll down to the Approval drop-
down list.

You have three options:
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 None: orders do not require approval

 All approvers can approve: every user with an approval role can approve 
all orders

 Using Groups: orders can only be approved by Approvers of the respective 
Approval Group

Choosing the latter option, Using Groups, displays the Default Approval 
Group drop-down list where you see the approval groups you created.

Choose one of the groups for the Default Approval Group.

3 Click Save to confirm your changes.

 Step 5: Check your Approval Groups

1 Now go back to the company profile in the Companies tab.

2 Go to the Approval Groups tab.

For each approval group you created earlier, you now see the approvers and 
users in the right column.
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Related topics: • Users on page 275
• Approving/Rejecting Orders on page 295
StoreFront User’s Guide



60 APPROVAL GROUPS
StoreFront User’s Guide



CHAPTER
4 Setting up Resources 
(Advanced Menu) 

Printer Administrator only

The Advanced menu provides access to general settings and preferences that 
need to be defined before you can create templates and set up a store. These 
resources are available for all Companies and Stores.

 Media ............................................................................................................................ 62
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 Shipping ...................................................................................................................... 65
 Shipping Services .............................................................................................. 65
 Shipping Regions ............................................................................................... 76
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 Payment Methods ............................................................................................. 81
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 TaxCloud Integration (US only) .................................................................... 85

 Production Settings ................................................................................................. 87
 Preflight Defaults .............................................................................................. 87
 Production Center ............................................................................................. 92
 Production Calendar ......................................................................................... 94
 Order Item Flags ................................................................................................ 95
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 Prepress Settings ............................................................................................... 98
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 Automated Product Creation .............................................................................104
 Custom Attributes ..................................................................................................106
 Predefined Values ..................................................................................................108
 Licenses .....................................................................................................................109

NOTE: The Advanced menu also provides access to the Translations feature. This 
is explained in a separate section: “Multilingual Storefronts” on page 511.
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Media

Media refers to the substrate on which the Product will be printed. 

NOTE: This resource is set for all Product Templates.

The following options are available:

 Media Types

 Media Sizes

Media Types In the Media Types dialog box you will define the different media types you want 
to make available and you can organize substrates in media type categories, e.g. 
offset paper, inkjet paper, PVC, etc.

Details Tab - Paper

Choose this category for paper media that you want to designate with a Grade.

Stock Brand Enter the brand of the substrate.

Weight Enter the range of paper weights, separated by a comma and without a space, for 
the paper brand you entered in Stock Brand. These weights will appear in the 
Weight drop-down list when you create your product templates. 

AND/OR

Thickness Enter the range of thickness values, separated by a comma and without a space, 
for the paper brand you entered in Stock Brand. These values will appear in the 
Thickness drop-down list when you create your product templates.

For example:

 Weight values: 100, 120, 150 g

 Thickness values: 200 µm; 8 mil (Imperial and US Customary)

NOTE: You must specify all available weights and thicknesses if you are using 
weight and packaging based shipping. Both values are required for the 
correct calculation of the shipping costs. See “Calculation Method” on 
page 68 for more information on shipping costs. If you enter both the weights 
and the thicknesses, STOREFRONT assumes that the respective weights match 
the respective thicknesses.
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MIS ID This code is included in the JDF order data and can be used to inform an MIS or 
ERP system on the media type. It is also displayed on the order item details page.

Grade Choose one of the generic grades to describe paper.

Details Tab - New Category

Choose this category for all other media that you do not want to designate with 
a Grade, including certain paper types (e.g. inkjet papers). New categories are 
added to the drop-down list after saving your changes and you can select this 
new category when creating subsequent media.

Category Name Only active if you choose New Category; enter a category name and this name 
appears in the drop-down list once you save this new medium.

Coating Front/Back Only active if you choose New Category; select one of the generic coatings to 
describe the substrate; the front and back coatings can be different.

 Create Media Types

1 On the menu bar, choose Advanced > Media.

A list of media is displayed in the Media Type dialog box.

2 Click the Add button to add a new substrate to the list.

3 In the Details tab, choose a category from the drop-down list. Initially you 
have one category, Paper, but you can add types by choosing New Category 
in the drop-down list. See “Details Tab - Paper” on page 62 and “Details Tab 
- New Category” on page 63 for more information.

4 Click Save to confirm your changes.

The new substrate is added to the list, designated with the stock brand and 
grade or coating. The category is displayed in the Cat. column which can be 
used to sort the media by category.

 Export Media Types

1 On the menu bar, choose Advanced > Media.

2 Click the Export button to export all the media types in the list.

You can choose to view or download an Excel file which displays all the 
media types with their details in a single worksheet.
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Media Sizes The Media Sizes dialog shows all the standard media sizes which are defined by 
default in the STOREFRONT system in the left panel. You can move standard sizes 
to the supported sizes to make them available for all media types. You can also 
create your own media sizes.

 Assign Media Sizes

1 On the menu bar, choose Advanced > Media and then choose Media Sizes.

2 Move the sizes that you want to make available from the Standard Media 
Sizes panel on the left to the Supported Media Sizes panel on the right by 
clicking the arrow in the middle.

The size is added automatically to the correct category. The category is 
created in the Supported Media Sizes column if it’s new.

3 Repeat to create a list of frequently used sizes

NOTE: Product templates can be created with custom sizes not mentioned in 
this list.

 Add Custom Media Sizes

You cannot add custom media sizes to the system categories so you may need to 
create a custom category first.

1 On the menu bar, choose Advanced > Media and then choose Media Sizes.

2 In the Standard media Sizes column, click the Add New Category button and 
enter a new Media Category Name.

3 Click Save to add the category to the list.

4 Click in the new category and then click the Add New Size button and enter 
a new size.

5 Click Save to add the custom media size to the list.

Related topics: • Product Templates on page 115
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Shipping

Storefront orders are shipped using a shipping service and every store must have 
at least one shipping service assigned to it. In the Shipping resource you can set 
the shipping region (a town, region, or even several countries) or a fixed 
address, order tracking, the estimated shipping date, and how the shipping price 
is to be calculated for each service.

The following options are available:

 Shipping Services

 Shipping Regions

 Packaging Units

Shipping Services Three types of shipping services exist:

 Ship to User Address: The shopper provides the delivery address in the 
shipping region you define.

 Ship to Fixed Address: You provide one or more pick-up points that the 
shopper can choose from.

 Ship to Address Specified in Separate File: The shopper provides a file 
containing shipping instructions for the order: multiple addresses, different 
packaging, grouping of items, delivery times, etc.

NOTE: A shipping service is only available for stores whose price list currency is 
the same as the currency of the shipping service. 

Related topics: • About Shipping Costs Based on Packaging on page 70

 Add a ‘Ship to User Address’ shipping service

You can allow a shopper to provide a delivery address which must be located in 
the selected shipping region.

1 On the menu bar, choose Advanced > Shipping > Shipping Services tab.

2 In the Shipping Service pane, click the Add button and choose Ship to User 
Address to add a new service to the list.
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3 In the General tab, complete the Name field.

4 In the Shipping Region list, select a region from the drop-down list.

The Shipping Region list contains one region, Worldwide, by default. You 
can add your own regions in the Shipping Regions dialog box: See “Create 
Shipping Regions” on page 76.

5 (US print service providers only) Select the Delivered by Printer check box 
if you are going to deliver orders yourself. This option affects the calculation 
of sales tax by the TaxCloud service.

6 Complete the following fields:

Tax Codes Select one of the tax rates from the drop-down list.

NOTE: The tax code option is not available for print service providers in the 
US. When creating your stores you can choose to use the TaxCloud service to 
calculate US sales and shipping tax. See “TaxCloud Integration” on page 566 
for more information.

Tracking Choose a standard service to be used for the actual shipping; this service will be 
used to track orders once they are shipped.

The following services are currently supported:

 Tracking Not Available

 Canada Post

 Chronopost (France)

 Custom

 DHL, DHL Germany

 DPD

 Federal Express

 Swiss Post

 UPS

 USPS

Choose ‘Custom’ if you are not sure who will provide this service or if the 
shipping service supports shipment tracking using a personalized URL. When 
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an order is shipped, a pop-up window allows you to insert the tracking URL 
which will then be included in the shipment confirmation e-mail to the 
shopper.

Specify Tracking URL
Template

In the Tracking drop-down, choose ‘Specify Tracking URL Template’ if you want 
to specify the syntax of the tracking URL template – for example, if the courier 
service does not use a predictable URL syntax.

The following is an example with AfterShip, a shipping aggregator, where a 
custom URL is entered with {0} acting as a placeholder for the delivery ID:

In this example, if a new order with delivery ID code 695478 is shipped, this 
means the tracking URL will be https://fancyprints.aftership.com/695478. 
Other aggregation services may also support the use of a tracking URL 
template.

Time to ship To indicate the estimated shipping date, select the check box and enter the 
Number of days that it takes to prepare an order for shipment. The shopper sees 
the estimated date during checkout by adding a message in the Shipping Info 
Tab. For example, set the Number of days to 2 days so a shopper who orders on 
Monday sees that his order ships on Wednesday. If the Order is placed BEFORE 
the Order Deadline (set in the Production Calendar), the current day is also 
taken into account: 2 days will then be "Tuesday" instead of "Wednesday".

NOTE: For this to work, you must define your production schedule. See 
Production Calendar. Keep in mind that the estimated shipping date does not 
take all production aspects into account (complex finishing, high quantities, 
workload, etc.) so you may want to include a disclaimer in the shipping info text.

Estimated shipping dates are shown in the Pending Orders tab: grayed out and 
in italics in the Shipped column. You can sort on this column to see which orders 
require priority. Once an order is shipped, the actual shipping date is shown in 
the regular font. For shipments that are overdue the estimated date is marked in 
red.

Shoppers see the estimated shipping date:
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 in the first checkout step, Shipping, if Shipping Info is configured for the 
Shipping Service

 in the second checkout step, Review, and in the order confirmation e-mail

 on the order details page

7 In the Pricing pane, complete the following fields:

Calculation Method This specifies how the shipping price is calculated:

 Fixed Fee per Shopping Cart Item: Enter a fixed amount to be charged for 
each item the shopper adds to the cart.

 Single Fixed Fee: A fixed amount will be charged for shipping the order.

 Percentage on Order Total: A percentage of the total order amount is 
added for shipping.

 Fixed Fee plus Percentage on Order Total: A fixed amount and a 
percentage will be added per order.

 Free Shipping: Nothing is added to the total amount of the order for 
shipping.

 Shipping costs will be added: At checkout, the shopper is notified that 
shipping costs will be added to the price of the order but an amount is not 
specified. The shipping cost is billed separately, outside the STOREFRONT 
system.

 Fixed Fee per Package: Enter a base price for the first package and a price 
for each additional package. STOREFRONT calculates the total number of 
packages based on the thickness and weight of the media. All the neces-
sary packaging parameters must be defined for this calculation method to 
work.

 Fee per Weight Unit: Enter a fixed fee and a price per weight unit. STORE-
FRONT calculates the total weight based on the media weight and the 
weight of the required packaging units. All the necessary packaging 
parameters must be defined for this calculation method to work.

 Fee per Packaging Unit: Enter the Fixed Fee you want to charge or leave 
this field blank, save the Shipping Service and then, in the table, set the 
price that you want to charge per packaging unit. See “Set packaging unit 
prices” on page 79 to do this. All the necessary packaging parameters 
must be defined for this calculation method to work. See “About Shipping 
Costs Based on Packaging” on page 70 for more information.
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If an order requires different packaging units, select the Use the highest 
price of first unit once for orders with different units check box if you 
only want to apply the higher Price of first Packaging Unit once (the 
highest of all first units will be applied). Otherwise the higher price for 
each first unit will be applied.

NOTE: The packaging unit table is empty if no units have been defined or 
if you have not yet saved the shipping service you are creating. See 
“Create packaging units” on page 77 to specify these units.

 UPS Quote: This method requires an account with UPS which may not be 
available in all countries. At checkout, STOREFRONT submits the address 
and order data to a UPS service that immediately quotes the shipping cost 
based on the weight and number of packages. See “Set up a real-time UPS 
Quote shipping service” on page 71 for more information.

 Weight based fee: Here you can specify a fixed cost and a price per kilo or 
pound for multiple weight categories. The weight is the combined weight 
of all of the items in the order. All the necessary packaging units must be 
defined for this calculation method to work.

Packing Optimization Controls how order items are packed together when Fee per Packaging Units is 
selected:

 By Number of Packaging Units: the system uses as few boxes or rolls as 
possible, even if this leads to higher shipping costs;

 By Shipping Costs: the system picks the combination of boxes or rolls with 
the lowest shipping cost, based on the shipping cost for first units, even if 
this leads to the use of additional packaging units.

Currency Select the appropriate currency for the calculation method.

NOTE: Once the shipping service has been selected for a store, you cannot edit 
the currency.

Free for orders above Enter an amount to offer free shipping for orders above this amount. Shipping is 
never free if you leave this field empty; if you enter 0, shipping is always free (the 
same as Free Shipping calculation method).

8 Click Save to confirm your changes.

The new Shipping Service is displayed in the list.
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Max. Shipping Cost Specify a value that cannot be exceeded when the shipping cost is calculated.

Shipping Info Tab

In this tab you can create a text blurb that appears under the shipping service 
during checkout.

If you enabled the Time to ship option, you can insert the following three 
variables in your text:

 {estimatedshippingdate} inserts the date when the order is expected 
to be shipped, e.g. '10/10/2017'. The date formatting depends on the 
regional settings of the store.

 {orderdeadline} inserts the cut-off time, e.g. '11:30 AM'; if you order 
before this time, the day counts as a production day.

 {shippingdays} inserts the number of days before orders will be 
shipped, e.g. 4

About Shipping Costs Based on Packaging

You can choose from several methods for calculating the shipping fee of an 
order. If you choose a shipping service whose cost is based on the packaging 
(Fixed Fee per Package, Fee per Weight Unit, Fee per Packaging Unit, UPS Quote 
calculation methods) when setting up a store, the shipping fee depends on the 
number and type of packaging units required to ship an order. STOREFRONT 
chooses the most appropriate packaging units and calculates the number of 
units by comparing the product specifications with the available packaging 
units. The number of packaging units is subsequently multiplied by the specified 
price of the unit.

Figure 4.9: Shipping Info (here with estimatedshippingdate variable) appears under the name 
of the Shipping Service at checkout
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The following steps are required to set up a store with a shipping service whose 
cost is based on the packaging.

1 Go to Advanced > Shipping > Packaging Units tab, and create packaging 
units for the packaging types that you want to make available: different 
boxes, tubes, wrapping, etc. See “Create packaging units” on page 77 for 
more information. You must set the weight, thickness and measurements for 
the media used for these packaging units in Advanced > Media. See 
“Media” on page 62 for more information.

2 Go to Advanced > Shipping > Shipping Services tab and create a service 
with a fee based on packaging (Fixed Fee per Package, Fee per Weight Unit, Fee 
per Packaging Unit as calculation method). This is where you set the shipping 
fee for the different units. See “Shipping” on page 65 for more information.

3 Go to Stores > Shipping tab and select a shipping service based on 
packaging. See “Shipping Tab” on page 215 for more information.

CAUTION: You must assign packaging units to a product template if your store 
uses a shipping service based on packaging as calculation method. If you do 
not do this, the shopper will not be able to complete the order process.

4 Go to Product Templates > Packaging Units tab and add packaging units 
(either boxes or rolls, not both) to the product templates that will be used to 
create products for the store. See “Packaging Units Tab” on page 147 for 
more information.

5 Go to Product Templates > Product Template tab to set packing measure-
ments for the product templates. See “Packing Measurements button” on 
page 126 for more information.

6 Go to Product > Pricing and Scheduling tab in the Shipping section and 
specify Combined Packaging options. See “Shipping” on page 168.

Related topics: • Taxes Tab on page 253

 Set up a real-time UPS Quote shipping service

This is a packaging-based, Ship to User Address services so read the information 
“About Shipping Costs Based on Packaging” on page 70. This method requires 
that you, as printer administrator, have an account with UPS which may not be 
available in all countries. When a shopper checks out, STOREFRONT submits the 
address and order data to UPS that immediately quotes the shipping cost based 
on the weight and number of packages.
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Prerequisites
You need to create an account with UPS before performing this procedure.

1 On the menu bar, choose Advanced > Shipping > Shipping Services tab.

2 In the Shipping Service pane, click the Add button and choose Ship to User 
Address to add a new service to the list.

3 Complete the fields as explained in “Add a ‘Ship to User Address’ shipping 
service” on page 65 and choose UPS Quote as the Calculation Method.

A dedicated dialog is displayed for the UPS Quote method.

4 Enter the following UPS information:

 User name/Password

 Access Key

 UPS Account Number

 Delivery Method: Select one or more Delivery Methods that UPS supports 
when shipping from the address in your Production Center to the region 
that you selected in your shipping service.

NOTE: You may want to create several shipping services – each with a 
dedicated UPS delivery method.

 Mark-up: You can enter a mark-up to be added on top of the UPS quote. 
StoreFront User’s Guide



 

4 SETTING UP RESOURCES (ADVANCED MENU) 73
 Fixed Fee: You can enter a fixed fee to be added on top of the UPS quote.

 Free for orders above: Enter an order amount that entitles the shopper to 
free shipping.

 Account Type: Make sure you select Production once you’ve finished 
testing the account; Production guarantees best performance.

5 Click Save to confirm your changes.

The new UPS Quote Shipping Service is displayed in the list.

 Add a ‘Ship to Fixed Addresses’ shipping service

You can specify shipping services with one or more fixed pick-up points. 
Shoppers can only have their orders delivered to the specified address or 
addresses.

1 On the menu bar, choose Advanced > Shipping > Shipping Services tab.

2 In the Shipping Service pane, click the Add button and choose Ship to Fixed 
Addresses to add a new fixed delivery addresses service to the list.

3 Complete the general and pricing sections as explained in “Add a ‘Ship to 
User Address’ shipping service” on page 65.

4 Enter the Delivery Address details and complete all the required fields.

5 In the Info pane you can use the HTML Editor to enter additional information 
to help a shopper.
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NOTE: The Delivery Address and Info panes may appear at the bottom of the 
window and you may need to scroll down.

6 Click Save to confirm your changes.

The new Shipping Service is displayed in the list with the delivery addresses 
indented.

You can add multiple delivery addresses to the same shipping service by 
selecting a Fixed Delivery Addresses service in the list and choosing Add New 
Delivery Address in the Add button context menu. You can enter the 
additional delivery address details; all the other settings are inherited from 
the service.
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TIP: You can customize the 
Fixed Delivery Address label 
when setting up the store: 
see “Shipping Tab” on 
page 215.

 Add a ‘Ship to Addresses Specified in Separate File’ shipping service

The shopper is requested to attach a file containing shipping instructions for his 
order. The document can be a TXT, Word, Excel, PDF or any other file and it is 
expected to specify how the order should be shipped. However, this is an off-line 
method for providing shipping instructions so none of the automation features 
(calculation of shipping cost based on destination, order data in Excel summary, 
communication with an MIS system, etc.) apply.

1 On the menu bar, choose Advanced > Shipping > Shipping Services tab.

2 In the Shipping Service pane, click the Add button and choose Ship to 
Addresses Specified in Separate File.

3 Complete the general and pricing sections as explained in “Add a ‘Ship to 
User Address’ shipping service” on page 65.

Figure 4.10: Fixed delivery address with opening hours added in the HTML editor – storefront 
view

Figure 4.11: A storefront checkout page where the shopper can upload a file with shipping 
instructions
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Orders that come in with this shipping service are indicated in the Pending 
tab of the Orders page with a diskette icon. You can download this file and 
read the instructions. 

Shipping Regions You can specify two types of shipping regions for the ‘Ship to User Address’ 
shipping services: 

 Country-based region: The ‘Ship to User Address’ can be anywhere in the 
specified country/countries or states.

 Zip code-based region: The zip/postal code of the ‘Ship to User Address’ 
must be included in the list of codes specified for this region.

A message informs shoppers to use a different shipping service if they enter an 
address which is located outside the region.

 Create Shipping Regions

1 On the menu bar, choose Advanced > Shipping.

2 In the Shipping Regions tab, click the Add button and choose a region type.

3 Complete the Name field (e.g. Europe, Benelux, Asia).

4 For a Country-Based Region, select the check boxes or double-click the 
countries you want to group in a region to add them to the list on the right.

For some countries you can select states or provinces. These countries can be 
expanded by clicking the black arrow.

OR

5 For a Zip Code-Based Region, select a country from the drop-down list and 
then enter the zip (postal) codes that you want to assign to this region. You 
can define ranges and multiple values or both.
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Follow the displayed instructions for designating the codes for the country in 
question.

6 Click Save to confirm your changes and validate the codes you entered.

Check the codes and syntax if the codes do not validate correctly.

The new Shipping Region is displayed in the list and will also be displayed in 
the Shipping Region drop-down list when creating a Ship to User Address 
shipping service.

Zip-code based regions are indicated with a special icon in the list of shipping 
regions.

Packaging Units If you choose Fee per Packaging Unit as calculation method for a shipping 
service, you need to define the packaging units you plan to use for shipping. 
These can be Boxes for brochures, etc. or Rolls for posters, etc.

 Create packaging units

1 On the menu bar, choose Advanced > Shipping.

2 In the Packaging Units tab, click the Add button.
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3 Complete the Name and Description fields so you know which unit to select 
when creating a product template.

4 Choose the Packaging Unit Type:

 Box:

 Roll:

5 Complete the following fields:

Box Dimensions The Length (1), Width (2) and Height (3) of the packaging unit as indicated in 
the diagram.

Roll Dimensions The minimum Width (1), maximum Width (2) and Diameter (3) of the 
packaging unit as indicated in the diagram. The Diameter value is only used for 
the UPS Quote shipping service calculation.

Tare Weight The weight of the packaging unit without its contents (optional).

Max. Gross Weight The maximum allowed weight of the contents including the packing unit 
(optional).

6 Click Save to confirm your changes.

The new packaging unit is displayed in the list and will now also appear in the 
Pricing table for your shipping service.

Related topics: • About Shipping Costs Based on Packaging on page 70
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 Set packaging unit prices

If you choose Fee per Packaging Unit as calculation method for a shipping 
service, a table is displayed with all the available units and their prices. The 
prices need to be set for all packaging units. 

1 On the menu bar, choose Advanced > Shipping.

2 In the Shipping Services tab, select the service whose prices you want to 
specify and in the Pricing pane, click the Edit button.

NOTE: The Edit button is at the bottom of the screen so you may need to scroll 
down.

The Edit Pricing dialog box is displayed.

3 Enter the price for each unit.

You can set different prices for the first packaging unit and the second and 
following units, for example if you want to give a discount if several identical 
units are ordered. If you do not want to distinguish between the first and 
additional units, only fill in the “Price of First Packaging Unit” column and 
leave the “Price of Additional Packaging Units” column empty.

4 Click Save to confirm your changes.

The prices are added in the respective column in the pricing table.

Related topics: • Create a store on page 206
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• Shipping Tab on page 215
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Payment Methods and Tax

The following options are available:

 Payment Methods

 Tax Config

 TaxCloud Integration (US only)

Payment Methods A store can be set up to accept one or more online payment methods from which 
shoppers can choose when placing orders. Online payment is optional in the case 
of private stores, which are often used in a B2B environment, for example to 
allow franchisees, branches or subsidiaries to order products. However, online 
payment is a requirement for public stores which are visited by unknown 
shoppers.

STOREFRONT provides two main methods for handling online payments: by bank 
transfer (also referred to as wire transfer) or via secure payment gateways such 
as Ingenico and PayPal. 

NOTE: This resource only needs to be set if one of the stores requires online 
payment of items.

 Set up payments by bank transfer

The Bank Transfer payment method allows shoppers to pay for their orders by 
transferring the order amount directly into a specified bank account. They 
receive instructions about how to make the payment during check-out. The 
same procedure can be used for payments with cheques.

Orders which are paid by bank transfer require manual intervention to update 
the payment status in the orders Pending tab. See“Pending Orders” on page 299.

NOTE: Bank transfers through external payment service providers are not 
supported in STOREFRONT. 

1 On the menu bar, choose Advanced > Payment Methods and Tax.

2 Click the Add button and choose a Bank Transfer in the list.
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3 Enter a name for the bank transfer payment method. This is the name that 
appears in the General tab of the store set-up.

4 Leave the Order processing only upon payment check box selected if you 
want orders to be put on hold until payment is received. If you are certain the 
shopper will pay, clear this check box and the orders will be processed while 
waiting for the payment.

NOTE: Selecting or clearing this option affects all orders that use this payment 
method, including orders which are already in the pending order list.

5 Click Save.

The Customization and Surcharge tabs are active.

6 In the Customization tab, enter a Description, Checkout Text and Payment 
Instructions.

The Description (optional) is displayed on the 1st page of the checkout 
wizard, when the shopper has to select the payment method. So here you can 
provide text that explains that the shopper is expected to pay for the order by 
bank transfer. 

The Checkout Text (mandatory) is displayed on the 3rd page of the 
checkout wizard. You can modify the sample text if you want. The 
{ordertotal} code generates the total sum to be paid for the order.

Figure 4.12: Description on the 1st page of the checkout wizard
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The Payment Instructions (mandatory) are displayed on the order details 
page when the shopper has completed the checkout wizard, and in the order 
confirmation e-mail. Edit the introductory text as required and enter the 
name of your Bank, your Account Number, and the name of the Company. 
The {ordertotal} and {ordernumber} codes generate the total sum and 
the order number.

7 Click Save.

Figure 4.13: Checkout Text on the 3rd page of the checkout wizard

Figure 4.14: Payment Instructions on the order details page
StoreFront User’s Guide



84 PAYMENT METHODS AND TAX
8 Go to the Surcharge tab if you want to charge extra for using a payment 
method: for example, an extra charge for paying with a credit card. Enter a 
fixed cost and/or percentage.

9 Click Save.

Related topics: • General Tab on page 196
• HTML WYSIWYG Editor on page 265

 Set up Payment Gateways

1 On the menu bar, choose Advanced > Payment Methods and Tax.

2 Click the Add button and choose a payment method in the list.

The following Payment Methods are currently available:

 Ingenico

 PayPal Payments Pro PayFlow Edition(UK and US only)

 PayPal Express Checkout

 Stripe

 Mercado Pago

 Inicis

 Bambora

3 Choose the Payment Method you want to use and enter the configuration 
details.

The configuration details are provided by the payment method service 
provider.

NOTE: Read how to apply for a payment gateway account and integrate this 
with STOREFRONT in “Configuring Payment Gateways” on page 563.
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4 Choose the Time of Payment from the drop-down list.

 Deferred: The customer’s card is authenticated when the purchase is 
made. This is a check that the card is valid and payment is feasible. Store-
Center will indicate for the order that online payment is required. The 
card is charged when the order status is changed to ‘Shipped’. Store-
Center will then briefly indicate that the payment is being captured. Once 
payment is processed, its status is updated. See “Payment Status and 
History” on page 320 for information on how the payment status is 
indicated with icons in the Pending Orders list.

 Direct: The customer’s card is charged when the purchase is made. Store-
Center will indicate in the Pending Orders list if the order is paid or if the 
payment failed.

5 Click Save to confirm your changes.

The Payment Method is now configured.

Tax Config In this tab you can configure how sales tax or VAT is applied when shoppers from 
abroad purchase items in your store. For each country, you can choose from one 
of the following options:

 No tax: Nothing is added to the product price when a foreign shopper 
purchases something.

 Foreign tax: The tax of the foreign shopper’s country is applied.

 Domestic tax: Your tax rate is applied to purchases made by foreign 
shoppers.

NOTE: Tax Config cannot be combined with TaxCloud for a US account.

TaxCloud 
Integration (US 
only)

Print service providers based in the US can enter their details for TaxCloud 
integration in the TaxCloud Integration dialog box.

Prerequisites
You must first visit the TaxCloud website, register for this service and obtain 
your TaxCloud codes before performing this procedure. See “TaxCloud Integra-
tion” on page 566 for more information on.
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 TaxCloud Integration

In this tab you can enter the TaxCloud details that you received when you regis-
tered with the TaxCloud service.

1 On the menu bar, choose Advanced > Payment Methods and 
Tax > TaxCloud Integration tab.

NOTE: The TaxCloud Integration button is only visible if your location is set 
to United States. Choose Advanced > Production Center to check your 
location. You need to sign out and sign back in for this change to take effect.

2 Enter or copy/paste the API ID and an API Key which were generated on the 
TaxCloud website. 

3 Click Save to confirm your changes.

Now you can enter the default TIC code.

4 Choose General Goods and Services as the default TIC and click Save to 
confirm your changes.

The TIC code is now displayed next to the TIC category.

The default TIC is used for all products on the storefront. You can specify a 
different code if required at the product level.

Related topics: • Create a store on page 206
• Configuring Payment Gateways on page 563
• TaxCloud Integration on page 566
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Production Settings

Here you can set the preflight defaults for Uploadable Products, PDF Preview 
details for Printed Stock, On Demand and Customizable Products, and the 
settings that control how orders to be printed are processed further by Apogee 
Prepress or Asanti.

The following options are available:

 Preflight Defaults

 Production Center

 Production Calendar

 Order Item Flags

 PDF Preview

 Prepress Settings

Preflight Defaults Shoppers upload their own PDFs or image files when ordering an Uploadable 
Product and STOREFRONT performs a number of preflight checks to validate the 
incoming files. In this tab you can decide which issues are fixed automatically 
and to which extent the shopper is warned about potential issues.

Figure 4.15: A shopper is notified about errors and fixes when uploading a file.
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NOTE: Remember that preflight warnings interrupt the ordering process and 
may have an adverse effect on the number of orders you receive.

The preflight defaults set here can be overridden by the preflight settings of a 
product template. Go to Product Templates > Preflight Tab.

 Set Preflight Defaults

 On the menu bar, choose Advanced > Production Settings > Preflight 
Defaults tab.

Options for Uploadable Products

File Support

Preflight will be performed on the following file types:

Unbound Set the allowed file types for unbound products: PDF for documents and/or 
TIFF, TIF, JPEG, JPG, GIF and BMP for images.

Select the Allow multiple documents combined in one PDF check box if you 
want to let shoppers upload a single PDF that contains more than one document 
(multi-document feature). For example, 50 posters with different information 
can be uploaded in the same PDF for a single-sided poster product. Each page of 
the PDF generates a job in the workflow system: in this case 50 jobs. If the 

Figure 4.16: A shopper can print the preflight report if necessary.
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product is for a double-sided poster product, 25 jobs will be created in the 
workflow system.

Clear the Allow automatic Trim Box rescaling check box if you do not want 
uploaded PDFs to be scaled automatically, for example if your shoppers upload 
PDFs that are not prepared with professional layout applications (these PDFs 
may be scaled incorrectly if they do not include a trim box).

Bound A shopper can only upload PDFs for bound products.

Editor Settings

This setting allows you to create stores with a mix of uploadable products with 
and without tools in the upload wizard.

Hide Tools Select this check-box to hide the tools so that shoppers cannot use tools to 
modify uploaded files for all products except those that do not follow the 
defaults: clear As Specified in the Preflight Defaults check-box in the Preflight 
tab of the template in question. See “Preflight Tab” on page 149.

Fixes

The following preflight issues are remedied automatically:

Allow Trim Box rescaling of
uploaded PDFs

When selected, the document will be scaled proportionally and you can choose 
from 2 modes for scaling which are important if the aspect ratio of the document 
is not the same as that of the product:

 Underfill: the document fills the width or height of the product and all the 
content remains visible; you may have white space at the top and bottom, 
or to the left and right.

 Overfill: the entire product is filled but some of the content may be 
cropped.

If you clear this option, the validation settings for Incorrect Trim Box apply: 
see “Validation (after fixes)” on page 90.

Allow addition of blank
pages to the uploaded PDF

When selected, blank pages will be added to ensure the document matches the 
number of pages in the product definition. For products with a self-cover, the 
blank pages will be added at the end of the file. For products with a separate 
cover, the blank pages will be added in front of the last two pages.

You can also choose to notify the shopper about these fixes and generate a 
warning that the shopper must confirm to continue. If you clear this option, the 
fixes are applied without notifying the shopper.
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NOTE: Fixed files can be downloaded by the shopper from the product page when 
the uploading process has finished.

Validation (after fixes)

The following parameters of the uploaded PDF or images are validated against 
the product definition:

Trim Box Tolerance The uploaded PDF is rescaled if the entered tolerance is exceeded.

Incorrect Trim Box Does the trim size match the product page size after taking into account the Trim 
Box Reference?

Missing Fonts Are the necessary fonts embedded?

Incorrect Number of Spot
Colors

The system only checks the number of spot colors when the color setup of your 
product contains 1, 2, 3 or 4 spot colors. Color is set up in the product template: 
see “Color” on page 128. If the color setup is specified as Full Color or Gray, no 
warnings or errors are displayed when the shopper uploads a file that does 
contain spot colors. Full Color indicates that the printed result will be CMYK (or 
whatever ink set is used in the flow) and that all spot colors in the uploaded file 
will be converted to that color space.

RGB, Lab or ICC Based
Content

Is the color space RGB or Lab? Are ICC profiles embedded?

Objects without ICC Profile Is line art tagged with an ICC profile?

Images without ICC Profile Are images tagged with an ICC profile?

Unexpected number of
pages (only for bound

products)

Checks whether the uploaded file contains the same number of pages as 
indicated in the product specifications on the storefront.

You can select how the issues will be handled by selecting one of the following 
options:

 Ignore: Do not check the uploaded file for the parameter in question.

 Warn: A warning is displayed and the shopper must choose to cancel the 
uploading process or continue and add the product to the cart.

 Reject: An error is displayed and the uploaded file cannot be added to the 
cart.
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Check Image Resolution This check verifies that the resolution of the uploaded files is sufficient to 
guarantee satisfactory print quality. Set the minimum values to generate 
warnings (Warn below) and errors (Reject below). Errors will stop the upload 
process. Different values can be specified for grayscale/color images and binary 
(line art) images.

Options for Customizable Products

For Customizable Products you can specify the severity when preflighting the 
shopper’s customized document: preflighting can generate a warning or error, 
or just be ignored. Here you set the defaults which you can still change when 
creating the product in the Online Editor: see “Warnings Tab” on page 450.

CAUTION: A shopper may be prevented from ordering a product.

 Select the preflight severity – Ignore, Warning, Error – in the drop-down list 
for the following parameters, and then select or clear the check boxes to 
control the behavior depending on the severity:

 Frame outside page

 Text overflow

 Missing Characters

 Image output resolution

 Image resize

 Empty variable

 Minimum Output Resolution

 Check resolution on: Any, Bitmap, Vector

 Minimum/Maximum Resize %

 Check resize on: Any, Bitmap, Vector

Prevent save on errors Selecting this check box prevents the shopper from saving the customized 
document if it contains errors.

Prevent PDF generation on
errors

Selecting this check box prevents the shopper from generating a PDF of the 
customized document if it contains errors.
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Show warnings on save Select this check box if you want the shopper to see the preflight warnings when 
saving the document. Otherwise the document is saved without notifying the 
shopper of potential issues.

NOTE: New settings only apply to newly created products, not to existing 
products.

Related topics: • Preflight Settings on page 450
• Preflight Results on page 451

Production Center  On the menu bar, choose Advanced > Production Settings > Production 
Center.

Company Details Here you can enter the address details of a production center from where orders 
are shipped. This section needs to be completed in full by US-based print service 
providers. The location entered here is used by the online TaxCloud service as 
the nexus to calculate the sales tax. See “TaxCloud Integration” on page 566 for 
more information. The address you enter is also validated on the fly by the 
TaxCloud service.

Time Zone Choose your time zone from the drop-down list. For example:

(UTC+02:00) Central European Summer Time (Europe/Brussels).

BCC Address Use this field to enter an e-mail address for sending a copy of out-going e-mails. 
A copy of all out-going e-mails is sent to this e-mail address by STOREFRONT for 
the following actions:

 account activation

 order confirmation

 StoreCenter notifications

 etc.

If these e-mails are sent to a mail client that supports rule sets, it is also a 
powerful way of automating certain tasks. You could, for example, set up a 
rule that notifies a customer service representative each time an order confir-
mation mail is sent for purchases in a specific store.

Order/Invoice/Quote
Number Format

When an order is placed, unique numbers (IDs) are generated by the system for 
the order number, the invoice number, and the quote number. You can 
customize and differentiate each of these numbers using different patterns and 
variables based, for example, on the date, the store or the company code. So 
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while your order numbering may be consecutive across all stores and companies 
for all orders (with the printernumber variable), you can number invoices 
consecutively by store if you have multiple stores (with the storenumber 
variable). Consecutive invoice numbering is a legal requirement in some 
countries so you need to set up the numbering so canceled orders do not affect 
your invoice numbering.

Click the Edit button to open the Order/Invoice/Quote Number Format simula-
tors where you can experiment with the patterns and variables.

In the Order/Invoice/Quote Number Format field, enter a combination of hard-
coded text and variables to create your numbering pattern. You can see the 
result in the Simulation panel.

For example, the following format as Invoice Number Format:

{date:yy}-{storenumber:5}

where: storenumber = counter at Store level set to start at 10

generates: 

18-00010

The following variables can be used:

 systemnumber: A counter that increments across all companies and 
stores in the STOREFRONT system and which cannot be reset; this is the 
default number if you leave the Order/Invoice/Quote Number Format 
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blank. The counter is always identical for a related order, invoice and 
quote; it also increments each time an order, invoice or quote is created.

 printernumber: A counter that increments across the companies and 
stores of your printer business and independently for orders, invoices and 
quotes. In other words, these counters are not necessarily in sync. You can 
reset the counter in the Printer Order/Invoice/Quote Number boxes 
below, at the end of this tab. For example, use this counter for your order 
numbers and quote numbers.

 storenumber: A counter that increments at the store level and which you 
can reset in the General tab of the store (see “Defining Numbers” on 
page 198). For example, use this counter for a continuous numbering of 
invoices per store irrespective of the numbering used for ordering or 
quotes.

 companycode: A static code (maximum 5 characters with letters and/or 
digits) that you can specify in the General tab of the company to identify 
the company (see “Companies” on page 46).

 storecode: A static code (maximum 5 characters with letters and/or 
digits) that you can specify in the General tab of the store to identify the 
store (see “Defining Numbers” on page 198).

 date: Sets the date; must be followed by format; format can be any 
combination of d, M, y (e.g. ddMMyy, ddMMyyyy, yyMMdd, etc.)

 length parameter: Sets the length of numbers; for example, 
storenumber:4 expresses the storenumber with 4 digits: 0003

Printer Order/Invoice/
Quote Number

Enter a number to reset the counter for the {printernumber} variable which 
can increment independently for orders, invoices and quotes across all of your 
companies and stores.

Related topics: • General Tab on page 196

Production 
Calendar

Use this tab to specify the days of the week when no production occurs and to 
add holidays. This information is required for the Time to ship feature 
(estimated shipping date) to work: see Shipping Services.

Order Deadline The cut-off time for a day to count as a production day. If the shopper orders 
before this time, the day counts as a day to calculate the estimated shipping time.
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NOTE: The cut-off time is in your time zone as set in the Production Center tab 
and not the time zone in the country where the shopper is located.

Weekly Holidays Select the days of the week which are not regular production days.

Yearly Holidays Click the Add button to add exceptions to the regular production days. Click in 
the Date field to display a monthly calendar and specify a day. Optionally enter 
a Name and a Description.

Order Item Flags You can customize the order items which require an intervention to facilitate 
production and/or indicate their production status by creating different order 
item flags.

 Create an Order Item Flag

1 On the menu bar, choose Advanced > Production Settings > Order Item 
Flags tab.

2 To create a new order item flag, click the Add button.

3 Complete the following fields in the General tab:

Name The text displayed in the Order Items Pane when you hover your mouse over 
the flag of the selected order item to see its production status.

Description Description that summarizes the order item flag and its use.

Figure 4.17: Order Item Flags View
StoreFront User’s Guide



96 PRODUCTION SETTINGS
Color Assigns a color to the order item flag.

Default Select this check box to automatically assign the order item flag to each new 
order item created. Only one order item flag can be set to be the default.

4 Click Save to confirm your changes.

The order item flag is added to the list. 

You can change the display sequence of these flags using the Move Up and 
Move Down arrow buttons.

 Edit an Order Item Flag

1 On the menu bar, choose Advanced > Production Settings > Order Item 
Flags tab.

2 Select the order item flag and make the changes in the General tab.

3 Click Save to confirm your changes.

 Delete an Order Item Flag

1 On the menu bar, choose Advanced > Production Settings > Order Item 
Flags tab.

2 Select the order item flag you want to delete and click the Delete button.

3 Click Delete to confirm in the dialog box.

Related topics: • Order Item Customization on page 318

PDF Preview These settings apply to the PDFs which are generated for preview purposes. A 
shopper can download a preview PDF before placing the order, and you may 
want to set restrictions for this PDF.

NOTE: These settings are only applied to newly created Preview PDFs.

Move an order item flag down in the list

Move an order item flag up in the list
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NOTE: For Printed Stock, On-Demand and Customizable Products only.

Security

Unless you specify otherwise here, the Preview PDFs do not allow content 
extraction, modification or printing. Choose the content features you want to 
provide explicitly by selecting the check boxes:

 Allow Content Extraction

 Allow Modification

 Allow Printing

NOTE: Preview PDF files are no longer password protected when all three 
security settings above are enabled and no watermark is defined.

Watermark

Select the Add Watermark check box to add a watermark to the PDF and then set 
the options:

Figure 4.18: A shopper can download a preview PDF before placing an order.
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Text The text to be displayed as a watermark; the text is repeated until the available 
space is used.

Color Click the color patch to open the color picker. See “Style Tab” on page 215 for 
more information on working with the color picker.

Font Size The font size for the watermark text.

Opacity Enter a low percentage if you want the watermark text to be transparent and 
show the content under the mark.

Angle The angle of the watermark on the pages.

Related topics: • PDF Preview Settings on page 205

Prepress Settings These settings control how the files of incoming orders are processed in your 
production workflow. Files can be sent automatically to your workflow system, 
downloaded manually, or exported to an FTP site or your PrintSphere space. 

NOTE: These are the default settings for products in all stores. You can change 
the file type settings when creating your product templates: see “Production 
Tab” on page 150.

Figure 4.19: A watermark in a preview PDF.
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 Configure Prepress Settings

 On the menu bar, choose Advanced > Production Settings > Prepress 
Settings tab.

Apogee Prepress/Asanti
Version

Choose your version from the drop-down list. This affects the JDF file generated 
by STOREFRONT for further processing.

Order Handling This option lets you choose how incoming orders are downloaded and 
processed.

Manually download order items for production: Select this option if you don’t have 
automatic integration with Apogee Prepress 8.0 or higher/Asanti or if you do 
not want to use automatic processing.

Automatically download all order items to Apogee Prepress/Asanti: Select this 
option to automatically send all order items to Apogee Prepress/Asanti. The 
following options appear:

 Hot Ticket: You must enter the name of a Hot Ticket which has a JDF 
import task processor and which your created in Apogee Prepress/Asanti 
for importing STOREFRONT jobs.

 Track Apogee Prepress/Asanti Feedback: Enables an extra button in the 
Orders tab that can be clicked to see feedback from the workflow system.

Automatically send order items to FTP server: Select this option if you want to 
export a ZIP file for each order item to an FTP server. Enter your FTP details:

 FTP Server: ftp.mycompany.com

 Default port is 21 (do not change)

 User name: myname

 Password: mypassword

 Active mode: select the check box to use FTP active mode as opposed to 
the default FTP passive mode

Automatically send order items to your PrintSphere: Sends a ZIP file to your 
PrintSphere space which can be set up to sync automatically to your local 
network. You can specify the Export Directory in your PrintSphere space, for 
example: /StoreFront/ExportOrders. Click the Folder button to navigate 
directly to this folder without logging on to PrintSphere.
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Default Ticket Template Enter the name of a ticket template that you created in Apogee Prepress/Asanti 
for processing orders downloaded automatically or choose a template in the 
drop-down list. Job ticket templates created in Apogee Prepress 8.0 and higher/
Asanti with the option ‘Mark available for STOREFRONT’ appear automatically in 
this drop-down list. This default ticket template can be overridden by specifying 
a ticket template in the Product Template. Refer to “Production Tab” on 
page 150.

Default File Type If you choose to download files manually (also applies when overriding your 
automatic flow), you can select which type of file is created for download:

 MJD (mime-packaged JDF) zip file: An MJD (mime-packaged job descrip-
tion) file is a single file which contains both the administrative order data 
as well as any available content (the PDF file the shopper uploaded or the 
PDF of the document the shopper customized or ordered).

 PDF/JDF zip file: the PDF with the page content and the JDF are two 
separate files. If you have a prepress workflow that is capable of 
processing MJD files, it is recommended to use that option. For all other 
systems choosing PDF/JDF is recommended. If you choose automatic 
downloading of files, Apogee Prepress/Asanti always downloads an MJD 
to create the jobs.

The files are contained in a zip package in both cases.

Related topics: • Integrating STOREFRONT with Apogee Prepress/Asanti on page 326
• Downloading and Processing Files on page 322
• Production Tab on page 150
• System Requirements on page 35
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External Accounts

On this page you can link STOREFRONT to your PrintSphere account, the file-
sharing service hosted by ECO3. You can use PrintSphere to create folders and 
sub-folders for your image libraries and then upload images to these folders in 
bulk. These images can then be referenced in customizable documents that you 
create with the Online Editor.

 Open External Accounts

 On the menu bar, choose Advanced > External Accounts.

The panel on the left lists the external accounts which have already been set 
up. The General tab on the right displays the details of the selected account:

Account The URL of the PrintSphere account (printsphere.com) and your user name for 
this account. You will need the matching password to create the locations.

Locations These are the paths to specific folders in your PrintSphere space. A single space 
can have several locations specified and you can choose the companies and 
stores that can link to these locations. You can see which customizable products 
and stores are linked to each location.

 Add an external account and location

Here we explain how you can link to folders in your PrintSphere space.

Prerequisites
You must have a PrintSphere account and you will need the credentials of this 
account to perform this procedure. Create a dedicated folder that you will use 
for STOREFRONT images and name this folder StoreFrontLibrary, for example. 
Create sub-folders as required and add image files that you want to reference in 
your customizable documents.

1 On the menu bar, choose Advanced > External Accounts.

2 Click the Add button to add a new account to the list.

3 In the Account panel, enter the URL of your PrintSphere account 
(printsphere.com) and your user name.

4 In the Locations panel, click the Add button to open the Add Location dialog.
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5 In the Path tab, choose a folder or a sub-folder and give this path an alias. The 
alias is the name you will see for this path in the Online Editor.

6 In the Links tab, choose the companies and then the stores that you want to 
want to give access to this folder.
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NOTE: Locations (but not accounts) can also be edited and added in the 
Upload Files dialog of the product wizard for customizable products. See 
“Creating Products” on page 157.

7 Click OK.

The account is added to the list and in the Locations panel you can see how 
many stores have access to the location.

8 To add additional locations to the same account, select the account in the list 
on the left and click the Add button again.

9 To edit an existing location, click the Edit button and make your changes in 
the Add Location dialog.

Related topics: • Online Editor on page 335
• Images Tab on page 435
• Use PrintSphere to upload images in bulk on page 443
• Creating Products on page 157
• Related Documentation on page 16 for info about PrintSphere
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Automated Product Creation

Use this feature if you have similar On-Demand Products that need to be created 
on a regular basis. The following single-version product types, i.e. 1 PDF per 
product, are supported:

 Unbound-Flat

 Unbound-Folded

 BoundSelfCover

 Bound-SeperateCover

 Unbound-Flat-VariableSize

PDF files can be dropped in input hot folders which are associated with a channel 
that creates the product and adds it to the specified store and category 
automatically.

Channel Name

The name of the channel as displayed in the Channel list. This requires that an 
External Account is configured. See “External Accounts” on page 101.

External Location

Click the Edit button to open the Select Location editor where you can specify 
the following:

External Account The PrintSphere account where the input folders are located and where PDFs 
can be dropped.

Location Folder Choose or create a subfolder in the external account location. The folder you 
select as "Location folder" will be the root for the channel. The name of the sub-
folder within the Location folder will be used as Category Name on the Store and 
the PrintSphere user must drop the PDF files in the subfolder in his PrintSphere 
Account. PDF files can never be dropped directly in the Location folder.

Store Click the Edit button to select a store from the list.

Product Template Click the Edit button to select a template that will be used to create the product 
using the input file
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Update on Upload This means that when a new PDF file is dropped in PrintSphere with a filename 
that is the same as an On-Demand product that is already available, the existing 
product will be updated to include the new PDF file.

Notifications tab Lists the products created from the input PDF files with Status, Processing Time, 
Error, etc. The processed files can be filtered by Error Only, Channel and Date 
Range.
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Custom Attributes

Use custom user attributes to add additional fields to the user profile which is 
visible on the profile page and on the self-registration page. For example, you 
can add fields for a mobile phone number, personal billing code, department ID 
code, etc.The information entered in these custom fields can subsequently be 
retrieved with the Autofill feature in the Online Editor.

 Add a custom user attribute

1 On the menu bar, choose Advanced > Custom Attributes.

2 In the Custom User Attributes tab, click the Add button to add a new custom 
user attribute to the list.

3 Specify as follows:

Display Name The name of the field as it is displayed in the user profile.

Unique Code Enter a unique code (or name) which will be used by the Autofill feature in the 
Online Editor to add the attribute to a customizable document. For example, use 
this feature to add a user’s social media information to a business card.

Default Value This value fills the box of the custom field.

Enabled Select the checkbox to activate the field on the user profile page.

Accessibility StoreCenter You can choose to make the field editable (Editable) or editable and mandatory 
(Mandatory) on the user profile page.

Accessibility STOREFRONT This option applies in the self-registration window and profile page where the 
shopper has the following options:

 Not Visible: the field is not displayed for the user to fill in

 Visible: the field is displayed but cannot be edited

 Editable: the field is displayed and can be edited

 Mandatory: the field is displayed and must be filled in

Max Size The maximum number of character that the user is allowed to enter in the field 
is 255.
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Save your changes to add the custom attribute to the list. The new attributes now 
appear on the profile page of the users of your stores.

Related topics: • Create Users on page 276
• Autofill Forms on page 380
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Predefined Values

Predefined values can be codes or other content that you want shoppers to 
choose from during checkout, for example order reference codes, purchase 
order numbers or product options.

 Add/edit a list of predefined values

1 On the menu bar, choose Advanced > Predefined Values.

2 Click the Add button to add a new list of values.

3 Enter a Name for the new list of values and choose Customer Reference 
from the Application drop-down list.

Now you can upload a TXT or CSV file which contains the values – one code 
per line in the file you upload.

Alternatively, choose Free Text Option from the Application drop-down list 
to create predefined values for Product Options.

4 Browse to the file with values and upload it.

The values you have in the file now appear in the Content panel.

5 Save your changes.

Now this list can be enabled when setting up your Store in the General Tab.
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Licenses

Each license entitles you to an amount of disk space, a number of stores, 
products and visitor sessions. Additional capacity can be obtained by upgrading 
to another license.

Clean-up starts automatically when the disk space quota is exceeded for 3 
consecutive months. The system continues to delete old order content data until 
the storage usage drops to 80% of the storage quota. However, the system never 
deletes data for orders that have not yet reached the ‘Shipped’ status and data 
that is not older than 3 months.

NOTE: The STOREFRONT License and Service Agreement contains more 
information about these licensing parameters and describes what happens if one 
or more parameters reach their limit.

You can view detailed license information in the Licenses tab and summary 
statistics on the Dashboard.

 License information via the Advanced menu

 On the menu bar, choose Advanced > Licenses.

An overview of your licenses with the maximum allowed resources and 
current usage is displayed. 

Licenses The name of your STOREFRONT license (different license packs are available) and 
licenses for other products with their start and end date. For example:

 Multistep Approval

 Automated Product Creation via PrintSphere

Quota The maximum allowed disk space average and login sessions. This disk space 
includes the configuration data of all the stores, the product data and the 
incoming orders data. The maximum number of visitor sessions is reset every 
month. The number of sessions increments each time a visitor accesses one or 
more of the public or private storefront pages. So a visitor who views several 
storefront pages and makes several orders only counts as one session.

PrintSphere Quota The maximum allowed disk space and usage of your PrintSphere file-sharing 
license. You can manage the license by clicking the View your PrintSphere 
licenses link which opens the SphereCenter application. 
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PrintSphere AutoPilot
Quota

The disk space assigned to you and the quota for Active Scripts and CPU time per 
month if you have the PrintSphere AutoPilot license. See the SphereCenter Help 
and the PrintSphere Help for more information about PrintSphere AutoPilot.

Products The maximum number of products that can be created in StoreCenter with the 
current license. This number includes products which are not used in a store or 
microstore, or are off-line. A product used in several stores only counts for one. 
There is no limitation on product templates.

Stores The number of stores and microstores that can be created in StoreCenter with 
the current license. This number includes stores and microstores which are not 
online.

Payment Methods Indicates that you have the option to set up payment gateways and bank trans-
fers. (See “Payment Methods” on page 81.)

Online Editor Actions Indicates that you have the option to create variable actions in the Online Editor. 
(See “Variable Actions” on page 458.)

Access Labels Indicates that you have the option to create access labels. (See “Access Labels” 
on page 262.)

Approval Groups Indicates that you have the option to create approval groups. (See “Approval 
Groups” on page 54.)

VDP Option Indicates that you have the option to create Variable Data Products. (See 
“Variable Data Processing (VDP)” on page 382.)

Digital Products Indicates that you have the option to create digital products. (See “Create a 
Digital Product” on page 169.)

Global Filter Indicates that you can use the Global Filter feature. (See “Global Filter” on 
page 24.)

Multi-version Products Indicates that you have the feature to create multi-version products.(See “Create 
multi-version or multi-SKU documents” on page 176.)

Product Discounts Indicates that you have the option to apply a discount to products. (See 
“Discount/Markup” on page 167.)

Promotions Indicates that you have the option to create promo codes. (See “Promotions Tab” 
on page 250.)

Quoting Indicates that you have the option to generate quotes. (See “Quoting” on 
page 205.)
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VDP Option Indicates that you have the Variable Data Processing option. (See “Variable Data 
Processing (VDP)” on page 382.)

 Licenses statistics on the Dashboard

1 Click the Dashboard link in the navigation bar to go to the Dashboard.

As Printer Administrator, you are able to view various statistics relating to 
your licenses.

The System panel displays the following statistics:

 Stores: the number of stores you have set up

 Microstores: the number of microstores you have set up

 Products: the total number of products created but not necessarily added 
to a store

 Customizable Products: the total number of customizable products 
created but not necessarily added to a store

 Product Kits: the total number of product kits created but not necessarily 
added to a store

 Storage: disk space used by your stores, including the data linked to 
placed orders, data uploaded to the server by the shopper for use in 
customizable products with the Online Editor; extra storage space per 
blocks of 400 GB can be ordered 

 License type and expiry date of the license 

The maximum values in the right-hand column depend on your license type. 

2 Click the Products link.
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The statistics are displayed for your products, broken down by company.

3 Click Dashboard to return to the Dashboard.

4 Click the Storage link.

The storage statistics are displayed, broken down by company and by type of 
data:

 Store Resources (Online Editor): space used by documents and assets for 
customizable products

 Store Resources (PDF, images, etc.): space used by other assets you have 
uploaded
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 Customer Resources (Online Editor): space used for assets uploaded to 
the Online Editor by shoppers

 Store Resources (PDF, images, etc.): space used for other assets uploaded 
by shoppers

5 Click Dashboard to return to the Dashboard.

Related topics: • “Order Monitoring on the Dashboard” on page 286
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CHAPTER
5 Product Templates 

Printer Administrator only

Product Templates allow you to optimize the overall efficiency of your stores by 
defining standard types for all your printed, non-printed, and digital products.

 Product Templates Overview .............................................................................116
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 Preferred Sizes Tab ................................................................................................130
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 Preflight Tab .............................................................................................................149
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Product Templates Overview

Stores can only be filled with products based on Product Templates. Templates 
can be used for all Companies and their stores or for a specific Company and its 
stores.

Product templates are also associated with price lists for the actual product and 
prices for options sold together with the product.

The Product Templates dialog consists of the Product Template list and four 
tabs:

 “General Tab” on page 122

 “Product Options Tab” on page 132

 “Pricing Tab” on page 138

 “Packaging Units Tab” on page 147

 “Preflight Tab” on page 149

 “Production Tab” on page 150

Prerequisites
Product Templates use common resources which need to be set up before you 
can create templates. These resources are available on the Advanced menu. See 
Setting up Resources (Advanced Menu) on page 61.

 Create a Product Template

1 On the menu bar, choose Product Templates.

2 Click the Add button to add a new template to the list.

Figure 5.20: A business card template used for several companies and stores
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3 Complete the fields in the General tab and choose the Base Type to reveal 
the fields that are relevant for the chosen base type.

4 If you want to add or edit your resources, click the Edit button next to the 
field in question.

For example, you can edit Media Sizes and add Standard Media Sizes to the 
Supported Media Sizes list.

5 Click Create to create the template.

The new Product Template is displayed in the list.

You can now proceed with the settings in the Product Options Tab, Pricing 
Tab, Packaging Units Tab, Preflight Tab, and Production Tab. Not all of these 
tabs are visible for some of the base types.

 Duplicate a Product Template

1 On the menu bar, choose Product Templates.

2 Click the Duplicate button in the toolbar and then the Duplicate button to 
confirm that you want to duplicate an existing template.

A copy of the Product Template is displayed in the list with the Copy suffix in 
the name.

3 Complete the fields in the General tab. You will probably want to change the 
name in the Template Name field.

4 If you want to add or edit your resources, click the Edit button next to the 
field in question.

5 Click Save to save your changes to the modified template.

The new Product Template is displayed in the list.

You can now proceed with Product Options, Pricing, Packaging Units, 
Preflight, and Production settings.
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 Delete a Product Template

1 On the menu bar, choose Product Templates.

2 Click the Delete button to delete a template from the list.

The template is removed from the list.

NOTE: If the template has already been used to create a product, a warning is 
displayed indicating that you cannot delete the template. This is because the 
template links the product to its pricing list.

 Export Product Templates

You may want to export a list of all your product templates to have an overview 
for reference purposes.

NOTE: It is not possible to round-trip (export/import) a file with product 
templates.

1 On the menu bar, choose Product Templates.

2 Click the Export button and choose Export Product Templates to export all 
the templates in the list.

You can choose to view or download an Excel file which contains a list of all 
the templates and their properties.

 Export Price Lists

You may want to export an overview of all your price lists for reference purposes.

NOTE: It is not possible to round-trip (export/import) a file with price lists.

1 On the menu bar, choose Product Templates.

2 Click the Export button and choose Export Price Lists to export all the price 
lists.

You can choose to view or download an Excel file which displays the different 
prices lists in separate worksheets.
StoreFront User’s Guide



 

5 PRODUCT TEMPLATES 119
 Create a template for a Digital product

A digital product doesn’t require you to specify any physical settings such as 
dimensions, media, etc. because the product will consist of one or more files that 
the shopper can download.

1 On the menu bar, choose Product Templates.

2 Click the Add button to add a new template to the list.

3 Complete the fields in the General tab and choose Digital in the Base Type 
drop-down list. This base type has no further general settings to be specified.

4 Click Create to create the template.

The new Product Template is displayed in the list. Only three tabs are 
displayed for a digital product template.

5 Open the Product Options tab and click the Add button.

Only one option type is available for digital product templates:

 Multi-value option

6 In the Multi-value Option dialog, enter the Option name. This is the text for 
the option heading in the Place Order panel on the storefront. 

7 Enter one or more Values for the options. For example, if the template is for 
e-books, you could enter ePub Reader, Kindle, Mobipocket as options. Click 
the Add button to add as many options as you need.

The first in the list is selected by default on the storefront. You can rearrange 
the list.

8 Click Save to save your changes.
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9 Open the Pricing tab and set the pricing for each option.

10 Click Save to save your changes to the modified template.

You can now create a product based on this template.

 Create a template for a Product Kit

A Product Kit inherits many settings from its kit items and their respective 
templates, but these may be overruled by the kit settings.

1 On the menu bar, choose Product Templates.

2 Click the Add button to add a new template to the list.

3 Complete the fields in the General tab and choose Kit in the Base Type drop-
down list. This base type only requires you to enter the Supported 
Quantities.

4 Click Create to create the template.

The new Product Template is displayed in the list. Only four tabs are 
displayed for a kit template: General, Product Options, Pricing and 
Packaging Units.

5 Add your Product Options:

 Single Value option

 Multi-Value option

6 You can only choose from three Pricing Formulas:

 Fixed Price

 Price/Copy

 Setup Cost + Price/Copy

The chosen price formula is applied on top of the sum of the prices of the kit 
items. You may want to set the kit price to zero or charge for an additional kit 
packaging.
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7 Packaging Units can be specified for the kit and overrules those of the kit 
items. If no packaging units are specified for the kit, those specified for the kit 
items will be used.
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General Tab

In this tab you will define the main settings for the product template.

General

Template Name Enter a name to identify the template in the Product Template list.

MIS ID (Visible after saving a new template, except for Non-Printed Product.) Enter a 
unique ID generated by the Management Information System (MIS) to ensure 
the MIS system correctly associates the product reported by STOREFRONT with 
the matching user account in its own database. Otherwise, leave this field 
empty.

MIS Template Enter the name of the Management Information System (MIS) template if 
applicable.

Description Enter a description that summarizes the template and its use.

Category Choose a category from the drop-down list or create a new one. You can enter 
the categories in the search filter at the top of the template list.

Available to You can create the template for all or one specific Company by making a selec-
tion in this drop-down list. Selecting All Companies ensures that the template 
can also be used for Companies that you will create in the future.

Base Type Choose a base type from the drop-down list.

A list of parameters is displayed depending on the base type you choose. 
Specify the parameters as required.

 Bound - Self Cover: a product consisting of stacked or nested parts which 
are bound but without a separate part for the cover, such as brochures, 
books, magazines, notebooks, textbooks

 Bound - Separate Cover: a bound product consisting of stacked or nested 
parts and a separate cover part, such as brochures, books, magazines, 
notebooks, textbooks

 Unbound - Flat: work which is not folded such as business cards, flyers, 
posters, tickets, banners; fixed size

 Unbound - Flat - Variable Size: the shopper can choose from a list of 
predefined sizes or set a custom size for flat work which is not folded such 
as posters, etc.; pricing may be based on the size (width height, surface). 
Choosing this type displays the Preferred Sizes Tab. See “Preferred Sizes 
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Tab” on page 130 for information on which product types can use this 
base type.

 Unbound - Folded: unbound flat work which is folded such as invitations, 
leaflets, folders

 Digital: This base type can only be used to create a Digital Product, i.e. 
files that you want to sell via your storefront, for example, e-books, audio 
files, images, video, etc. You only need to specify a few general settings for 
this base type.

 Kit: This base type can only be used to create a Product Kit, i.e. a bundle 
of products that are sold together. 

 Non-printed Product: This base type can only be used to create Non-
printed Products such as gadgets, giveaways, accessories, etc.

Binding Side This option allows you to set the binding side for special bound products such as 
calendars and notepads.

 Left, Right, Top or Bottom

Binding Order This option specifies how the parts of a bound product will be assembled.

 Nesting: parts are assembled within each other

 Stacking: parts are assembled on top of each other

Binding Method Choose a binding for bound products.

Channel Binding: A U-shaped clamp is used to bind the sheets and cover.

Coil Binding: A metal or plastic coil is used to bind the sheets and cover.

Corner Stitch: A staple in one corner binds the sheets.

Edge Gluing: The sheets are glued along the edge.
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NOTE: Choose a binding method that is compatible with the binding order.

Measurements

Size The finished, trimmed size of a product. For folded products you specify a closed 
size and an open size (e.g. closed size is 210 mm x 297 mm; open size is 420 mm 
x 297 mm); bound and flat products only have a closed size. Enter a custom size 
or choose a standard media size from the drop-down list. For Unbound - Flat - 
Variable Size, you can set a minimum and maximum size and the shopper can 
choose a size between these values when uploading a file; you can also allow the 
product to be rotated to fit the entered size.

Orientation You can specify the required orientation or make this dependent on the 
uploaded file:

Hard Cover: The publication has a separate hard cover.

Loose Binding: A method that allows individual sheets to be inserted or removed. 
Loose binding can also be used for a 4-page leaflet which is defined as a ‘Bound - 
Self Cover’ product. In this case, the shopper must provide a file with 4 pages as 
opposed to uploading a spread for an ‘Unbound - Folded’ product.

Plastic Comb: A plastic comb is used to bind the sheets and cover.

Ring: Sheets are punched with holes for insertion in a ring binder.

Saddle Stitched: The sheets and cover are secured by wire staples through the 
center fold.

Soft Cover: The publication has a separate flexible cover.

Strip Band: Sheets and cover are bound using a strip band.

Tape: Sheets and cover are bound using a tape.

Wire Comb: A wire comb is used to bind the sheets and cover.
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 Portrait

 Landscape

 Landscape & Portrait: The orientation depends on the uploaded file.

Bleed Specify a bleed area for images and documents of Uploadable Products. Entering 
a value scales TIFF and JPEG files to the size + bleed. This bleed is only applied 
to PDFs if the PDF needs to be scaled, otherwise the bleed specified in the 
document is respected.

Folding Scheme For a folded (unbound) product you can specify how the sheet is to be folded:

Single Fold: The sheet is folded in the middle to create 2 
panels.

2-Fold Letter Fold: The sheet is folded inwards twice to 
create 3 panels.

2-Fold Accordion (Zigzag) Fold: The sheet is folded twice 
to create 3 zigzagging panels.

3-Fold Letter Fold: The sheet is folded inwards three 
times to create 4 panels; also referred to as a gate-fold.
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NOTE: Folding a sheet usually requires short panels to keep the finished 
product flat.

Media Type Specify the paper stock for printing the order on; for the body part and the cover 
part separately in the case of Bound - Separate Cover. You can make additional 
media type options available (with or without a surcharge) in the Product 
Options tab; see “Product Options Tab” on page 132.

Display Name The name of the Media Type as you want to display it in the storefront; for 
example, you may want to display a less technical name for the paper stock.

NOTE: Media Type Display Name is one of the translatable product 
options.

Packing Measurements button

Packing measurements are used to calculate how many packaging units are 
required for an order.

NOTE: Only relevant if your store uses a shipping service that needs to calculate 
the shipping cost based on these measurements. For example, this is not relevant 
for free shipping.

3-Fold Accordion (Zigzag) Fold: The sheet is folded three 
times to create 4 zigzagging panels.

3-Fold Parallel Fold: The sheet is folded three times to 
create 4 panels which are nested inside each other.
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 Click the Packing Measurements button to open a dialog box where you can 
fine-tune the packing information. 

For a Bound-Separate Cover template type you can specify the measurements 
by selecting one of the following three options from the drop-down list:

 Copy-based: Enter the total thickness and weight for one copy of the 
finished product.

 Page-based (fixed thickness): Enter the total thickness for one copy if this 
is known, e.g. a filled binder. The weight is calculated based on the weight 
of each page. In Extra you can enter the weight of the binder.

 Page-based (calculated thickness): This option accepts the calculated 
thickness and weight for each page but you can specify extra thickness 
and weight per copy, e.g. for the binding.

Select the Custom check box if you want to override the calculated thickness 
or weight values:

 Thickness: This is the thickness that corresponds with the paper weight 
(grammage) specified for the selected media; these thicknesses are 
defined in Advanced >Media for all your media. If the thickness is not 
specified in the media type, you must enter it here.

Figure 5.21: You can override the calculated packing measurements and add extra 
specifications. These are used to calculate the number of packaging units 
required for an order.
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 Weight: This is the weight of a sheet calculated for the given size and 
selected paper weight (grammage).

For the Unbound-Folded and Unbound-Flat templates you can override the 
calculated values for thickness and weight of a folded copy or sheet 
respectively.

Color

Specify the colors for the front and back of the product. If applicable, select the 
Back follows front option to use the same colors for both sides of the product. 
The following color options are possible:

 Black & White

 Full Color (i.e. CMYK)

 Black & White + 1 to 4 Spot Colors

 Full Color + 1 to 4 Spot Colors

 1 to 4 Spot Colors

For flat and folded products you can specify combinations and also leave the back 
blank (single-sided vs. double-sided). For bound-separate cover products, you 
specify the colors for the body and cover parts separately. You can make 
additional color options available (with or without a surcharge) in the Product 
Options tab; see “Product Options Tab” on page 132.

Pages

Supported Page Counts Enter page count values separated by a comma and without a space, and choose 
one of the options. These page counts include the cover.

 Users can only order the specified number(s) of pages: Only page counts 
as indicated in this field are selectable from the menu in the storefront.

 Users can order an intermediate page count: Select this option for a more 
flexible range of page counts for when you don’t know the exact page 
count of a product. In the Use multiples drop-down list, choose a 
multiple of 1, 2, 4 or 8 to be added to the supported number of pages.
For example, if you have 8, 16, 24, 32, 48 as supported page counts and a 
multiple of 4 is selected, a shopper can order a product with a 12 pages. 
The first and last values in this field are the minimum and maximum page 
counts.
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Quantities

Supported Quantities Enter order quantities separated by a comma and without a space, and choose 
one of the options:

 Users can only order the specified quantities: Only the quantities as 
entered in this field are selectable from a menu in the storefront. Other 
quantities cannot be ordered.

 Users can order intermediate quantities: Any quantity between the 
minimum (first) quantity and the maximum (last) quantity can be 
entered for ordering on the storefront.

Default Quantity Enter a quantity if you want the default quantity to be higher than the lowest 
supported quantity of the template. Can also be set in the product wizard (see 
“Create a product” on page 157.)
StoreFront User’s Guide



130 PREFERRED SIZES TAB
Preferred Sizes Tab

This tab is displayed for the Unbound flat - Variable Size template base type. The 
products using this template have a minimum and maximum size. In this tab, 
you create a list of predefined sizes that the shopper can choose from, within the 
range of the minimum and maximum sizes.

The Unbound flat - Variable Size template base type can be used for the following 
product types:

When the Unbound flat - Variable Size template base type is used for an upload-
able product, the uploaded file is scaled to the requested size.

 Add/Edit Preferred Sizes for Variable Size template

1 On the menu bar, choose Product Templates and select the template you 
want to edit.

2 Click the Preferred Sizes tab and then the Add button.

The minimum and maximum sizes are displayed in the dialog.

3 Choose one or more predefined sizes from the Size drop-down list which do 
not exceed the minimum and maximum sizes.

4 Choose the Orientation

 Portrait: 1 size is added to the list with the highest value set for the height 
(H)

 Landscape:1 size is added to the lists with the highest value set for the 
width (W)

 Portrait/Landscape: 2 sizes are added to the list

5 Click Save.

The size or sizes are added to the list.

6 Repeat to add additional preferred sizes.

Customizable product (HTML5-based): see “Customizable Product with User-Definable Size” 
on page 508

Uploadable product: the uploaded file is scaled to the requested size
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7 Select the Use only listed sizes check box if you do not want to allow the 
shopper to use a custom size. If you do not select this check box, the Custom 
option is available for the shopper and a random size that does not exceed the 
minimum and maximum sizes can be entered.

8 You can change the display sequence of these sizes on the storefront using 
the Move Up and Move Down arrow buttons, and set the default size with the 
Make Default button.

Figure 5.22: The list of sizes with the custom option on a storefront

Make a size the default size on the storefront
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Product Options Tab

Product options can be items or services that are sold with a Product, e.g. gift 
wrapping, displays for flyers, or extra colors or media types which the shopper 
can choose from. These are defined for each Product Template.

 Add/Edit Product Options

1 On the menu bar, choose Product Templates.

2 Click the Product Options tab.

A list of options is displayed with option values.

NOTE: The list is empty if you have not yet defined options for this template.

3 To create a new option, click the Add button.

The following option types are possible:

 Single-value option: Add an item or service that you want to present with 
the product.

 Multi-value option: Add an item or service with sub-options.

 Color option: Add these options to let the shopper choose from a selection 
of colors for the front and the back sides – different colors can be specified 
for the cover and body of a product where applicable.

Figure 5.23: Multi-value and single-value options displayed on a storefront
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 Downloadable PDF or Image option: This option displays a list where 
shoppers can choose between the printed product, a high resolution PDF 
or image, or both. You can choose the name for the option, the values that 
appear in the list, and the file format of the product as PDF, PNG, or JPEG.

 Media type option: Add one or more media type options to let the shopper 
choose from a selection of media for the product – different media types 
can be specified for the cover and body of a product where applicable.

 Free Text Option: Add one or more free text options for text or predefined 
values. A free text option can be set to "required" to type a text or to select 
a value before the product can be added to the shopping cart.

4 If you choose single-value option, you will see the following settings:

Option Name The name of the option as it is displayed on the storefront

Checked by default in the
Store

If you select this check box, this option will be selected by default on the 
storefront and added automatically to the total price when an order is placed 
The shopper can clear this check box and choose not to buy the option.

NOTE: All options checked by default are added automatically to the order.

5 If you choose multi-value option, you can click the Add button to add as 
many sub-options as you need.

The first in the list is selected by default on the storefront and added automat-
ically to the total price when an order is placed. The shopper cannot clear the 
default sub-option in the drop-down list. For this reason, you may want to 
create a sub-option with zero charge so the shopper can choose not to buy the 
option.

6 If you choose Color option, you can select alternative colors from the drop-
down lists and click the Add button to add as many colors as you need. Alter-
native colors can also be specified for the body and cover parts separately, if 
applicable for the product type.
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The initial color will be checked by default on the storefront.

7 If you choose Downloadable PDF or Image option, enter the name of the 
option (mandatory), the values for the options, and one of the downloadable 
format types.

Values: 

 Only print

 Print and high resolution PDF or Image

 Only high resolution PDF or Image, no print.

If you do not change the values, the default values in the list are used.

PDF or Image:

 PDF

 PNG with Resolution (in ppi)

 JPEG with Resolution (in ppi) and Quality (level from 1 to 100)

Figure 5.24: Downloadable PDF or Image option

Figure 5.25: Print and high resolution PNG offered on a storefront
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8 If you choose Media Type option, you can select a second Media Type and 
Weight from the drop-down lists, and click the Add button to add as many 
types as you need.

The initial media type will be checked by default on the storefront.

NOTE: The initial media type option is set in the Product Template tab under 
Media Type Display Name. 

9 Go to the Packing Measurements tab of the Media Type Option Value if you 
want to set different measurements for the additional media type option.

10 Click Save to confirm your changes.

The option and its sub-options are added to the list. The initial media type 
and colors as set in the Product Template tab are indicated in the list with a 
link icon.

You can add new sub-options to Multi-Value, Media Type and Color options 
by clicking the Add button and choosing the Add option value for selected.

You can change the display sequence of these options and sub-options on the 
storefront using the Move Up and Move Down arrow buttons, and change the 
Checked by default options using the Make Default button. If you add 
options to a template which is already being used for products, you can add 
these options to the existing products with the Push to Products button.

Figure 5.26: Product options displayed when defining a product template (StoreCenter)

Move an option or sub-option down in the list

Move an option or sub-option up in the list
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NOTE: If you added a product option to a template which is already being 
used for a product, you cannot delete it from the list.

For clarity’s sake, it is recommended to group all single-value options at the 
bottom of the product options list on the storefront.

You can pick the options that you want to display on the storefront when 
creating or editing products. See “Creating Products” on page 157.

 Delete a Product Option from a template

1 On the menu bar, choose Product Templates.

2 Click the Product Options tab.

A list of options is displayed with option values.

NOTE: The list is empty if you have not yet defined options for this template.

3 To delete an option, select it in the list and click the Delete button.

4 The Delete dialog is displayed with a list of products that use this option.

Make a sub-option the default option on the storefront

Push to Products: Makes a new option available to all existing products based on this tem-
plate

Figure 5.27: Product options when ordering on a storefront

1 Multi-value options in a drop-down list
2 Single-value options with a check box
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5 Go to each product that uses the option and disable the option.

When you have done this for all the products in the list, go back to the 
Product Options tab and delete the option in the template.
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Pricing Tab

If you choose to apply a payment method when setting up a store, the product 
template must have a price list that covers the available quantities and options 
that can be ordered with the product. These price lists are managed in the 
Pricing tab of the Product Templates dialog and new price lists that you create in 
the Product Templates dialog are added to the Price List drop-down list. See 
“Setting up a Store” on page 195.

When you create a Product Template, you need to choose an existing price list to 
add the prices for the new template, or edit an existing price list. If prices are not 
set for a product template in the price list selected for the store, any products 
created from that template may appear on the storefront but they will be 
unavailable for purchasing.

Two price lists are provided in the Price Lists list by default: including or 
excluding tax. This enables you to display rounded prices or commercially 
attractive prices (e.g. 99-prices) with or without the tax included. You can add 
your own price lists to differentiate between standard and discount prices, prices 
in other currencies, prices for different Companies, etc.

A price list consists of the following price information:

 Price Matrix: This is the main table with prices for the different quantities 
and page counts possible with a product template

 Color option: Here you specify the costs to be charged for different color 
options. The initial color is always included in the Price Matrix.

 Media type option: The initial media type is included in the Price Matrix 
prices but additional types need to be priced here.

 Single-value and/or Multi-value options: Here you can set the prices for 
special finishing, accessories to be delivered with a product, etc.

 Downloadable PDF option: Here you set the prices for downloading a 
high resolution PDF instead of a physical product.

 Free Text option

Each price list may contain all the prices for all product templates and conse-
quently for all the products (all products are based on product templates). Every 
time a new product template is created, all the price lists are marked as incom-
plete with the alert icon  until the Price Matrix and option prices are filled in 
for the new product template. You only need to update the price list(s) that you 
will use for a particular template, however, you must ensure that the price list 
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you select for your store contains the pricing information for the products you 
add to the product catalog. Products without pricing information are also 
indicated with the alert icon  in the product catalog.

NOTE: If you choose Payment Method None when creating a store, the product 
template does not require a price list and you can skip this section.

 Set Pricing

1 On the menu bar, choose Product Templates.

2 Click the Pricing tab.

A list of price lists is displayed in the top pane. Two price lists are provided by 
default: one price list including taxes and one excluding taxes.

3 Choose a price list in the Price Lists list and select Price Matrix in the Pricing 
pane below.

The Price Matrix is displayed in the bottom pane.

If you have just created the Product Template, only the Quantity column is 
filled in with the supported quantities. 

An alert icon indicates that the prices in the Price Matrix are incomplete.

4 Click the Edit button to display the Edit Price Matrix dialog.

5 In the Pricing Formula drop-down list, choose one of the following formulas 
for calculating the prices for products based on this template:

TIP: When entering values in 
the Price Matrix, you can use 
the Tab key to navigate the 
cells.

 Fixed Price: Specify your prices for each quantity and page count. No 
other printing cost applies.
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 Price/Copy: Specify your prices for one copy (unit). This formula is useful 
if the shopper can order intermediate quantities.

 Price/Page: Specify the price per page. For example, 60 copies of a 16 
page brochure at 1 dollar/page will cost 960 dollars. 

 Setup Cost + Price/Page: Specify your prices/page and the setup cost for 
each quantity and page count.
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 Setup Cost + Price/Copy: Specify your price per copy (unit) page and the 
setup cost for each quantity and page count.

 Setup Cost + Price per square metre/foot: (only for products based on an 
Unbound Flat - Variable Size template) The product unit does not have 
fixed dimensions, so specify different prices per square metre/foot of 
media depending on the ordered quantities. 

 Setup Cost + Degressive pricing per square metre/foot: (only for 
products based on an Unbound Flat - Variable Size template and their 
options) Specify a price depending on the total amount of media used, 
regardless of the number of copies ordered: e.g. a lower price for higher 
total sizes. You can also set a minimum price for the product. 
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TIP: Setup costs can be an 
important cost factor in 
certain printing 
environments. Compare the 
pricing of short runs printed 
digitally and longer print 
runs in offset.

For a complex price matrix, you can copy the data from a spreadsheet. See 
“Using a spreadsheet to prepare and maintain a price matrix” on page 143.

Select the Cross-Item Pricing option if you want to apply pricing and 
discount to several items. For example, you order 8 packs of 250 cards. One 
pack of 250 cards costs 10 euros but 2000 cards cost 60 euros. On the order 
summary and all other reporting, each pack of 250 cards will have a price of 
7.5 euros. If the pricing involves setup costs you can choose to apply a Single 
Setup Cost.

6 Click Save to confirm the formula and prices.

The completed Price Matrix is displayed for the selected price list.

If you created Product Options, you need to set the prices for these too. 

An alert icon indicates that the price for a Product Option is incomplete.

7 Click an Option in the Pricing pane and click the Edit button.

8 Choose one of the following pricing methods:

 Fixed: The specified price is added once to the total price for the ordered 
quantity, e.g. a special service.
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 %: A percentage of the price for the ordered quantity is added once to the 
total price (without other options), e.g. special packaging. The 
percentage does not apply on top of other options.

 Unit: The option has its own unit price which is added per the specified 
quantity, e.g. a special box per 250 business cards, and a one-time Setup 
Cost (optional).

 Per Page: The option price is calculated by multiplying the specified price 
by the page count, plus a Setup Cost (optional).

 Price Matrix: Choose this option if you want to apply a price formula to 
control pricing in a non-linear way. You can choose from the same pricing 
formulas as for the product. This is useful for options such as color, 
varnish, or binding styles. You can also limit the availability of an option 
(e.g. varnish that you only want to print if the print run is sufficient) by 
not specifying prices for lower quantities. Choose a formula in the Pricing 
Formula drop-down list. The different options are explained above.

 Size-based: (Unbound products only) The option is calculated depending 
on the width, height, or surface area of the product, or a combination of 
these properties; for example: varnish, laminating or adding grommets 
for Unbound Flat - Variable Size products (signs, posters, etc.)

9 Click Save to confirm your changes.

The option price is displayed for the selected Product Option.

The alert icon is no longer displayed when you have completed all the price 
information.

 Using a spreadsheet to prepare and maintain a price matrix

1 Prepare your raw price data in a spreadsheet, e.g. the setup cost and price/
copy for different page counts.

2 Copy the cells that you have prepared in the spreadsheet.

NOTE: Do not include the quantities and total price in your copied data 
because these are calculated in the price matrix.

3 In the Edit Price Matrix dialog, click in the top left cell.

You have two options, depending on the browser you are using:
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If you are using the Firefox browser, clicking in the cell activates the here link 
which you can click to open a dialog where you can paste the data you copied 
in your spreadsheet. Click OK.

OR

For all browsers except Firefox, with the cursor in the top left cell, press 
CTRL+V (paste) to paste the data directly in the price matrix.

The data is pasted into the price matrix and the totals are calculated and 
displayed in the Price Table.

4 Click Save to confirm the pricing matrix.

 Create a new price list in Product Templates

Price lists can be created in the Product Templates dialog. A newly created price 
list does not contain any prices.

1 On the menu bar, choose Product Templates and then the Pricing tab.

2 Click the Add button to add a new Price List to the list.

3 Complete the fields in the Create Price List dialog.

Name This name appears in the Price Lists list and in the Pricing drop-down list when 
setting up a store.

Currency This is the currency used to display the prices; you may want to set up different 
price lists which are differentiated by currency.

Exclude taxes Select or clear this check box to exclude or include tax in the prices you enter in 
the Price Matrix. 
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Description Additional information

4 Click Save.

The new price list is displayed in the list with the alert icon. This icon 
indicates that the price list is incomplete.

5 Enter the pricing for all the Product Templates. See “Set Pricing” on 
page 139.

 Duplicate a price list in Product Templates

Price lists can be duplicated in the Product Templates dialog. A duplicated price 
list contains all the prices of the original.

1 On the menu bar, choose Product Templates and then the Pricing tab.

2 Click the Duplicate button to copy and adapt an existing price list.

3 Click Duplicate.

The duplicated price list contains all the prices entered for the original price 
list.

4 If necessary, edit the Price Matrix and Option prices in the duplicated list as 
described in “Set Pricing” on page 139.

 Delete a price list in Product Templates

Price lists can be deleted in the Product Templates dialog.

1 On the menu bar, choose Product Templates and then the Pricing tab.

2 Click the Delete button to delete a Price List from the list.

3 Click Delete to confirm.

The price list no longer appears in the list.

NOTE: A price list cannot be deleted if it is being used for a store.
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 Create a new price list in Stores

1 On the menu bar, choose Stores and select a store.

2 In the Set Up pane, click the Add button next to the Price List drop-down list.

3 Complete the fields in the Create Price List dialog.

Name This name appears in the Pricing drop-down list. It’s also added to the Price Lists 
list in Product Templates > Pricing. 

Currency This is the currency used to display the prices; you may want to set up different 
price lists which are differentiated by currency.

Exclude taxes Select or clear this check box to exclude or include tax in the prices you enter in 
the Price Matrix. 

Description Additional information

4 Click Save.

The new price list is displayed in the Pricing drop-down list.

NOTE: You can only delete a Pricing List in the Product Templates dialog. See 
“Delete a price list in Product Templates” on page 145.
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Packaging Units Tab

In this tab you select the packaging units that can be used to ship the products 
you create with this template. This tab only needs to be completed if your store 
uses a shipping service whose cost is based on the packaging (Fixed Fee per 
Package, Fee per Weight Unit, Fee per Packaging Unit calculation method).

CAUTION: You must assign packaging units to a template if your store uses a 
shipping service whose cost is based on the packaging. If you do not do this, the 
shopper will not be able to use the shipping service as it will not be visible on the 
storefront.

Prerequisites
Packaging units must be created in Advanced > Shipping >Packaging Units 
before you can assign them to a template. See “Create packaging units” on 
page 77 for more information.

The weight and thickness of the media used for the template must be specified 
in Advanced > Media. See “Media” on page 62 for more information.

Packing Measurements must also be set in the General tab of the product 
template. See “Packing Measurements button” on page 126.

 Select Packaging Units

1 On the menu bar, choose Product Templates and then the Packaging Units 
tab.

2 Click the Add button to add a new Packaging Unit to the list.

3 Select a packaging unit from the drop-down list and its specifications are 
displayed. STOREFRONT will calculate the shipping fee based on these specifi-
cations and the specifications of the product. Initially, you can choose boxes 
or rolls if these are available but you cannot have boxes and rolls in the same 
template.

If you have more than one packaging unit, the most appropriate packaging 
units will be selected.

Alternatively, you can enter the maximum number of copies per packaging 
unit in the Max. Copies box to overrule this calculation. For example, use 
this option if you only want to ship maximum 5 posters in a tube.
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4 In the Packaging Parameters pane, specify whether you want the products 
to be shipped in 2 or more small boxes instead of 1 large box in the Keep 
smaller boxes drop-down list.

 Packaging Simulator

Once you have selected the packaging units, you can use the Packaging 
Simulator to simulate possible packaging scenarios for orders containing 
products based on this template.

1 On the menu bar, choose Product Templates and then the Packaging Units 
tab.

2 In the Packaging Simulator pane, enter a representative page count (bound 
products only) and order quantity, and click the Calculate button.

3 The simulator displays how the order will be packed.

Related topics: • “About Shipping Costs Based on Packaging” on page 70
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Preflight Tab

In this tab you can override the default preflight settings for the products created 
with this template. The settings are the same as in Advanced > Production 
Settings > Preflight Defaults. See “Preflight Defaults” on page 87.

NOTE: Only for Uploadable and Customizable products.
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Production Tab

In this tab you can override the default prepress settings for all products based 
on this template. You can also enable the Apogee WebApproval Flow to let 
shoppers review their ordered content in the WebApproval application (requires 
setting up the shopper as a guest approver in Apogee Prepress).

 Override the default prepress settings

1 On the menu bar, choose Product Templates.

2 Click Production and clear the File type check box.

Now you can specify the file type, MJD Mime or PDF/JDF. See “Prepress 
Settings” on page 98 for more information about these file types and when 
they are relevant.

3 Enter the Ticket Template that you want to use instead of the default ticket 
template or leave this field empty if you do not want to override the default. 
See “Prepress Settings” on page 98 for more information on when a ticket 
template is relevant. Job ticket templates created in Apogee Prepress 11.0 
and higher, or Asanti Production 4.0 and higher with the option ‘Mark avail-
able for STOREFRONT’ appear automatically in this drop-down list.

 Enable Apogee WebApproval Flow integration

The use of WebApproval does not affect order statuses. As long as orders are 
being processed, they have the status ‘In Production’ in StoreCenter. When 
pages are rejected in WebApproval, this also does not impact the order in Store-
Center. Replacing the rejected pages will have to be handled manually. 
WebApproval uses its standard messages to invite a shopper to approve pages. 
This means the shopper will receive an e-mail with a subject line such as ‘The 
first pages are available to inspect in job “23599-001 A4 Catalog (23599)”’. The 
e-mail body will state ‘You are invited to approve the pages of your job “23599-
001 A4 Catalog (23599)”. The first pages are available to inspect. You can go to 
your job by clicking the following link: ’. No reference is made to the fact that this 
is a product previously ordered via a storefront. The only link is the job name 
which includes the StoreFront order ID and product name. This means that 
WebApproval should only be used in stores for which users can be made familiar 
with the approval process and know that it is part of the ordering process. It can 
be useful to mention the WebApproval step in the product description of all 
products that require such an approval.

1 On the menu bar, choose Product Templates.

2 Click Production and enable the Apogee WebApproval Flow check box.
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 Override the default Print Process with JDF Production Intent

When a print job is described using JDF, a Production Intent tag can indicate if 
that job is intended to be produced using an offset (lithography), digital 
(electro-photography) or inkjet press. You can choose this intent in the Print 
Process drop-down list and this overrides the default Prepress Setting.

Related topics: • Configure Prepress Settings on page 99
• Integrating STOREFRONT with Apogee Prepress/Asanti on page 326
• Downloading and Processing Files on page 322
• System Requirements on page 35
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CHAPTER
6 Products

Products are the publications and non-printed items that you want to sell or 
distribute via stores. They are initially created for a specific Company and can be 
used in all the stores of the Company.

This section explains how to create and edit the different product types. Once a 
product has been created, you can assign it to an existing or new store.

 Products List Overview ........................................................................................154
 Product Types ..........................................................................................................155
 Creating Products ..................................................................................................157
 Editing Products .....................................................................................................180
153
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Products List Overview

 On the menu bar, choose Products and select a company to see the list of 
products which have been created for a company.

1 Products for the selected company
2 Stores where the product is used (empty if not used in a store)
3 Product type icons
4 The template on which the product is based (click to go to this template)
5 Stock level: multiple stock levels are indicated by ‘Multiple’, otherwise the quantity is 

displayed
6 Tax code
7 Product is assigned/unassigned (in use or not in use by a store)
8 Free shipping (lorry icon)
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Product Types

The following types of products are available:

 Customizable Product: The shopper can edit the publication before buying it 
(e.g. business cards, data sheets); you need to upload a STOREFRONT Package.

 Variable Data Product: The shopper can upload an Excel file (both XLS and 
XLSX formats are supported) to create multiple versions of a publication with 
variable data (names, addresses, product names, images, etc.). This is a 
special type of customizable product.

 Uploadable Product: The shopper can upload a PDF or an image file (JPEG, 
TIFF, PNG, BMP) which is printed according to the product definition. PDF 
files are preflighted (optional) to check conformity with the product defini-
tion. The shopper can control how image files are placed on the available 
media.

NOTE: Image files (JPEG, TIFF, PNG, BMP) can only be uploaded for unbound 
folded and flat template base types.

 On-Demand Product: The publication already exists and a quantity is printed 
on-demand as ordered by the shopper.

 Printed Stock Product: The publication is already printed and in stock.

 Non-Printed Product: Items in stock which are not printed publications (e.g. 
giveaways, promotional items, pick and pack products).

 Digital Product: This product type can be used if you want to sell digital 
products such as e-books, images, videos, clip-art, templates. The shopper 
receives an e-mail with a link to download the files. The e-mail is sent when 
the order reaches the Prepared order status (5 to 20 minutes after the order 
is placed). The link will also appear on the order details page: the shopper 
needs to refresh the page to see it.

 Product Kit: A bundle of products, i.e. kit items, that are sold together. 
Business cards, letterheads and envelopes are a typical example of a product 
kit. 

NOTE: All the products in a store are based on Product Templates which have a 
specified base type (bound, unbound, digital, etc.). However, you can create 
different types of products from a single template.
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The following icons are used to indicate the different product types in the 
products list.

The following icons are used to indicate the status of a product.

Customizable product (HTML5-based)

Variable data product (HTML5-based)

Uploadable product

On-Demand product

Printed stock product

Non-printed product

Digital product

Product Kit

Unassigned (not in use by a store)

Price list is not complete

Stock alarm level is reached

Product is out of stock

Free shipping: for product with free shipping enabled or for a digital product (shipping does 
not apply)

The product will become available (scheduling is applied)

The product will become unavailable (scheduling is applied)

Expired: the product is no longer available (scheduling is applied)
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Creating Products

The procedures for creating a product may differ slightly and depends on the 
type of product you want to create.

Prerequisites

 A product is created for a company so this company must already be created. 
See “Create a Company” on page 46

 A new product must match the characteristics (media type, page count, 
allowed order quantities, etc.) of an existing Product Template. These 
characteristics are inherited from the template. You may need to create a 
new Product Template. See “Product Templates” on page 115.

 Create a product

1 On the menu bar, choose Products.

2 Select the company you want to create the product for in the Company drop-
down list.

3 Click the Add button and choose a product type in the list.

4 Enter the Product Name.

This is the title of the product as it is displayed on the storefront.

NOTE: Do not use the following forbidden characters: / \ : * ? " < > |

5 For Printed Stock Products, enter the number of units you have in stock and 
set an alarm level. You will be informed by e-mail when the stock reaches the 
alarm level or is out-of-stock. See also “Replenish low (alarm level reached) 
and out-of-stock products” on page 184.

6 Choose a Product Template from the list.

Some product templates can be used for different product types. Remember 
that the template must match the requirements for your new product: media 
type, page count, allowed order quantities, etc. However, templates that are 
not compatible with the product type are not displayed in the list. For 
example, Unbound - Flat - Variable - Size templates are only displayed for 
Uploadable Products.
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7 Click Create to go to the next step.

The Describe Your Product dialog is displayed.

8 Complete the Product Description:

Summary This description is displayed when you hover over the product block on the 
Category overview page. It’s also used for the HTML meta description 
element on the Product page.

Product Description Here you can use the HTML WYSIWYG Editor to write a longer description 
which is displayed under the preview image on the Product page. See “HTML 
WYSIWYG Editor” on page 265 for more information on formatting the text.

Miscellaneous Select the No Approval Required check-box to bypass the order approval 
process for this product; these orders will go immediately to the Pending tab.

Quantity For a Variable Data Product, the quantity of the order depends on the Excel file 
that a shopper uploads. Here you set how the total number of units will be 
specified:

 Specified in the product page: The shopper specifies, on the product page, 
a quantity for each record in the uploaded Excel file. The quantity is the 
same for all records.

 Specified in the Excel file: The shopper uploads an Excel file that includes 
a column for the quantity of each record. The quantity can be different for 
each record.

 One copy per record: One unit is produced for each record in the Excel 
file. This option is typically used for direct mail products.
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SKU Code Choose Single SKU if you want to use the same code for all versions of a product, 
or select an option category from the drop-down list and enter an SKU code 
based on the different product options, i.e. so-called multi-SKU products. For 
example, specify a code for the different color versions of a non-printed product. 
Selecting the option category is important when creating a Digital Product. See 
“Create a Digital Product” on page 169.

Backorder Allowed Non-Printed and Printed Stock products only. Select the check box if you want 
to allow shoppers to order products even if they are no longer in stock. See “Set 
backorder quantity” on page 186.

9 Click Next.

The Upload Files dialog is displayed.

For Customizable Products and Variable Data Products:

Figure 6.28: Variable data upload link (1) and Excel file template (2), on a storefront product 
page.
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 Browse to the location of the StoreFront Package to upload a customizable 
document that matches the specifications of the selected product template 
(size, etc.), as indicated in the STOREFRONT Package panel.

The package is a file with a .zip extension. Uploading a file is a requirement 
to continue the creation of your product.

NOTE: The ZIP file must be a STOREFRONT package with a document that 
matches the specifications of the selected product template, otherwise the 
product cannot be created. STOREFRONT packages are created in Adobe 
InDesign using the STOREFRONT Converter plug-in. See “Online Editor” on 
page 335 for more information.

 Browse to the location of a Data Excel file from which shoppers can select 
records when customizing the document, using the autofill feature: see “Use 
an Excel file for Autofill” on page 506.

 Choose the Online Editor that you want to make available for the shopper 
(see “Online Editor” on page 335 for more information):

Technology:

 HTML: means that the newer, HTML5-based version of the Online Editor 
is activated.

Workspace:

 Basic: the shopper can only edit or add text and images to existing text 
frames.

 Advanced: the shopper can add content and also create new frames, link 
text frames, add lines, etc.

 Forms: the shopper adds content using form fields and has no direct 
control over the layout.

 Expert: combines the Advanced and Forms workspaces.
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NOTE: You can only choose the Forms or Expert workspace for Variable Data 
Products.

For each version of the Online Editor you can also fine-tune the user interface 
by showing or hiding the following panel items:

Image Panels:

 Show My Images

 Show Product Images: You also have the option to show External 
Locations which are folders outside the STOREFRONT server. Each location 
is identified with an alias. Click the Edit button to open the Select 
Locations dialog where you can select a location or add a new location. 
See “External Accounts” on page 101.

 Show Store Images

 Show Design Images

For example, you may want to prevent shoppers using their own images in a 
layout to prevent copyright issues.

Text Panels:

 Show Character/Paragraph Settings

 Show Character Styles

 Show Paragraph Styles

For example, you may want to give shoppers the option to change the font.

See “Images Tab” on page 435 and “Text Tab” on page 431 for more informa-
tion about these features in the Online Editor.

Extra features:

 3D visualization

For On-Demand and Printed Stock Products:

 Browse to the files you want to upload:

 Low resolution PDF: This is the PDF preview file that can be downloaded 
by the shopper. Remember to upload a low resolution file for this purpose 
to ensure that a shopper cannot use the file for printing elsewhere. It is 
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recommended to add a watermark. See “PDF Preview” on page 96 for 
adding a watermark with STOREFRONT.

 High resolution PDF: The PDF file which is used for print production.

NOTE: These products can be Multi-Version, in which case you can specify 
files for each version.

Figure 6.29: The flip book button (1) and PDF preview button (2) on a storefront product page.
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For Uploadable Products:

 Browse to template files (maximum 4) that you want make available for 
downloading on the storefront. The templates can be any type of file (ZIP, 
PDF, Illustrator, InDesign, Word, etc.) to illustrate or explain the expected 
requirements of the uploaded product, or to be used by the shopper to create 
the publication he wants to upload. Providing a template is optional but the 
file extension must always be included in the file name. Examples of template 
files are envelopes, newsletters, point-of-sales materials. The maximum file 
size for uploading is 1 GB.

For Non-Printed Products:

Figure 6.30: A shopper can browse through the document in flip book mode.

Figure 6.31: Document templates in 2 different file formats, available for downloading by a 
shopper
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 No production files need to be uploaded.

10 Upload one or more preview images to illustrate the product on the store-
front. If you don’t have a dedicated preview image, the first page of your 
document is displayed as the preview by selecting Generate from High-
resolution PDF.

A dedicated preview image can be useful if you want to display a preview 
which is different than the first page of the uploaded document, e.g. a cover 
with a ‘New’ or ‘Special Offer’ banner. If the product is Non-Printed and 
multi-version, you can upload images per version.

These can be JPEG, GIF or PNG files. STOREFRONT creates a thumbnail of each 
image which can be clicked to its full size.

You can provide several preview images to illustrate the cover and a selection 
of inside pages for example.

Click the Add button and browse to additional images.

Figure 6.32: Preview images illustrate the cover and inside of a publication on a storefront
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NOTE: For uploadable products, it is recommended to upload an informative 
preview image that, for example, indicates the expected orientation of the 
product.

For a Digital Product:

 In the Digital Content panel, browse to the file or files you want to upload. A 
file can be uploaded for each SKU code. These are the files that a shopper can 
buy and download. See “Create a Digital Product” on page 169.

NOTE: Digital Products can be Multi-Version, in which case you can specify 
files for each version.

For a Product Kit:

 Upload images that illustrate the Product Kit, not the individual items. For 
example, upload one or more images of the kit packaging. See “Create a 
Product Kit” on page 173 to add the individual products to the kit.

11 Click Next.

The Pick Your Options dialog is displayed where you can select which 
product options you want to display on the storefront.

Follow the instructions as some product types do not allow multiple options. 
For example, only one color option and one media type option can be 
selected for Printed Stock products.
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You can change the default options by selecting an option in the list and 
clicking the Make Default button.

12 Click Next.

The Create Product Specifications and Define Tags dialog is displayed. 
See “Add Product Tags” on page 178.

13 In the Product Specifications panel, you can choose from 3 options in the 
drop-down list for displaying information under the Place Order box on the 
storefront product page: 

 System-generated: Choose this option if you want to show the product 
specifications as they are generated automatically by the system.

 Hide: Hides the system-generated specifications on the storefront.

 Customize: If you choose this option, the system specifications are 
displayed in the HTML WYSIWYG editor where you can add information 
or edit the existing specifications. This information replaces the system-
generated specifications under the Place Order box. You can always go 
back to the system-generated specifications by clicking the Revert button. 
You may prefer to use customized specifications for more complex 
products that need further clarification (a point of sales display, large 
posters with grommets, etc.). You can format the text and even add 
images using the HTML WYSIWYG editor.

14 In the Product Tags panel, click an existing tag to add it to the comma-
separated list of tags, or enter a new tag. Separate multiple tags with a 
comma.

See “Add Product Tags” on page 178 for more information.

15 Click Next.

The Set Product Restrictions dialog is displayed. Depending on the product 
template used to create the product, you will see one or more panels where 
you can set restrictions on certain template characteristics. For example, a 
template may provide quantities between 50 and 5000 copies but you can set 
a restriction to offer only quantities between 100 and 500. You can also set a 
Default Quantity if you want the lowest supported quantity to be higher 
than the lowest supported quantity of the template (see “Default Quantity” 
on page 129). Restrictions do not apply for a digital product.
StoreFront User’s Guide



 

6 PRODUCTS 167
16 Click Next.

The Select Access Labels dialog is displayed.

17 Choose the labels that you want to assign to the product by selecting the 
check boxes.

The checked labels appear in the panel on the right.

See “Access Labels” on page 262 for more information about using access 
labels to control who can see which products on the storefront.

NOTE: Access labels set on a Product Category override access labels set on a 
Product.

18 Click Next.

The Set Price and Schedule dialog is displayed with the following settings: 

Pricing (VDP and multi-documents only) Select the check boxes to apply the set-up cost, 
quantity pricing and package unit cost for each individual record or document. 
Clear the check boxes to apply the cost and pricing once to the entire order item. 
For example, if you have lower prices for higher quantities of an ordered item, 
the total price will be higher if you select the Quantity pricing per seperate 
record/document check box. Selecting this option also affects the calculation 
method for shipping: when the Fixed Fee per Shopping Cart Item option is 
enabled, the fixed fee is multiplied for each separate record/document (see 
“Shipping Services” on page 65).

Discount/Markup Applies a discount/markup (higher price) only to the product you are creating 
as opposed to an overall discount on the price list. Enter a Fixed or Percentage 
discount in the box for the selected price lists:

 Fixed: for example, enter 5 to apply a discount/markup of 5 euros 
(dollars, etc.) per copy or item

 Percentage: for example, enter 10 to apply a 10% discount/markup

 Discount/Markup: Choose whether you want to apply a discount or a 
markup (higher price)

Select the Also show the non-discounted price check box to display the 
original price on the storefront.
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NOTE: If the product is part of a Product Kit, the discount is only applied if the 
product in question is also available in the same store. Alternatively, use the 
Cost Weight option as described in “Create a Product Kit” on page 173 to 
apply a discount for products in a Product Kit. See also “Create a Product Kit 
with Discounted Kit Items” on page 176.

Tax For all countries except US. Choose one of the tax code resources in the drop-
down list.

TIC US only. Taxability Information Code (TIC) for US sales tax calculation by the 
TaxCloud service. Use this option to set a specific TIC which is different than the 
code set at the store level. See “TaxCloud Integration” on page 566 for more 
information.

Shipping Select the Free shipping (always) check box to always offer free shipping for 
this product, and choose whether or not the product can be combined with other 
order items for Combined Packing:

 None: do not combine ordered products with each other for shipping

 Same Template: the ordered product may be grouped with items based 
on the same product template

 Same/Compatible Size: group the item with any product that allows 
grouping, provided that product has the same size, with a tolerance of five 
percent (for boxes)/provided that the product’s dimensions fall within 
the minimum and maximum width constraints of the roll packaging unit 
dimensions (for rolls)

Scheduling - Limit Product
Availability

Here you can set the product availability. A product which is not available is not 
displayed on the storefront.
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 From and To are empty: the product is available immediately and no end 
date applies

 From: Enter the date from when the product will be available.

 To: Enter the date when the product will no longer be available.

19 Click Save and Close.

The new product is added to the list with its details (grayed out).

At this stage, the product has not yet been assigned to a store and this is 
indicated with the Unassigned icon:

This icon is no longer displayed once the product is being used in at least one 
store.

 Create a Variable Data Product

See “Variable Data Processing (VDP)” on page 382.

 Create a Digital Product

NOTE: This feature may not be included in your license pack.

This is the procedure for creating a digital product once you have created a 
template for a digital product. See “Creating Products” on page 157.
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1 On the menu bar, choose Products.

2 Select the company you want to create the product for in the Company drop-
down list.

3 Click the Add button and choose Digital Product in the list.

4 Enter the Product Name.

This is the title of the product as it is displayed on the storefront.

NOTE: Do not use the following forbidden characters: / \ : * ? " < > |

5 Select the product template in the list. The list is filtered and you only see 
templates that can be used for digital products.

6 Click Create to go to the next step.

The Describe Your Product dialog is displayed.

Figure 6.33: A digital product with multiple values in a drop-down list to download different 
file formats of the same publication

1 Product title
2 Description
3 Options
4 Specifications (customized)
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7 Complete the Product Summary and Description.

8 In the Miscellaneous panel, enter the SKU code. This is your ID code for the 
file or files that you are going to upload.

Choose Single SKU if you only want to upload 1 file. In this case, an SKU code 
is also optional.

OR

Choose your option in the drop-down list if you want to upload more than 
one file. In this case you must enter a unique SKU code for each file you want 
to upload.

NOTE: If you do not change the default Single SKU to your option, you will not 
be able to upload more than one file.

9 Click Next.

10 Upload one or more preview images.

11 In the Digital Content panel, upload the files for each option.
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The following file types are supported:

 Audio file types: MP3 (version 2.3.1 and later), WAV

 Compressed file types: ARJ, GZIP, TAR, TGZ, ZIP

 E-book file types: AZW, EPUB, MOBI, PRC

 General file types: HTML, PDF, RTF, TXT, XML

 Image file types: AI, BMP, DXF, EPS, GIF, ICO, INDD, JPEG, PNG, PSD, 
SWF, TIFF

 Office file types: DOC, PPT, XLS

 Video file types: AVI, FLV, MPEG, MPG, MP4, MOV, SWF, WMV

Other file types are best packaged in a ZIP file

12 Click Next. For Digital Products, the Product Specifications are set to Hide by 
default. However, if you want to show specifications such as the ISBN 
number on the product page, choose Customize in the drop-down list and 
enter the information using the HTML WYSIWYG editor.
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13 Click Next. In the Set Price and Schedule dialog, you only need to select the 
Tax Code. The Shipping and Scheduling settings are not necessary because 
the files can be downloaded immediately by the shopper.

14 Click Save and Close.

The new product is added to the list with its details (grayed out).

At this stage, the product has not yet been assigned to a store and this is 
indicated with the Unassigned icon:

This icon is no longer displayed once the product is being used in at least one 
store.

 Create a Product Kit

NOTE: This feature may not be included in your license pack.

A product kit is a bundle of products, i.e. kit items, that are sold together. 
Business cards, letterheads and envelopes are a typical example of a product kit. 
The kit items behave just like the original products, and the shopper can specify 
quantities and options for the individual kit items.
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A kit must contain at least two products and may contain up to sixteen of the 
same or different product types, including customizable products. The shopper 
edits the kit items in a step-by-step wizard. A product kit cannot contain another 
product kit as kit item.

This is the procedure for creating a product kit once you have created a product 
kit template.

1 Start by creating a product as explained in “Creating Products” on page 157.

2 In the Upload Files dialog, upload images that illustrate the product kit, not 
the individual items. For example, upload one or more images of the kit 
packaging. The individual items in the kit are illustrated with their respective 
preview images.

3 Click Next to display the Compose Product Kit dialog.

Figure 6.34: A product kit consisting of 3 products. The shopper clicks the Edit button to open 
the wizard and specify the details for each product. 
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4 In the Kit Items panel, click the Add button and select at least two products 
for your product kit from the list of products. Press and hold the CTRL key to 
select multiple products and click Add. You can add different product types 
to a product kit.

The products are added to the Kit Items list where you can specify a Cost 
Weight. The default cost weight is 100% which means that the full price of 
the kit item is added to the price of the product kit as specified in the product 
template. You can specify a lower cost weight (< 100%) if a kit item is less 
expensive when part of a kit, or increase its price (> 100%). It is not possible 
to show the original price of the kit item on the storefront if it is affected by 
the cost weight. See “Create a Product Kit with Discounted Kit Items” on 
page 176 if you want to do this.

5 Select the Show price details for the kit items check box if you want to let 
the shopper see the prices of the different products in the product kit wizard 
and during the checkout procedure on the storefront.

NOTE: This kind of information is cached on the STOREFRONT server and is not 
updated immediately for shoppers to see. See “Caching” on page 196.

6 Click Next to continue with the wizard as explained in “Creating Products” 
on page 157.

A product kit behaves like a regular product and can have access labels, 
discount, etc. You may also want to set restrictions, for example on the 
quantities, when a product is part of a kit.
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NOTE: Don’t forget to add the product kit to your store. Orders for product kits 
are processed together as a whole, like regular products.

CAUTION: Be careful when changing the composition of product kits for kits that 
are already used in a store. Invalid kits will be removed from the shopping cart.

 Create a Product Kit with Discounted Kit Items

A Product Kit behaves like a regular product and you can apply a price and a 
discount to the kit in the same way as you would for a product (see “Creating 
Products” on page 157). The price of the product kit is added to the price of the 
individual kit items. If the individual kit items have their own discount 
(percentage or fixed), these discounts are applied on top of the Product Kit 
discount. However, this is only true if the kit items are also offered as separate 
products in the same store. If you do not want to include the individual kit items 
in the same store, you have the following options:

 You can offer kit items at lower (or higher) prices using the Cost Weight 
option as described in “Create a Product Kit” on page 173, however, this is 
always a percentage discount and the discount is not displayed as such to the 
shopper on the storefront.

 To add a discounted product to a kit without making it available in the store, 
add it to the store but set it up so shoppers can’t actually buy it:

 Set the availability date in the distant future so the product never 
becomes available.

 Assign an access label to the product but not to any users (the Access 
Labels feature requires a MallPack Silver license).

 Put the product in a disabled product category.

NOTE: Disabling the product in the product list is not a solution because the 
product will no longer be available in the Product Kit.

 Create multi-version or multi-SKU documents

To create multi-SKU versions of non-printed products, for example a USB 
memory stick that is available in multiple colors, see the procedure for creating 
a product and select an option category per code (see “SKU Code” on page 159).
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You can also create multi-version products for on-demand products, for example 
publications in multiple languages or with international variations, and assign 
an SKU code to each version.

1 Define options in the product template:

2 In the product settings you can choose to make all options available or you 
can limit the number of available options. In the Product Description tab, you 
need to specify which option defines the versions. You can then give each 
unique version its matching SKU code.

3 In the Upload Files tab, you can upload the files associated with each version.
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When users select a different version, this means the product image, PDF 
preview file and flipbook also differ per version. STOREFRONT will also send a 
different high-res production file to the Apogee Prepress or Asanti workflow, 
depending on the version ordered.

 Add Product Tags

When defining a product, you have the opportunity to add invisible tags to the 
product specification. These can be existing tags which have been used for other 
products or new tags that you create as needed.

Tags are keywords which are not necessarily included in the title or description 
of the product but which you may want to include to improve searching effec-
tiveness when shoppers are looking for a particular product on the storefront. 
These keywords can refer to the subject, language, etc. of your publication or 
product. It’s also good practice to include synonyms.

 In the Create Product Specifications and Define Tags dialog of the product 
wizard, you can either:

Click an existing tag to add it to your product.

OR

Enter one or more new tags, each separated with a comma. These new tags 
will appear the next time you use the wizard.
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 Create a product with user-definable size

Some products can use a template that allows the shopper to choose the size. See 
“Preferred Sizes Tab” on page 130 and “Customizable Product with User-Defin-
able Size” on page 508.
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Editing Products

Once a product has been created and appears in the product list overview, you 
can perform a number of actions on it.

 Edit a Product

You can edit the product settings by selecting the product in the Product list and 
clicking the Edit button. Modifications also apply to products which are already 
assigned to a store.

NOTE: Changes to the product name, description and preview images are 
displayed with a slight delay (maximum 10 minutes) on the storefront due to 
caching. 

1 Highlight the product in the list and click the Edit button.

2 Choose one of the options in the list and edit as required: 

 Description: Opens the Description dialog where you can modify the 
Product Name, Summary, Description and SKU code.

 Uploaded Files: Opens the Upload Files dialog where you can change the 
initially uploaded files.

 Options: Opens the Pick Your Options dialog where you can select the 
product options you want to offer, for example a selection of the media 
types inherited from the template.

 Specifications and Tags: Opens the Product Specifications and Tags 
dialog where you can set the Product Specifications and add or delete 
tags.

 Restrictions: Opens the Set Product Restrictions dialog where you can 
edit the quantities.

 Access Labels: Opens the Access Labels dialog where you can select or 
clear labels. See “Access Labels” on page 262 for more information about 
using access labels to control who can see products on the storefront. 

 Pricing and Scheduling: Opens the Scheduling dialog where you can 
change the availability dates.
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 Items in stock: Opens a dialog where you can edit the stock for Printed 
Stock Products and Non-Printed Products.

 Online Editor: Opens the Online Editor for Customizable and Variable 
Data products. This is where you fine-tune the document and define what 
can be changed by the shopper. See “Online Editor” on page 335 for more 
information.

3 Click Save and Close to confirm your changes or click the X button in the top 
right corner to close the editing dialog without saving.

 Show/hide a Product on the storefront

You can show or hide a product on the storefront. You may want to do this if a 
publication is no longer up-to-date, if it is unavailable or needs to be taken off-
line temporarily.

1 On the menu bar, choose Products.

2 Select a company in the Company drop-down list.

3 Highlight an enabled (black) product in the list and click the Enable/Disable 
button to hide the product.

The product is still in the list but it is now grayed out. It’s also grayed out in 
the Product Catalog of the store.

The product is no longer displayed on the storefronts of the stores it was 
assigned to.

4 Click the Enable/Disable button again to show the product and display it 
again in the storefront.

 Delete a Product

1 Highlight a product in the list and click the Delete button to delete the 
product from the list.

CAUTION: Deleting a product in the product list will also delete the product 
on all the storefronts. No warning is displayed.

2 Click the Delete button to confirm.
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 Duplicate a Product (same or different company)

Products can be copied for use by the stores of the same company or use by the 
stores of a different company.

1 Highlight a product in the list and click the Duplicate button.

2 In the Duplicate for company drop-down list, choose the company that you 
want to duplicate the product for.

3 Click Duplicate.

A duplicate product is added to the list with the same name and the ‘- Copy’ 
suffix. If you copied the product for a different company, select this company 
in the Company drop-down list at the top of the panel.

4 Highlight the product in the list and click the Edit button to modify the name 
and any other settings you want to change.

At this stage, the product is grayed out in the list because it is not being used 
in a store.

 Export a list of all stock products

You can export an Excel file that lists all the printed and non-printed stock 
products with their current stock levels.

1 On the menu bar, choose Products.

2 Select a company in the Company drop-down list.

3 Click the Export Products with Stock Levels button to open or save an Excel 
file with all the stock details.

The following details are provided:

 company id, name and MIS id

 linked stores: stores where the products are made available

 product id, name, SKU

 option id, name, value id, value name, value SKU
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 stock: the quantities still in stock

 Backorder Limit and Backorder Available

 Look up where a product is used

Products can be used in multiple product categories and across the stores of the 
same company. In the Stores column of the Products list, you can see in which 
stores a product is being used. You can use the look-up feature to navigate 
quickly to the product categories where a product is being used.

1 Select a product in the product list.

2 Click the Look-up button.

The stores where the product is used are listed with links to the respective 
product categories.

3 Click a link to go to the store’s Product Catalog and the relevant product 
category.

 Copy Variables and Actions to another product

If you created a product with many variables and sophisticated actions to 
validate the formatting of e-mail addresses and phone numbers, you can now 
copy all these settings to another product without redoing all that work.

1 First create your new product.

2 Select any product in the product list.

3 Click the Copy Data button.

4 Choose your new product in the To field and the product you want to copy 
the Variables or Actions from in the From field. Alternatively, select both 
products in the Products list so they appear in the From and To fields.

5 Choose whether you want to remove Variables and/or Actions that already 
exist in the product.
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 Replenish low (alarm level reached) and out-of-stock products

For Printed Stock Products and Non-Printed Products you can set an alarm level 
for when the stock reaches a certain level or is completely out of stock. All printer 
administrators are informed by e-mail when these levels are reached so you can 
replenish the stock. 

1 Click the link in the notification e-mail to go directly to the low-stock product.

OR

On the menu bar, choose Products and select the company and highlight the 
product which needs replenishing in the list of products.

All printer administrators received an e-mail with the name of this product 
and it is indicated in the list with a special warning icon and the alarm level 
or out-of-stock level.

2 Click the Edit button and then Items in Stock to add extra stock.

You can now enter extra stock which is added to the remaining stock, and 
modify the alarm level if you want.
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3 Click Save to confirm your changes.

Low stock levels and out-of-stock products are also reported in the System 
Messages panel on the Dashboard. Stock values can also be negative due to back-
orders. Replenishing a negative stock must always be done to minimum value 0. 
For example, if the stock is -500 then the stock must be replenished with 
minimum 500.

The following notifications are possible:

 Out-of-stock and with backorder limit reached

 Out-of-stock but available for backorder

 Out-of-stock

 Stock below alarm level

Figure 6.35: System messages for out-of-stock and low stock levels
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 Set backorder quantity

If the Backorder Allowed option is enable when creating the product, shoppers 
can order a quantity of this product even if the quantity exceeds the available 
stock.

1 Select the product in the list of products.

2 Click the Edit button and then Items in Stock to set the backorder quantity.

You can now enter a quantity in the Backorder Limit box. This is the 
maximum quantity that shoppers can order on top of the quantity in stock. 
This quantity is displayed for shoppers in the Place Order panel.

If you leave the Backorder Limit box empty, the backorder quantity is 
unlimited.

Related topics: • Product Templates on page 115
• Product Catalog Tab on page 208
• Add Products to an existing Category on page 211
• Online Editor on page 335
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7 Stores, Microstores and 
Storefronts

NOTE: Some of the procedures in this section are for the Printer Administrator 
only.

The Printer Administrator sets up one or more stores in the StoreCenter for 
specific Companies. Every store has a corresponding storefront with a unique 
internet address (URL) and a customized look and feel. Microstores can be 
derived from main stores.
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Storefront Website Overview

The storefront is the actual website where the products are displayed — with or 
without prices. The range of products available on the storefront is referred to as 
the Product Catalog and similar products are organized in Product Categories.

A storefront is private and secured if it can only be visited by users who have 
been assigned a login and password. The storefront is public if it can be accessed 
by anyone with internet access.

Storefront Grid The storefront consists of a header area and a footer area which is identical for 
all pages of the storefront. The navigation bar provides links to the various 
pages.

1 Logo
2 Swirl
3 Language bar with links to localized storefront pages (optional)
4 Shopping cart and account
5 Navigation bar with page links and Search
6 Page content
7 Customizable footer (optional)

Figure 7.36: Storefront grid
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Home Page The Home page is the landing page of the storefront where the Product Catalog 
is displayed. 

1 Link names in the navigation bar
2 Banner
3 Page title
4 Content
5 Image inserted in content
6 Contact box (optional)
7 Link box (optional)
8 Product catalog with product categories

Figure 7.37: Home page layout
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Product Category 
Page

Clicking a Product Category in the Product Catalog takes you to the second level 
of the website with pages that display all the products per Category.

1 Breadcrumb navigation trail
2 Current product category title
3 Navigation to other product categories
4 Products

Figure 7.38: Product Category page with products
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Product Page Clicking a product in the Product Catalog takes you to the third level of the 
website with pages that display the information about the actual product.

1 Product name
2 Place Order box with available quantities, media types and product options
3 Specifications of the product (system-generated, hidden or customized)
4 Available order quantities and prices with pricing table footer
5 Product description
6 Preview images

Figure 7.39: Product page
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Optional Pages Three optional pages with links in the navigation bar contain additional infor-
mation. The Copyright notice and a link to the Terms & Conditions page can be 
placed at the bottom of all pages. 

1 Link names in the navigation bar
2 Page title
3 Content (can also include images)
4 Contact box (optional)
5 Link box (optional)

Search Every storefront page has a search box in the top right corner which is designed 
to help shoppers find products. To understand how search works you need to 
know that it is based on the following principles:

 The search engine is meant to find specific products or product categories. It 
will not search information pages or external sites.

 Search is not case-sensitive.

Figure 7.40: Layout of the optional pages
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 The use of wild cards, such as * or ?, or logical operators, such as AND or OR, 
is not supported.

 The following system fields are searched:

 Category name

 Product name

 Product description

 Product

 SKU

Regular and Suggestions Search

A regular search is performed when the shopper enters a search term and presses 
the Enter key or clicks the Search button. When the shopper starts typing, a list 
of suggestions appears in a separate pop-up window. This is the suggestions 
search. Clicking the View All button triggers the regular search function.

Responsive Design If you think shoppers will be viewing your storefront on mobile devices (smart-
phones, tablets, notebooks, etc.) you can choose to make it responsive. This 
means the page grid elements will adapt automatically to the size of the screen. 
For example, on a smartphone, the navigation bar is replaced by the Menu 
button (the so-called hamburger icon), the banner picture is hidden, the Product 
Catalogs are displayed in 2 columns instead of 4, and the language bar becomes 
a menu.

This option is chosen in the Style Tab. If you have a custom footer on your pages, 
you also need to make some changes in the Custom Footer Tab.

The responsive design grid uses the following screen widths to show/hide 
certain elements and adapt their arrangement:

 smaller than 768 px

 between 768 px and 992 px

 between 992 px and 1200 px

 larger than 1200 px
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You should test what your storefront will look like in responsive mode on the 
various devices. You can do an initial test on a full-size computer monitor by 
reducing the size of the browser window to see the effect.

Figure 7.41: A  storefront home page on a small screen
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Setting up a Store

Printer Administrator only

A store and the corresponding storefront are managed in the Stores section. This 
section is divided into several tabs with the settings for the store and options for 
styling the storefront.

Complete the procedures provided here for each tab:

 General Tab: Set up the store (required)

 Product Catalog Tab: Add Categories and Products to the store (required)

 Languages Tab (optional)

 Shipping Tab: Choose a shipping resource (required)

 Style Tab: Define the look and feel of the storefront (recommended)

 Pages Tab: Add and edit the pages of the storefront (required)

 Invoice Tab: Customize your invoices (optional)

 Custom Footer Tab (optional)

 Promotions Tab

 Taxes Tab

 Meta Tags Tab (optional)

 Banners Tab: Create attractive carousel banners in HTML5 (optional)

Prerequisites
A store can only be created and set up with the products you want to sell or 
distribute if the following have been created:

 A Company (required): “Companies and Administrators” on page 45.

 A Company Administrator (optional): See “Companies and Administrators” 
on page 45.
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 A shipping service (required): See “Setting up Resources (Advanced Menu)” 
on page 61.

 The Products you want to sell: See “Products” on page 153.

Caching

To increase the performance of the storefronts, certain information is cached on 
the STOREFRONT server which means that some of the changes you make in 
StoreCenter are not displayed immediately. The maximum delay is 10 minutes 
but it is usually shorter.

For example, product names, descriptions, product kits, product discounts, and 
preview images are cached so any modifications are displayed on the storefront 
with a delay. Prices are not cached so selecting a different price list takes effect 
immediately, except for the discounts.

General Tab The General tab is where you enter the general information for the store. All of 
these fields are mandatory. Some fields are only displayed for editing after 
saving your initial store settings.

General

Name Enter the name of the store, for example My Online Store. This name is used 
for the <title> tag on all the storefront pages. This is also the name of your 
storefront which appears in the browser title bar and tabs, the logon page and e-
mail communications. 

NOTE: This name can be overridden by the SEO title of the individual pages. 
See “Pages Tab” on page 222.

Site ID This is a prefix which is added to your storefront URL to create a unique URL for 
this particular store. If your Site ID is myonlinestore, the URL for your storefront 
is https://myonlinestore.apogeestorefront.com. This ID does not neces-
sary have to be the same as the Name.

Figure 7.42: Store name in browser title bar and tab (with favicon)
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NOTE: The storefront URL for Asanti storefronts is https://
myonlinestore.asanti/storefront/.

Only lower case, numbers and hyphens are allowed. Spaces are not allowed. If 
the URL already exists, a warning is displayed prompting you to choose a 
different site ID.

TIP: Once your storefront is live and advertised, it is not recommended to change 
the site ID and corresponding website address (URL).

Custom Domain This field is visible and can be edited after saving your initial store settings. You 
can use your own, custom URL for the storefront instead of the STOREFRONT URL 
formed with the Site ID. The custom domain is used for all the pages of the 
storefront.

The following domain types are supported but should not contain non-Latin 
characters:

 domain: e.g. myURL.com

 sub-domains: e.g. shop.myURL.com (but not myURL.com/shop)

An example of custom domain redirecting:

 A shopper navigates to https://myURL.com. The login window appears and 
the URL automatically changes to https://
myURL.apogeestorefront.com. As soon as the user has filled in the name 
and password, and clicks OK, the main page appears and all URLs are now 
https://myURL.com. On a public storefront, shoppers only have to log in 
when they want to order products, so most visitors will not see the URL 
redirect.

NOTE: Read the important information about setting up your DNS server in 
the Custom Domain Name dialog.

URL This is a link to the storefront. If the store is off-line, the link is a preview. See 
“Previewing an off-line storefront” on page 206.

Status The storefront remains offline while you set it up; the status changes to online 
when the store is enabled. See “Putting your storefront online/offline” on 
page 206.

Store Company Select the company you want to create the store for in the Company drop-down 
list.
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Store E-mail This e-mail address is used for sending notifications when an order is placed, 
shipped, forgotten password, etc. Specify a company administrator’s e-mail 
address if this person needs to approve orders.

Tracking ID Click the Edit button to open the Google Analytics dialog where you can enter 
the Google Analytics ID you generated on the Google Analytics website. It is 
recommended to add the listed domain names to the referral exclusion list in 
Google Analytics. See “Google Analytics” on page 569 for more information 
about using Google Analytics to monitor activity on your storefront.

Maps API Key This feature allows you to implement autocomplete functionality for shipping 
and billing addresses. 

Defining Numbers

These numbers can be used in customized numbering patterns to number 
orders, invoices and quotes by store. Here you can reset them, for example, in 
the beginning of a new year. See “Order/Invoice/Quote Number Format” on 
page 92.

Store Code Enter a code (maximum 5 characters with letters and/or digits) of your choice 
to identify this particular store. The code is used by the {storecode} variable. 

Store Order Number The {storenumber} variable you can set for order numbering per store in the 
Order Number Format. Enter a number to reset the counter.

Store Invoice Number The {storenumber} variable you can set for invoice numbering per store in the 
Invoice Number Format. Enter a number to reset the counter.

Store Quote Number The {storenumber} variable you can set for quote numbering per store in the 
Quote Number Format. Enter a number to reset the counter.

Login and Checkout

Access  Private (password protected): The storefront can only be used by Users 
known by the system. You either create these users in StoreCenter or you 
enable the self-registration feature on the login page. Private is the recom-
mended setting for B2B stores. All payment method options are available.

 Public: The storefront can be viewed and used by anyone on the worldwide 
web; if you choose this option, the system automatically creates a sitemap for 
your storefront. See “Search Engine Optimization (SEO)” on page 33 for 
more information about the sitemap.

Add -to-cart-flow Choose what happens when a shopper adds something to the cart:

 Show Cart: the shopping cart is displayed and the shopper can click 
Continue shopping to navigate back or start the checkout process
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 Show Homepage: the homepage is displayed; this can be handy if orders 
generally consist of a mix of different products; a confirmation window is 
displayed every time a product is added to the cart

 Stay on Product Page: the product is added to the cart but you do not jump 
to the cart; a confirmation window is displayed every time a product is 
added to the cart

Reference  Optional - Free text

 Required - Free text

 Required - Predefined List: see “Predefined Values” on page 108

Select this check box if you want to force the shopper to supply an order refer-
ence at checkout: for example, an internal purchase order code. A window pops 
up before the shopper can place the order, and this window must be acknowl-
edged in order to proceed. You can specify the message in this dialog box: see 
“Edit the Order Reference dialog (Reference tab)” on page 234. If you do not 
select this check box, the shopper can optionally enter her own reference by 
clicking a link on the Place Order page.

Customer Approval Use this option if you want shoppers to check their product before committing 
the order – self-approval by the shopper.

 Not required: orders do not require approval

 For Customizable and VDP Products: the shopper can only proceed from the 
cart to checkout after reviewing a soft proof and approving the ordered 
product

Approval You can choose whether you want orders to be approved by a Company Admin-
istrator or Approver before they are processed. All incoming orders then appear 
first in the Approval tab of Orders (private stores only.). Choose one of the 
following options in the drop-down list:

 Multistep Approval: Selecting this option displays the Number of Approval 
Steps field, where you can select the number of approvers, and the Assign 

Figure 7.43: A shopper must click Approval to open a window with a soft proof that he can 
download and approve 
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Approvers button to specify approvers. The number of steps is displayed in 
the Steps column of the Orders > Approval tab. Administrators can approve 
for all steps if required.

 Using Groups: orders can only be approved by Approvers of the respective 
Approval Group

Choosing the latter option, Using Groups, displays the Default Approval Group 
drop-down list where you see your approval groups. Choose one of the groups as 
the Default Approval Group. See “Approval Groups” on page 54.

Payment and Pricing

Payment Method  External (use price list): For public stores only. The payment is not through 
an online payment gateway but via an off-line method as explained in the 
terms and conditions of the storefront, such as sending an invoice or pay as 
you collect.

 Ignore price list: For private and public stores. The Printer bills the Company 
based on information outside the STOREFRONT application.

 Via Contract (use price list): For private stores only. Orders are charged and 
billed on the basis of a contract between the Company and the Printer. Billing 
is handled by another system or service, not by STOREFRONT.

 Select one or more payment methods from the list below: Choosing this 
option lists all your pre-defined payment methods. See “Payment Methods” 
on page 81. Choose the methods that you want to activate for this store, 
which may include:

 One or more bank transfer methods: the shopper pays for his order by 
paying the order amount into a bank account as instructed during 
checkout.

 One or more payment gateways: Orders are charged at the displayed 
prices and to the billing address via an online payment gateway; see 
“Configuring Payment Gateways” on page 563 for more information.

Price List Choose one price list from the drop-down list; this option is not visible if the 
Payment Method is set to Ignore price list.

A price list can be selected that includes or excludes taxes; these price lists are 
created in the Pricing tab of the Product Templates (see “Set Pricing” on 
page 139). Click the Add button if you want to add a price list here.

Discount Specify a negative value for a discount on all the prices, or a positive value for a 
markup to increase all the prices in the price list. Entering a discount or markup 
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percentage means that the displayed prices will be different than the prices in 
the price list for all products using the price list, and there is no indication that a 
discount is applied. This feature can be used to give customers a discount on 
your standard price list, or to quickly apply an overall price increase. To apply a 
discount to a specific product, see “Discount/Markup” on page 167 in the 
product wizard.

Tax This section controls how tax (e.g. VAT) is handled in orders, invoices and 
quotes:

 Show a separate line per tax rate on orders and invoices: Select this option 
to display the tax percentage; if different tax rates apply to different 
items, each rate is listed on a separate line.

 Add taxes for cross-border B2B orders: Select this check box to add taxes 
for cross-border B2B orders.

 Add taxes for cross-border B2C orders: Select this check box to add taxes 
for cross-border B2C orders.

Use TaxCloud for US sales
tax calculation

For print service providers in the US: Select this option if you want to display the 
sales tax which is calculated automatically by the TaxCloud service. If you leave 
this option unchecked, no sales and shipping tax will be calculated. See 
“TaxCloud Integration” on page 566 for more information.

NOTE: Only Price Lists with Tax Exclusive are supported with TaxCloud.

Additional Fees You can define up to three additional fees that are applied to all orders in a store 
to compensate for rapidly changing costs. These charges will be displayed in the 
order summary during checkout, the final order details created, the order confir-
mation e-mail, as well as on invoices and exported order data. To add additional 
fees, fill in the following fields:

 Label: Enter a description of the fee you want to include in final order.

 Type: Select the fee type from the drop-down list: Fixed or Percentage on 
calculated on the items sub-total.

 Value: Enter the price for the defined fee.

 Limit: Set a limit by which the defined fee is not applied if the items sub-
total of the order exceeds this amount.
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 Tax Code: Choose one of the tax rates from the drop-down list: None, 
Super Reduced Rate, Reduced Rate (Low), Reduced Rate (High), 
Standard Rate, or Parking Rate.

NOTE: When the Use TaxCloud for US sales tax calculation option is enabled for 
a US printer account, no additional fees can be applied.

NOTE: The label for the additional fees can be translated into any language 
supported by the store.

Pricing Select the Show Prices in the Store check box to show prices on the storefront; 
the option is not visible if the Payment Method ignores the price list; prices are 
always shown if you choose a payment method (Bank Transfer, Ingenico, 
PayPal, or Stripe) and this check box cannot be cleared.

If you select this check box you can choose to display prices on the product pages 
or category pages, or on both, by selecting the following check boxes:

 Show Price Table on Product Pages: A table is displayed with prices and 
you can set the number of rows you want to display in the Max. Rows 
drop-down list.

Figure 7.44: An example of additional fees

Figure 7.45: Prices and specifications on a storefront product page
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 Show Price Labels on Category Pages: The base price for the lowest order 
quantity is displayed. The label is hidden when you hover over the image 
to see the description.

Add taxes for cross-border
B2B orders

Leave this check box unselected if you do not want to apply tax for international 
business-to-business (B2B) orders. The store must have a tax-exclusive price list. 
B2B shoppers are identified as such when they provide a tax or VAT number in 
the Billing Address form.

Add taxes for cross-border
B2C orders

Leave this check box unselected if you do not want to apply tax for international 
consumer business (B2C) orders. The store must have a tax-exclusive price list. 
It is recommended to check whether offering this tax-free option to your inter-
national consumer shoppers is legal in your market.

Price Rounding Select the Use price rounding in store check box to round the prices of the order 
to the nearest multiple of the selected rounding unit:

 Rounding Unit: 0.05, 0.10, 0.50, 1.00. In some countries you are required to 
round to the smallest currency denomination. For example, choose 0.05 to 
round €14.96 to €14.95;

 Rounding On: Total Only applies rounding to the total sum of the order; 
Individual Shopping Items applies rounding to each order item. 

Formatting

Default Language Here you can choose the default language used to display the storefront; in the 
drop-down list you can choose from the languages you made available for the 
Company in question.

NOTE: The default language cannot be changed afterwards.

Regional Formatting Select a locale to set the formatting for numbers, money, dates and time.

Figure 7.46: Price label on a category page
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Units Select a units system for measurements and weights:

 Metric: cm, mm, etc.

 Imperial: inches, pounds, etc.

 US Customary: inches, pounds, etc.

Stock Select the Show items in stock check box to display the available stock in the 
Place Order box on the product page.

Advanced

Online Editor Autofill Forms This feature controls how fields are filled in documents using variables in the 
Online Editor:

 Autofill disabled: form fields are empty when a shopper opens a 
document with variables in the Online Editor;

 Autofill user profile values only: data from the shopper’s profile is filled in 
automatically, e.g. name and address on a business card; the shopper can 
overtype these values but the edits are not saved in the system;

 Autofill most recently used values: the data used the last time for these 
variables are filled in automatically the next time a document with the 
same variables is opened in the Online Editor;

 Autofill user profile values complemented with the most recently used 
values: combines the two previous options;

See also “Use an Excel file for Autofill” on page 506.

Figure 7.47: Available stock on a storefront product page
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Quoting NOTE: This feature may not be included in your license pack.

Select the checkbox to enable the generation of quotes in the storefront for all 
users. This allows shoppers to obtain a document with the details and the total 
price of an order (products, shipping, packaging, etc.) without uploading 
dummy files and actually placing the order. An additional button, Add to Quote, 
is displayed in the Place Order panel.

Shoppers can immediately review and print the quote and they also receive an 
e-mail with a link to each quote they make for future reference.

PDF Preview Settings Clear the check box to specify dedicated settings for this store, other than those 
specified in the Advanced >Production Settings. See“PDF Preview” on page 96.

Figure 7.48: Add to Quote button so a shopper can create a quote

Figure 7.49: A quote ready for printing
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Orders/Products History Lets you control the extent of the order and products history that shoppers can 
see:

 Show all

 Show last year

 Show last 2 years

 Create a store

1 On the menu bar, choose Stores.

2 Click the Create button to add a new store to the list.

3 Complete the fields in the General tab.

4 Click Create to confirm your changes.

The new store is displayed in the list. 

NOTE: The store is grayed out in the list because the storefront is still off-line.

5 Complete the information in the others tabs as required.

 Previewing an off-line storefront

A store remains off-line while you are setting it up but you can preview the 
content at all times.

1 On the menu bar, choose Stores and select the store you want to view.

2 Click the URL link in the General tab.

The storefront is opened in a new tab/window of your browser.

NOTE: For a private store, you need to create a User and log on with the User 
credentials. See “Create a new user” on page 276. You cannot log on with 
your administrator credentials.

 Putting your storefront online/offline

With the initial set-up of your store completed, you can put your storefront 
online and make it available to shoppers. In addition, you may want to switch 
the storefront online/off-line for maintenance or other reasons.
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NOTE: A store which is off-line still counts for your license.

1 On the menu bar, choose Stores and select the store you want to go live with.

2 At the bottom of the Store list, click the Enable/Disable button

The storefront is now online.

NOTE: You can only go live with your storefront if at least the General and 
Shipping tabs have been completed.

3 To take a live storefront off-line, click the Enable/Disable button.

The storefront is now off-line but still available in StoreCenter.

 Viewing an online storefront

You can view a storefront once it has been put online.

1 On the menu bar, choose Stores and select the store you want to view.

2 Click the URL link in the General tab.

The storefront is opened in a new tab/window of your browser.

NOTE: For a private store, you need to create a User and log on with the User 
credentials. See “Create a new user” on page 276.

 Delete a store

If a storefront is no longer in use, you may want to delete the store to free up disk 
space and the license allocation.

Prerequisites

 All active orders are complete or canceled

 No microstores depend on the store you want to delete

CAUTION: All users created for this store will also be deleted.
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1 On the menu bar, choose Stores and select the store you want to delete.

2 At the bottom of the Store list, click the Delete button.

The store and all its users are deleted. The storefront is no longer online. The 
products used for the storefront are not deleted.

Product Catalog 
Tab

Products and categories are set up in the Product Catalog tab of the Stores 
section.

First you create a category and then you can add sub-categories and products to 
these categories, or add them to an existing category. If a category or sub-
category contains a mix of products and sub-categories, the products will be 
listed first, followed by the sub-categories.

TIP: Depending on the storefront target group, categories for products can be set 
up for different types of publications (brochures, catalogs, flyers, posters, etc.), 
for different types of commercial items (drills, saws, knives, etc.), or for various 
geographic regions (North Sales Region, South Sales Region, etc.).

 Add a Category and Products

1 On the menu bar, choose Stores.

2 Select the store you want to create the Product Catalog for in the Store list.

3 In the Product Catalog tab, click the Add button in the Categories column:

4 Choose one of the following options:

 On the same level: to create a category at the top level or at the level of the 
selected category

 One level deeper: to create a sub-category under the level of the selected 
category

5 Enter the Category Name which is displayed on the pages to identify your 
product categories. The name must be unique at the given level.

6 Enter the Category Description which is used to fill the description meta 
tag in the head of the HTML code on the product category pages of your store-
front. The description meta tag is useful for search engine optimization 
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(SEO) if your store is public. See “Search Engine Optimization (SEO)” on 
page 33.

For example, entering my catalog description, generates the following 
HTML code:

<meta name="description" content="my catalog description" />

The Category Description is also displayed when you hover over the catego-
ries on the home page, and as a tooltip in the navigation list on the left as you 
drill down into the categories.

7 Upload a Category Image by browsing to the image of your choice.

This optional Category Image is used to illustrate a category on the store-
front. If no image is uploaded, the category is displayed as a colored box.

The Category Image is used for all language versions of the storefront.

8 Choose a Carousel Banner:

 Same as parent category: if you are creating a sub-category, you can 
choose to display the same banner as the parent category

 None: a banner is not displayed

 Predefined banners: if you have created banners, they are listed here (see 
“Banners Tab” on page 255)

TIP: Select the ‘Keep dialog 
open’ check box if you want 
to add more new categories.

9 Click Add to add the category to the list.

10 With the category still selected, click the Add button in the Product column.

The Product List is displayed.

Figure 7.50: Category without and with a Category Image displayed on a storefront
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An alert icon is displayed if the selected Price List for the product is not 
complete.

If the store is to include shipping costs based on packaging, you shouldn’t 
select products using product templates which do not have packaging units 
assigned as indicated with the following icon:

11 Select one or more products and click Add to add them to the selected 
product category.

TIP: You can populate 
several categories with the 
same products.

The products are added to the bottom of the list and you can see a thumbnail 
and a summary of details for each product by highlighting it in the list. See 
“Creating Products” on page 157 for more information on products.
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The products are displayed in their respective product categories on the 
storefront Home page, with their description and specifications.

NOTE: It can take up to 3 minutes before a product is displayed on the 
storefront.

12 If necessary, use the Up and Down buttons to rearrange the product catego-
ries and the products. This reflects the sequence of the categories and the 
products on the storefront. 

 Add Products to an existing Category

1 On the menu bar, choose Stores.

2 Select the store you want to add products to.

3 Select the category you want to add the product to and click the Add button 
in the Product column.

TIP: To insert a product at a 
certain location in the list, 
select a product in the list 
and then click Add. The 
product is added under the 
selected product in the list.

The master Product List is displayed with all the available products. You can 
sort the products by clicking the column headers. For example, click the last 
column header to display the products which have not been assigned to a 
store at the top of the list.
StoreFront User’s Guide



212 SETTING UP A STORE
4 Select one or more products and click Add to add them to the selected 
product category.

The products are added to the list and you can see a summary of details for 
each product by highlighting it in the list. See “Creating Products” on 
page 157 for more information on products.

NOTE: You can populate several product categories with the same products.

The products are displayed in their respective product categories on the 
storefront Home page, with their description and specifications.

NOTE: It can take up to 3 minutes before a product is displayed on the 
storefront.

 Assign Access Labels to Product Categories

See “Access Labels” on page 262 for more information about using access labels 
to control who can see products on the storefront. 

1 Select the Use Access Labels check box to activate this feature when editing 
a category.

2 Select a category in the list and click the Edit button.

3 In the Access Labels tab, you will see the labels that were defined for this 
company.

4 Choose the labels that you want to assign to the category by selecting the 
check boxes.

The checked labels appear in the panel on the right.

NOTE: Product category labels override product labels.

5 Click Save to confirm your changes.

The Access Labels icon indicates that the category has labels applied to it.
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 Show Products of a Single Active Category on the Homepage

1 Select the Show products from one single active category on Homepage 
check box to activate this feature.

2 Click Save to confirm your changes.

The homepage displays products from this single active category.

NOTE: The products will only be displayed on the homepage when there is 
only one active category or when there are multiple active categories in the 
store and only one category can be accessed by enabling Use Access Labels.

 Disable or enable a category

1 On the menu bar, choose Stores > Product Catalog.

2 Choose the category you want to disable.
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TIP: Press the CTRL key to 
select multiple categories.

3 Click the Disable button.

The category is no longer displayed in the store.

Languages Tab The storefront can be displayed in several languages and a shopper can switch 
between languages by clicking the links in the language bar in the top right 
corner of the pages. 

1 On the menu bar, choose Stores and select the store you want to set the 
Languages for.

2 In the Languages tab, select a language in the Available Languages column 
and click Add or double-click the language to add it to the Supported 
Languages column.

The Available languages are the languages you chose when creating the 
Company to which this store is assigned.

3 Click Save to confirm your changes.

The storefront now displays the language links in a drop-down list in the top 
right corner, and a shopper can switch between languages.

NOTE: This setting enables the language versions of the storefront but only 
provides the translations of the default design components. The actual 
content has to be translated separately. See “Multilingual Storefronts” on 
page 511.
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Shipping Tab You need to specify how orders are shipped before putting the storefront online. 
A storefront can provide more than one shipping service for a shopper to choose 
from. These services are set up in the Advanced section. See “Create Shipping 
Regions” on page 76 for more information.

1 On the menu bar, choose Stores and select a store in the Store list.

2 In the Shipping tab, choose the Shipping Service you require in the top pane 
and click the Move Down button to move it to the Supported Shipping 
Services pane.

NOTE: A shipping service which is grayed out is not available because it is in 
a different currency than the currency of the store.

3 If you select a Ship to Fixed Addresses service which has multiple delivery 
addresses that shoppers can choose from, you may want to customize the 
label that shoppers will see for this service. Enter the label you want to 
display in the Fixed Delivery Address Label box. See “Add a ‘Ship to Fixed 
Addresses’ shipping service” on page 73.

4 When shoppers enter the delivery address for an order, they must include 
their name, address, postal code, city and country. You can make it manda-
tory to provide a company name, tax number, e-mail address, or phone 
number as an option. Shipping services may require this information in the 
event of a delivery problem:

 Company Name

 Tax Number

 E-mail Address

 Phone

Related topics: • About Shipping Costs Based on Packaging on page 70

Style Tab Once you have added a store to the Store list, you can start designing the store-
front. You can change the overall look and feel of a storefront at any time, 
however, it is recommended to do this while the store is off-line.
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Prerequisites
Products and other resources such as shipping, taxes, languages, etc. must also 
be set up before you can continue with the following procedures.

Set-up

Style You have four options to set the basic style of the pages.

 Autumna 22: Provides a modern look to storefronts by using flat tints, 
rounded corners, bigger buttons with more padding and larger text, 
minimized shadows, more white space, along with making stores more 
mobile-friendly.

 Show Colored Bars: Displays colored bars at the top and bottom of the 
pages in the primary color.

 Show Custom Background: Activates the Background panel with options 
to work creatively with a background image that’s displayed on all pages.

 Show Swirl: Displays a swirl in the color of your choice on all pages.

NOTE: Some of the parameters listed below may not be available depending on 
the style chosen.

Primary Color Used for top level design elements such as main buttons, link text, boxes

Secondary Color Used for lower level design elements such as the border of the contact box

Swirl Color The color of the swirl image

Logo Puts a logo on the left side of the banner on each page.

NOTE: This logo also appears in e-mails sent to users.

Store FavIcon A favicon is a small image which appears in the address bar, tabs and favorites 
bar of the browser. Special tools are available on the internet to create a favicon 
file (ICO).

Homepage Options Defines the place of the content for the homepage:

 Place content at the bottom

 Hide content

 Place content to the left
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 Place content on top

NOTE: Homepage Options will replace Pages parameter only when the Style 
Autumna 22 is selected.

Pages Makes your storefront responsive to ensure optimum viewing on a variety of 
screen sizes. See “Responsive Design” on page 193. If you do not select this 
option, your storefront website will have a fixed width (960 px) and shoppers 
will have difficulties reading, navigating and ordering products on small 
devices.

NOTE: This parameter is only available for the Style options Show Colored Bars 
and Show Custom Background.

Category and Product

Image Scaling Select the Automated Scaling check-box to enable the hovering behavior option: 
Show zoom effect in category and product rollovers.

Hovering Behavior This option lets you control what happens when a shopper hovers over Product 
Categories and Products:

 Show short description in category and product rollovers: hides the image 
and shows the short description

 Show thumbnails in category and product rollovers: only changes the 
background color to the primary color

 Show zoom effect in category and product rollovers: the thumbnail 
images will cover the entire area of the box. Select the Image Scaling - 
Automated Scaling check-box to enable this option. You need to upload 
thumbnail images which are large enough: 720 px wide x 430 px high.

Title Font You can select a different web font for the categories and products.

Title Font Size You can select a different web font size for the categories and products.

Store

Main Font You can select a different web font for the store.

Button Font You can select a different web font for the buttons.

Body Text Size You can select a different web font size.
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Background

The background of your pages is the bottom most layer where you can use an 
image or color to fill the entire window. The overlay is the layer above the 
background that contains the actual content of the pages. If the page is long, the 
overlay scrolls over the background.

Text Color If you choose a dark overlay color you should set a light color for the text to 
override the default black color for text.

Color Sets the background color of the pages.

Overlay Color Sets the background color for the content section and cart area of the pages.

Overlay Opacity Enter a value lower than 100 to make the overlay area of the page transparent.

Language Bar Opacity Sets the opacity of the language bar in the top right corner. You may want to 
change this if the language bar interferes with your page design. Set to 0% to 
make the bar invisible. See also “Languages Tab” on page 214. (Does not apply 
for responsive storefronts.)

Image The image used as the background for all the pages.

Attach to Lets you control scrolling of the background image on the storefront pages:

 Browser Window: The background image is fixed to the browser window 
and will never scroll.

 Web Page: The background image is fixed to the page content and the 
image and content scrolls up and down.

 Menu Bar: The background image starts from the menu bar and is fixed to 
the page content. The image and content scrolls up and down.

Position Anchors the image in the specified Position: Center, Left, Right, Center, Top, 
Bottom.

Repeat Options to repeat the background image vertically and/or horizontally.
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Figure 7.51:  Autumna 22 style with graphic logo

Figure 7.52:  Colored Bars style with graphic logo
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TIP: When designing your 
storefront, you can see your 
changes by logging onto the 
storefront and refreshing the 
pages (press F5 or click the 
Reload button).

Figure 7.53: Colored bars style with text logo

Figure 7.54: Background image anchored to top; no repeat; overlay opacity 0; transparent 
PNG to hide default system logo
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 Create the look and feel in the Style tab

1 On the menu bar, choose Stores and select the store you want to style.

2 In the Style tab, you start by selecting the basic style from the Style drop-
down list.

TIP: Don’t choose bright or 
light colors for text on the 
storefront because this can 
be difficult to read. 

3 Click the color patches to edit the primary and secondary colors.

The color picker is displayed.

Figure 7.55: Custom Background style; small image repeated horizontally and vertically to 
create background pattern of lines; overlay opacity 50

Figure 7.56: Swirl style with logo; swirl color same as primary color
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4 Select a color with the hue slider (rainbow colors) and make the hue lighter 
or darker by moving the cursor in the mixer pane on the left. Alternatively, 
enter an RGB, HSB or a 6-digit hex value.

The new color is displayed in a patch adjacent to the current color.

5 Click outside the color picker to close the picker and confirm your new color.

6 If applicable, change the Swirl Color image on the storefront.

7 Click Browse to select a logo for display in the banner of the storefront.

The logo is previewed underneath the Browse box. You can delete the logo 
by clicking the Delete button or replace it with another.

8 Click Browse to select a store Favicon.

The favicon image is previewed underneath the Browse box. You can delete 
the favicon icon by clicking the Delete button or you can replace it with 
another.

9 If you selected the Show Custom Background style option, set the colors and 
images for the background of the pages.

10 Click Save to confirm your changes.

Related topics: • Setting up Resources (Advanced Menu) on page 61
• Multilingual Storefronts on page 511

Pages Tab You first create the home page, which is the landing page of the storefront where 
the Product Catalog is displayed. The home page must be created as every store-
front has at least a home page. The six additional pages, legal information and 
boxes are optional. You can also customize the Login dialog and the Footer of the 
order details and e-mails in the respective tabs.

TIP: Including Terms & Conditions and other information on an e-commerce 
website may be a legal requirement in your country.
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 Add/edit pages in the Pages tab

1 On the menu bar, choose Stores and select the store you want to add/edit 
Pages for.

2 In the Pages tab, click Edit in the Homepage tab to create/edit the landing 
page of the website.

For each page you can edit the following features. Some features are 
optional.

Link Name The text displayed as the page link in the storefront menu bar (mandatory)

Title The title for the page content which appears under the banner image; you can 
leave this blank if you need the space at the top of the page for other layout 
elements.

Content The actual content of the page; you have a blog-style HTML WYSIWYG Editor to 
write text, insert tables, and place images on the pages; you can also paste text 
from various sources and switch to HTML mode if you want to use HTML tags. 
See “HTML WYSIWYG Editor” on page 265 for more information.

Boxes Select the check boxes to add the Contact box and/or Link box, which you create 
in the Boxes tab, to the page. See “Create/edit Contact and Link boxes (Boxes 
tab)” on page 232.

Banner Browse to add a static banner image (PNG, JPG, GIF) for the page between the 
navigation bar and the page Link Name. You can use the same banner for all the 
storefront pages or a different one for each page. This image is also used as an 
alternative image for browsers and devices that do not support Flash.

Carousel Banner Browse to add a predefined HTML5 banner as image for the page between the 
navigation bar and the page Link Name. You create these banners in the Banners 
Tab.

Page <title> Enter text to fill the title tag in the head of the HTML code on this page of your 
storefront. For example, entering My Company’s Store, generates the 
following HTML code:

<title>My Company's Store</title>

Page <description> Enter text to fill the description meta tag in the head of the HTML code on this 
page of your storefront. For example, entering Webshop for ordering 
prints, generates the following HTML code:

<meta name="description" content="Webshop for ordering prints" />
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NOTE: Putting information in the head tag of the HTML code is useful for 
search engine optimization (SEO) if your store is public. See“Search Engine 
Optimization (SEO)” on page 33 for more information.

3 Click Save to confirm your changes to the Home page.

The home page is automatically enabled and ready for viewing.

Check the result by clicking the Preview button. If the store is online and 
you’re logged on to the storefront, refresh the pages to see your changes or 
click View. If the store is off-line, the link is a preview. See “Previewing an off-
line storefront” on page 206.

4 Click the Page 1 tab and repeat this procedure to add a second link in the 
navigation bar.

Remember that these optional pages cannot include the Product Catalog. 
They are typically used to display additional information about the store-
front, for example:

 a FAQ page about the ordering and delivery process

 guidelines for shoppers who want to submit their own content

 company news, who to contact, etc.

5 Select the Show page in menu check box at the top of the Page tab to add it 
to the storefront.

6 Repeat this procedure for Page 2 to Page 6 as required.
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 Customize the storefront login page

In the Login tab, you can customize the login screen that visitors see when they 
log on to a storefront. For example, you can add contact details (phone number, 
e-mail link, link to a website, self-registration to help a visitor with the logon 
process.

NOTE: For private stores only.

1 On the menu bar, choose Stores and select the store you want to enable/edit 
the login page for.

2 In the Pages tab, click Edit in the Login tab to enable/edit the Login page of 
the website.

3 Select the Customization check box and write your own text for the login 
screen in the HTML WYSIWYG Editor. You can also add a small image. See 
“HTML WYSIWYG Editor” on page 265 for more information.

4 Click Save to confirm your changes.

Your new content will now appear in the panel on the right of the login screen 
for your storefront.

Figure 7.57: Colored bars style with animated banner and contact box
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NOTE: All the other information in this dialog is generated by the system.

 Customize the storefront login page background

In the Login tab, you can customize the background of the login page that 
visitors see when they log on to a storefront. You can add a background image 
and a logo. 

NOTE: For private stores only.

1 On the menu bar, choose Stores and select the store you want to enable/edit 
the login page for.

2 In the Pages tab, click Edit in the Login tab to enable/edit the Login page of 
the website.

3 Select the Full screen image background check box and upload background 
image and logo using the Choose File buttons. 

4 Click Save to confirm your changes.

A full-screen image background and a logo on the login window of the store 
will now appear.

 Add a Register button to the storefront login page (self-registration)

You can let new store visitors register themselves when they are on the login 
page. The self-registration feature adds a Register button to the login screen, 
and users with an e-mail address of a specified domain are given access without 
intervention of the administrator.
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1 On the menu bar, choose Stores and select the store for which you want to 
enable self-registration.

2 In the Pages tab, click Edit in the Login tab.

3 Select the Self-registration check box and enter the relevant domain name, 
or multiple domain names separated by commas, in the E-mail domains field, 
for example:

mycompany.com,mycompany.fr,mycompany.de

You can enter up to 1024 characters in the box.

NOTE: Do not enter the domains of popular e-mail providers (gmail.com, 
hotmail.com, etc.) as this would give many users access to your storefront.

4 Select the Billable to company check box next to the Billing Address option 
and choose a company for billing the orders from the drop-down list. If you 
do no select this option, the shopper has to specify the billing address when 
checking out.

5 Click Save to confirm your changes.

The login page now displays a Register button so visitors with a valid e-mail 
address of one of the specified domains can register.

A password is sent automatically to their e-mail address upon completion of 
this registration process.
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 Add/edit legal information (Legal tab)

In the Legal tab, you can provide information which may be required from a legal 
point of view. The content is either displayed in the footer on all the storefront 
pages, or under the pricing table.

 In the Pages tab, click Edit in the Legal tab to create/edit the Copyright 
Notice, Terms & Conditions, and Cookies page of the website.

The following can be edited:

 Copyright Notice

 Terms & Conditions Page

 Cookie Acceptance Page

 Custom Pricing Information

 Custom Quote Information

 Place Order Button

 Custom Backorder Information

 Custom Tax Exemption Information

Copyright Notice

TIP: Enter ALT+0169 on a 
Windows computer or 
Option key + g on a 
Macintosh computer to type 
the copyright symbol (©).

Select this check box and enter the copyright notice that you want to display at 
the bottom of all pages (e.g. 2023 © My Company).

Terms & Conditions Page

Select this check box and complete the fields to display a Terms & Conditions 
link on all storefront pages that opens a separate page with your own terms and 

Figure 7.58: A footer on all storefront pages with legal information
StoreFront User’s Guide



 

7 STORES, MICROSTORES AND STOREFRONTS 229
conditions. See “Terms & Conditions” on page 37 for more information about 
what you should mention in your terms and conditions.

Users must acknowledge
the Terms & Conditions at

checkout

Legislation in certain countries may require that a shopper explicitly acknowl-
edges the terms and condition of a storefront when ordering products. Select 
this check box if this is the case for your country and the following text will be 
added under the total amount of the order, before the checkout procedure is 
completed:

 I agree to the Terms & Conditions (where Terms & Conditions is a link to the 
Terms & Conditions page.

Link Name The hyperlink text which is displayed on each page.

Title The title of the page that opens when you click the hyperlink.

Content Use the HTML WYSIWYG Editor to create the content for the Terms & Condition 
page. See “HTML WYSIWYG Editor” on page 265 for more information.

NOTE: Terms & Conditions is a hyperlink to a page while the Copyright Notice 
is simply text.

Cookie Acceptance Page

Select this check box and complete the fields to display a disclaimer about the 
use of cookies. 

Users must acknowledge
the use of Cookies when

visiting the store

Legislation in certain countries may require that a shopper is explicitly informed 
about the use of cookies on a website and that they acknowledge acceptance of 
cookies. Select this check box to display a blocking pop-up window with cookie 
usage notification including two buttons at the bottom that allow the user to 
accept all cookies or only the essential ones.

Link Name The hyperlink text which is displayed at the bottom of each page.

Title The title of the page that opens when you click the hyperlink.

Content Use the HTML WYSIWYG Editor to create the content for the use Cookies Accep-
tance page. See “HTML WYSIWYG Editor” on page 265 for more information.
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Custom Pricing Information

Here you can specify text to be added on the storefront product page to explain 
that prices include or exclude taxes and shipping, or other information. Select 
the check box and specify:

 Pricing Table: Enter custom text that you want to display under the pricing 
table, for example to inform shoppers that tax is included. Leave empty to 
display no text under the pricing table. This text is also displayed under the 
list of items in the shopping cart.

 Product Price: Enter custom text that you want to display under the price in 
the Place Order panel of the product page, and for the Total Price in the 
Product Kit wizard.

NOTE: If you do not select the check box, the standard tax and shipping footer, 
depending on the store configuration, is inserted under each pricing table but 
no default information is displayed under the product price.

Figure 7.59: An Example of Cookie Consent Pop-up Window
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Custom Quote Information

Select the check box and enter information that you want to include in quotes 
that a shopper can create on the storefront. See “Quoting” on page 205.

Place Order Button

Select this check box to enable a customized Place Order button. Otherwise, the 
system default button is displayed. The Place Order button is the last button in 
the checkout flow without integrated payment gateway. When a shopper clicks 
this button, the order is placed and the shopper is bound to pay the amount for 
the order. In some countries you need to follow guidelines to protect consumer 
rights and you may need to customize the Place Order button to comply with 
regulations.

Figure 7.60: Custom pricing information displayed under the price and under the pricing table
StoreFront User’s Guide



232 SETTING UP A STORE
Custom Backorder Information

Enter your text for the backorder information. You can use the variables 
(macros) mentioned under the box in your text.

Custom Tax Exemption Information

Enter text that will appear during checkout in the order details and in the order 
confirmation e-mail.

 Create/edit Contact and Link boxes (Boxes tab)

The Boxes tab is where you create the Contact and Link boxes which can subse-
quently be inserted on your pages.

1 In the Pages tab, click Edit in the Boxes tab to create/edit the Contact Box 
and Link Box.

You can set up the following two boxes:

Contact Box Enter a Title for the box and use the HTML WYSIWYG Editor to create content. 
You will typically insert a mailto link (e.g. mailto:info@MyCompany.com).

Link Box Enter a Title for the box and use the HTML WYSIWYG Editor to create content. 
You can insert one or more internal or external hyperlinks to provide additional 
information, announce special offers, news, etc.

For example, insert the following URL to create a link to a list of previous 
orders (with <storename> being the name of the storefront):

https://<storename>.apogeestorefront.com/storefront/
accountProductList.ep

Or the following code with keywords of your products to link to the search 
results for those keywords:

https://<storename>.apogeestorefront.com/storefront/
search.ep?keyWords=calendar

Figure 7.61: A customized Place Order button
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See “HTML WYSIWYG Editor” on page 265 for more information.

2 Click Save to confirm your changes.

The Contact and Link boxes are displayed under the content of the Home 
page and to the left of the content on the other pages.

NOTE: The boxes must be enabled for each page by selecting the Boxes check 
boxes when setting up the page. See “Pages Tab” on page 222.

 Add a footer to order details (Footer tab)

For order-related e-mails and the Order Details page on the storefront, you can 
add your own content underneath the order details. The footer can be used to 
inform shoppers about invoicing, inquiries about their order, information about 
shipping, etc.

1 In the Pages tab, click Edit in the Footer tab to enable/edit the footer.

2 Choose where you want the footer to appear. You can add the footer to either 
or both of the following locations:

 Enabled in e-mails: adds the footer to order-related e-mails

 Enabled in “Order Details”: adds the footer to the Order Details

3 Enter the content using the HTML WYSIWYG Editor. See “HTML WYSIWYG 
Editor” on page 265 for more information.

4 Click Save to confirm your changes.

Your new content now appears under the order details on the storefront.
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 Edit the Order Reference dialog (Reference tab)

The Order Reference dialog is displayed when a shopper proceeds to checkout. 
You can edit the text of this dialog and the link text that opens the dialog, so it 
better fits your needs. For example, you can specify the type of purchase code the 
shopper must enter before checking out.

1 In the Pages tab, click Edit in the Reference tab to edit the default text of the 
dialog.

TIP: Watch the online 
training video on this topic 
(YouTube).

2 In the Name field, enter the text for the dialog title.

This text is also used for the link text on the Checkout page and the column 
header on the Your Orders page.

3 In the Text field, enter the content using the HTML WYSIWYG Editor. See 
“HTML WYSIWYG Editor” on page 265 for more information.

4 Click Save to confirm your changes.

Your dialog title and text now appear in the order reference dialog on the 
storefront.

Figure 7.62: Footer with your own content under the order details
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The dialog title is also used for the link text on the Checkout page.

NOTE: You only edit the text of the dialog and link text in the Reference tab. 
See “Reference” on page 199 for information about this option and how you 
can force the dialog to appear for all orders.

 Redirect a page to a URL outside STOREFRONT

A page link can also be a link to a URL outside the STOREFRONT system. This is 
done by inserting a hidden script in the page content.

1 Select the page you want to set up with a redirect link.

2 Click Edit and select the Show page in menu check box.

3 Enter a Link Name, e.g. Blog, and optionally a Title.

4 In the Content panel, choose Tools > Source code and paste the following 
code:

Figure 7.63: Order reference dialog with title (1), text (2) and input field for the reference code 
to be entered by the shopper(3)
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<script>// <! [CDATA [

window.location.replace("http://destination.com");

// ]]></script>

5 Click OK and Save your page.

When you click the page link, you briefly see the page with your title before 
being redirected to your URL outside STOREFRONT.

Invoice Tab A PDF invoice consisting of one or more pages, which includes the billing 
address, shipping address, a list of the order items and the total order value, can 
be generated automatically for all orders. The shopper receives an e-mail notifi-
cation when the order is shipped, with a link to the order details page where the 
invoice can be downloaded via a link in the top right corner. The invoice is avail-
able when all the order items have been shipped.

Related topics: • Download all invoices on page 289
• Generate/regenerate an invoice on page 306

Figure 7.64: A page link in the menu bar that redirects to a URL 
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On the Invoice tab you can specify whether you want invoices to be generated or 
not, and whether the default invoice format is to be used or a customized format:

Generate Invoice  Never: No invoices are generated.

 When billable to user: An invoice is only generated if the user actually has 
to pay for the order, not the user’s company.

 Always: An invoice is generated for all orders.

Figure 7.65: A default invoice layout (A4)

1 Header (with rounded corners)
2 Order items table
3 Totals
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PDF Invoice Layout  A4 Size Default Layout: A4 size invoices are generated based on a default 
template that uses your logo and the color scheme you specified for your 
storefront; you can fine-tune some of the default settings .

 Letter Size Default Layout: The same as the previous option but with 
Letter paper size.

 Custom Layout: the pages of the invoice are generated based on your PDF 
Form templates; these PDF Form documents use variables that retrieve 
the necessary information from the system in order to create the invoice.

 Select an option to display the layout settings that you can set for the invoice.

 Click the Invoice Preview button to see a sample invoice.

Text Form Fields Choose a font family for all the text on the invoice. Special fonts are added for 
the languages Japan, Korean, Chinese-Simplified and Chinese-Traditional:

 Japanese fonts: HeiseiMin-W3, HeiseiKakuGo-W5 and KozMinPro-
Regular

 Korean fonts: HYGoThic-Medium, HYSMyeongJo-Medium and HYSMy-
eongJoStd-Medium

 Chinese-Simplified fonts: STSong-Light and STSongStd-Light

 Chinese-Traditional fonts: MHei-Medium, MSung-Light and MSungStd-
Light

Frame Form Fields Switch rounded corners on/off for all table borders; set the border width for the 
header table and order items table.

Date Choose a Short, Medium or Long date format for the invoice date.

Table Layout Format the header, order items table and totals.

PDF Form Templates (Only for Custom Layout) Select PDF Form documents that you want to use as 
templates for your invoice:

 First Page: This template is used for the first page of your invoice. The same 
template is used for continuing pages (e.g. if the list of order items is long) if 
no template has been selected for Additional Pages.

 Additional Pages: This template is used for continuing pages.
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 Last Page: Use if your invoice needs to include additional information, e.g. 
Terms and Conditions

NOTE: Each PDF must be maximum 1 page.

 How to create a Custom PDF Invoice

Custom PDF invoices are based on PDF Forms that you need to create and 
upload to the system. PDF Forms are interactive PDF documents that include 
fields that can be filled with variable data. These fields are filled automatically 
with data which is retrieved from the STOREFRONT system. Sample documents 
can be found in the STOREFRONT Starter Kit which you can download from 
ApogeeNetwork.

 Step 1: Create the invoice layout

Create the layout of your invoice in your favorite design software, e.g. Adobe 
InDesign, with all the static elements such as the company logo, colored panels, 

Figure 7.66: PDF Form with STOREFRONT variables
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etc. The document will typically consist of 3 pages: the first page, the second 
page for all continuing pages (to accommodate long lists of order items), and the 
last page for static text such as the Terms & Conditions. You can use the sample 
documents in the Starter Kit to get started.

 Step 2: Add text fields

Add form text fields for all the variable content that needs to be retrieved from 
the system. In InDesign, choose Window > Interactive > Buttons and Forms. 
Leave the text fields empty but use the STOREFRONT variable codes for the text 
field name. This controls how the content is retrieved: for example, invoice no., 
invoice date, order items etc. See “STOREFRONT Variables for Custom Invoices” 
on page 240 for a list of the variables that you can use.

NOTE: You can also add the form text fields to your layout in Acrobat Pro.

 Step 3: Export individual pages

When you are happy with your invoice layout, export each page of the document 
as individual PDFs. In InDesign, make sure you select Adobe PDF (Interactive) 
as file type to retain the interactive functionality of a PDF Form.

 Step 4: Fine-tune the PDF Form

If any of the variables need to be right-aligned, open your PDFs in Acrobat Pro. 
With the Forms tool open, select the text frame that you want to right-align and 
set the Alignment option in the Options tab to Right. Save your PDFs.

 Step 5: Upload the PDF Forms in StoreCenter

In StoreCenter, go to Stores > Invoice and select Custom Layout. In the PDF 
Form Templates panel, browse to your PDF Form documents to upload them to 
the system.

STOREFRONT Variables for Custom Invoices

The following variables can be used for PDF Form fields.

 Variable name Description  example

Variables on Store level 

ASF_STORE_NAME  Store Name   SunDiver

ASF_STORE_LOGO Store Logo - The logo will be 
scaled proportionally to fit in the 
frame. Note: see further down 
for modifiers 

Page specific variables 
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ASF_PAGENR Page number of the current page 2

ASF_PAGENR_NRPAGES Combination of page number 
and the number of pages in the 
invoice

2-7

General variables on Invoice level 

ASF_INVOICE_TITLE Label Invoice

ASF_INVOICE_NR_TITLE Title of Order ID Invoice 
Number

ASF_INVOICE_NR Invoice ID 00003

ASF_INVOICE_DATE_TITLE Invoice Date

ASF_INVOICE_DATE Date on which the invoice has 
been made.

ASF_CUSTOMER_REFERENCE_TITLE Label Customer 
Ref.

ASF_CUSTOMER_REFERENCE Reference as given by the cus-
tomer

 Variables on Billing Entity

ASF_BILLING_TITLE Label Billing 
Address 

ASF_BILLING_COMPANY_NAME Company Name (if applicable)

ASF_BILLING_ADDRESSLINE1

ASF_BILLING_ADDRESSLINE2

ASF_BILLING_ADDRESSLINES Combines both address lines in 
a single variable to avoid empty 
lines

ASF_BILLING_COUNTRY

ASF_BILLING_CITY

ASF_BILLING_POSTALCODE

ASF_BILLING_COMPANY_VAT_TITLE  Label VAT Number

ASF_BILLING_COMPANY_VAT VAT Number   

ASF_BILING_COMPANY_MIS_ID MIS Id of Company to be billed

ASF_COMPANY_MIS_ID Idem as ASF_BILING_COMPA-
NY_MIS_ID

ASF_BILLING_NAME Name of the person to be billed

ASF_BILLING_NAMES  Company Name, Tax Number 
and Person Name combined 

 

ASF_BILLING_ADDRESS  Address of the person to be 
billed (including address, zip + 
city, country) 

 

ASF_BILLING_NAMES_ADDRESS  Names, Tax Number and Address 
combined  

 

 Variable name Description  example
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ASF_BILLING_NAMES_ADDRESS_METHOD Names, Tax Number, Address 
and Payment Method combined 

ASF_BILLING_COORDINATES  Coordinates of the person to be 
billed (can including phone, e-
mail) 

 

ASF_BILLING_METHOD  Line that describes the billing 
method 

Via PayPal

ASF_BILLING_DATA  All of the above (similar to 
HTML)

 

Variables on Shipment Entity 

ASF_SHIPMENT_TITLE  Label Shipment 
Address 

ASF_SHIPMENT_COMPANY_NAME  Company Name   

ASF_SHIPMENT_ADDRESSLINE1

ASF_SHIPMENT_ADDRESSLINE2

ASF_SHIPMENT_ADDRESSLINES Combines both address lines in 
a single variable to avoid empty 
lines

ASF_SHIPMENT_COUNTRY

ASF_SHIPMENT_CITY

ASF_SHIPMENT_POSTALCODE

ASF_SHIPMENT_NAME  Name of the person used for 
shipment 

 

ASF_SHIPMENT_NAMES  Company Name and Person 
Name combined 

 

ASF_SHIPMENT_ADDRESS  Shipment Address (including 
address, zip + city, country) 

 

ASF_SHIPMENT_NAMES_ADDRESS  Names and Address combined   

ASF_SHIPMENT_NAMES_ADDRESS_METHOD Names, Address and Method

ASF_SHIPMENT_COORDINATES  Coordinates of the person used 
for shipment (can including. 
phone, e-mail) 

 

ASF_SHIPMENT_METHOD Line that describes the shipment 
method

ASF_SHIPMENT_DATA All of the above (similar to 
HTML)

Extra variables on Shipment and Billing level*

ASF_DATA1_TITLE  Label  

ASF_DATA1 ASF_BILLING_DATA or ASF_-
SHIPMENT_DATA or empty 

 

ASF_DATA1_NAMES_ADDRESS  Names and Address   

 Variable name Description  example
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ASF_DATA1_NAMES_ADDRESS_METHOD Names, Address and Method 

ASF_DATA1_METHOD  Method  

ASF_DATA2_TITLE  Label  

 ASF_DATA2  ASF_BILLING_DATA or empty  

 ASF_DATA2_NAMES_ADDRESS  Names and Address   

 ASF_DATA2_NAMES_ADDRESS_METHOD  Names, Address and Method   

 ASF_DATA2_METHOD  Method  

ASF_SHIPMENT_COMPANY_VAT_TITLE Label

ASF_SHIPMENT_COMPANY_VAT Tax value Delivery Address

Variables on Order level 

ASF_ORDER_NR Order ID 256897

ASF_ORDER_NR_TITLE Order title ID 256897

ASF_ORDER_STATUS_TITLE  Label Order Status

ASF_ORDER_STATUS  Status of the order Shipped

ASF_ORDER_USER_NAME_TITLE  Label Ordered by

ASF_ORDER_USER_NAME  Name of the person that submit-
ted the order 

 

ASF_ORDER_USER_EMAIL_TITLE  Label E-mail 
Address

ASF_ORDER_USER_EMAIL  E-mail of the person that sub-
mitted the order 

 

ASF_ORDER_USER_PHONE_TITLE  Label Phone

ASF_ORDER_USER_PHONE Phone number of the person 
that submitted the order

 

ASF_ORDER_USER_FAX_TITLE Label Fax

ASF_ORDER_USER_FAX Fax number of the person that 
submitted the order

 

ASF_ORDER_USER_MIS_ID MIS ID of the user  

ASF_ USER_MIS_ID Idem as ASF_ORDER_US-
ER_MIS_ID

 

ASF_ORDER_DATE_TITLE Label Ordered on

 Variable name Description  example
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* If both Shipment and Billing data are available for the invoice, they each can 
be put in a separate entry (in our standard template, the Shipment Data are 
typically put on the left side whereas the Billing Data are put on the right side). 
If, for some reason, the Shipment Data are not available (because no shipment 
has been specified), one might want to put the BillingData in the box of the 
Shipment Data and leave the box that was normally used for the Billing Data 
blank. This functionality can be realized by using the ASF_DATA1 and 
ASF_DATA2 variables. ASF_DATA1 will refer to the Shipment Data if they are 
available, otherwise it will refer to the Billing Data. ASF_DATA2 will refer to the 
Billing Data (if the Shipment Data are available), otherwise they will be blank.

** The ASF_ORDER_ITEMS frames will be used for outputting the invoice lines. 
How this will be done exactly, can be parameterized by a number of extra 
formatting parameters (to be completed). These include:

 Setting to generate Order Header: can be switched off. In this case, the 
invoice template designer can choose to put this information in other frames 
(see ASF_ORDER_... fields)

 Enable/disable columns and indicate spacing (in percentages)

 Use frames (boxes) for Order Items

 Use frames (boxing) for Order Totals

 Font family/point size to be used... 

Text field modifiers that can be used in a custom invoice 

All text form fields take over the properties as defined in the PDF forms (such as 
color, point size, multi-line, alignment etc.). The font selection, however, are 
overruled by STOREFRONT. In StoreCenter, it is possible to choose a font family. 
By default, the font to be used is the normal or regular font of the font family. To 

ASF_ORDER_DATE Date on which the order has 
been submitted

 

Variable for Invoice Lines**

ASF_ORDER_ITEMS  Frame that contains the Order 
Header (if configured in Store-
Center) and the Order Lines. 
Note: there can only be one 
such field per page (if there are 
more, the first container encoun-
tered will be used

 

 Variable name Description  example
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use the bold, bold-italic or italic font, you need to apply a modifier to the variable 
name. Here are a few examples:

 ASF_SHIPMENT_METHOD:BOLD

 ASF_SHIPMENT_METHOD:ITALIC

 ASF_SHIPMENT_METHOD:BOLDITALIC

If you do not want to use the fonts specified by the font family, you can revert to 
 the original font by using the “ORIGINAL” modifier. Example:

ASF_SHIPMENT_METHOD:ORIGINAL 

Date field modifiers that can be used in a custom invoice

The variables denoting dates (such as ASF_ORDER_DATE and ASF_INVOICE_-
DATE) can have special modifiers:

Image field modifiers that can be used in a custom invoice

Currently only applicable for ASF_STORE_LOGO

Images are always scaled so that either the width or the height takes the full 
available space. In addition to this rule, the image will be further aligned 
according to the following modifiers: 

Use one of TOP/MIDV/BOTTOM only;  use one of LEFT/MIDH/RIGHT only. 
Example: ASF_STORE_LOGO:MIDH:MIDV will center the image.

Modifier Description Example

+[integer]  Indicates an offset in days that will be added to 
the date. Used to calculate a date on which the 
invoice must be paid 

 ASF_INVOICE_DATE:+60

SHORT Short date formatting   

MEDIUM Medium date formatting   

LONG Long date formatting   

Modifier Description Example

TOP Align image to the top. This is the default setting.

MIDV Center the image vertically   

BOTTOM Align the image to the top   

LEFT Align the image to the left. This is the default setting.  

MIDH Center the image horizontally   

RIGHT Align image to the right   
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Frame fields and frame field modifiers that can be used in a custom invoice

It is possible to draw rectangles around frames with the same formatting as 
specified in StoreCenter. 

The following modifiers are available:

 

Examples:

ASF_FRAME:THICK:ROUNDED:COLOR

ASF_FRAME:ROUNDED 

Variable Description Remark

ASF_FRAME   

ASF_BILLING_FRAME  Similar as ASF_-
FRAME 

Will only be shown if there is billing infor-
mation

ASF_SHIPMENT_FRAME  Similar as ASF_-
FRAME 

Will only be shown if there is shipping 
information 

ASF_DATA1_FRAME  Similar as ASF_-
FRAME 

Will only be shown if there is DATA1 infor-
mation (see higher for the meaning of 
DATA1

ASF_DATA2_FRAME  Similar as ASF_-
FRAME 

Will only be shown if there is DATA2 infor-
mation (see higher for the meaning of 
DATA2) 

Modifier Description Example

ROUNDED Use rounded corners   

RECTANGULAR Use rectangular corners    

THICK Use the thick lines (thickness specified in StoreCenter 
variable) 

 

THIN Use thin lines   

COLOR Use the primary color instead of black   

BLACK Use black for the frame   
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Special fields that can be used in a custom invoice

NOTE: The date and page numbering variables are not supported in the 
ASF_MACRO fields.

Field Description Remark

ASF_VALUE[a-zA-Z0-9]  Displays the default value in 
the PDF template (that is: the 
value is not replaced!)

 The font that is used before is 
determined as with the other 
form fields (if text modifiers are 
used, it is possible to change the 
font). 

ASF_CUSTOM[0-9]_TITLE  Custom field title, e.g. ASF_-
CUSTOM2_TITLE 

 Not yet supported server-side 

ASF_CUSTOM[0-9]   Custom field, e.g. ASF_CUS-
TOM2 

 Not yet supported server-side 

ASF_MACRO[a-zA-Z0-9]   Similar to ASF_VALUE* above, 
but the default value can con-
tain variables that will be 
expanded. The variables must 
be enclosed by # characters.

Examples: “#ASF_-
BILLING_NAMES#” or “#ASF_-
BILLING_ADDRESS#” 

Table 7.2 Form text field with ASF_MACRO combining ASF_BILLING_NAMES and 
ASF_BILLING_ADDRESS
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Custom Footer Tab The Custom Footer is inserted at the bottom of every page on the storefront. This 
is the ideal location to put content such as:

 a list of supported payment options

 information about shipping and shipping costs

 link to a sign-up form for a newsletter

 the company tag line or other commercial messages

 contact information and the company address

 copyright notice and the Terms & Conditions link

 links to other pages of the storefront (e.g. product pages) or external links

 code snippets for various widgets: page tracking and analytics, chat service, 
etc.

NOTE: Enabling the custom footer replaces the Copyright Notice, the link to the 
Terms & Conditions Page, and the Cookie Acceptance page which are explained 
in “Add/edit legal information (Legal tab)” on page 228. It is recommended that 
you provide this information in the custom footer.

Figure 7.67: Custom footer on a storefront page
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 Create/edit the custom footer

The custom footer is a table with one row by default but you can add extra rows 
if necessary. A table is used to control the layout.

If you choose to make your storefront responsive (see “Responsive Design” on 
page 193)and you have a lot of content in the custom footer, it is recommended 
to put the content in table cells so they reflow more gracefully under each other 
on a small screen.

1 On the menu bar, choose Stores and select a store, and click the Custom 
Footer tab.

2 Select the Enable Custom Footer check box.

NOTE: This check box is not selected by default and the system generates the 
standard footer with a Copyright Notice, the Terms & Conditions link, and 
the Cookies Acceptance page if they have been set. 

You can now enable a background color and/or a background image for the 
footer area.

3 In the content box, click the Edit button to enter and format the text you want 
to display in the footer area using the HTML WYSIWYG Editor. See “HTML 
WYSIWYG Editor” on page 265 for more information.

This is in the first row of your footer table. If you do not create extra cells in 
this row, there is no need to set a Minimum Cell Width but the width must be 
wide enough to accommodate the text or image.

4 To create extra cells in the first row, click the Add button and choose To this 
Row. Enter your content and set the Minimum Cell Width.

5 To create a second row, click the Add button and choose To new Row.

The text appears on top of the background color or image. The number of 
lines in a cell determines the height of its row. You can type empty lines to 
move the text content up or down.
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6 It is recommended to include a link to your Terms & Conditions and/or 
cookies disclaimer page: click the Insert Link button in the editor. If you 
created the Terms & Conditions page in the Pages >Legal tab, click the 
STOREFRONT Links button to create a link to that page. You can also specify a 
URL to link to such a page on your website.

7 Click Save to confirm your changes.

Your new footer is applied at the bottom of all the pages of the storefront.

Promotions Tab NOTE: This feature may not be included in your license pack.

A promotion (promo code) entitles a user to a discount on one or more orders. 
The shopper enters the code at check-out and the discount is applied to the sub-
total of the order items. You can create a promotion with a single promo code or 
with multiple promo codes.

 Single Code: allows several shoppers to use the same code to obtain a 
discount, e.g. enter 'DEAL2016' at check-out to get 5% off. 

 Multiple Codes: a batch of promo codes is generated so shoppers can be 
given a dedicated discount code, e.g. 900 codes for a personalized e-mail 
campaign.

 Set up and export promotion codes

1 On the menu bar, choose Stores and select a store, and open the Promotions 
tab to see the list of promotions which is initially empty.

2 Click the Add button to add a new promotion to the list.

3 In the Create Promotion dialog, enter the Name and Description of the 
promotion.

4 Choose a promotion type:

 Promotion on all Products

 Promotion on single Product: Click the Edit button to choose the product 
you want to promote.

 Promotion on all Shipping Services

 Promotion on single Shipping Service: Select the shipping service you 
want to promote on the drop-down list.
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5 Enter a value for a Fixed discount or a Percentage discount which is the 
result of the promotion.

6 In the Usage Limit section, you can specify the maximum number of times 
and/or a period during which the code can be used:

 Usage Limit: minimum 1

 From-To: The default From date is the creation date which is set automat-
ically. The To date is not mandatory and can be left blank if you do not 
want to limit the duration of the promotion.

7 In the Promo Code panel, you have two options:

 Single Code: select this button and enter the Code that you want to use for 
this promotion. You may want to set the Usage Limit at least to the 
number of shoppers expected to use the code.

 Multiple Codes: select this button and enter an optional Code Prefix (e.g. 
DEAL-APRIL – max. 32 characters) and the Number of Codes (e.g. 250 – 
max 999). This example will generate 250 unique codes: DEAL-
APRIL02VNpp, DEAL-APRIL0hOBig, DEAL-APRIL0jtjsi, DEAL-
APRIL0Rd1fP, DEAL-APRIL0YqpSd, etc. You may want to set the Usage 
Limit to “1”.

8 Click Save.

The new promotion is added to the list. 
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9 Select the promotion in the list to display the single code or the multiple 
codes in the Promo Codes panel.

10 Click the Export button to export the codes in an Excel file. This is useful for 
importing the codes into an another application, e.g. e-mail campaign 
software.

The promo code is now enabled on the storefront and shoppers can provide 
their promo code in the Review step at checkout.

The promo code button is displayed on the storefront as long as a store has a 
valid promotion.

In the promotions list you can see how often a particular code has been used.

Figure 7.68: Promo code button enabled on a storefront
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Usage of the codes is also reported in the order summary report (see “Order 
Monitoring on the Dashboard” on page 286).

NOTE: This kind of information is cached on the STOREFRONT server and is not 
updated immediately for shoppers to see. See “Caching” on page 196.

Taxes Tab The Taxes tab lists the VAT and other types of sales taxes applicable around the 
world. Different VAT and tax rates may apply, depending on your location.

 On the menu bar, choose Stores and select a store, and click the Taxes tab to 
see the list of taxes per locale.

In the Name column you can see the locales for which tax rates are provided 
and the different tax rates. For example, for European countries you have the 
following rates: None, parking rate, reduced rates, standard rates, super 
reduced rates, etc.

The Percentage column lists the tax rate and whether it is included or not 
included in the price displayed on the storefront.

The relevant tax and tax rates are applied automatically, depending on the 
type of product:

 For products that need to be shipped (printed and non-printed products): 
the tax rate is applied of the country specified in the shipping service 
selected by the shopper

 For digital products and print products ordered as PDF: the tax rate of the 
country in the billing address is applied

CAUTION: If a tax-exclusive rate applies in a country, the prices will always be 
displayed without taxes, even if a tax-inclusive price list is selected for the 
store.

Related topics: • Payment Methods and Tax on page 81
• Creating Products on page 157
• Use TaxCloud for US sales tax calculation on page 201
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Meta Tags Tab In this tab you can specify content to be inserted in the meta name element. 
These elements are added to the head element on all your storefront pages. The 
following are a few examples:

 to define you as the author of the site:

<meta name="author" content="John Doe" />

 to define your company as the copyright holder of the site:

<meta name="copyright" content="My Company" />

 to claim ownership of a public storefront so that it can be analyzed using 
Google Webmaster Tools. Similar tags exist for Bing or Yahoo:

<meta name="google-site-verification" content="my IDcode" />

The ID code is the content code generated by Google Webmaster Tools.

 to prevent the pages of a public storefront being indexed by search engines – 
by default for private stores:

<meta name="robots" content="noindex,nofollow" />

CAUTION: The STOREFRONT system automatically creates a sitemap for public 
stores. The sitemap allows search engines to crawl your public storefronts 
and index them for searching. If you do not want your storefront to appear in 
the search results of search engines, don’t forget to set up the robots meta 
tag as described here. See “Search Engine Optimization (SEO)” on page 33 
for more information on search engines.

 to insert one of the geotags that can be used to associate a storefront with a 
certain location:

<meta name="geo.placename" content="my city" />

Meta tags are particularly important for public stores. See also “Search Engine 
Optimization (SEO)” on page 33.

1 Enter a string in the Name field to define the meta element type.

2 Enter a string in the Content field.

3 Click Save.

The element or elements are added to your pages.
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Banners Tab In this tab you create one or more banners that can subsequently be used on the 
pages of the storefront. This feature allows you to create attractive carousel 
banners with images that a shopper can click to go directly to a product page or 
a category page, or to an external URL. 

 Create/edit a banner

1 On the menu bar, choose Stores and select a store, and click the Banners tab.

2 Click the Create button to open the banner settings.

Name This is the name that is displayed in the Carousel Banner drop-down list when 
editing pages. See “Pages Tab” on page 222.

Transition Effect Select a transition effect:

Figure 7.69: Carousel banner of 4 transitioning images with list on the right
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Fading: images fade into each other (combine with longer transition duration)

Sliding: images slide from right to left

Transition and Interval
Duration

Enter a duration for the transition effect between multiple images and the time 
that each image remains visible during the cycle.

List Select this option to create a list of image thumbnails on the right or left of the 
main image; the shopper can click the thumbnails to see the image in the 
carousel.

Images If the banner images have different widths, the images which are narrower are 
centered vertically.

Banner Height The banner is displayed between the navigation bar and the rest of the page 
content; set the height of the banner here.

Text Enter text that you want to display under the image carousel.

Banner Images Click the Add button to open the Banner Images dialog:

NOTE: You can only add the images after saving the banner.

 Text: the text that appears under each image, in the thumbnail list and the 
carousel

 Image: browse to select an image that you want to include in your banner

 Click-through link: creates a hot spot on the image in the carousel with a 
link to a STOREFRONT page or an external URL.

Repeat for as many images that you want to insert in your carousel cycle.
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Microstores

A microstore is derived from an existing store, referred to as the main store, and 
inherits many of the latter’s settings. Microstores provide a convenient way to 
quickly create new stores, for example, to target specific audiences with a combi-
nation of shared and dedicated products. Microstores are also a useful 
mechanism for re-using the products of an existing store for several customers 
and each with their own branding.

Example 1: Microstores for the same customer

A major financial services company has a main storefront where head-office staff 
can order publications related to all the activities and services of the company. 
The company has a separate division for banking and another for insurances. 
Microstores can be set up easily with only the publications for the respective 
divisions. So while these microstores use all the settings and styling of the main 
store, staff in each division can only purchase specific publications from their 
microstore.

Example 2: Microstores for different customers

A print service provider has created a store with a wide range of stationery 
products for Company A. Other customers are also interested in a store for 
distributing stationery to their staff. In this case, the print service provider can 
easily create microstores for Company B and Company C with each company’s 
branding, and re-use typical stationery products across these microstores.

Figure 7.70: Microstores example 1: The storefronts of the main store and microstores have 
similar styling but offer different sets of publications to order.
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The following settings are inherited from the main store and can be fine-tuned 
for the microstore. The tabs are visible when editing the microstore:

 General Tab: only a few settings can be changed: price list, URL, e-mail, 
Approval setting; most are disabled: public/private store; payment method, 
etc.

 Product Catalog Tab

 Style Tab

 Pages Tab

 Invoice Tab

 Custom Footer Tab

 Promotions Tab

 Taxes Tab

 Banners Tab

 Shipping Tab

Figure 7.71: Microstores example 2: The storefronts of the main store and microstores have 
different styling to reflect the branding of different customers but offer similar 
publications to order.
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The following settings are inherited from the main store but cannot be changed 
for the microstore. The tabs are not visible when editing the microstore:

 Languages tab

 Meta Tags Tab

The following settings are not inherited:

 Users: You must create new users for your microstore from scratch. Users 
cannot be duplicated across stores.

Prerequisites
The main store from which you create your microstore and the company for the 
new microstore must already exist.

 Create a microstore

1 On the menu bar, choose Stores.

2 In the list, select a store in the list that is to serve as the main store.

3 Click the Create button and then Microstore.

4 In the General tab, choose the Company for which the microstore will be 
used. This can be a different Company than the Company set for the main 
store.

NOTE: It is recommended that the default language of the parent store 
company and the microstore company are the same. Otherwise, translation 
issues may occur.

5 Complete the other editable fields in the General tab. Some fields are inher-
ited from the main store while others are unique for the microstore.

The microstore has its own Name, Site ID (for a unique URL), e-mail.

NOTE: You can choose a different Price List as long as it uses the same 
currency as the main store. This prevents issues when choosing shipping 
services, which are currency-specific.

6 Click the Create button to add your microstore to the list of stores.
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The microstore is indented under the main store in the list.

Now you can continue to set up the microstore.

7 In the Product Catalog tab you initially see the categories which have been 
inherited from the main store. They are indicated with the Share icon.

You can disable/enable these categories and rearrange them as desired for 
the microstore. The shared categories inherit the products as used in the 
main store.

CAUTION: Products added or deleted in the main store categories are 
subsequently also added or deleted in the microstore categories.

You can also add new categories. In the example below, you see 4 shared 
categories of which 1 is enabled, and 4 new categories which have been 
created and enabled specifically for the microstore.

8 In the Style, Pages, Invoice or Custom Footer tabs, click the Edit 
Microstore button to change the settings for the microstore. The initial 
settings are inherited from the main store.

You can always revert to the values of the main store by clicking the Revert 
to Main Store button, but this buttons also resets the values in other tabs.
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CAUTION: Revert to Main Store resets the Style, all the Pages tabs, Invoice 
and Custom Footer tabs to the settings of the main store. Undo is not 
available.

9 Click Save to confirm your changes.

The microstore is grayed out in the list because its storefront is still off-line. 
See “Setting up a Store” on page 195 for more information about the settings 
in general, putting the microstore storefront online, deleting a microstore, 
etc.
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Access Labels

NOTE: This feature may not be included in your license pack.

TIP: Watch the online 
training video on this topic 
(YouTube).

By default, all the products in your store are available to all its users. You can 
control access to individual products and/or product categories at the user’s level 
by applying access labels.

Only users who have been assigned matching access labels can see these 
products and/or product categories on the storefront and order them. For 
example, in a large organization, you may want to filter your products by dealer 
location (north, south, east, west), by distribution channel (dealer, distributor, 
chain store), or by language if you have products in different languages.

Figure 7.72: Users can see products/product categories if they have matching access labels.
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You can create up to 512 access labels per company. This means you can create 
stores in which each individual user sees a different range of products.

Access labels are listed alphabetically when you assign them to products or 
product categories. To manage a long list of labels, you can use prefixes in the 
name, e.g. Sales_User1, Sales_User2, Marketing_User3, Marketing_User4, etc. 
This makes it easier to quickly find a specific access label.

 Setting up access labels

Access labels need to be defined and applied at various levels.

1 Define a set of access labels for a company: see “Create a Company” on 
page 46.

You can specify a different set of access labels for each company.

2 Apply the access labels you created in step 1 to the Product Categories of the 
store: see “Assign Access Labels to Product Categories” on page 212.

AND/OR

3 Apply the access labels you created in step 1 to individual Products: see 
“Creating Products” on page 157.

4 Assign the access labels to the Users to control which products or product 
categories they can see on the storefront: see “Create a new user” on 
page 276.

Products and Users with access labels are indicated in their respective lists by the 
following icon:

Figure 7.73: Shoppers can only see a product or product category on the storefront if their 
user profile has matching access labels. Product category labels override 
product labels.
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Hover over the icon to see which access labels have been assigned to the product 
or user.

You can check that a user actually has access to the correct products with the 
Impersonate feature. See “Impersonate a user” on page 282.
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HTML WYSIWYG Editor

The HTML WYSIWYG Editor is used to format the content of your storefront 
pages, product descriptions and other content.

 Choose Stores >Pages and click the Edit button at the top of any of the 
individual Pages tabs to open the Editor.

OR

To edit the description of a product, choose Products > Edit Description.

The HTML WYSIWYG Editor is used at various other locations in StoreCenter to 
format text.

TIP: Consult a HTML 
reference guide for more 
information about the 
general HTML settings.

Many of the commands are similar to those used in popular word processors, but 
remember that you are creating HTML pages and certain limitations apply. The 
Editor hides the HTML code in the normal view, however, more advanced users 
can switch to the HTML mode to edit the code.

Commands are chosen from the menus on the menu bar. Some commands can 
also be applied by clicking tool icons on the toolbar. An overview of the main 
commands is given in the next section.

NOTE: The formatting you see in the HTML WYSIWYG Editor does not always 
correspond with the actual formatting of the storefront page. You must preview 
your pages on the storefront to be sure the expected results are obtained.

View Options  With the editor open, choose View to select the optimum editing 
environment:

 Show blocks: displays dotted lines around the HTML blocks (p, h1, h2, ol, 
ul, etc.)

 Visual aids: displays cues to indicate certain HTML elements (e.g. when 
you add an anchor)

 Preview: an impression of what the page will look like on your storefront

 Full Screen: opens the editor outside the Edit Page dialog; choose this 
option again to return to the Edit Page dialog and save your page
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1 Menu bar
2 Toolbar
3 Page content with Show Blocks selected
4 Status bar with tag path

Figure 7.74: HTML WYSIWYG Editor overview
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Styles It is recommended to use styles to format your pages as they add standard HTML 
tags to your content for font color, size and other properties.

 Position the cursor in a paragraph (no need to select text) and choose 
Format > Formats on the menu bar. The following styles are available:

 Choose Tools > Source Code to see the HTML code.

TIP: Choose Format > Clear 
Formatting if you want to 
reformat selected text from 
scratch after applying styles 
or adding your own HTML 
code. This may be necessary 
if the formatting on the 
actual web page is not what 
you expected.

In Source Code mode you can add your own formatting to the HTML code of 
the page.

Style HTML tag Effect

Headers Heading 1-6 h1 - h6 Creates standard HTML heading styles

Inline The same in-line styles you see on the For-
mat menu

Blocks Paragraph p Applies/re-applies the <p> tag

Blockquote blockquote Indents and centers the paragraph

Div div Encloses the paragraph between an open an 
closed <div> tag. You can apply separate 
styling to this div.

Pre pre Applies Courier font and keeps text on a sin-
gle line

Alignment Left, Center, 
Right, Justify

The same paragraph alignments styles you 
see in the toolbar

Store Black
Primary Color
Secondary Color

span with 
class for 
the colors

Applies the pre-defined colors of your store 
to the selected text (in-line formatting).

Figure 7.75: The source code of a blockquote with store colors applied in-line
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Paragraph 
Formatting

 Position the cursor in a paragraph and click one of the formatting tools to 
apply the following formatting to the entire paragraph (no need to select 
text):

 left, center, right alignment and justified alignment

 bullet lists and numbered lists

Inline Formatting  Select the text you want to format, and choose Format on the menu bar to 
apply in-line formatting to the selected text. Bold and italic can also be 
applied from the toolbar. The following in-line styles are available:

 bold, italic, underline, strikethrough, superscript, subscript

 To remove in-line formatting, choose Format > Clear formatting.

Cut, Copy and 
Paste

You can use the standard commands and keyboard shortcuts, CTRL+X (cut), 
CTRL+C (copy) and CTRL+V (paste), to cut, copy and paste text within the 
HTML WYSIWYG Editor. These commands can also be found on the Edit menu.

Choose Edit >  Paste as Text, when pasting from another application and you 
want to be sure all the formatting is cleared.

NOTE: Selecting Paste as Text turns on this mode until you choose Edit >  Paste 
as Text again.

Hide content on 
small screens

If you have set up a responsive storefront, you may want to hide certain page 
content all together on small screens. To do this, switch to Source Code view and 
apply class=”hidden-xs” to the content you want to hide.

All content with this class is hidden on small screens.

Figure 7.76: The hidden-xs class applied to hide content
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Insert/Modify a 
Table

1 Position the cursor where you want to insert a table.

2 Choose Table > Insert Table, and select the number of rows and columns by 
dragging your cursor across the grid.

The table is inserted; you can drag the handles to increase the height and 
width of the table.

The Insert/Modify Table dialog is displayed where you can define General 
and Advanced Properties. Many of these are general HTML settings.

TIP: Consult a HTML 
reference guide for more 
information on HTML tables.

3 Choose Table > Table Properties to display the Table properties dialog 
where you can set overall table properties such as cell spacing, padding, etc.

On the Table menu, you have extensive controls to add/delete rows and 
columns, merge cells, etc.

4 Click in each cell to enter the data.

5 Click Save to confirm your changes.

Preview your storefront page and open the HTML WYSIWYG Editor again to 
modify the table as required.

6 To modify the table, position the cursor in the table, choose Table > Table 
Properties, and fine-tune the table settings.

Links and 
Hyperlinks

You can link to products, categories and other storefront pages, or create hyper-
links to external websites.

 Insert/Edit a link

1 Select the text you want to assign a link to and click the Link tool or choose 
Insert > Insert Link.

The Insert Link dialog is displayed:

STOREFRONT Links Choose a product page, a category page or one of your storefront pages that you 
want to link to. The page URL appears in the Link URL field.

URL Enter a website URL with the https:// prefix, e.g. https://
www.mywebsite.com.

Text to display The highlighted link text.

Target Choose whether the target page must open in the same browser window or a 
new window.
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2 Click OK.

The link text is displayed in the secondary color and underlined.

3 Click Save.

NOTE: To remove a link, select and delete the link text.

Anchors If you have long pages, an anchor can be used to insert a link to a specified 
location on the same page or on a different page.

 Insert/Edit an anchor

1 Select the text that you want to link to.

2 Choose Insert > Anchor.

The Anchor dialog is displayed.

3 Enter an anchor name, e.g. my_anchor.

4 Click OK.

An anchor is inserted on the page and you can now create a link to this anchor 
from another location on the page or from a different page. 

5 Select the text you want to assign a link to and click the Link tool.

The Insert Link dialog is displayed.

6 For links on the same page, enter the anchor name preceded by the hash (#) 
symbol, for example #my_anchor, in the Link URL field.

OR

For links to an anchor on a different page, select the page in the Link List field 
and append the anchor name preceded by the hash (#) symbol to the end of 
the URL in the Link URL field.

7 Click Save.

Insert/Upload 
Images

Inserting images is a two-step procedure that consist of uploading new images 
to the STOREFRONT server and then inserting the images on the pages as 
required.
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 Insert an image

1 Position the cursor where you want to insert the image and click the Insert/
Edit Image tool.

The Insert/Edit Image dialog is displayed.

2 Click in the Image List drop-down list and choose the image you want to 
insert.

NOTE: The list is empty if no images have been uploaded.

OR, if the Image List is empty

Click the browse button next to the Source field and upload an image to the 
STOREFRONT server. Repeat this step for as many images as you want to add 
to the list. The uploaded images are now included in the Image List.

3 Select the image you want to use from the drop-down list.

4 Enter a description of the image; this description is displayed if the image 
fails to load on the page (alt attribute).

5 Specify the dimensions for displaying the image in your document, and 
whether you want to constrain the proportions. The native dimensions of the 
image are entered by default.

6 Click OK.

7 Click Save.

Insert Video

 Insert/edit a video

1 Position the cursor where you want to insert the video and choose 
Insert > Insert Video.

2 Paste the code that points to a video, for example a video hosted on YouTube.

3 Click Save and view your page to check that the video plays as expected.

4 To edit an existing link to a video, highlight the video in your document and 
choose Insert > Insert Video.
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Special Symbols The HTML WYSIWYG Editor includes a powerful feature for inserting special 
characters and symbols.

 Insert custom characters

1 Position the cursor where you want to insert the custom character and choose 
Insert > Special Character.

The Special Character table is displayed.

2 Click the character you require to insert it in your text.
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3 Close the dialog.

HTML Mode Choose Tools > Source Code to switch to HTML mode to view and edit the 
HTML code of your pages. You may want to:

 paste content in HTML from another editor

 add complex content such as special tables

 enhance the styling of the page you created initially in the HTML WYSIWYG 
Editor

To avoid unpredictable results, only work in this mode if you understand HTML.

NOTE: When you switch back to the WYSIWYG view, unsupported code and 
syntax errors are replaced by supported code or deleted.

Figure 7.77: Example: Image with default left alignment and padding-right: 5px 
added to style in the HTML code; 
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CHAPTER
8 Users

The visitors of your storefront are referred to as users.

 Create Users ......................................................................................................276
 Managing Users ...............................................................................................278

For private stores, you must set up users and provide logon details so they can 
access the storefront. Alternatively, you can activate self-registration on the 
login page so new users can initiate their own user account.

If your store is public, visitors of the storefront will need to create their own 
account when they proceed to the checkout. They appear automatically in 
STOREFRONT as users.

NOTE: Administrators cannot log on to their storefronts with their administrator 
credentials. They need to create their own user account for each store or 
impersonate another user (see “Impersonate a user” on page 282).

Figure 8.78: Users panel with users per store and toolbar
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Create Users Prerequisites
Users are assigned to stores so you must have at least one store set up before you 
can create a user.

 Create a new user

1 On the menu bar, choose Users.

2 Click the Add button.

3 In the top panel of the Profile tab, select the Store or Microstore you want to 
assign a user to.

NOTE: If you want to give a person access to several stores, you need to create 
a user instance for each store.

4 Choose a Language in the drop-down list, preferably a language that is 
supported by the store.

5 In the Title drop-down list, choose a title for the formal salutation. The 
options depend on the language you just selected for this user.

For example, if you chose English as language, the following title options are 
displayed:

 Mr.

 Ms.

 Ms./Mr.: if you do not know the gender of the person

For example, if you chose German as language, the following title options are 
displayed:

 Frau Dr.

 Herr Dr.

 Frau/Herr: if you do not know the gender of the person

 Frau

 Herr
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NOTE: The title is only displayed in e-mails if you selected the formal 
salutation style for the Company.

NOTE: For German, the title is also shown on the storefront when formal is 
enabled.

6 Enter the user’s name and other personal details:

 E-mail: Enter a valid e-mail address for sending notifications; if you want 
to use a fake or dummy e-mail address for testing purposes, use the 
example.com domain (e.g. fakeuser@example.com) to avoid e-mail 
bouncing and error logs on the StoreCenter server.

 MIS ID: If applicable, enter the ID of a Management Information System 
(MIS) to ensure the MIS system correctly associates the user reported by 
STOREFRONT with the matching user account in its own database. You can 
also use this field to enter an employee number or another identification 
code. Otherwise, leave this field empty.

7 Select the Quoting check box if you want to allow the user to generate quotes 
in the store if the Quoting feature is not selected for the store. See “Quoting” 
on page 205.

8 Select the Tax Exemption check box if a user is exempt from paying sales tax 
(e.g. users ordering for charities).

9 You can choose one of the following Billable To options:

 User: Orders will be billed to the user and you must complete the user’s 
details in the Billing Address panel.

 Company: Orders will be billed to the company and the company’s details 
are displayed in the Billing Address panel; the shopper does not have to 
pay at checkout.

10 Click Save.

NOTE: The user profile may also include custom fields. See “Custom 
Attributes” on page 106.
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11 The new user is added to the list which mentions the e-mail address, the 
Creation date and the Last login date. The Last login date is useful for filtering 
the list of users: see “Filter users” on page 279.

A welcome e-mail with logon information is sent to the user in the preferred 
language, inviting the user to log on to the storefront where he can set a 
password of his choice. You can specify the sender e-mail address in the 
Production Settings (see “Production Center” on page 92).

12 You can set access labels for this user in the Access Labels tab.

See “Access Labels” on page 262 for more information about using access 
labels to control who can see which products on the storefront.

13 You can set approval rights for this user in the Approval tab.

See “Approval Groups” on page 54 for more information about controlling 
who can approve orders.

14 Click Save.

Managing Users

 Disable a user

You can decline a user’s access to a storefront temporarily by disabling him or 
her.

1 On the menu bar, choose Users.

TIP: You can use CTRL-select 
and SHIFT-select to select 
multiple users and disable/
enable them.

2 Select the user you want to disable.

3 Click the Enable/Disable button.

The user remains in the list but he no longer has access to the storefront. The 
user can be re-activated using the same button.

 Delete a user account

You can delete a user permanently.

1 On the menu bar, choose Users.
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TIP: You can use CTRL-select 
and SHIFT-select to select 
multiple users and delete 
them.

2 Select the user you want to delete.

3 Click the Delete button.

The user is removed from the list and no longer has access to the storefront.

 Filter users

The list of users includes a column specifying the last time a user signed in to the 
store (Last login). If no date is show, the user never accessed the store. The last 
login may be in the distant past which means a user is no longer using the store. 
You can create filtered lists of these users to send reminders to these users, to 
comply with data privacy regulations, to promote usage, etc.

1 On the menu bar, choose Users.

2 Click the Tools button (cogwheel) and then choose Last Login Filter.

A filter panel is displayed at the top of the list.

3 Select a check box to activate the filter parameters:

 start date only: all users who logged in after the specified date

 end date only: all users who logged in before the specified date

 both dates: all users who logged in between the specified dates

4 Click Search.

Users that meet the search criteria are displayed in the list. If you want, you 
can select these users in the list (press CTRL) and export the filtered list: see 
“Export a list of users” on page 279.

5 To undo the filter, clear the check boxes and click Search.

 Export a list of users

1 On the menu bar, choose Users.
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You can export all the users in the list or selected users.

TIP: You can use CTRL-select 
and SHIFT-select to select 
multiple users and export 
them.

2 Click the Export button.

You can choose to view or download an Excel file which contains a list of the 
selected users with their personal details and billable address details.

 Import a list of users

Users can be imported into STOREFRONT from an Excel file. You need to contact 
your ECO3 representative for this import operation, however, the procedure 
below explains how you can prepare the data in the Excel file.

NOTE: Your ECO3 representative or dealer can tell you what the maximum 
number of users is.

1 On the menu bar, choose Users.

2 Click the Export button to retrieve an example of the Excel file you need.

You can choose to view or download an Excel file which contains a list of all 
the existing users with their personal details and billable address details.

3 Save the Excel file to your hard disk.

4 Open the Excel file and clear the data for the existing users.

CAUTION: Do not modify the content of the first row in the spreadsheet, 
otherwise the data import will fail.

5 Enter the details for each user that you want to add, on a separate row.

Leave the first two columns empty.

 0:User Id

 1:User GUID

These IDs will be filled in by STOREFRONT upon import.

The following columns are mandatory:

 2:E-Mail: this is the unique identifier for each user and the same e-mail 
address cannot be used for more than one user
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 3:First Name

 4:Last Name

 11:Store Name

 24:Street 1

 26:City

 28:ZIP

 29:Country: two-digit ISO 3166 code; e.g. DE (Germany), US (United 
States), GB (United Kingdom), FR (France), ES (Spain), NL (The Nether-
lands), BE (Belgium), PT (Portugal), PL (Poland), etc. The full list can be 
found on the ISO website.

 39:ZIP (Extra): only mandatory for Brazil, Poland, Japan, US

The following columns are optional:

 6:Phone

 7:Fax

 8:Locale

 16:Store Company Name

 20:Address First Name: used for billing

 21:Address Last Name: used for billing

 25:Street 2

 27:State/Province

 30:Tax Number

 31: Company Name (for billing)

 32:Address MIS ID: used for billing

 33:MIS ID: can be used to identify a person with a number

 34:Address E-Mail: used for billing
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 38: Invoice Company Name:
If a user has the setting "Billable To: Company", enter the correct name of 
a company that exists in StoreCenter; the other billing address fields do 
not need to be completed in the Excel file.
If a user has the setting "Billable To: User", leave this field empty and 
complete the billing address fields.

 39:ZIP (Extra): only for US

 40:Salutation: Mr., Mrs. or Ms./Mr., or local translations; if you do not 
provide this column, the default salutation is used in the language of the 
user as defined in column 8:Locale.

 41: Tax Exempt Cert Id

 42: Access Labels

 43: Bypass Access Labels

 44: Approval Type

 45: Approval Groups

Delete the other columns in the Excel sheet or leave the cells empty.

6 Save the Excel file.

NOTE: The data must be on the first spreadsheet of the file.

The Excel file is now ready for importing into StoreCenter. Please contact 
your ECO3 representative or dealer for this feature.

 Impersonate a user

A Printer Administrator can use this feature to log on to a storefront as a user 
with his own administrator credentials to troubleshoot issues. For example, you 
may want to fix a customizable product or reproduce a problem that a user has 
reported or check access labels.

CAUTION: Any purchases you make are on behalf of the user you are 
impersonating.

1 On the menu bar, choose Users.

2 Select the user you want to impersonate.
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3 Click the Tools button (cogwheel) and then choose Impersonate.

The storefront opens in a new browser window and the Impersonate a user 
dialog is displayed with your Printer Administrator e-mail address in the E-
mail Address field and the user’s e-mail address in the Login as field.

4 Enter your password in the Password field and click Login to sign in to the 
storefront as the user you are impersonating.

You can now perform all user actions on the storefront: browse products, 
check the shopping cart, make purchases, view the user’s order history, edit 
the user’s account, etc.

5 Log out to end the Impersonate session.

Related topics: • Access Labels on page 262

 Reset a user’s password

The Printer Administrator can use this feature to re-send an e-mail that invites 
the user to visit the storefront and set a password of his choice.

1 On the menu bar, choose Users.

2 Select the user whose password you want to reset.

3 Click the Tools button (cogwheel) and then choose Reset Password.

4 Click the Reset Password button to send an e-mail to the user, inviting him 
to log on to the storefront and set a new password.

Related topics: • Stores, Microstores and Storefronts on page 187
• Add a Register button to the storefront login page (self-registration) on page 226
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CHAPTER
9 Monitoring and 
Processing Orders

NOTE: Some of the procedures in this section are for the Printer Administrator 
only.

A Company Administrator can monitor orders placed by shoppers on the store-
front and also manage orders and stocks if these options have been selected for 
him. Only the Printer Administrator and Operator are able to process orders.

 Order Monitoring on the Dashboard ...............................................................286
 The Dashboard ..................................................................................................286
 Orders Pane .......................................................................................................290

 Approving/Rejecting Orders ..............................................................................295
 Pending Orders .......................................................................................................299
 Complete Orders ....................................................................................................308
 Canceled Orders .....................................................................................................310
 Order Details, Package Slip and Invoice .......................................................313
 Order Item Details, Preview PDF, Last Minute Changes .........................315
 Order Item Customization ..................................................................................318
 Payment Status and History ..............................................................................320
 Downloading and Processing Files .................................................................322
 Integrating STOREFRONT with Apogee Prepress/Asanti .............................326
 Troubleshooting Orders .......................................................................................334
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Order Monitoring on the Dashboard

Once a store has been set up, the monitoring of incoming orders is one of the key 
activities in the StoreCenter of STOREFRONT. Two areas of StoreCenter focus on 
these tasks:

 The Dashboard

 Orders Pane

Related topics: • “Licenses statistics on the Dashboard” on page 111

The Dashboard The StoreCenter Dashboard, which is the landing page when you log on to 
STOREFRONT, provides a summary overview of all orders and a list of the most 
recent orders. You can navigate from these overviews directly to the relevant 
tabs of the Orders pane. The Orders overview also has a link to order statistics.

 Selecting orders via the Dashboard

1 Click the Dashboard link in the navigation bar to go to the Dashboard.

The Orders overview table is displayed with the orders broken down by 
status.

2 Click the status links to go to the Orders pane.

Figure 9.79: Orders overview and recent orders on the Dashboard
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.

The Incoming, In Production, Shipped and Pending Shipments links take you 
to the Pending tab in the Orders pane. The list of pending order items is 
filtered accordingly. Company Administrators/Approvers and Company 
Approvers will see orders waiting for approval if this has been set up for their 
store.

OR

Click an order line in the Recent Orders table to go to the relevant tab in the 
Orders pane.
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 Order statistics on the Dashboard

1 Click the Dashboard link in the navigation bar to go to the Dashboard.

2 Click the Statistics link.

The statistics are displayed.

You can filter the statistics by:

 Order status

 Company: All Companies or a specific Company

 Store per Company: All stores of the selected Company or a specific store

 Date: the maximum period for statistics is 13 months

3 Hover your mouse over the graph to see the exact number of orders on a 
given day.
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 Download an Excel report of orders

Use this procedure to create an Excel file with data relating to orders.

1 Click the Dashboard link in the navigation bar to go to the Dashboard.

2 Click the Statistics link.

The statistics are displayed.

3 Choose Excel Report in the report type drop-down list.

4 Filter the statistics as required (by Status, Company-Store, date) and click the 
Download Excel Report link.

You can view or download the Excel file which has one worksheet that lists 
all the orders, taking into account your filter settings, and a second 
worksheet with the items for these orders.

In each worksheet, the columns have a title, such as column C which has the 
title '2:Store Name'. If you use software to automatically parse the order data, 
that software should not rely on data being present in a specific column, nor 
should it rely on the full title of the column, which may change over time or 
be translated to the preferred language of the user who is exporting the data. 
The software should take the number in the column title as the sole refer-
ence. In our example: the '2' will always refer to the column that contains the 
name of the store in which the order was generated. In future versions of 
STOREFRONT, the column order may change, the column titles may change 
but the column ID numbers will remain consistent.

To facilitate automated order processing and save API calls, this report 
contains the following identifiers: "48:Order UidPK", "58:Order Item UidPK", 
and "59:Shipment UidPK". 

 Download all invoices

Use this procedure to download copies of all invoices.

1 Click the Dashboard link in the navigation bar to go to the Dashboard.

2 Click the Statistics link.
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The statistics are displayed.

3 Choose Invoices in ZIP or Invoices in Single PDF in the report type drop-
down list.

4 Filter the statistics as required (by Status, Company-Store, date) and click the 
Download Report link.

Depending on the report type you chose, all the invoices are created as 
separate PDF files and collected in a ZIP file, or all the invoices are generated 
in a single PDF.

 Order details via the Dashboard

1 Click the Dashboard link in the navigation bar to go to the Dashboard.

2 In the Recent Orders pane, click the information button to view the Order 
Details of a selected order.

The order details for the selected order are displayed in a new browser 
window.

3 Close the browser window with the Order Details to return to the Dashboard.

Orders Pane On the Dashboard, click the order status links or recent orders to go to the Orders 
pane where you can see more details about the status of the orders. Alterna-
tively, click Orders on the menu bar.

Orders appear in the top panel while the individual order items (products) are 
listed in the bottom panel.

1 Approval, Pending, Complete, Canceled and Search tabs

Figure 9.80: The Orders pane
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2 Order panel with a list of orders
3 Order item panel with the individual order items for the selected order

If your store has been set up with an approval requirement, all incoming orders 
appear first in the Approval tab and need to be approved before they can be 
processed. Otherwise, incoming orders appear in the Pending tab. Orders move 
to the Completed tab if they have been shipped and marked as completed. Orders 
canceled by an administrator are moved to the Canceled tab.

Printer Administrators, Company Administrators/Approvers, and Company 
Approvers can approve/reject orders. The Company Administrator may have 
rights to manage orders of his/her own company in the Pending tab but gener-
ally this activity is reserved for the Printer Administrator and Printer Operator 
who process the orders further. The Company Administrator can always monitor 
the status of orders in the different tabs. All StoreCenter roles, except the 
Company Approvers, can also customize (set order item flag) the order items 
which require an intervention to facilitate production.

The Pending tab toolbar provides buttons to change the status of orders and 
mark them as Available (To Be Shipped), Shipped, Completed or Canceled.

Each tab and panel has a Search box to search in the displayed lists. You can also 
search across all orders in the Search tab.

Order Statuses

In the different tabs of the Orders pane, the status of an order is further indicated 
by the order status icons.

Order or order item to be approved (approval tab)

Order has been approved and continued to production (approval tab)

Order item has been rejected

Order item has been approved

Awaiting inventory for Printed Stock or Non-Printed products ordered in backorder.

Created: incoming but not yet prepared by the system for downloading (Pending tab)

Prepared: incoming and all data has been prepared by the system for downloading

In production: the item has been downloaded and is being processed (prepress, printing, fin-
ishing)
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To be shipped, i.e. available (stock and non-print products are assigned this status immedi-
ately); Product Kit order items with Prepared status

Shipped: the order has been shipped to the shopper

Order or order item returned

Completed: the order has been shipped and requires no further action

Canceled: the order or order item has been canceled by an administrator and requires no fur-
ther action

The order item has a comment made by the shopper

The order item has workflow feedback information; click the icon to open the workflow feed-
back

The order or order item has encountered a problem that prevents the order from being ful-
filled. The issue will be fixed by the STOREFRONT team. Contact your ECO3 Service support or 
dealer if the issue is not resolved automatically.

An order cannot be downloaded to the workflow system or uploaded to the specified FTP 
server.
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Orders Toolbar Buttons

Refresh the list of orders

Continue with the selected order to production (send from the Approval tab to the Pending 
tab)

Display the order package slip

Display the payment history for the selected order

Display details of the selected order or order item

Display packing instructions

Download the shipping instructions file

Generate/Regenerate the invoice (e.g. after modifying the Store invoice presets)

Update the payment by bank transfer status

Mark the order as completed

Mark pending orders as completed (with date range)

Mark the order as shipped

Cancel the selected order or order items

Return the order or order item

Approve the selected order item

Reject the selected order item

Retry order item upload to FTP (upload to FTP failed)
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Download the selected order items

Mark the order or order item as to be shipped (available)

Put the order items in a new, separate shipment (splitting an order)

Resubmit: Reverts the order item status to Prepared so it can be submitted again to the work-
flow. (Apogee Prepress/Asanti)

Order item customization (order item flags)

Edit the order item in the online editor (for customizable or variable data products)

Download a preview PDF

Download the Variable Data Processing file attached to an order item (Excel file)

Display workflow information (Apogee Prepress/Asanti)

View order list with order items in separate panel

View order items list
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Approving/Rejecting Orders

The approval/rejection step is optional but can be set up to allow the Company 
Administrator/Approver or Company Approver to check whether an order is 
eligible for further processing in STOREFRONT. The order may contain incorrect 
information, exceed an agreed budget or need formal approval from a central 
approving authority.

You can approve/reject an order and all its order items, or you can split the order 
and approve/reject individual order items.

It is recommended that the Company Administrator chooses to receive an e-mail 
notification for all orders if the approval requirement is set. See “Edit your 
Account Profile” on page 42 for more information.

You can fine-tune the approval workflow by creating approval groups and 
administrators with an approval role for these groups. See “Approval Groups” on 
page 54.

Prerequisites
An order only needs to be approved/rejected if this requirement has been set up 
for the store by the Printer Administrator. See “Setting up a Store” on page 195 
and “Approval Groups” on page 54 for more information.

 Approve/reject an order or order items

1 On the menu bar, choose Orders.

2 Click the Approval tab and select the order you want to approve/reject.

Incoming orders are indicated with the To be Approved status icon:

NOTE: Orders awaiting approval do not appear in the Pending tab until they 
have been approved.

3 Click the information button to view the Order Details.

4 Close the Order Details.

You can also review the Order Item details and view a preview PDF for each 
individual order item (only for printed items).
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5 Select the order item and then click the Preview PDF link to check the 
content of the supplied data (only for printed items).

AND/OR

6 Click the information button to see the Order Item Details and check which 
items were purchased.

7 If you want to check or edit the contents of a customizable or variable data 
product, click the Edit Customization button to open the document in the 
Online Editor.

8 With the order selected in the top panel, click the Continue to Production 
button to approve all the order items.

OR

Mark the individual order items as Approved/Rejected in the Order Items 
panel:

Select the individual order items and click the Mark order item as approved 
or Mark order item as rejected button.

An approved order item is indicated with the following order status icon:

A rejected order item is indicated with the following order status icon:

In the order panel, click the Continue to Production button to send all the 
order items to the Pending tab, including those items which have not been 
approved or rejected.

In the Continue Order dialog, you can enter a reason for rejecting order 
items.
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NOTE: Order items which are not marked as approved or rejected are passed 
to production as if they were approved.

9 Click Continue.

If you rejected the order or certain items, an e-mail is sent to the shopper 
informing him and stating the reason for the rejection.

The approved order is indicated with following Order Approved and 
Continued to Production status icon in the order list:

Clicking the Pending tab refreshes the status of the order.

The order now appears in the Pending list with the Created status, and the 
order items also have the Created status:
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An incremental suffix is appended to the order number to indicate it has been 
split off from the original order and does not contain all the original order 
items.

NOTE: A rejected order or rejected order item is not displayed in the Pending 
tab. 

If you return to the Approval tab, the order is no longer displayed.

NOTE: Rejected orders are removed from the system and are no longer 
displayed in any of the tabs once you click Refresh.
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Pending Orders

The Pending tab is the default tab that you see when opening the Orders pane. 
This is where most of the processing actions are performed. It has two views and 
you can also filter the orders by status.

1 Buttons to switch between Orders with/without Order Items
2 Drop-down to filter orders by status

 Orders and Order Items view: lists all the pending orders in the top pane and 
the items per order in the bottom pane. You can filter the orders by All, 
Incoming, To be Shipped or Shipped.

 Order Items only view: lists the items which are awaiting the To Be Shipped 
status, across all the orders. In other words, these are orders that need to 
printed. You can filter the order items by All, Incoming and In Production.

NOTE: If STOREFRONT is integrated with Apogee Prepress 12 and higher, or Asanti 
Production 4.0 and higher, the Prepared status automatically changes to In 
Production once order items are downloaded by Apogee Prepress/Asanti 
Production.

Figure 9.81: Views and filtering in the Pending tab
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 Process a pending order

1 In the Pending tab, click the View Orders and Order Items button (left) view.

2 Select the order you want to process.

NOTE: Orders awaiting approval appear in the Approval tab until they have 
been approved.

Incoming orders are indicated with the order Created status icon until they 
have been prepared by STOREFRONT:

Once they are prepared, i.e. the JDF data generated and a print-ready PDF 
file has been created, the status icon changes to Prepared:

NOTE: Orders which require payment by bank transfer remain in Awaiting 
Payment status until you confirm that the payment has been received. See 
“Update bank transfer payments” on page 304.

3 Click the information button to view the Order Details.

4 Close the Order Details.

5 Select the order in the top pane to display the items for the order in the 
bottom pane.

A single order may contain different types of order items (products).

6 Select the order item you want to process.

Do one of the following using the toolbar buttons, depending on the product 
type:

TIP: Press ALT while clicking 
the download button to 
toggle between a PDF/JDF 
or an MJD zip-compressed 
file.

 For Customizable, Variable Data, Uploadable and On Demand, products:

Click the download button  to download an MJD or PDF zip-compressed file; 

the order status changes to In Production .
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 For Printed Stock and Non-Printed Stock products: The product is in stock 
or can be ordered in backorder. The status of products in stock changes 
directly to Available (To Be Shipped) . Products in backorder have the 
Awaiting Inventory status until the stock is updated and then Available 
(To Be Shipped) once the stock has been updated.

 For Digital products and Print products ordered as PDF: The status 
changes immediately to Shipped .

7 Repeat for all the order items.

When all the order items are available, the status of the order changes to 
Ready to be Shipped .

NOTE: If you want to ship an order item before all the items are available, you 
need to split the order into order parts. See “Splitting orders into order parts 
(New shipment)” on page 302.

8 Select the order or orders with the In Production  status and click the Ship 
Order button.

The Ship Order dialog is displayed where you can enter a comment and the 
delivery service Tracking Number or URL to monitor the delivery.

The Send Mail check box is selected by default, but you may want to disable 
this feature, for example if many orders are being shipped on the same day.

If the online payment has not been captured yet, an option is displayed for 
you to confirm that “I agree to go ahead with the shipment anyway”.

9 Click Ship.

The order status is updated in the list with the tracking number or URL in the 
Tracking column. If the shipping service is set to Tracking Not Available, you 
will see the first 30 characters of the comment in this column.
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NOTE: To edit the tracking URL or add it later, press ALT while clicking the 
field in the tracking column. (Only Administrators and Operators who are 
allowed to manage orders can do this.)

The shopper receives a confirmation e-mail with the tracking number and 
comment. The shopper can click the tracking number to go to the website of 
the delivery service provider and check the status of the delivery.

The following Shipped order status icon is displayed:

In the Tracking column you can click the number to check the shipment 
status of the order on the delivery service provider’s website.

Shipped orders remain in the Pending list until they are marked Complete.

 Splitting orders into order parts (New shipment)

You can create sub-orders, or order parts, from the individual items of an order, 
for example, to ship them without waiting until all the other orders items are 
ready. This is done in the Pending tab on Prepared orders. It is not possible in the 
Approval tab.

The packaging is re-calculated for the different order parts because these order 
parts are shipped separately. The total shipping cost will NEVER be higher than 
the original shipping cost if the parts were ordered as a single order.

1 In the Pending tab, click the View Orders and Order Items button (left) view.
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2 Select the order you want to split in the top pane to display the order items 
(products) in the bottom pane.

3 Select the order item or items you want to split off and click the New 
Shipment button.

4 Click Split Order.

5 The order is now split into two separate orders in the top pane and an incre-
mental suffix is added to the original order number as follows:

 xxxxx-1: the original order with the remaining order items

 xxxxx-2: the newly created sub-order with the split-off order item or items

6 If necessary, the original order can be split again to create another sub-order:

 xxxxx-1: the original order with the remaining order items

 xxxxx-3: the newly created sub-order with the split-off order item

You can now process and ship these orders separately.

 Monitor/process all pending items across all orders

 In the Pending tab, click the View Order Items Only button (right).

This view shows all the items of orders with the following status:

 Incoming (Created and Prepared)

 In Production
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TIP: You can use CTRL-select 
and SHIFT-select to perform 
actions on several items 
simultaneously.

In this view, you can perform the following actions on a selected order item:

 download

 mark as available (ready to be shipped)

 Viewing order comments

A Shopper can create a comment for each item in the storefront shopping cart. 
These comments are indicated by a yellow icon in the order items pane in the 
Pending tab.

1 In the Pending tab, click the View Orders and Order Items button (left) view.

2 Select an order to display the order items in the bottom pane.

Order items with a comment are indicated with the following icon:

NOTE: Comments may include specific requirements for printing a job or 
delivering the order and as such play an important role in the monitoring 
process.

3 Hover over the icon to display the comment.

 Update bank transfer payments

Orders paid by bank transfer require manual intervention when the bank 
transfer has been received.
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1 In the Pending tab, click the View Orders and Order Items button (left) view.

Orders paid by bank transfer appear in the order list with a special icon in the 
payment status column to indicate that a bank transfer is required.

These orders have the Awaiting Payment status until you manually set the 
payment to Complete.

2 Select the order in the list and click the Update bank transfer payment 
button.

The Payment History dialog is displayed.

3 Click the Add button to confirm the payment.

4 Click Add Payment and then Close.

The payment status changes to Complete and the processing continues.

NOTE: This bank transfer payment verification can be skipped. See “Set up 
payments by bank transfer” on page 81.

Payment by bank transfer required: the order is on hold until the status is changed to pay-
ment complete

Payment by bank transfer is complete: the payment has been received and the status 
changed; the order can now be processed
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 Return the order or order item

Once an order has been shipped, it’s not possible to cancel it. In certain situations 
(e.g. a digital product) you may need to recall the order, or the shopper may 
return the order. In these cases, you can change the order status to returned.

1 In the Pending tab, click the View Orders and Order Items button (left) view.

2 Select the shipped order or order item in the list and click the Return the 
order button.

3 Enter a reason for changing the status and click Return Order.

The status of the order changes to Order is returned.

For Digital products and Print products ordered as PDF, this means that the 
link to download the file is deactivated. No notifications are sent.

 Generate/regenerate an invoice

You may want to create or regenerate an invoice, for example, if you changed 
the general settings for invoices or you enabled invoice creation for the store 
after an order was placed (see “Invoice Tab” on page 236).

1 In the Pending or Complete tab, select the order with the Shipped status for 
which you want to generate or regenerate the invoice. 

Orders for which an invoice have already been created are indicated with the 
following icon:

Payment by bank transfer is not required to continue with the order: no manual intervention 
is required for the order to be processed
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If a shipped order doesn’t have the invoice icon, the order was probably 
placed before you enabled invoices and you will now create the invoice for 
the first time.

2 Click the Regenerate invoice button.

3 Click the invoice icon to open the invoice you just generated. You can hover 
over the invoice icon to see the creation date and time.

To download all your invoices for archiving via the Dashboard, see “Download 
all invoices” on page 289.
StoreFront User’s Guide



308 COMPLETE ORDERS
Complete Orders

Once an order has been processed and shipped, you can mark it as complete to 
move it from the Pending tab to the Complete tab. You reduce the number of 
orders in the list and obtain a better overview of orders which are still in 
progress.

 Mark orders as complete

1 In the Pending tab, click the View Orders and Order Items button (left) view.

2 Select the order you want to mark as complete.

NOTE: Only Shipped orders can be marked as Complete.

3 Click the Mark the order as completed button.

The status changes from Shipped to Complete in the Pending tab.

4 Click the Refresh button or the Complete tab and the completed order is 
moved to the Complete tab.

 Mark pending orders as complete

You can mark multiple orders with the In Production, Available or Shipped 
status as complete by specifying a creation date or date range. This is useful for 
cleaning up orders in the Pending tab.

1 Click the Mark pending orders as complete button, without selecting any of 
the pending orders in the list.

2 Select the Created after and/or the Created before check boxes to display a 
calendar picker:

 Created after: marks all orders created after this date (From)

 Created before: marks all orders created before this date (To)

Use both check boxes to define a From/To date range.
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NOTE: To prevent you from accidentally deleting recent orders, only orders 
older than 1 month can be selected.

3 Click OK to display a confirmation screen specifying the number of orders 
that will be marked.

4 Click OK.

Any orders created during the specified period and with the In Production, 
Available or Shipped status are moved to the Complete tab. No further 
actions can be performed on these orders in the Pending tab and no e-mails 
are sent to confirm that the status of the order has changed.
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Canceled Orders

If you don’t want to process an order which is pending in the Pending tab, you 
can cancel it. Orders are moved to the Canceled tab when they have been 
marked as canceled in the Pending tab.

Paid orders will be set to the Refunded status before they can assume the 
Canceled status.

NOTE: Shoppers need to be refunded via your bank. STOREFRONT allows you to 
monitor refunds with special status icons in the canceled orders list. You can 
keep track of refunds and the exact amount, on the payment history page (see 
“Payment History” on page 320).

 Cancel orders or order items

1 In the Pending tab, click the View Orders and Order Items button (left) view.

2 Select the order or sub-order you want to cancel.

3 Click the Cancel the order button and confirm that you want to cancel the 
order.

The status changes from its current status (Incoming, In Production, To Be 
Shipped) to Canceled in the Pending tab. By default, an e-mail is sent to 
inform the shopper. Clear the Send E-mail check box if you do not want to 
inform the shopper (i.e. silent cancellation).

4 Click the Refresh button or the Canceled tab and the canceled order is moved 
to the Canceled tab.

à
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5 To cancel an order item, select the order item and click the Cancel the order 
item button.

A new order part is then created and sent to the Canceled tab with this 
canceled item.

 Refund a canceled order

1 In the Canceled tab, select the order or sub-order that needs to be refunded. 
These orders are indicated with a credit card and purple arrow icon in the list 
of canceled orders.

2 Click the Refund Order button.

A dialog is displayed where you can confirm that you want to refund the 
indicated refund amount. You can enter a comment and also change the 
amount to be refunded, for example to compensate for administrative costs 
or other expenses.

à

à
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3 Click Refund.

The payment status changes to Order Refund, Refunded indicated with a 
credit card and gray arrow icon.

The order status has now changed to Canceled.
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Order Details, Package Slip and Invoice

Order Details provide an overview of all the items of an order, including the 
prices and a link to the payment history. These details can be consulted at any 
time during order processing. The invoice PDF file can be downloaded if the 
order has been shipped.

The Package Slip is meant to be printed and enclosed with the order when it is 
shipped.

These documents are always in the language of the shopper.

 View and print the Order Details

1 On the menu bar, choose Orders and In any of the tabs, select the order you 
want to view.

OR

Click the order in the Recent Orders pane on the Dashboard.

2 Click the information button to view the Order Details.

A new browser window opens with the Order Details:

 order status, number and date

 delivery address, service and order reference

 link to the tracking service

 shipping cost

 discount (promo code)

 billing address

 list of all order items with quantities and prices including and excluding 
tax

 the total price including and excluding tax

3 You can print this page by clicking the link in the top right corner. You can 
also download the invoice PDF file if this feature has been set and the order 
has been shipped.
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4 Close the browser window or tab to return to the Orders pane.

 View/print the Package Slip

An itemized list of order items with the shipping address, order details and refer-
ence number can be viewed and printed. This slip can be enclosed with the 
order. The following information is provided:

 store information

 order number and date

 shopper’s order reference if provided at checkout

 delivery address

 name of the shipping service

 list of all order items with quantities and SKU codes, but not the prices

1 On the menu bar, choose Orders.

2 In any of the tabs, select the order you want to view.

3 Click the Package Slip button. 

A new browser window or tab opens with an itemized list that can be printed.

4 Click the Print link to print this package slip.

5 Close the browser window or tab to return to the Orders pane.
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Order Item Details, Preview PDF, Last Minute Changes

You can easily check the details of an order item at any time during order 
processing. Approvers can check the details and preview a PDF of the individual 
order items before approving an order. Operators can immediately check the 
specifications and a preview PDF before downloading the production package 
for an order item. Approvers can also open customizable and variable data 
products in the Online Editor to perform last minute changes.

 View the Order Item Details

The Information link in the Order Items pane opens a new window with the 
following Order Item Details (where applicable):

 order number, date, customer and order reference

 shipping info with estimated shipping date and shipping method

 order item number and ordered quantity

 name, type and content of the product

 product template specifications

 product specifications

 product options

 packing details with the calculation of packaging units and weight

 user comment

1 On the menu bar, choose Orders.

OR

Navigate to the Orders pane by clicking an order on the Dashboard.

2 In any of the tabs, select the order and then the individual item you want to 
view.

3 Click the information button to view the Order Item Details.
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TIP: Press the CTRL or SHIFT 
keys to select multiple order 
items and view all the 
details in a single document 
and then print a PDF for each 
item.

A new browser window or tab opens with the Order Item Details.

4 Click the links (Product, Product Template, Packaging Unit) for more 
detailed information if necessary.

5 Click the PDF Preview link under the thumbnail in the top right corner, to 
view or download a preview of the production PDF which is contained in the 
production package.

6 Close the browser window or tab to return to the Orders pane.

 View/print a production PDF preview

You can view the PDF of an order item before downloading the actual produc-
tion package. This is the PDF which is contained in the download package.

1 On the menu bar, choose Orders.
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2 In any of the tabs, select the order and then the individual item you want to 
view.

3 Click the Download Preview PDF button. 

You are prompted to save or open the PDF file.

 Edit a customizable product (last-minute changes)

You can open a customizable product, including variable data products, in the 
Online Editor to make last-minute changes before processing the order. This is 
an interesting feature for correcting typos and making last minute changes.

NOTE: If the order has already been sent for processing, a new revision is re-sent.

1 On the menu bar, choose Orders.

2 In any of the tabs, select the order and then the individual item you want to 
view.

3 Click the Edit Customization button. 

The document is opened in the Online Editor where you can edit the 
document and/or the uploaded variable data.

4 Close the Online Editor and save your changes.

You can now continue the order processing workflow.

Related topics: • Online Editor on page 335
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Order Item Customization

You can customize the order items which require an intervention to facilitate 
production and/or indicate their production status by creating different order 
item flags.

You can assign the order items flags independently of order item status. Defined 
conditions for flags are independent of each other. There is no workflow to 
proceed to the next or previous status.

TIP: You can use View Order 
Items Only view in the 
Pending tab to sort the list of 
all the order items by order 
items flags.

 You can sort all order items by condition to quickly find all the items those 
require some action.

 You can use the search box to find all items customized with a certain flag. 
For example, searching for ''bundled” will only display the order items with 
the status “Bundled shipping”.

NOTE: Order item flags are only visible in StoreCenter, they are not visible in 
stores.

 Create/edit Order Item Flag

1 In the Pending tab, click the View Orders and Order Items button (left) view.

2 Select an order to display the order items in the bottom pane.
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3 Click the Order Item Customization button to assign a selected order item 
flag to one or multiple selected order items.

Select an order item flag from the available order item flags.

Click Update to save your changes.

Related topics: • Order Item Flags on page 95
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Payment Status and History

 Payment Status

Orders may need to be paid before they can be processed. Icons in the Payment 
Status column of the orders list indicate the status of the payment and you will 
be prompted to acknowledge an error when you want to ship an order that 
contains a payment warning. See “Payment Methods and Tax” on page 81 for 
more information on direct and deferred payment.

 Hover over the payment status icons in the Payment Status column for more 
information about the payment status of an order.

 Payment History

The Payment History gives an overview of the payment statuses for the specified 
order.

 In any of the tabs, select the order whose payment history you want to view 
and click the Payment Overview button.

Online payment required (to be captured); only displayed for deferred payments

Online payment in progress (capturing)

The order is paid (captured)

Payment failed

Refunding order

The order is to be refunded

The order is refunded

Payment by bank transfer required: the order is on hold until the status is changed to pay-
ment complete

Payment by bank transfer is complete: the payment has been received and the status 
changed; the order can now be processed

Payment by bank transfer is not required to continue with the order
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The history of payment statuses is listed with the following details:

 Payment ID

 Merchant reference

 Status of the payment: authorizing, in progress, captured, refunded

 Date of the status

 Total amount of the payment

 etc.

NOTE: The information you see in this overview may vary for the different 
gateway providers. See “Configuring Payment Gateways” on page 563 for 
more information.

Related topics: • How to handle a ‘Payment failed’ order status on page 334
• Refund a canceled order on page 311
• How to handle a ‘Payment failed’ order status on page 334
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Downloading and Processing Files

For some incoming orders, files need to be downloaded from STOREFRONT so 
they can be printed. The files are contained in a ZIP package which can be 
downloaded manually or automatically for the following product types:

 Customizable, including Variable Data Products

 Uploadable

 On Demand

Two types of zip packages can be downloaded:

 MJD

 PDF/JDF

See “Production Tab” on page 150 for more information.

 Manual download of order items

In a manual flow, the downloaded files need to be assigned manually to a hot 
ticket or job ticket for further processing.

1 In the Pending tab, click the order item you want to download.

You can select the order item in either of the two views.

The order item must have the Prepared status.

2 Select the prepared order item and click the Download button.

TIP: You can use CTRL-select 
and SHIFT-select to 
download several order 
items simultaneously.

A dialog prompts you to save or open the ZIP file.

3 Save the zip package to a location of your choice.

NOTE: Depending on the Production Settings in the Advanced menu, the zip 
package contains an MJD (mime packaged job definition) file or a PDF and a 
JDF file. You can toggle between these two types of ZIP files by pressing the 
ALT key while clicking the Download button.
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The order item and order statuses change to In Production.

4 Upload the files in the zip package to the Apogee Prepress hot ticket or job 
ticket.

 Automatic processing with Apogee Prepress/Asanti

If STOREFRONT is integrated with Apogee Prepress 11.0 and higher, or Asanti 
Production 4.0 and higher, incoming orders are polled and files are downloaded 
automatically and submitted to Apogee Prepress/Asanti. The order status is 
automatically set to In Production.

See “Integrating STOREFRONT with Apogee Prepress/Asanti” on page 326.

 Send order item files to your FTP server

The Send to FTP feature is specified in your Advanced settings, but you may 
need to upload the ZIPs manually if the upload fails. 

1 Go to Advanced > Production Settings > Prepress Settings and select the 
Automatically send order items to FTP Server option.

2 Enter the FTP Server (you can specify a directory for all the downloads, e.g. 
<servername>/foldername), the Username and Password, and Save your 
changes.

A ZIP file will now be created for each order item of an incoming order and 
these ZIP files are uploaded automatically to the specified FTP server.

If uploading to the FTP server fails, for example if the server is not available, 
an error icon is displayed next to the order item.

Click the Retry Order Upload button in the toolbar to re-send the ZIP to the 
specified FTP server.

 Send order item files to your PrintSphere space

The link with your PrintSphere space is set up in your Advanced settings. 

1 Go to Advanced > Production Settings > Prepress Settings and select the 
Automatically send order items to PrintSphere option.
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2 Specify the Export Directory in your PrintSphere space, for example:

/StoreFront/ExportOrders

A ZIP file will now be created for each order item of an incoming order and 
these ZIP files are uploaded automatically to the specified directory in your 
PrintSphere space. You can set up PrintSphere to sync files automatically to 
your local network. See the PrintSphere online help for more information.

 Bypass automatic downloading/uploading

You can bypass automatic downloading to your ECO3 workflow system, for 
example if the Apogee Prepress/Asanti service is not available and you want to 
download the files and process them manually. This procedure can also be used 
to bypass automatic uploading to an FTP server.

1 In the Pending tab, click the order item you want to download.

The order item must have the Prepared status.

NOTE: If the order has the Created status, the server may be busy. Check back 
later.

2 Select the prepared order item and press the SHIFT key while clicking the 
Download button. Press the ALT + SHIFT keys to change the default file 
type: MJD or PDF + JDF.

The Download Order Item dialog prompts you to download a ZIP containing 
an MJD file or JDF/JDF files.

3 Click Download to save the ZIP to a location of your choice.

The order item and order statuses change to In Production.

4 Upload the files in the zip package to the Apogee Prepress/Asanti hot ticket 
or job ticket.

NOTE: An order item can also be downloaded when it has reached the Shipped 
or Complete status. The MJD file also includes the PDF file.
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 Resubmit an order item to Apogee Prepress/Asanti

If you accidentally deleted the Apogee Prepress/Asanti job an order item was 
assigned to, you can resubmit it.

1 In the Pending tab, click the order item you want to resubmit.

The order item has already been downloaded for initial processing so the 
status is In Production.

2 Click the Resubmit button to revert the status of the order to Prepared.

The order item will be picked up automatically by the workflow system and 
a new Apogee Prepress/Asanti job will be created.

 Manually reprocess an automatically downloaded order item

If you accidentally deleted the Apogee Prepress/Asanti job an order item was 
assigned to, you can manually download the ZIP which has already been 
downloaded automatically.

1 In the Pending tab, click the order item you want to reprocess.

The order item has already been downloaded for initial processing so the 
status is In Production.

Press the ALT + SHIFT keys while clicking the Download button.

The Bypass Apogee Prepress/Asanti dialog prompts you to download a ZIP 
containing an MJD file or JDF/JDF files.

2 Click Download to save the ZIP to a location of your choice.

The order item and order statuses change to In Production.

3 Upload the files in the zip package to the Apogee Prepress/Asanti hot ticket 
or job ticket.
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Integrating STOREFRONT with Apogee Prepress/Asanti 

Integration with Apogee Prepress/Asanti enables the automatic downloading of 
orders as they appear in STOREFRONT. You need to create a special hot ticket and 
dedicated job ticket templates, and set up communication between the two 
systems.

How it works

Apogee Prepress/Asanti polls STOREFRONT for new orders that need to be printed 
and downloads these orders automatically and according to the specified polling 
frequency.

A special STOREFRONT hot ticket imports the STOREFRONT MJD (Mime packaged 
Job Definition format) file which includes a JDF (Job Description Format) file 
that describes the job, and a PDF which is the actual content that needs to be 
printed. The JDF file specifies the name of a job ticket template that you select in 
STOREFRONT to create the job in Apogee Prepress/Asanti.

In STOREFRONT you can specify this job ticket template for each product in the 
product template. In addition, a default job ticket template can be defined in 
STOREFRONT which can be used as a fallback if no job ticket template is specified 
in the product template. The product definition in these job ticket templates 
match the characteristics of the different STOREFRONT product templates 
(bound, unbound, flat, folded, etc.). The JDF Server resource in Apogee 
Prepress/Asanti maps JDF data contained in the STOREFRONT MJD file to product 
definition settings that Apogee Prepress/Asanti understands.

NOTE: Please contact your ECO3 representative if you need assistance 
creating job ticket templates that match the characteristics of your 
STOREFRONT products, or to configure the JDF Server resource.

Prerequisites
This feature is only possible with Apogee Prepress 11.0 and higher (Manage or 
Integrate versions) and Asanti Production 4.0 and higher.

To set this up, perform the following steps in the StoreCenter and in Apogee 
Prepress/Asanti.

 Step 1: Production Settings in STOREFRONT

1 In the StoreCenter, choose Advanced > Production Settings > Prepress 
Settings tab.
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2 Choose version 9.1 or higher from the Apogee Prepress version drop-down 
list or version 2.0 or higher for Asanti Production.

3 For Order Handling, choose Automatically download all order items to 
Apogee Prepress/Asanti.

4 Leave the Default Ticket Template field blank for the time-being.

5 In the Hot Ticket field, enter the name of a hot ticket you will create in 
Apogee Prepress/Asanti, e.g. StoreFront, without the file extension.

Select the Track Feedback check box to enable an extra button in the Orders 
tab that can be clicked to see feedback from the workflow system.

6 Click Save to confirm your changes.

Now go to your Apogee Prepress/Asanti application.

 Step 2: Create STOREFRONT Tickets in Apogee Prepress/Asanti

First you create a hot ticket to import the job description and then a job ticket 
template to create the Apogee Prepress/Asanti jobs.

1 In Apogee Prepress/Asanti, create a Hot Ticket with the name StoreFront 
which only contains a JDFImport task processor.

An example of such a hot ticket with the name StoreFront is available as a 
Hot Ticket Template in the Tutorial category in the Apogee Prepress/Asanti 
client. 
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2 Open this example hot ticket template and you’ll see that it only contains the 
JDFImport input task processor.

3 Submit the hot ticket without modifying it, as a new hot ticket with the name 
StoreFront.
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NOTE: The name is case-sensitive and must be the same as what you entered 
in the StoreCenter Production Settings tab.

4 Now create a Job Ticket Template. Apogee Prepress/Asanti uses these 
templates to create new jobs from incoming orders. As a starting point, you 
can use the Job Ticket Template which is provided with your system in the 
Tutorial category StoreFront Product Template. The following conditions 
must be met when creating job ticket templates for STOREFRONT:

 The ticket template must have an input channel Hot Folder and must 
contain a full production plan.

 Do NOT set the Hot Folder input to just $ORDER because a single order in 
STOREFRONT can result in two Order Items which generate two jobs in 
Apogee Prepress/Asanti. Therefore you should use $JOB, $JOBID or 
$ORDER\$JOBID (or $ORDER-$JOBID).

NOTE: All possible ticket templates are supported, not only job ticket 
templates: Job and Hot Ticket templates, Asanti Layout Tickets and Layout 
Hot Ticket templates.

5 Save the template as a template, for example with the name StoreFront 
Product Template and select the Make available to StoreFront option in 
the Save dialog.

NOTE: If you don’t select the Make available to StoreFront option when 
saving, the template does not appear in the StoreCenter.
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The template is added to the list of templates and a special icon identifies 
these STOREFRONT templates.

6 Create additional Job Ticket Templates as required for different types of jobs.

7 In Apogee Prepress/Asanti, go to System Overview and open the STORE-
FRONT resource.

8 In the Configuration tab, select the Enable StoreFront Polling check box.
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This controls how and when Apogee Prepress/Asanti polls the STOREFRONT 
system for new orders that can be downloaded.

9 Enter the STOREFRONT URL, and the e-mail address and password of the 
printer account that you use to log on the StoreCenter.

10 Set the Polling Time and configure the proxy server if you have one.
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11 Click OK to save your changes.

The connection is established with STOREFRONT. If necessary, resolve any 
errors that are displayed.

 Step 3: Refresh the Production Settings in STOREFRONT

1 Go back to the StoreCenter and refresh the page with the Production Settings 
tab or choose Advanced > Production Settings > Production Settings 
tab.

The Ticket Templates you just created in Apogee Prepress/Asanti now 
appear in the Default Ticket Template drop-down list.

2 Choose the Ticket Template you want to use as the default for creating jobs 
from downloaded order items.
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NOTE: The Ticket Template you choose here is a fallback for when you have 
not specified a job ticket template at the Product Template level. See 
“Production Tab” on page 150.

3 Click Save to confirm your changes.

Related topics: • Integration with Apogee Prepress and Asanti on page 31
• Configure Prepress Settings on page 99
• Production Tab on page 150
• System Requirements on page 35
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Troubleshooting Orders

 How to handle a ‘Payment failed’ order status

In stores that use online payment, a problem with the payment transaction can 
cause a new order to be given the 'Payment failed' status. This status is indicated 
by a card with a red triangle in the Order List.

It is recommended to cancel an order which has the 'Payment failed' status. A 
window will appear in which you can specify the reason for the order cancella-
tion. This message is mailed back to the shopper to inform him or her why the 
order will not be processed. By explicitly letting the shopper know that the order 
failed, you avoid possible misunderstandings: the shopper may not be aware 
that the payment was not processed and waits for an order that never arrives. If 
you cancel the order, the shopper can take the initiative to place a new order.
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10 Online Editor

The Online Editor is a module in the STOREFRONT StoreCenter which is used to 
work with Customizable Products and Variable Data Products. These products 
are created with the STOREFRONT Converter plug-in from InDesign documents 
and can be further customized in StoreCenter with the Online Editor.

 Introduction .............................................................................................................336
 Converter Plug-In ...................................................................................................337
 Online Editor Overview ........................................................................................350
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 Workspace Tabs and Panels ..............................................................................402
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 Variable Actions Samples ...................................................................................465
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 Use an Excel file for Autofill ..............................................................................506
 Customizable Product with User-Definable Size .......................................508

NOTE: Some of the procedures in this section are for the Printer Administrator 
only.
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Introduction

A Customizable Product is a publication that a shopper can edit to personalize 
the content before ordering. Typical examples are business cards, letterheads, 
newsletters, posters, etc. A Variable Data Product (VDP) is a special kind of 
customizable product that allows a shopper to upload variable data such as 
names, addresses, images, etc. and merge these data with a product to create 
multiple publications.

The print service provider’s designer creates the base layout in Adobe InDesign 
and converts them into a StoreFront Package using the StoreFront Converter 
plug-in. The StoreFront Package is uploaded and administrators can use the 
Online Editor integrated in STOREFRONT to fine-tune the base layouts and set 
restrictions on the extent to which the shopper can modify the documents. A 
similar version of the Online Editor is available on the storefront so shoppers can 
add or edit their personal content.

In the following sections, the Customizable and Variable Data product types are 
discussed together.

Figure 10.82: Customizable/Variable Data product flow

Customizable product

Variable data product
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Converter Plug-In

With the Converter plug-in you can save an InDesign document as a STOREFRONT 
package. This is a ZIP package that can be opened and edited in the Online Editor 
of StoreCenter. The ZIP package contains all the necessary data as inherited from 
the InDesign document:

 the document with inherited styles in the STOREFRONT format

 embedded fonts

 embedded images

 complex design elements such as gradients and large files which are 
converted to PDF for optimum online presentation

 inherited layers which are locked or editable as specified

The Converter plug-in can be installed on as many computers as required and 
you can also give it to freelance designers. It is recommended that you check 
regularly that you have the latest version of the Converter plug-in. The version 
number is indicated in the top right corner of the Converter windows.

Three versions of the converter are available to ensure compatibility with the 
various versions of InDesign:

NOTE: Plug-ins are also referred to as extensions in Adobe InDesign.

Prerequisites
The following procedures are for using the Converter plug-in with Adobe 
InDesign which needs to be installed on your computer. 

STOREFRONT packages can be created on Windows as well as Macintosh 
computers. See “System Requirements” on page 35.

NOTE: Read the Technical Information provided with the plug-in for information 
on installing the latest version of the plug-in.

Related topics: • Converter Windows (up to InDesign CS6) on page 345
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 Install the Converter plug-in

1 Click the Download Plug-in link in the StoreCenter navigation bar to 
download the latest STOREFRONT Converter plug-in.

2 Save the ZIP file to a location on your computer.

3 Browse to this location and unzip this file which contains a folder with the 
latest version and another with older versions.

4 Read the technical note for the installation instructions with your InDesign 
version.

STOREFRONT Converter is added to the list of extensions.

5 Restart InDesign and you can now start the Converter from the File menu or 
the Window menu, depending on the version of InDesign.

 Prepare an InDesign document

Documents need to match the specifications of the product templates on which 
the customizable product will be based. For example, a customizable business 
card will be based on a business card product template which has specific dimen-
sions. Your InDesign document must have the same dimensions.

It is recommended to prepare an InDesign document with layers so you can lock 
static content. See “Conversion Recommendations” on page 348 for more 
details.

You may need to embed instructions for the shopper. For example if the shopper 
can choose from selected fonts, include sample text in the different fonts on a 
locked layer.

Your design also needs to take into account the workspace version that you 
choose for the shopper: Advanced, Basic, Forms or Expert. See “Online Editor 
Overview” on page 350 for more information.

TIP: If you need to modify or update the base document or design of an existing 
customizable product, it is recommended to do this in the Online Editor if 
possible. Otherwise you will have to redo all the work you performed in the 
Online Editor (form fields, constraints, etc.).

 Create a package with the Converter plug-in (InDesign CC and later)

1 In Adobe InDesign, open an existing InDesign document or create a new 
document that you want to use as a customizable product in STOREFRONT.
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The document layout should consist of layers to separate static design 
elements from the customizable frames. Layers containing static information 
should be locked so the shopper cannot modify this information.

2 Choose Window > Extensions > StoreFront Converter to start the 
Converter.

The Converter dialog is displayed.

3 In the Export to StoreFront panel, choose the document you want to convert 
from the Source drop-down list and choose the other settings as required. 
See “Converter Windows (InDesign CC and later)” on page 341 for more 
information.

4 Click Go to save the document as a STOREFRONT package.

This also starts the preflight checks to check that the Converter translates all 
design elements in the layout properly into a STOREFRONT Package. Warnings 
or errors may flag issues in the saved package. If the preflight detects errors, 
you will not be able to create the package. If this is the case, you need to open 
the second converter tool to fix the errors. Choose 
Window > Extensions > StoreFront Live Preflight to open the preflight 
tool, and click the Preflight document button. See “STOREFRONT Live 
Preflight” on page 343.

5 Optionally, the preflight step can also be performed before you create the 
package and when you are creating your document. This give you more 
control for fixing issues. Choose Window > Extensions > StoreFront Live 
Preflight to open the preflight tool. See “STOREFRONT Live Preflight” on 
page 343.

A ZIP file is created which is ready for uploading in StoreCenter when you 
create a customizable product.

6 Click the “x” in the top right corner to close the Converter.

 Create a package with the Converter plug-in (up to InDesign CS6)

1 In Adobe InDesign, open an existing InDesign document or create a new 
document that you want to use as a customizable product in STOREFRONT.

The document layout should consist of layers to separate static design 
elements from the customizable frames. Layers containing static information 
should be locked so the shopper cannot modify this information.

2 Choose File > Export for Apogee StoreFront to start the Converter.

The Converter dialog is displayed.
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3 Choose the document you want to convert from the InDesign file drop-down 
list and choose the other settings as required. See “Export for STOREFRONT” 
on page 345 for more information.

4 Click Create ZIP to save the document as a STOREFRONT package.

The conversion starts and the Converter checks that all design elements in 
the layout can be translated properly into a STOREFRONT Package. The results 
are displayed in the Converter Preflight Report. See “Preflight Report” on 
page 347 for more information.

Warnings or errors may be displayed to flag issues in the saved package. See 
“Conversion Recommendations” on page 348 for more information. 

5 Click Back to fix the issue.

OR

Click Save Document to finish the conversion.

OR

Click X in the top right corner of the window to abort the conversion.

A ZIP file is created which is ready for uploading in StoreCenter when you 
create a customizable product.

6 Click the “x” in the top right corner to close the Converter.

 Uninstall the Converter plug-in (InDesign CC and later)

 You can uninstall the converter as you would remove other programs.

 Uninstall the Converter plug-in (up to InDesign CS6)

1 Open the Adobe Extension Manager and highlight the STOREFRONT 
Converter plug-in in the list of extensions.

2 Click the Remove button.
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3 Click Yes to confirm that you want to uninstall the plug-in.

Converter Windows (InDesign CC and later)

The Convert plug-in for InDesign CC and later consists of two separate tools 
which can be opened from the Window > Extensions menu:

 STOREFRONT Converter: the tool that creates the package

 STOREFRONT Live Preflight: the preflight tool

STOREFRONT Converter

This is where you create the ZIP package. The document is always preflighted in 
the background when you create the ZIP package but you can’t fix the issues.
StoreFront User’s Guide



342 CONVERTER PLUG-IN
This tool consists of the following three panels:

Export Settings Log File: The default location for a log file with details about the conversion. You 
can enter a different location and file name if you want.

Log Detail: Select the level of detail that you want to see in the log file: from 
Debug with the most information, to Verbose, Info, Warning and Error with the 
least information.

Document options: 

 Convert gradient to PDF: Select this check box if the document contains 
complex gradients. Some gradient effects, such as circular multi-tone 
gradients, are not supported by the Online Editor. By converting such 
objects to PDF, their visual appearance remains unchanged in the custom-
izable product.
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 Include hidden layers: Select this check box to include all hidden layers in 
the document in your package.

 Use high resolution for locked layers: Converts everything on the selected 
layer to PDF and places it on the layer. See “PDF Conversion Settings for 
Locked Layers and Images” on page 349.

 Export selection only: Only converts the frames selected in the document.

Export to STOREFRONT Source: This is a list of all the files you have open in InDesign. Choose the 
document you want to convert from the drop-down list.

Locked Layers: This is a list of the layers in the selected InDesign document. 
Select one or more layers that you want to lock. Locked layers are saved as PDFs 
in the package. If you lock the layers here, you cannot edit them in the Store-
Center Online Editor.

Go button: Starts the conversion.

Preferences Language: Here you can change the language of the Converter plug-in.

The Export Settings and Preferences are saved for the next time you open the 
Converter plug-in.

STOREFRONT Live Preflight

The STOREFRONT Live Preflight tool allows you to preflight and fix the document 
while you are working in it, before you create the package.
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1 Choose Window > Extensions > StoreFront Live Preflight to open the 
preflight tool.

2 Open your document and click the Preflight document button to start the 
preflight.

A list of issues is displayed: errors have a red exclamation mark icon and 
warnings have a yellow triangle icon. 

3 Select an issue in the list to display the details and how you can fix the issue.

4 In the Actions column you can click the arrow icon to go to the issue in your 
document.

5 In the Actions column, you can click the spanner icon to open the Fix dialog 
box which suggests ways to fix the issue. Select one of the fixes and click Fix 
or click Cancel to close the dialog box without fixing.

6 Click the Preflight document button again and the issue you just fixed 
should no longer be displayed in the list.

7 Repeat until the critical issues are resolved.

Errors must be fixed to be able to create the package.

NOTE: See “Conversion Recommendations” on page 348 for more 
information. 

Select the Real time preflight check box if you want to see preflight issues while 
editing your document.
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Converter Windows (up to InDesign CS6)

Export for STOREFRONT

 In InDesign, choose File > Export for Apogee StoreFront to start the 
Converter.

InDesign file This is a list of all the files you have open in InDesign. Choose the document you 
want to convert from the drop-down list. You may need to click Refresh List if 
you open new documents while the Converter is open.

Img. preset From the drop-down list you can choose a quality preset for converting TIFFs, 
gradients and locked layers to PDFs as these elements may be too complex for 
processing with the Online Editor.
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Convert all TIFFs to PDF Select this check box if the document has many TIFFs and you want to reduce file 
size. TIFF files are converted into PDFs using the selected Img. preset.

Convert gradients to PDF Select this check box if the document contains complex gradients. Some 
gradient effects, such as circular multi-tone gradients, are not supported by the 
Online Editor. By converting such objects to PDF, their visual appearance 
remains unchanged in the customizable product. The gradients are converted 
into PDFs using the selected Img. preset.

Locked Layers This is a list of the layers in the selected InDesign document. Select one or more 
layers that you want to lock. Use the CTRL key to select multiple layers. Locked 
layers are saved as PDFs in the package using the selected Img. preset. If you 
lock the layers here, you cannot edit them in the StoreCenter Online Editor.

Place as high resolution
files

Select this check box to save the locked layers with a lower compression rate.

Create Zip button Click this button to continue the conversion.
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Preflight Report

 This window is displayed when the conversion is completed and shows the 
results of the conversion. See “Converter Preflight Messages” on page 539 for 
more information about these messages.

More information icon Click this icon to see a popup with more information about the issue and a 
solution.

Select button Click this button to go to the location of the issue in the document.

Type  Warning: The issue is not critical and you can continue saving the package.

 Error: The issue is critical and you must fix the issue before continuing.

Page The page number where the issue is located.

Description Description of the issue.

Show Log Opens a detailed conversion log.

Save Log Saves a detailed conversion log.
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Conversion 
Recommendations

Follow these recommendations when creating your InDesign documents to 
reduce the number of errors and warnings.

Font Usage

The Converter embeds the fonts used in the document in the package. You 
should only use the following supported font formats in your InDesign 
documents: 

 TrueType (.ttf), OpenType TrueType (.otf), OpenType Type 1 (.otf)

Other font formats, such as Type 1 and Online Adobe Fonts, will generate 
errors/warnings during Converter Preflighting. Replace fonts that are in an 
unsupported format by their equivalent TrueType or OpenType version.

Font File Extension

Ensure that fonts are Windows-compatible which means that the file extension 
must be included.

Locked Layers

It is recommended to keep locked layers in the background, with editable layers 
on top. Depending on the layout, it may sometimes be desirable to have locked 
elements in the foreground. If putting a locked layer in the foreground leads to 
visual artefacts in the Online Editor, consider putting those elements in the 
editable layer and locking those frames using the Online Editor.

Color Palette in STOREFRONT Packages

When an InDesign document is exported to a STOREFRONT package using the 
Converter plug-in, this document also contains the color palette - the list of 
colors that were defined in InDesign. However, the Converter plug-in will not 
export colors for which a duplicate exists, i.e. a color with a different name but 
the same color values. So if your InDesign color palette contains two colors, e.g. 
'Warm Yellow' and 'Logo', with the same CMYK values, only the second color will 
appear in the list of colors in the Online Editor. It is therefore recommended that 
each color name has unique color values in the InDesign document.

Import Error Messages

The Online Editor does not support the entire feature set of Adobe InDesign. This 
is quite logical as the Online Editor is a web tool that needs to be accessed quickly 
while Adobe InDesign is a full-blown desktop application. Specific features or 
effects which are not supported by the Online Editor can always be preserved by 
putting the affected frame on a locked layer. During the package creation this 
layer will be converted to PDF, so the desired effect is kept but you will not be 
able to edit it anymore in the Online Editor. See “Converter Preflight Messages” 
on page 539 for more information about these messages.
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PDF Conversion Settings for Locked Layers and Images

The first time you convert an InDesign file to a STOREFRONT package with the 
converter for InDesign CC, the plug-in creates three PDF presets which you can 
modify if you want:

 Converter - Images: This preset defines the settings for the conversion of 
images used in the InDesign file (TIFF, EPS, PSD, AI). The Online Editor 
supports these file types natively but when the conversion is done via the 
plug-in, images are optimized according to their dimensions used in the 
document (300 dpi, at placed dimensions).

 Converter - Locked Layers High Res: This preset defines the settings for the 
conversion of locked layers when the check box "Use high resolutions for 
Locked Layers" is selected.

 Converter - Locked Layers Low Res: This preset defines the settings for the 
conversion of locked layers

To change the settings of these presets in InDesign, choose: File > Adobe PDF 
Presets.

A good reason to change the preset might be to prevent problems with transpar-
encies during the creation of the downsampled low resolution preview PDF from 
the link in the shopping cart. By changing the compatibility settings to PDF 1.3 
you make sure that all transparency is flattened already during the package 
creation.

You can change basically any setting but be aware that your changes will influ-
ence the predefined behavior. Also don't change the name, otherwise the plug in 
will simply create a new one with the original name.
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Online Editor Overview

Once the STOREFRONT Package has been created and uploaded for use as a 
customizable product, administrators can use the Online Editor in StoreCenter 
to fine-tune the document. This may involve:

 adding content

 fine-tuning the design

 setting constraints to control what shoppers can edit

 adding variables (i.e. interactive form fields) to the document

 preparing variable data Excel template (Variable Data Product)

NOTE: You cannot create a document from scratch in the Online Editor. You must 
always start with a STOREFRONT Package.

A light version of the Online Editor is used by shoppers when they customize the 
product on the storefront.

When creating the product, you can choose one of four versions of the Online 
Editor workspace:

 Basic: You have the same extensive editing features as in the Advanced 
version while the shopper can only edit existing frames.

 Advanced: You have extensive editing features to add and edit frames, and 
change the layout of the document. The shopper also has an advanced set of 
features to customize the product.

 Forms: In the Forms tab you can create variables for document form fields. 
To edit the customizable product, the shopper only has to enter information 
in the form input fields. A Variable Data Product always uses the Forms 
version.

 Expert: This workspace combines the Advanced and Forms workspaces and 
enables shoppers to edit certain aspects of the document layout in combina-
tion with the forms functionality.

If you don’t see one of the features described in this section, the document may 
not be set to work with the required version of the Online Editor.
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Prerequisites
You can only open the Online Editor for a customizable product which has 
already been created and appears in the list of products. It is recommended to 
perform this step immediately after defining the customizable product. See 
“Product Types” on page 155 and “Creating Products” on page 157 for more 
information.

 Open/Close the Online Editor

1 On the menu bar, choose Products.

2 Select a company in the Company drop-down list.

3 Highlight a Customizable Product or a Variable Data Product in the Products 
list.

4 Click the Edit button.

5 Choose Online Editor in the list to open the product in the Online Editor.

6 Click the “x” in the top right corner to close the Online Editor.

If you did not save the changes to your document, you are prompted to do so 
before exiting the Online Editor.

Customizable product

Variable data product (VDP)
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Workspace

1 Document workspace with edit toolbar
2 Inline edit toolbar
3 Navigation and view toolbar
4 Workspace tabs: Forms, Objects, Text, Images, Tables, Shapes, Barcodes, Warnings, 

Document

Edit Toolbar The Edit toolbar at the top of the Online Editor is used to add text frames, image 
frames and objects to an existing document. The Edit tools work in conjunction 
with the workspace tabs.

The following tools are available:

Figure 10.83: The Online Editor Workspace

Add a text frame

Insert a table

Add an image frame

Add a barcode

Add a shape

Add a rectangle
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Once a document has been modified, the Save, Revert and Undo/Redo buttons 
are activated.

Related topics: • Basic Editing on page 357

Add a circle

Add a line

* An asterisk indicates that the document has been modified

Pointer: to select a frame

Pointer: to select multiple frames

Create a linked text frame

Break linked test frames

Copy the selected frame

Paste the selected frame

Check the spelling

Browse to the image directories for image variables

Save the document

Revert to the last saved version of the document
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In-line Toolbar When you select a frame or add a new one using the Edit tools, the in-line toolbar 
is displayed in the document workspace, under the selected frame.

The following tools are available, depending on the type of frame you select:

Figure 10.84: Inline toolbar under an image frame

Hides the in-line toolbar.

Edit text mode.

Pointer. Edit frame mode.

Crops an image.

Flips the object back to its original orientation.

Flips horizontally.

Flips vertically.

Flips horizontally and vertically.

Brings the frame to the front.

Brings the frame forward.

Sends the frame back.

Sends the frame to the back.
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Cursor States The cursor may change as you hover over an object frame to indicate that certain 
actions are possible.

Navigation and 
View Toolbar

The Navigation and View toolbar at the bottom of the Online Editor provides 
several ways to inspect all the pages of the document.

The following tools are available:

Deletes the frame.

If the in-line toolbar is hidden, click the Show Inline Toolbar button in the top left corner of 
the workspace.

Indicates that you can move a selected frame.

Indicates that you can rotate a frame.

Indicates that you can resize a frame.

Creates a low-resolution PDF of the document for previewing purposes.

Shows/hides bleed and margins.

Show/hides the Help layer (if created for the current document).

View the document as a flipbook.

Rotate document counter-clockwise (preview only).

Rotate document clockwise (preview only).

Show/hide source of all text frames

Zoom the document so it fits the workspace width.
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Use the Slider or magnifying glass icons to zoom in and out. Alternatively, hold 
down the CTRL key and press the plus or minus keys. 

The Simulate button lets you switch between the following two views in order 
to test the constraints:

 Content Administrator: This is the normal view when working with the 
Online Editor in StoreCenter to create the customizable product.

 End-User: The administrator can switch to this view for a preview of how the 
shopper will see the document in the Online Editor on the storefront. For 
example, if you lock frame resizing for end-users you’ll see that the frame can 
no longer be resized when you switch to End-User view.

Zoom the document so it fits the workspace height.

Zoom to fit the document in the workspace window.
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Basic Editing

These are the basic procedures for editing your document in the Online Editor 
workspace.

 Move, resize, rotate a frame

Text and images are placed in frames in the document.

1 In the workspace, select a frame and make sure the pointer is activated. If you 
selected a Text frame, click the Edit Frame button on the in-line toolbar if this 
is not the case.

2 Hover over the frame and the cursor assumes the following states:

TIP: Press the CTRL key to 
temporarily disable the snap 
guides and automatic 
placement.

 black hand: You can move the frame; you can use the green snap guides 
to align the frame with other frames in the document or the page edges.

 black arrows in the corners and along the sides: You can resize the frame.

 white hand to rotate: You can rotate a frame around its center.
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 Place/Edit text

1 On the Edit toolbar, click the Text tool.

A new text frame is placed on the document.

OR

Select a text frame in the document and make sure the text cursor is 
activated. Double-click in the frame or click the Edit Text button on the in-
line toolbar if this is not the case.

The cursor is positioned in the text frame and a black hand icon is displayed 
to the left of the selected frame.

Now you can edit or add text, or add form variables.

In the Text tab, you can inspect and edit the properties of the selected text 
frame. See “Forms Tab” on page 402 and “Text Tab” on page 431 for more 
information on formatting text.

2 Hover over the text frame and the cursor assumes the following states:

 black arrows in the corners and along the sides: You can resize the frame.

 black rotate arrow: You can rotate the text frame around one fixed point.

TIP: Press the CTRL key to 
select a frame that you know 
is hidden under another 
frame.

3 To move the text frame while in edit mode, hover over the black hand on the 
left of the frame until the cursor also changes to a hand.

At this point you can move the text frame.
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 Apply a character style to text

1 Double-click in a text frame or click the Edit Text button on the in-line 
toolbar.

2 Highlight the text you want to style.

3 Open the Character Styles panel and double-click a style in the list to apply it 
to the selected text. See “Text Tab” on page 431 for more information on 
styles.

 Apply a paragraph style to text

1 Double-click in a text frame or click the Edit Text button on the in-line 
toolbar.

2 Position the cursor in the paragraph you want to style.

3 Open the Paragraph Styles panel and double-click a style in the list to apply 
it to the paragraph. See “Text Tab” on page 431 for more information on 
styles.

 Indenting and tabs

In Edit Text mode, an administrator will see a ruler at the top of text frames for 
formatting paragraph indents, first line indents and tabs. This is similar to what 
you have in a regular word processor.
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1 Left paragraph indent (bottom marker)
2 First line indent (top marker)
3 Tab stop
4 Right paragraph indent

 Click the paragraph left indent marker (1) to indent the entire paragraph in 
which the cursor is positioned.

 Click the first line indent marker (2) to indent the first line of the paragraph 
in which the cursor is positioned.

Figure 10.85: Text with various paragraph indents using tabs, and numbers aligned on a decimal point.
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 Click in the ruler to place a tab stop marker (3). Select the tab stop marker to 
display the tab stop settings panel where you can set the values for a tab stop:

 Type: left aligned, centered, right aligned or decimal

 Align on: If you selected Decimal as tab type, you can also set the 
character to align on. This is used typically for numbers where you can 
choose to align on a decimal comma or point.

 Leader Char.: Enter a leader character of your choice, for example a dash, 
full stop, etc. This character is used to fill the space to the tab stop.

 Click the paragraph right indent marker (4) to indent the entire paragraph in 
which the cursor is positioned.

 Hyphenate text

1 Select a text frame and open the Text Frame Settings panel.

2 Choose a language in the Text Language drop-down list and click the 
Hyphenate button.

TIP: You do not need to 
select the text for these 
tasks.

3 Click the Unhyphenate or Undo button to revert to text which is not 
hyphenated.

 Check spelling

1 Select a text frame in the document and make sure the text cursor is 
activated. Double-click in the frame or click the Edit Text button on the in-
line toolbar if this is not the case.
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2 Click the Check Spelling button.

The Check Spelling button acts as a toggle, enabling or disabling the spelling 
check. After you enable the spelling check, squiggly lines appear beneath the 
misspelled words.

3 Configure the text language in the Text Frame Settings panel of the 
workspace tab TEXT. Select of the language from the drop-down list you 
want to check the spelling.

NOTE: Text Language options are only visible when spell checking is enabled.

4 Place the cursor on a misspelled text, suggestions appear below the word.
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Select a suggestion to include in your document. If you don't agree with any 
of the suggestions, select Ignore All.

5 Click Close and the Save button when you’ve finished the spelling check.

 Align text vertically

By default, text is aligned vertically at the top of the text frame.

1 Select a text frame and open the Text Frame Settings panel.

2 In the Vertical Align drop-down list, choose Top, Middle, Bottom or Justify. 
Choose Justify for example to distribute the text vertically within the frame.

 Insert an in-line frame in a text frame

An in-line frame is a text, image or other frame that is positioned inside a text 
frame. The in-line frame is linked to the text and moves up or down as new text 
is added.
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1 Select a text frame and make sure you are in Text Edit mode.

2 In the Text tab, open the Text Frame Settings panel.

3 In the Insert - Select frame to insert drop-down list, choose the type of 
frame you want to insert.

4 Select the in-line frame and edit as required.

NOTE: The containing text frame must be selected in order to edit the in-line 
frames.

 Link (threading) text frames

Text frames can be linked if you want text to flow automatically from one frame 
to another. You can link two or more text frames to create a thread.

1 On the Edit toolbar, click the Link tool.

2 Select the first text and then the second text frame to link them.

The frames are now linked with a red bar.
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When you type in the first text frame and the frame is full, the text flows into 
the second frame.

3 To unlink the text frames, click the Unlink tool and click in one of the linked 
frames.

NOTE: It’s recommended to link to a newly created text frame.

4 When you’ve finished linking/unlinking, click the Pointer tool to continue 
working.

Figure 10.86: Text frame with the yellow overflow icon (left page); text frame with text flowing to a linked text frame (right 
page).
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 Use a custom baseline grid

The custom baseline grid allows you to override the document grid and apply 
custom line spacing to a paragraph of text.

1 Position the cursor in the text you want to modify and in the Text tab, open 
the Paragraph Settings.

2 Select the Align to baseline check box.

3 This applies the document grid to the paragraph; this may be different than 
the text frame grid.

4 Click the Edit Frame button on the in-line toolbar and open the Frame 
Custom Baseline Grid panel.

5 Click the Use Custom Grid check box and specify the grid as required. See 
“Frame Custom Baseline Grid” on page 435 for information about these 
settings.

Figure 10.87: Custom baseline grid with offset from top of frame (Show Guides selected)
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 Place/Edit an image

1 On the Edit toolbar, click the Image tool.

A new image frame is placed on the document.

2 Click the Assign Image button to insert an image.

The Select Image dialog is displayed.

3 Select a library in the Assets From drop-down list.

4 Choose an image from the existing assets and double-click the image to insert 
the image in the frame in your document.

OR

Click the Browse for local file button to select an image of your choice.

The image is inserted in the frame and you will see this image in the Assets 
list the next time you insert an image. See “Images Tab” on page 435 for more 
information about image libraries.

5 You can now use the Crop and Flip tools to position the image in the frame, 
and subsequently any of the other in-line tools to position the frame in the 
document.

6 Click the Crop tool.

The Crop dialog is displayed and you can choose how you want to fit and 
anchor the image inside the frame.

7 When you have obtained the desired result, click Close to return to the 
document.

8 Click the Flip tools to flip the image horizontally, vertically or both, within 
the frame.

See also: How to use image libraries

 Wrap text around an image

1 Insert a new image or select an existing image in your document.

2 Open the Wrap Settings panel in the Objects tab.
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3 Select the Wrap Text check box.

4 In the Type drop-down list, select Flow Around.

The text now flows around both sides of the image frame.

OR

Select Wrap Both Sides.

The text is now cleared on both sides of the image frame.

You can also clear the text on the left or right side of the image with the Wrap 
to left and Wrap to right options in the drop-down list.

5 You can increase the clearance around the image by entering a value in the 
Left, Right, Top and Bottom fields.
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 Place/Edit a free-form shape

1 On the Edit toolbar, click the Shape tool.

A new frame is placed on the document; you can move, resize or rotate the 
frame as desired.

OR

Select a shape frame in the document.

2 In the top toolbar or in-line toolbar, click the Edit Path button.

Extra path editing tools are displayed in the top toolbar of the workspace.

3 Click the Close Path Editor button to return to the document.

 Place/Edit a rectangle, circle or line

 On the Edit toolbar, click the Rectangle, Circle or Line tool.

A new frame is placed on the document; you can move, resize or rotate the 
frame as desired.

OR

Select an existing frame in the document to edit it.

Select an anchor point to move it.

Add an anchor point: Position the cursor on the path and click to add a new anchor point.

Remove an anchor point: Position the cursor on an anchor point and click to remove it.

Convert an anchor point: Position the cursor on an anchor point and drag it to add a Bézier 
handle. Double-clicking an anchor point that already has Bézier handles converts it into a 
regular anchor point.

Add a rectangle.

Add a circle or oval object.

Add a line.
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 Set constraints and lock a frame

NOTE: You can only set constraints for existing frames, not for new frames added 
by the shopper.

1 Select an existing frame in the document or add a new frame.

2 Make sure the Simulate button is set to Content Administrator view.

3 Open the Object Constraints panel in the Objects tab.

4 At the top of the tab, set the minimum and maximum width and height of the 
object and where it can be moved in the document. See “Objects Tab” on 
page 419 for more information.

5 Set the Frame Constraints. See “Objects Tab” on page 419 for more 
information.

For example, lock all frame properties for the end user, except Content, so the 
shopper can only change the content of the frame but not change its position 
in the design.

6 Set the Frame Content constraints. See “Objects Tab” on page 419 for more 
information.

For example, set all constraints to Limited selection for end-users and 
select None for each property so the shopper cannot change any of these 
design elements.

NOTE: If you choose a limited selection for a property, you must select at least 
one option for that property, otherwise all the options remain available.

7 Click the Simulate button and switch to End-User view to check the effects of 
the constraints.

8 Click the Save button on the workspace toolbar to save your changes.

9 Close the Online Editor.

 Set Border and Fill properties

1 Select an existing frame in the document or add a new frame, and open the 
Border and Fill panel in the Shapes tab.

2 Choose the settings as required. See “Shapes Tab” on page 447 for more 
information.

The settings are applied immediately to the object.
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 Assign a shape to Text, Images and Shapes

1 Select an existing Text, Image or Shape object in the document or add a new 
object, and open the Border and Fill panel in the Shapes tab.

2 Click the Assign Shape button and double-click one of the shapes to apply 
the shape to the object.

Figure 10.88: Example of a shape assigned to a free-form shape frame, with fill and border 
colors.
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Advanced Editing

The Online Editor is also used for the following, more advanced editing features:

 “Tables” on page 372

 “Form Field Variables” on page 373

 “Autofill Forms” on page 380

 “Variable Data Processing (VDP)” on page 382

 “Generate QR Codes” on page 394

 “Dynamic Layout Function Formulas” on page 398

Tables You can edit tables that are present in your STOREFRONT package and which were 
created in InDesign, or you can create tables from scratch.

 Insert a new table

1 Insert a new table frame by clicking the Table icon in the toolbar and position 
the table on the page.

It’s possible that the frame of the table is not visible. In the Table tab, open the 
Table Settings panel and click the Select Table Frame button to highlight the 
frame of the table.

2 Click in the table and in the Table tab, open the Table Settings panel and 
choose Border > Yes, and Default Cell Border > Yes, so you can see the table 
and cell borders of the new table.

3 In the Table Row and Table Column panels, add the number of rows/
columns that you require for your table.

4 Go back to the Table Settings panel to format the rows and columns as 
required with fill and borders.

5 To format and align the text in cells, go to the Text tab.
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 Delete a table

1 Select the table you want to delete.

2 It’s possible that the frame of the table is not visible. In the Table tab, open the 
Table Settings panel and click the Select Table Frame button to highlight the 
frame of the table.

The in-line toolbar is displayed with a delete icon.

3 Click the delete icon to delete the table.

Form Field 
Variables

Form input provides additional control for customizable products. The shopper 
enters information in the interactive form fields of the document. These form 
fields are located in the Forms tab. Each form field is a variable that you, as an 
administrator, can set up in the Forms tab of the Online Editor.
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NOTE: Form input fields can be combined with editable text frames in the same 
document.

Related topics: • Variable Actions on page 458
• Variable Actions Samples on page 465

 Insert variables (fields) in a forms document

This procedure is only possible in the Forms and Expert workspaces which 
include the Forms tab. See “Forms Tab” on page 402 for more information.

1 Place a new text frame on the document.

2 Click the Forms tab to create the variables (form input fields) for your form.

3 Click the Add button (plus icon) to add a variable to the list.

4 Click the Edit button (pencil icon) next to the variable to set up/edit the 
variable.
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The Settings dialog is displayed.

5 Enter a Name and Display Name, and choose a Variable Type.

6 Complete the General and Type Specific tabs. See “Variables Settings Editor” 
on page 406 for more information.

7 Click Close to close the Settings dialog.

The variable is added to the Variables list.

You have created a variable which can now be used in multiple text frames.

8 Add more variables as required.
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9 Choose a default text direction:

 Left to Right

 Right to Left

10 Double-click in the text frame or click the Edit Text button on the in-line 
toolbar.

At the insertion point you can now insert the variable.

11 Select the variable you want to insert in the Variables list and click the Insert 
Variable button.

OR

Double-click the variable in the list to insert it in the document.

The variable is inserted in the text frame. The variable name starts and ends 
with a “%” character.

OR

Type the variable name.

12 If required, click the Insert Text Condition button to insert a condition.

13 In the Step 2: Assign Variables pane, select the Selected frame contains 
variables check box to enable the variables in the text frame. See “Step 2: 
Assign Variables Panel” on page 404 for more information.
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NOTE: If this check box is not selected, the variable names are displayed as 
text and it is not possible to enter data in the form fields on the storefront.

This option also activates the Toggle Source button on the in-line toolbar.

TIP: Select text in your 
document and click the 
Insert Variable button to 
insert a variable with the 
selected text as sample text.

14 In the Step 3: Initialize Form Variables pane, you can enter sample text in 
the form fields or leave the form fields blank. See “Step 3: Initialize Form 
Variables Panel” on page 405 for more information.

If you enter sample text, use the Toggle Source button to switch between the 
variable source code and the sample text.

15 Repeat the procedure for all text frames with variables.

16 Click the Save button on the workspace toolbar to save your changes.

17 Close the Online Editor and add the product to a store.

NOTE: If the product has already been assigned to a store, the changes you 
made are automatically retrieved for this product on the storefront.

18 Inspect the form on the storefront.

Figure 10.89: Variables in a document - Online Editor view
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Inspecting the form on the storefront is necessary to ensure that shoppers can 
use the form fields as expected and submit the order. See “Testing Customiz-
able Products” on page 456.

 Add an image variable to a form

An image variable adds a drop-down list to the form where the user can select an 
image to be inserted in the document.

1 Create a new variable for the document and choose Image as Type.

2 Close the New Variable Settings as no other type-specific settings need to be 
set.

3 Draw an image frame in the document.

4 To link the image frame with the variable, select the frame in the document 
and then click the Attach Image Variable button in the Forms Step1: Create 
Variables panel.

Figure 10.90: Form input fields on a storefront – display names

Figure 10.91: Filled form input fields on a storefront
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5 All the image buttons on the form must be associated with one of the image 
libraries. To do this, click the document tool in the top toolbar and then the 
folder button to browse to a directory. See “Images Tab” on page 435 for 
more information about managing image assets and the different image 
directories. The images in the specified directory can be selected by the user 
via a drop-down list on the form. The selected image is placed in the 
document. 

Alternatively, the user can browse to a local folder on his computer to select 
an image.

NOTE: Browsing for a local file is only supported for image variables that are 
linked to the "My Images" directory.

NOTE: The constraints that apply to the inserted images are set on the image 
frame. See “Objects Tab” on page 419. It is recommended to lock the frame 
so the shopper cannot delete the image from the image frame while the 
variable still refers to the image; otherwise the image is reloaded when the 
document is reopened.

 Add a button bar to a form

1 Create a new variable for the document and choose Button Bar as Type.

2 Click the Add button (plus icon) to add a variable item. This is the actual 
button.

3 In the Label box, enter the text you want to display on the button.

4 Optionally, enter a tooltip (a message that appears when the user hovers over 
the button in the form).

5 Optionally, choose an icon. If you choose an icon, the button will be the icon 
instead of a button with a label.

Figure 10.92: Image variable on a form
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6 Click the Edit button to open the Action editor where you can create the code 
for the action that you want to assign to the button (e.g. clear all input fields: 
set variable x value = string <empty>). The action will be activated when 
the user clicks the button. See “Variable Actions” on page 458 to create 
actions.

7 When you’ve finished creating your action, close the Action editor.

8 Click the Add button (plus icon) to add another variable item if you want to 
add another button to the button bar and repeat the procedure for as many 
buttons that you want.

9 Close the New Variable Settings and finish the procedure to add the variable 
to the form.

Autofill Forms The autofill form feature uses the information already available in a shopper’s 
user profile to autofill form field variables in a customizable product. In other 
words, a shopper logs in to a storefront, opens a document for editing and her 
personal details (name, phone number, etc.) are already filled in. In addition, if 
the shopper changes the value for this variable in a document, the new value is 
remembered for all subsequent documents using this variable.

 Set up autofill form fields

1 Create a document with form field variables as explained in “Insert variables 
(fields) in a forms document” on page 374.

2 For the name of the variables in Variable Settings dialog, you must follow a 
convention to retrieve the values which are available in the user profile. 

Figure 10.93: Button Bar variable on a form
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The following values can be retrieved:

Create as many variables as required using these user profile variables. 
Ideally, you will enter a different name for the Display Name of your variable.

3 Save the document, add it to a store and test that the results are as expected 
by editing the document in the online editor on a storefront.

The retrieved values are filled in automatically in the document and in the 
form fields. If necessary, the autofill values can also be edited for this 
document. The edited values are remembered for subsequent documents 
created by the user. 

User profile variable name Value returned (autofill)

ASF_COMPANYNAME company name

ASF_FIRSTNAME first name

ASF_LASTNAME last name

ASF_NAME name

ASF_EMAIL e-mail address

ASF_PHONE phone number

ASF_FAX fax number

ASF_STREET1 street line 1

ASF_STREET2 street line 2

ASF_ZIPCODE zip code line

ASF_ZIP4CODE zip code line 2

ASF_CITY city

ASF_SUBCOUNTRY sub country line

ASF_COUNTRY country

ASF_USERMISID MIS ID code that identifies the user

ASF_COMPANYMISID MIS ID code that identifies the company
StoreFront User’s Guide



382 ADVANCED EDITING
NOTE: The fields are filled with values retrieved from the profile of the user 
who has log in to a storefront. This means you can only test the document by 
logging in to a storefront.

NOTE: A user can have more than one address in the address book. The 
address related user profile variables will be retrieved from the first address 
in the address book that matches the first and last name of the user who is 
currently logged in. If no matching address is found, then the variables will 
not retrieve a default value from the address book.

NOTE: The user profile variable names all start with prefix "ASF_" (which is 
short for ApogeeStoreFront). When you create other variables in the Online 
Editor we advice not to use this "ASF_" prefix in order not to clash with 
potential new variables that might be added to future versions and also in 
order to have a clear distinction for yourself between custom variables names 
and variables names created by the system.

Variable Data 
Processing (VDP)

NOTE: This feature may not be included in your license pack.

This procedure is only for a Variable Data Product, a special kind of Customiz-
able Product which is designed for variable data processing (VDP) and typically 
used to personalize publications. The following are examples of VDP:

 50 names to create 50 sets of business cards

 150 addresses to print fashion posters that point customers to the nearest 
outlet

 500 letters with a name and address for a direct marketing campaign

Variable Data Products use the Forms or Expert workspace. See “Forms Tab” on 
page 402 for more information. In addition, when you save a Variable Data 
Product, a variable data template (Excel spreadsheet) is created which the 
shopper can use to enter the variable data. This variable data file is subsequently 
uploaded and the data are merged with the product.

In the following sections you create a Variable Data Product and then simulate 
an order to retrieve the variable data template and generate a series of 
documents with merged variable data.
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NOTE: You cannot use Variable Actions in a Variable Data Product.

 Insert variable data fields for a Variable Data Product

 STEP 1: Create a Variable Data Product

1 Create a new Variable Data Product as explained in “Creating Products” on 
page 157.

NOTE: The Variable Data Product type is only available if you have the 
required license pack.

You can use templates based on all base types except Unbound Flat - Variable 
Size. For bound products you must define a fixed number of pages. Pages will 
not be added if the variable content does not fit the available space.

2 On the first page of the wizard you need to select how the shopper will be able 
to choose a quantity. In the Miscellaneous panel, choose one of the following 
options from the Quantity drop-down list:

 Specified in the Excel file: The shopper uploads an Excel file that includes 
a column for the quantity of each row (column header label is 
ASF_Quantity). The quantity can be different for each row.

 Specified in the product page: The shopper specifies, on the product page, 
a quantity for each row in the uploaded Excel file. The quantity is the 
same for all rows.

 One copy per record: One unit is produced for each row in the Excel file. 
This option can be used for direct mail merging of names and addresses.

3 Select the check-box Add “ASF_EXCLUDE” field to the Excel file to add an 
additional column with heading ASF_EXLCUDE to the Excel file so rows can 
StoreFront User’s Guide



384 ADVANCED EDITING
be excluded from processing, for example if you only want to process some 
of the rows in a large master file. See “Downloading/uploading the variable 
data file” on page 386.

4 Continue with the wizard and save the new product.

A Variable Data Product is indicated with the following icon in the list of 
products:

 STEP 2: Edit this product in the Online Editor.

1 Create the form fields for your variable data document as explained in “Insert 
variables (fields) in a forms document” on page 374. Alternatively, save an 
existing document with form fields and upload this document when creating 
the Variable Data Product. See “Package Output” on page 452.

Special care is required when creating the form fields because the field names 
are used to create the variable data template (Excel file) which is made avail-
able for downloading by the shopper. 

2 Select the variable in the list and click the pencil icon to open the Variable 
Settings.

3 In the General tab of the Variable Settings dialog, make sure the Name does 
not contain any spaces or forbidden characters.

NOTE: Do not use spaces or the following forbidden characters for the Name 
of the variable: / \ : *  " < > |
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4 For Type, you can select any of the available options (Short Text, Long Text, 
Formatted Text, Image, Date, etc.) except Divider.

5 Make sure the Push changes to datasource check box remains selected.

6 Click Close to close the Variables Settings dialog.

7 Do this for all the form field variables in the document.

8 In the Assign Variables panel, you can fine-tune how the variable data will be 
displayed. For example you can apply copyfitting, however, remember that 
additional pages will never be created to accommodate overflowing content.
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9 Save the document.

STOREFRONT now saves a variable data template that the shopper can use to 
supply variable data.

10 Add the product to your store and go to the storefront to check the variable 
data template.

 Downloading/uploading the variable data file

The variable data template (Excel spreadsheet), which is automatically created 
when you save your Variable Data Product, can only be downloaded from the 
storefront. In the following procedure you will simulate how a shopper orders a 
Variable Data Product to retrieve the data template file, enter some variable data 
in the spreadsheet, and check the results.

1 On the storefront of the store where you added the Variable Data Product, 
simulate an order for this product.

2 On the Place Order page, you have two options for downloading the variable 
data template (Excel file):
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Click the Excel data template Download link under Templates to download 
the file directly.

OR

Click the Upload Data & Start Editing button and subsequently the Excel 
data template Download link.

An Excel file with the name of the product is saved to your Downloads folder.

3 Go to your Downloads folder and open the Excel file.
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The spreadsheet contains 2 worksheets:

 Variables: This is the worksheet where the actual data must be entered. 
Do not change the first row of cells because these are the column headings 
that map the data to the variable names used in your document. However, 
you can change the order of the columns if you want. Each row in this 
sheet corresponds to a record of your variable data. A tool tip above each 
column heading displays the variable settings for that particular column: 
max. line length, mandatory, etc. Warnings are generated if these settings 
are not respected.

NOTE: The ASF_EXCLUDE value can be used to exclude a number of 
certain rows when parsing the VDP data. In the ASF_EXCLUDE column, 
enter ‘1’ to ignore the row, or leave empty or enter ‘0’ to process the row. 
See “Insert variable data fields for a Variable Data Product” on page 383.

 Help: This worksheet provides an overview of the variable settings and 
instructions for this particular product, including the maximum number 
of data rows (records) allowed.

4 Enter your variable data in the Variables worksheet and save the file.
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NOTE: If the Variable Data Product has Quantity set to Specified in the Excel 
file, you can specify the quantity for each record in the first column (ASF 
Quantity).

5 Go back to the Product Page and click the Upload Data & Start Editing 
button and subsequently the Choose File button.

6 Browse to your variable data file (Excel file, both XLS and XLSX formats are 
supported) and upload it.

If your variable data includes images, upload a ZIP file containing those 
images either in the same folder as the spreadsheet or in a sub-folder speci-
fied in the spreadsheet.

7 After validation, the product opens in the Online Editor.

NOTE: See “Troubleshooting the variable data upload” on page 393 if the 
upload is not successful.
StoreFront User’s Guide



390 ADVANCED EDITING
The variable data records are displayed in the Uploaded Data panel of the 
Variables tab with the first record displayed in the Form Input panel.

8 Click the Previous and Next buttons to navigate up and down this list.

The variable data is displayed in the document and you can check for each 
record whether the layout is correct.
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9 If you have many records, you can select the Filter check box to see the 
records with the shortest and longest values for each field. 

Again, this is handy to check that text is not overflowing.

You can also set a custom value to filter on the specified number of digits, for 
example, to check phone numbers.

10 You can edit and fine-tune the variable data as required in the Form Input 
panel.
StoreFront User’s Guide



392 ADVANCED EDITING
11 Save the document to confirm your changes and proceed to the Shopping 
Cart Items page.

Any modified data is saved with the document.

12 On the Shopping Cart Items page, click the PDF Preview link to check how the 
variable data has been merged with the document.

Your default PDF reader opens a PDF that contains the different instances of 
your variable data document.

NOTE: For the sake of performance, the PDF preview does not contain all the 
instances of the merged document. The number of merged documents that 
can be previewed depends on the document in question.

13 On the Shopping Cart Items page, you can also re-open the document in the 
Online Editor to edit the document and/or the variable data.

14 On the Shopping Cart Items page, you can also download the variable data 
Excel file for future reference.
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NOTE: The Excel file you download here is the one you edited and contains 
the variable data.

15 Click the Checkout button to proceed to checkout.

 Troubleshooting the variable data upload

Special care is required when a shopper prepares the variable data file for 
merging data with a document. This file is based on the template he downloads 
on the Product page of a storefront. The file can only be used for the product it 
was initially created for.

When a shopper uploads the Excel file, STOREFRONT validates the file to ensure 
the variable data can be merged with the document. If the validation fails, a 
dialog is displayed with a link to your rejected variable data file. This file can be 
opened and the columns and cells that contain incorrect data are highlighted in 
red. Shoppers should be informed about the following recommendations:

 Do not edit the header rows (row 1 on the Variables worksheet).

 Do not exceed the maximum number of records (data rows in the Excel file). 
The maximum number of records is specified on the Help worksheet in the 
Excel file you download.

 Do not exceed the maximum number of characters and other constraints 
which are displayed in the cell tool tips.

 Never leave a cell empty if the data is mandatory.

 How are VDP orders processed in Apogee Prepress?

 If a single copy is printed of every record:

 For unbound products either one single job containing all pages is created 
or multiple jobs are created. The latter happens if the order item exceeds 
100 records.

 For bound self cover products a separate job with 1 part (Body) is created 
for every record.
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 For bound separate cover product a separate job with 2 parts (Cover and 
Body) is created for every record.

 If multiple copies are printed of each record:

 For unbound products either multiple JDF Parts are combined in one job 
or multiple jobs are created. The latter happens if the order item exceeds 
100 records.

 For bound self cover products a separate job with 1 part (Body) is created 
for every record.

 For bound separate cover products a separate job with 2 parts (Cover and 
Body) is created for every record.

 If a VDP job is split across multiple prepress orders, its descriptive name will 
indicate this, e.g. ‘VDP Direct Mailing [1-100 of 364]’ or ‘Summer Campaign 
[1 of 4]’.

Generate QR Codes Quick Response (QR) codes are used on printed media to quickly read informa-
tion into mobile devices for further processing. The following are some examples 
of the information that can be encoded:

 URL: points to a website; example:

http://www.ECO3.com

 geolocation: points to a location; example

geo: 51.172852 ,4.466523 

 E-mail: provides an address for sending an e-mail message; example:

mailto: info@ECO3.com

 SMS: provides a phone number for sending a text message; example:

sms: [phone number]

 calendar event: adds an event to a diary; example code:

BEGIN:VEVENT
SUMMARY:Conference
DTSTART:20120411083000
DTEND:20120411173000
END:VEVENT
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 vCard: adds a person’s name and details to a list of contacts; example code:

Visit http://en.wikipedia.org/wiki/VCard for more information about 
vCards.

 and many more.

TIP: Watch the online 
training video on this topic 
(YouTube).

This feature can be combined with variables to allow a shopper to input the 
details in a form and create the QR code.

 Generate a QR code in a barcode frame

This procedure is only possible in the Forms and Expert workspaces which 
include the Barcodes tab. See “Barcodes Tab” on page 448 for more information.

1 In the Forms workspace, click the Barcode tool on the Edit toolbar.

A new frame is placed on the document; you can move and rotate the frame 
as desired.

2 In the Barcodes tab, select QR CODE in the Type drop-down list and format 
as required.

3 Select a variable in the Variable drop-down list (only visible if variables have 
been defined, for example E-mail).

BEGIN:VCARD
VERSION:2.1
N:Doe;John
FN:John Doe
TITLE:CEO
ORG:Sundiver
EMAIL:John@sundiver.com
URL:www.sundiver.com
END:VCARD
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The value entered for this variable, in the customizable product, by the 
shopper will be inserted in the generated QR code.

OR

In the Value box, enter the syntax for the QR code, for example, a vCard 
which allows readers to add a person’s name and details to a list of contacts.

This syntax may include one or more variables combined with static text. 
Variables are enclosed in ‘%’ signs. For example, the code for a vCard which 
uses variables for all the contact details except the name of the company in 
the e-mail address, and the company URL, would look like this:
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4 Click Apply.

The QR code with vCard information is added to the form. You can scale the 
QR code if it appears too large on your document.

When a shopper enters his/her personal details in the form, these will be 
added to the QR code. The same variables can be used for the visible 
information.

5 You can edit the settings by selecting the barcode frame and clicking Apply 
again to re-apply your changes.

6 Click the Save button on the workspace toolbar to save your changes.

7 Close the Online Editor.

Check that the form input fields work as expected on the storefront and test that 
the QR code can be scanned properly.

BEGIN:VCARD
VERSION:2.1
N:%Last%;%First%;;;
FN:%First% %Last%
TITLE:%Title%
ORG:%Company%
ADR:;;%Street%;%City%;;%ZIP%;%Country%
TEL;HOME:
TEL;WORK:%Phone%
TEL;CELL:%Mobile%
EMAIL:%First%@sundiver.com
URL:www.sundiver.com
END:VCARD
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Related topics: • Special characters in QR codes

Dynamic Layout 
Function Formulas

The Dynamic Layout feature allows you to create documents whose objects are 
positioned using relative values with formulas, as opposed to a static layout with 
absolute values and anchors.

NOTE: Changing an anchoring setting will instantly update the corresponding 
dynamic layout setting, however, changing the dynamic function breaks the link 
with applied anchor settings. 

1 Click the function buttons (f) next to the various property fields to display the 
formula field.

If a warning is displayed that the link with currently applied anchor settings 
will be broken, click Yes to continue.

2 Enter a formula to specify the object’s location dynamically. The formula will 
refer to other element properties and variable values:

Figure 10.94: A card completed on a storefront: the QR code contains the same form input 
variables as for the visible information
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 Supported operators in formulas

 Reference to other elements in formula

Frame tag names: By typing the frame tag followed by a dot and the name 
of the property you want to reference. If frame tag contains a space or 
special character, the frame tag can still be used in the function but must 
be put between brackets. e.g.: [My frame tag].X

Page: By typing “Page” followed by a dot, and the name of the property 
you want to reference. e.g.: Page.Width

Paragraph tag names within a text frame: A text paragraph can be tagged, 
and can also be referenced in a Dynamic Layout function. This is possible 
by first typing the name (tag) of the frame, followed by a dot, followed by 
the name of the paragraph (tag). e.g.: [My frame 
tag].MyParagraphTag.Bottom

Variable: Variable types Number and Coordinate can be used inside a 
function.

+ adding

- subtracting

* multiplying

/ dividing

() parentheses
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Refer to the variable by simply typing the name of the variable, or by 
specifying variable.value. Both will resolve to the value of the variable. 
e.g.: [My Number variable]

NOTE: Note that functions, tags and references are case insensitive.

 Properties

 Self: When creating a function for a certain frame in which you want to 
use a property of that particular frame, you can use the tag of the frame, 
but you can also use "self". e.g.: Y = page.height - self.height

X The X position of the referenced rotated frame (note reference 
point) (or 0 for page)

Y The Y position of the referenced rotated frame (note reference 
point) (or 0 for page)

Top The Y value of the top of the referenced rotated frame (or 0 for 
page)

Bottom The Y value of the bottom of the referenced rotated frame or 
page height

Left The X value of the left of the referenced rotated frame (or 0 for 
page)

Right The X value of the right of the referenced rotated frame or page 
width

CenterY The Y value of the center of the referenced rotated frame or 
page

CenterX The X value of the center of the referenced rotated frame or 
page

Width The width of the referenced frame or page (note value is scaled)

NonScaledWidth The non scaled width of the referenced frame

Height The height of the referenced frame or page (note value is scaled)

NonScaledHeight The non scaled height of the referenced frame

Rotation Rotation of the frame (note doesn't exist on inline frames)

ScaleX X Scale of the frame

ScaleY Y Scale of the frame
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 Specific predefined functions

 Units: The supported units are millimeters, inches, points, pixels (or mm, 
in, pt, px). If no unit are specified, the Dynamic Layout engine will assume 
the value is in points. Multiple units can be used within a single function. 
e.g.: frameA.width=50mm+10in+5pt

 Errors: Invalid formulas are displayed in red with a warning; you need to 
correct the syntax.

Related topics: • Object Location on page 422
• Anchors on page 423
• Customizable Product with User-Definable Size on page 508

MinMax(min, max, 
input)

Clamps a given value between a minimum and maximum value.
e.g. MinMax(300, 700, myVariable)
When the width of myVariable is lower than 300, the function 
will return 300.
If the width is above 700, the function will return 700.
If myVariable is somewhere between, it will return the actual 
value (e.g. 450)

ClampMin(min, 
input)

If the input value is less than the minimum, return the mini-
mum value otherwise return the input value

ClampMax(max, 
input)

If the input value is greater than the maximum, return the maxi-
mum value otherwise return the input value
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Workspace Tabs and Panels

The workspace tabs contain the settings for the different objects.

 Click a Tab header to open a Tab.

 Within the tabs, click the panel headers to open/collapse the individual 
panels.

The following tabs are available:

 “Forms Tab” on page 402

 “Objects Tab” on page 419

 “Text Tab” on page 431

 “Images Tab” on page 435

 “Table Tab” on page 447

 “Shapes Tab” on page 447

 “Barcodes Tab” on page 448

 “Warnings Tab” on page 450

 “Document Tab” on page 452

Forms Tab The Forms tab is only visible in the Forms and Expert versions of the workspace 
where it is displayed as the first tab.

The 3 panels on the Forms tab are the steps of a wizard to help you create and 
activate the form variables (i.e. the interactive form fields):

Figure 10.95: The Text tab selected with all settings panels collapsed.
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 “Step 1: Create Variables Panel” on page 403

 “Step 2: Assign Variables Panel” on page 404

 “Step 3: Initialize Form Variables Panel” on page 405

Step 1: Create Variables Panel

This is the first panel to be completed when creating a forms document. 

Default text dir. Choose Left to Right or Right to Left for the text direction of the variable.

Insert Variable This button inserts a variable from the Variables list in the document.

Insert Text Condition A variable to show/hide content: empty value = False; filled value = True.

Example 1: Insert the variable as a check box whereby the static text entered 
between the if and endif tags is only displayed if the check box is selected by 
the shopper.

%if:Company Name-USA% Sundiver Incorporated %endif:Company Name-USA% 

Example 2: The e-mail line is not displayed if no e-mail is entered.

%if:Email% Email: %Email% %endif:Email% 

Figure 10.96: Example of a Variables list
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This panel also provides access to the Variable Settings Editor. See “Variables 
Settings Editor” on page 406 for more information.

Create Variables Tools

Step 2: Assign Variables Panel

This is the second panel to be completed when creating a forms document. This 
pane is activated if a variable is selected in the document.

Flatten All Variables Removes all the variables.

View Mode You can switch between 2 view modes:

Preview: displays the sample text for the form fields

Source: displays the source code of the variables

Edit Story Displays the text of the selected frame in a full-page editing window on the right, 
making it easier to edit variables in a long article which may span multiple pages.

Selected frames contain
variables

This check box must be selected to activate the variables in the selected frame.

NOTE: If this check box is not selected, the variable source code is displayed on 
the input document on the storefront and the shopper cannot edit the form 
fields.

Creates a new variable and adds it to the Variables list.

Deletes the selected variable from the Variables list.

Moves the variable up in the Variables list.

Moves the variable down in the Variables list.

Creates a duplicate of the selected variable and adds it to the Variables list.

Opens the Variables Settings Editor.
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Flatten Variables Replaces all variables by their current values. This is useful if a document was 
initially created for the Forms workspace but needs to be reworked to use the 
Basic or Advanced workspace.

Remove all empty
paragraphs

If a variable is not resolved, a paragraph may be left empty in the form. Select 
this check box if you want these empty paragraphs to be removed. For example: 
if your form provides fields for fax and telephone numbers, the fax paragraph 
will be deleted if no fax number is provided.

Apply Copyfitting Copyfitting refers to the process of making sure that the available text fits within 
the frame. Depending on the settings, this may mean the font size of the text is 
increased to fill up empty space, or it may mean the font size is decreased so that 
the text fits within the frame. Use copyfitting if you are not sure that there is 
sufficient space in the frame for all of the variables and static text.

Style: The default style is the Custom setting which enables you to specify specific 
settings for the selected text frame. However, you can choose a copy fitting style 
from the drop-down list if you want the copy fitting to be consistent across 
selected text frames. See “Copy Fitting Styles and Style Settings” on page 418.

Between x and x%: Sets lower and upper font size limits after copyfitting is 
applied. If, for example, 'between 75% and 100%' is used, this means the font 
size can never become bigger than it is right now but if the text does not fit the 
available space, the font size can automatically be reduced by up to 25%. If 
'between 75% and 150%' is used, this means the font size may become up to 50% 
larger if the available text does not completely fill the available frame.

Max. Lines: Sets a maximum number of lines after copyfitting is applied.The 
default value is “-1” which is the same as an empty field and means that Max. 
Lines will not be applied.

Only when there is overflow: Copyfitting is only applied when there is too much 
text for the text frame.

For example: if copyfitting is selected with Max. Lines set to 3, copyfitting is no 
longer applied when the text exceeds 3 lines.

Enable Leading and/or Tracking: Leading will be adjusted; the minimum value 
cannot be greater than the value set in the text frame; if this is the case, the value 
of the text frame will be applied as minimum.

Step 3: Initialize Form Variables Panel

This panel shows your variables as interactive form fields, similar to how they 
are displayed in the Forms tab on the storefront.
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You can enter sample text in each field and this appears immediately in the 
document, or you can leave the fields empty.

Variables Settings Editor

 The Variables Settings Editor is opened by clicking the Edit button (pencil 
icon) in the Variables list of the Step 1: Create Variables panel.

Name The name of the variable as it appears in the variable list. Variable names should 
not start with 'ASF_' (e.g. ASF_discount_rate) because the prefix 'ASF_' is 
reserved for system use. See “Autofill Forms” on page 380 for the list of ASF_ 
variables

Display Name The name of the variable as displayed for the shopper, i.e. the form field label.

Type Describes the type of information to be entered in the form field. Choose a 
variable type from the drop-down list: Short Text, Long Text, Formatted Text, 
Image, Number, Checkbox, Date, List, Divider, Button Bar, etc. See “Type 
Specific Tab” on page 408 for more information about these variable types.
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Each type has its own specific settings. See “Type Specific Tab” on page 408 for 
more information.

Figure 10.97: The different variables as they appear on the input form on a storefront.

1 Short text variable used as condition for (2)
2 List variable with list items dependent on (1)
3 Check box variables with text condition
4 Check box variable
5 Divider with dashes
6 Divider with ‘=’ characters
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General Tab

These settings are the same for all variable types.

Required Select if the field must be filled by the shopper. If selected, a warning icon with 
tooltip is generated if the field is left empty.

Visible The form field can be hidden from the shopper with only the value entered by the 
administrator being visible. A complex variable that uses the value of another 
variable may not need to be visible.

Prefix The text you enter here is placed before the variable (if filled), e.g. a currency 
unit.

Suffix The text you enter here is placed after the variable (if filled), e.g. a measurement 
unit.

User Info (help) The text you enter here is displayed as a Help tool tip when the shopper hovers 
over the form field.

Show in-line Select this check box to also display the User Info under the form field.

Remove paragraph if var. is
empty

Select this check box to remove empty lines and paragraphs if the form field is 
not filled in.

Type Specific Tab

Each variable type has additional specific settings.

Short Text The form field can contain one line of text. The style of the text is inherited from 
the layout and cannot be changed by the shopper. An example of its use is a 
business card where this variable can be used for entering the first and last name 
of a person

Max. Characters: The maximum number of characters allowed for the form field.

Show max. length in input form: Select this check box to display the maximum 
number of allowed characters on the input form.

Text Direction: Choose a text direction for the text typed in the form field: Inherit, 
Left to Right, Right to Left

Long Text The form field can contain several lines of text. The style of the text is inherited 
from the layout and cannot be changed by the shopper. This variable can be used 
for entering the address on a business card. The settings are the same as for Short 
Text, plus the option to set the height of the form field.
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Formatted Text A form field where the shopper can add text and modify fonts and other 
formatting.

Height: Enter a value to specify the height of the form field in pixels.

Editor Options: Select the options as required to give the shopper more control 
when entering text in the form field. Some options can only be controlled if they 
are present in the InDesign document.

 Font: The fonts used in the InDesign source document can be selected.

 Font Size: The font size can be specified in points.

 Font Style: Select this option if different font styles (bold, italic, etc.) were 
used in the source document.

 Color: The list of colors used in the source document are available for 
selection.

 Baseline Position: Normal, superscript or subscript

 Alignment: Left, center, right, justification.

 Bullet Lists: provides automatic formatting of bulleted lists.

Calculated field A Calculated Field has no input option, and the value for this field can only be set 
by using an action script in which the return value is calculated. Note that the 
"Online Editor Actions" license option must be enabled in order to use this field. 
When this license is available, an additional "Actions" tab will be shown in the 
variable settings dialog. A Calculated Field variable has an additional "Value" 
option:
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Make sure that the action script for the "Value" option returns the result at the 
end of the script. In this example the calculated field returns the value of another 
"Short Text" variable.

Image This variable creates a drop-down list of images on the form that can be clicked 
to insert an image in the document. Alternatively, users can also click a button 
to browse for a local file on their computer. See “Add an image variable to a 
form” on page 378.

Number This form field can only contain a number.

Minimum: The lowest number the shopper can enter in the form field. Example: 
if the minimum is set to 100 and the shopper enters 59, the value reverts to 100. 

Maximum: The highest number the shopper can enter in the form field. Example: 
if the maximum is set to 1000 and the shopper enters 1500, the value reverts to 
1000.

Snap Interval: The interval of the allowed intermediate numbers between the 
minimum and maximum numbers. If the minimum number is set to 2 and the 
snap interval to 3, the user is allowed to enter 2,5,8,11,14,etc. Set to “1” if you 
want to allow all intermediate numbers.

Step Size: The amount that the number increases when using the up and down 
buttons in the form.

Decimal Separator: Choose a decimal separator for your locale: full stop, comma 
or leave blank.

Thousands Separator: Choose a thousands separator for your locale: full stop, 
comma or leave blank.
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Precision: Select the number of decimal digits for the number from the drop-
down list.

Rounding: Choose an option from the drop-down list (None, Nearest, Up, Down) 
for rounding off numbers that the shopper enters and which are not allowed.

Checkbox This variable adds a check box to the input form. If the shopper selects the check 
box, the line of text is replaced by an alternative line.

For example on a business card, the check box variable could be used to add a 
check box labeled 'Display country website'. If the shopper selects this option, 
the URL of the company website is inserted on the business card.

Checked Value: The value shown on the input form if the check box is selected.

Unchecked Value: The value shown on the input form if the check box is not 
selected. 
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NOTE: You cannot leave the Unchecked Value field blank. Type a space if you do 
not want anything to be displayed if the check box is not selected.

With the Checkbox variable you can also use the Insert Text Condition. See 
“Insert Text Condition” on page 403.

Date The shopper will be able to choose a date on a pop-up calendar and insert it in 
the document.

Display format: You can specify your own format using D (day), M (month) and 
Y (year) and the separator of choice. The date is always expressed with 
numerals. For example, 5 October 2016:
/MM/DD/YYYY generates 10/05/2016
D-M-YY generates 5-10-16

Figure 10.98: Storefront input form with check boxes: Selecting the check box (1) inserts static text in the document using Insert 
Text Condition (2). Selecting check box (3) replaces an empty or static line of text (4).
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Start week on Monday: Select to start a week on Mondays in the calendar; other-
wise the weeks start on Sunday.

Selectable days in the past: Enter the number of days that the calendar must 
show in the past; set to “0” if you don’t want to allow days in the past.

Selectable days in the future: Enter the number of days that the calendar must 
show in the future.

Between: Select a start date and an end date for the calendar.

Disable days: Choose the days that you want to disable in the calendar, e.g. 
Saturday and Sunday.

List This variable generates a list. Click the + button to add list items. List items can 
be deleted (x) or rearranged in the list with the Up and Down buttons.

For example, suppose a company has subsidiaries and when creating a business 
card, a shopper has to insert the address of one of these subsidiaries. You can 
define a list that contains the names of all of the subsidiaries and their addresses. 
When a user selects a subsidiary in the form, the corresponding address is 
inserted on the business card. Each address is a list item and the address is 
entered in the Value box as shown in the following example. You can also define 
a condition to only show certain addresses depending on the country the 
shopper has entered:
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Name: The label of the list item in the form.

Value (optional): An optional value that’s resolved when the list item is selected 
by the shopper.

Only show when: You can choose an existing variable in this drop-down list and 
use it as a condition to display specified list items.
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Include Empty Item: Select this check box if the user is allowed not to choose 
from the available list items. The list will then contain a blank line which the 
shopper can select to indicate none of the available choices is appropriate and 
avoid empty lines.

Allow multiple items to be selected: Displays all the list items (that fulfill the 
optional condition) in a list with check boxes. The shopper can select one or 
more list items on the form. If this option is not selected, the list items are 
displayed in a drop-down list.

Figure 10.99: Storefront input form with a list depending on the input of another variable: Entering a country (1) on the form 
generates a list of relevant addresses (2) that a shopper can insert on a business card (3).
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Concatenation Prefix/Suffix: Enter a prefix or suffix to join list items. For example 
2 hard returns as a suffix to separate resolved variables.

Color/Paragraph Style/
Character Style/Font

Allow for selection (and in some cases modification) of resource items. Note that 
these input types are mostly used by actions and do not offer a lot of control over 
use throughout the document.

Coordinate Coordinate variables are presented to the user as an input of a measurement 
unit. The unit (mm, in, inch, pt, etc.) can be added to the input and will be 
converted to the unit that was selected for your storefront or for your account in 
StoreCenter (Imperial, Metric or US Customary). Basic calculations can also be 
executed with this variable, typing in e.g. 50+30 will result in 80 mm. This type 
of variable is mostly used in action scripts.

Divider Places a blank space on the form — not in the document — and can be used to 
group form fields or enhance the layout. You must leave the Display Name field 
blank or type a series of dashes or ‘=’ characters to create a line. Use the arrow 
buttons to position the divider or dividers in the list of variables.

Figure 10.100: A suffix can be used to separate 2 addresses (1).
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Button Bar A Button Bar variable consists of one or more variable items and each variable 
item represents a button on a Button Bar on the form, not in the document; a 
different action can then be defined for each button. The buttons can be used to 
enhance the usability of the form: for example, a Clear All button to empty all the 
input fields, or a Page button to jump to a specific page in a document. See “Add 
a button bar to a form” on page 379.
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Copy Fitting Styles and Style Settings

Copy fitting styles make sure the same copy fitting percentages are applied to all 
selected text frames. For example, if a user customizes a business card and enters 
a long address, applying a copy fitting style can make sure the font size of the e-
mail address, company URL, and other data use the same font size. Applying the 
same copy fitting style to the selected text frames ensures the use of consistent 
font sizes throughout the document.

You create the Copy Fitting Style in this panel and then apply the style to selected 
text frames in Step 2: Assign Variables Panel.

 Create a copy fitting style

1 Go to the Copy Fitting Styles pane in the Forms tab.

2 Click the Add button (plus icon) to add a style to the list.

3 Click the Edit button (pencil icon) next to the style in the list or open the Copy 
Fitting Style Settings pane to rename the style and specify its settings:

 Affected frames behave as a group: When selected, text frames with the 
same style behave as a group. This allows you to quickly make changes to 
the font size in multiple frames.

 Minimum/Maximum: Sets lower and upper font size limits after copyfit-
ting is applied. If, for example, 'between 75% and 100%' is used, this 
means the font size can never become bigger than it is right now but if the 
text does not fit the available space, the font size can automatically be 
reduced by up to 25%. If 'between 75% and 150%' is used, this means the 
font size may become up to 50% larger if the available text does not 
completely fill the available frame.

 Max. Lines: Sets a maximum number of lines after copyfitting is applied.

 Only when there is overflow: Copyfitting is only applied when there is too 
much text for the text frame.

For example: if copyfitting is selected with Max. Lines set to 3, copyfitting 
is no longer applied when the text exceeds 3 lines.

4 The new copy fitting style can now be selected in the Apply Copyfitting drop-
down list in the Step 2: Assign Variables Panel.
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Objects Tab In the Objects tab you can control how the shopper will be able to modify or not 
modify your design and its content.

Constraints can be applied to all object types (text, images, free-form and 
predefined shapes) and layers initially created in InDesign as well as new objects 
and layers that you create in the Online Editor. The set of constraints differs 
slightly for each object type. 

Constraints are initially inherited from the containing level, but these can be 
overruled by the constraints you set in the Objects tab. The hierarchy of levels is 
as follows:

 Document (default constraints)

 Layer

 Object

 Frame

 Frame

 Frame Content

The Objects tab is available for all versions of the workspace, however, it is never 
displayed in the storefront version of the editor.

NOTE: The constraints for objects are set in the Object Constraints panel and 
constraints for layers are set when you edit the layer settings in the Layers List 
panel.

The Objects tab consists of the following panels:

 Object Constraints

 Object Constraints - General

 Frame Constraints (locking)

 Frame Content Constraints

 Object Location

 Anchors
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 Wrap Settings

 Layers List

 Click in the panel headers to open the individual panels.

Object Constraints

Object Constraints - General

Min. Max Width, Height Here you can enter a minimum and maximum height and width of the object in 
millimeters, and choose to preserve the aspect ratio or not.

Min. Resolution (image
box)

The minimum allowed resolution.

NOTE: Set to -1 to use the document setting.

Allowed Resize (image box) You can set a minimum and maximum resize ratio as a percentage of the 
original.

NOTE: Set to -1 to use the document setting.

Move Region Anywhere: The frame can be positioned anywhere, even outside the page.

Page: The frame can only be moved within the page.

Page Margins: The frame can only be moved within the page margins.

Bleed Box: The frame can be moved outside the page but within the bleed area.

Custom Region: Choose this option to specify a region where the frame can be 
moved. The area is highlighted in gray and defined by 4 coordinates:

 X: the distance of the move region from the left of the page

 Y: the distance of the move region from the top of the page

 X2: the distance of the move region from the right of the page

 Y2: the distance of the move region from the bottom of the page
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Frame Constraints (locking)

Frame constraints are set by choosing one of the following constraints for the 
different frame properties:

 Inherit: The constraint is inherited from the object’s layer (parent element). 
The layer constraint level is indicated under each property.

 No: The constraint does not apply and the administrator and shopper (end-
user) can change the setting.

 Lock: The constraint applies for the content administrator and the shopper.

 Lock for end-users: The constraint applies only for the shopper on the 
storefront.

NOTE: In the Forms workspace, all objects except Content are locked by default. 
These constraints are inherited from the so-called Document level and are 
meant to prevent the shopper from modifying the frames. The Inherit constraint 
consequently keeps these objects locked and you must set them to No if you 
really want to unlock them.

Figure 10.101: Custom move region with coordinates
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Set All To The constraint you choose here is set for all the following properties.

Lock Move Choose a constraint to allow/prevent the shopper moving the frame.

Lock Resize Choose a constraint to allow/prevent the shopper resizing the frame.

Lock Rotate Choose a constraint to allow/prevent the shopper rotating the frame.

Lock Delete Choose a constraint to show/hide the Delete button on the in-line toolbar.

Lock Content Choose a constraint to allow/prevent the shopper editing the content of the 
frame. For example, lock the content of an image frame to prevent the shopper 
assigning a different image.

Lock Frame Settings Choose a constraint to show/hide the frame settings buttons on the in-line 
toolbar (Move Back, Forward, etc.).

NOTE: To see the effect of these constraints, switch between Text Edit and Frame 
Edit modes.

Frame Content Constraints

Frame content constraints are set by choosing one of the following constraint 
levels:

 Inherit: The constraint is inherited from the object’s layer (parent element). 
The layer constraint level is indicated under each property.

 All items allowed: The property is not locked and all the available options can 
be used by the administrator and shopper (end-user).

 Limited selection: Only a selection of options is available for the property. 
The constraint applies for the content administrator and the shopper. 

 Limited selection for end-users: Only a selection of options is available for the 
property. The constraint applies only for the shopper on the storefront.

Set All To The constraint you choose here is set for all the listed properties: Border Colors, 
Fill Colors, Font Selection, Font Size, Text Colors, Paragraph Styles and 
Character Styles.

Object Location

This panel provides details on the position and dimensions of a selected object 
as it appears in the document. These fields are filled with absolute values, or by 
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clicking the function buttons next to the fields you can enter formulas to make 
the layout dynamic. See “Dynamic Layout Function Formulas” on page 398.

Page The number of the page in the document where the object is located.

Content The type of frame (shape, text, etc.) of the current object.

Tag A frame identifier for use in actions and anchors. See “Moving frames using a 
variable action” on page 499 and “Anchors” on page 423.

Layer Indicates the layer the object is located on. Select a different layer from the drop-
down list if you want the object to appear on different layer. The top layer in the 
list is the default layer.

Layouts Clear the Include In All Layouts check box to select layouts for this object from 
the list. 

Reference Point Choose one of the nine points in the grid as a reference for the X and Y 
coordinates.

X, Y The X and Y co-ordinates of the object on the canvas.

Width, Height The current dimensions of the object.

Rotation Increase the value to rotate clockwise; decrease the value to rotate 
counterclockwise.

Skew Increase the value to skew the object from right to left; decrease the value to 
skew from left to right.

Horizontal/Vertical Scale The horizontal and vertical scale factor; default is 100%.

Anchors

An anchor can be used to control the position of a frame in a document if other 
frames are modified or page dimensions change. For example, if the Auto Grow 
feature is used (see “Text Tab” on page 431) to change the dimensions of a frame 
or if an action is used to change its position, anchors can be applied to maintain 
the initial alignment. 

Anchor settings

Use the cross to indicate on which side you want to align. You can align multiple 
sides of the frame with one or more frames.
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Target The component type to anchor the frame to:

 Page: the page dimensions

 Frame: another frame

 Text

Frame A list of all the tagged frames in the document.

Point The point for aligning the frame with the target frame: Left, Right, Top, Bottom, 
Center X, Center Y

Offset A distance for offsetting the alignment.

Min./Max. Minimum and maximum values to the alignment point.

 To anchor frames

1 First you need to tag the target frame (e.g. Frame 2) that you want to anchor 
to. This is done in the Object Location panel. Select the target frame and in 
the Object Location panel of the Objects tab, enter a name in the Tag box. You 
need to be in Frame Edit mode.

The new frame tag will appear in the Frame drop-down list in the Anchor 
panel.

2 Select the frame you want to anchor (e.g. Frame 1) and specify how you want 
to anchor it in the Anchors panel: see Anchor settings.
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Wrap Settings

In this panel you can select the Wrap Text option to control how text flows 
around image and text boxes.

In the Type drop-down list, you have the following options:

 Flow Around: the text flows around the image or text box

 Wrap to left: the text is cleared along the left side of the image or text box

 Wrap to right: the text is cleared along the right side of the image or text 
box

 Wrap both sides: the text is cleared on both sides of the image or text box
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You can also specify the clearance.

Layers List

You can use layers to organize and group content in a document as you would in 
other layout programs.

In this panel you see a list of the layers in your document. Select or clear a layer 
check box to show or hide the layer in the document. When you save the custom-
izable product, only the selected layers will be included.

Initially the list contains the layers from your InDesign document. You can edit, 
set constraints and copy these layers or create your own new layers. You can also 
add a Help layer, which can contain information to assist the shopper.

New objects you add to your documents are added by default to the top layer in 
this list. You can rearrange the order of this list with the up and down arrows.

NOTE: The sorting order does not affect the objects on the layer, and you can only 
use the arrange buttons in order to change the object order.

Layer Settings

 Click the Edit button (pencil icon) in the layer list to specify the layer settings.

Name The name of the layer as it appears in the list.

Visibility Variable Choose a variable from the drop-down list. Only Check box type variables appear 
in the list. The check box variable appears in the form input and the shopper can 
select/clear the check box to show/hide the layer.

Include in output The layer is visible in the final PDF of the customizable product (default state). 
Clear this check box to prevent a layer appearing in the final PDF.
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Is Help Layer Select this check box if you want to make the layer a Help layer. A Help layer can 
contain prompts — in the actual document — for the shopper on how to edit the 
document. This layer is never included in the ordered product.

No Text Wrap if Invisible Wraps the text on visible layers when the option is enabled on hidden layers.

Opacity Set the opacity level for the layer. 100 is the maximum opacity and hides content 
below the layer; lower values increase transparency so lower layers are visible.

Content Type Choose a type from the drop-down list:

 Unspecified

 Background

 Variable Data

Layouts Clear the Include In All Layouts check box to select layouts for this object from 
the list.

Move Region See “Object Constraints - General” on page 420.

Frame Constraints See “Frame Constraints (locking)” on page 421. 

Frame Content Constraints See “Frame Content Constraints” on page 422.

NOTE: If you choose Inherit constraints, this has the same effect on 
underlying objects as Lock for end users in the Forms workspace, and Not 
Locked in the Advanced and Basic workspaces.

 Show/hide a layer (check box variable)

The visibility of a layer can also be controlled in the storefront Online Editor. You 
first need to create a Check box type variable and link this variable to the layer.

1 In the Forms tab, create a new variable and set the Type to check box. For 
example, enter ‘Show/hide layer’ for the Display Name.
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2 In the Objects tab, create a new layer and in the layer settings, choose your 
new variable from the Visibility Variable drop-down list.

3 Specify the other settings for the layer and close the Layer Settings.

4 Put the content you want to show/hide on this new layer. The layer can 
contain text or images, for example specific artwork for a business card.

5 Save your customizable product.
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In the storefront Online Editor, a shopper will now see a check box that can 
be used to show/hide the layer that contains an image.

 Create a Help layer

A Help layer is a layer which is included in a customizable product but never 
output in the finalized product (i.e. when the shopper has finished editing). You 
can put Help information on this layer to guide a shopper through the editing 
process.

1 In the Objects tab, open the layer List panel, create a new layer and edit the 
settings.

2 Enter a name that appears in the Layer List and select the Help Layer check 
box.

NOTE: Selecting the Include in Output check box has no effect for a Help 
layer.
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3 Specify the other settings for the layer and close the Layer Settings.

The new layer is indicated in the Layer List with a Help icon.

4 Place your Help prompts on the layer. These can be text or images.

5 Check that your Help prompts are on the Help layer in the Object Location 
panel.

6 Save your customizable product.
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In the storefront Online Editor, a shopper will now see the Help prompts 
which can be switched on and off with the Help icon in the toolbar.

The Help layer is never included in the final PDF of the document, irrespec-
tive of whether it is switched on or off in the online editor.

Related topics: • Show/Hide Layers on page 466

Text Tab The Text tab consists of the following panels:

 Character Settings

 Character Styles

 Paragraph Settings

 Paragraph Styles

 Text Frame Settings

 Glyphs

 Frame Custom Baseline Grid

Character Settings

Use the settings in this panel for one-off adjustments to the in-line styling of 
selected text: Font, Size, Underline, Strikethrough, Position (Normal, Super-
script, Subscript), Baseline, Case, Color, Tracking (word spacing), Enable 
Kerning, Leading (line spacing), Text Overprint and Non-breaking text.
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 To apply kerning to selected text, specify a value in the Tracking field. The 
Enable Kerning check box does not need to be selected. This check box 
enables the customized kerning when importing documents from InDesign.

Character Styles

Use character styles to apply consistent in-line styling to selected text. The 
character styles list shows all the styles inherited from the InDesign document. 
You can create new character styles or delete styles from the list.

 Click the Add button (plus icon) to add a style to the list and then click the 
Edit button (pencil icon) to set the character properties.

Paragraph Settings

Use the settings in this panel for one-off adjustments to the paragraph where the 
cursor is positioned, or to multiple selected paragraphs.

Indent left and right icons Indents with a bullet and then space between the bullet and the indented 
paragraph; this is the margin of the paragraph as shown in the Left Margin box.

Align icons Left, center, right, justify

Direction Left to Right or Right to Left

Align to Baseline Alignment with the document baseline guide (can be different than the align-
ment of the text frame)

Space Before, Space After Adds space before/after a paragraph.

Indent Indents the first line of the paragraph

Left Margin, Right Margin Space to the left and right of the paragraph

Paragraph Styles

Use paragraph styles to apply consistent styling to paragraphs. The paragraph 
styles list shows all the styles inherited from the InDesign document. You can 
create new paragraph styles or delete styles from the list.

Creates a new style and adds it to the list.

Deletes the selected style from the list.

Opens the Character Settings.
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 Click the Add button (plus icon) to add a style to the list and then click the 
Edit button (pencil icon) to set the properties.

Name You can rename your style.

Next Style Choose a style from the drop-down list to apply after the current style.

Apply to new frames Select this check box if you don’t want your changes to apply to existing frames.

Paragraph Specify the paragraph settings.

Indents Specify the indentation.

Character Specify the character settings for this paragraph style. For example, set the font, 
font size, color and leading (line spacing) for this paragraph style.

Text Frame Settings

These are general settings that apply to all the text in the text frame.

Fill with placeholder text Fills the frame with Lorem Ipsum text. 

Hyphenate/Unhyphenate Inserts hyphenation to flow words to the next line; the rules of the selected Text 
Language are used for the hyphenation.

Text Language The language for hyphenation

Vertical Align Vertical alignment of text is possible in all shapes.

 Top

 Middle

 Bottom

 Justify

Text Stroke Creates an outline of the font of your text. Select the check box and you can set 
the Weight and the Color of the outline. Use together with the text color to 
obtain creative effects.

Creates a new style and adds it to the list.

Deletes the selected style from the list.

Opens the Character Settings.
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Auto Grow Frame Select to automatically resize a frame to accommodate the text. When enabled, 
you can specify the Direction of the expansion and how much.

Insert This option is for inserting in-line frames in a paragraph, to ensure the frame 
flows with the text. See “Insert an in-line frame in a text frame” on page 363. You 
can choose the following frames in the drop-down list:

 Text

 Table

 Image

 Barcode

 Shape

 Rectangular

Here you specify the vertical alignment of the text within the text frame, and a 
language for hyphenating the text in the selected text frame.

Glyphs

Use the Glyphs panel to insert special characters and symbols in text.

 All: Shows all the characters available for the font used in the document; 
characters in red are not supported; double-click a symbol to insert it in your 
document at cursor.

 Common: Displays a selection of common symbols; double-click a symbol to 
insert it in your document at cursor.
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 Special Characters: Displays a drop-down list with special characters; choose 
one of the following special characters in the list and click the + button to 
insert it in your document at cursor:

 Page break

 Column break

 Frame break

 Discretionary hyphen

 Non-breaking space

 Soft return

Frame Custom Baseline Grid

A frame can have its own baseline grid that overrides the general document 
baseline. You need to be in Edit Frame mode to see the settings in this panel. See 
“Use a custom baseline grid” on page 366 for the procedure.

Use Custom Grid Selecting this check box overrides the document baseline grid so you can set 
your custom line spacing.

Start Select from where you want the custom baseline grid to be applied:

 Top of frame inset

 Top page margin

 Top of frame

Offset The distance from the top of the object you selected in the Start drop-down list.

Increment The line spacing value.

Show guides Select this check box to display the grid lines.

Document Baseline Grid

Here you can set the document level grid which can be selected in the Paragraph 
Settings. The parameters are the same as for the Frame Custom Baseline Grid.

Images Tab The panels on the Images tab provide an overview of the image assets and their 
settings.
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The Images tab consists of the following panels:

 Library Images

 Design Images

 Image Settings

 Image Dimensions

Library Images

In this panel you can upload images to the STOREFRONT server for use when 
editing and designing your customizable product. Images are organized in 
different categories so you can choose to make some or all of them available to 
shoppers on the storefront.

 Product images: This is where you put images that can be used for this partic-
ular product by shoppers. A selection of images can be uploaded and 
shoppers can choose an image of their choice from the library, for example, 
to replace an image in the initial design.

 Store images: A separate library is available for every store and microstore in 
the system. This is where you keep images such as logos and clip-art that you 
would only use with a particular store. By default, this category cannot be 
used by shoppers.

 My Images: A shopper can also upload images to the STOREFRONT server and 
these are managed in the My Images library.
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NOTE: The My Images library is only visible on the storefront.

Design Images

This panel lists all the images which were included in the document when it was 
converted from InDesign. You can add images to this list if you need them while 
editing the original design of your document in the Online Editor. For example, 
if you want to assign a new image to an image frame in your document, you can 
add it here first.

Image Settings

In this panel you have the same image editing tools as on the in-line toolbar. You 
can crop and flip, or replace an existing image in an image frame, or assign an 
image to a new frame. 

 Select an image frame in the document to see its settings in the Image 
Settings panel.

 Add a new frame in the document and use the Image Settings panel to select 
an image from the libraries and position the image in the document.

Assign Image button Click this button to select an image from your assets library and assign it to the 
selected frame. If the frame already has an image, this image is removed from 
the frame and replaced with the new one.

Clear Image button Click this button to remove the image from the selected frame, not the library.

Flip Click the icons to flip the selected image:

In addition, you have the following options for extra control:

Display Quality This setting specifies how you see images and PDF elements in the preview of 
your documents. Select a quality setting from the drop-down list if you want to 
override the quality setting of the document. You may also want to do this if your 
document contains complex image elements (e.g. gradient fills or gradient text), 

Flips the object back to its original orientation.

Flips horizontally.

Flips vertically.

Flips horizontally and vertically.
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and the preview is not processed correctly. You can see a better preview by speci-
fying a quality setting here.

 Document Setting: Displays the preview as set in the document; this is the 
default setting when you open the document.

 Session Only: These settings are only used for previewing during the 
current working session; when you open the document again after saving, 
the quality setting is reverted to the document setting. 

NOTE: The locked layers of your document are converted to PDF, so these are 
also affected by the image setting.

Fit Several fitting options are available if the image you assign to a frame is not the 
same size as the frame.

 Frame: The frame is expanded on all sides so the image fits in the frame 
in its original proportions.

 Stretch: The image is resized to fit inside the frame, without maintaining 
its proportions. Select the Allow crop contents check-box to crop, resize 
and move the image within the frame while the stretched proportions are 
preserved.

 Proportional: The image is resized until the height or width fits inside the 
frame. If the proportions of the frame are not the same as the image 
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proportions, you will see empty bands along the sides of the frame. You 
can change the alignment of the image inside the frame by choosing one 
of the Anchor options.

 Manual: You can resize the image by dragging the image handles (only 
proportional), and crop the image by dragging it beyond the frame 
borders.

 Proportional, Outside: The image is resized until the height or width fits 
inside the frame; if the proportions of the frame are not the same as the 
image proportions, parts of the image appear outside the frame. You can 
change the alignment of the image in the frame by choosing one of the 
Anchor options.

 Original Size: The size of the frame adapts to the original size of the image 
and will fit the image in that frame.

 Smart Fit: Allows you to automatically position an image within a smaller 
frame based on a specific focus on part of that image. See “Smart Fit an 
image” on page 445. 

Anchor You can select one of the following anchor points within a frame to position an 
image whose size does not match the frame size, for example after applying 
fitting.

 Top Left

 Top

 Left

 Center
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 Right

 Bottom Left

 Bottom

 Bottom Right

Image Dimensions

This read-only panel displays the image properties of a selected image.

 To add an image to the library

1 In the Images tab, select a library category in the list and click the Browse 
button.

The images list is displayed.

Figure 10.102: Fit: proportional, outside; Anchor: center
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2 Click the Browse for local file button to add an image to the library list.

The following file formats are recommended:

 JPG

 TIF

 EPS (fonts embedded)

The following files are supported but the quality may be insufficient for 
printing:

 PNG
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 GIF 

The following files can be used but not all the features are supported:

 PDF (fonts embedded)

 AI (fonts embedded)

 PSD (fonts embedded)

Some of these image file formats offer advanced functions such as layers or 
embedded transfer curves that may not be supported in the Online Editor. In 
some cases it may be required to convert files to PDF or another format before 
using them in the Online Editor.

Files must be added one by one. The selected images are added to the list.

NOTE: See “Use PrintSphere to upload images in bulk” on page 443 for 
uploading images in batches.
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3 Click the X button next to an image if you want to remove it from the library.

 Use PrintSphere to upload images in bulk

As an alternative to uploading images to the STOREFRONT server, you can also 
upload them to PrintSphere (www.printsphere.com), a file-sharing service 
hosted by ECO3. This alternative allows you to create folders and sub-folders 
where your image files can be uploaded in bulk. You can share selected folders 
with other users and let them collaborate by contributing files to these folders.

See “External Accounts” on page 101 to configure the link between STOREFRONT 
and PrintSphere and add folder locations.
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NOTE: Images in a PrintSphere folder cannot be used in image variables nor can 
they be inserted using the Insert image button on an image frame in the Online 
Editor. The PrintSphere folders are only visible in the Images tab of the Online 
Editor.

 To filter/search the image library

1 Click the Search button.

The search box is displayed.

TIP: Use Search and leave 
the search field empty to see 
a list of all the library images 
in the system.

2 Enter your search keywords and click the Search button on the right.
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The results panel first goes blank and then displays the search results.

NOTE: The search is performed across all the library categories even if you 
selected a library category, and you may need to wait a few moments before 
the results appear.

3 Clear the search box and click Search again to see a list of all library images 
in the system.

 Smart Fit an image

The Smart Fit option lets you automatically position an image within a smaller 
frame based on a specific focus on part of that image. The focus is defined by 
specifying a "Point of Interest" on the image and the "Subject Position" which is 
the position in the frame where you want this focus point to be shown. This 
option ensures that the right part of the image is shown in the right proportion, 
especially in dynamic layouts where an image frame can have different width 
and height rations.

1 Choose Smart Fit in the Image Settings. See “Image Settings” on page 437.

2 Choose Edit Point of Interest to specify the subject area.
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Drag the red cross to the desired location and specify the subject area by 
resizing the frame with the blue handles.

3 Define the Subject Position (the location in the image frame where the focus 
should be) by dragging the green area which is superimposed on the image.

The coordinates change accordingly.

The subject area is positioned relative to the coordinates of the image frame. 
In the example, the X position of the subject frame is 28.4% of the width of 
the image frame, and the same applies to Y, W(idth) and H(eight).
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Table Tab This tab contains the settings for the rows, columns and cells of a table. This 
includes settings for borders, fills, etc. To position text in cells, go to the Text 
Tab.

 Select a table in the document or create a new one and then go to the Table 
tab to configure the table.

Refer to “Tables” on page 372 for instructions on creating/editing tables.

Shapes Tab This tab contains the Border and Fill settings for a selected frame. 

The available settings depend on the object type and they are similar to what you 
find in popular image editing software.

 Click in the Border and Fill header to open the settings panel.

Assign Shape button

You can assign shapes to text, image and shape frames. The button opens the 
Select Shape dialog where you can choose the shape you want to apply to the 
object. See “Assign a shape to Text, Images and Shapes” on page 371.

The following properties can be set:

Border

These options depend on the frame type of the object you want to assign a shape 
to.

 Weight

 Color

 Style (Normal, Inset, Outset)

 Join (Miter, Round, Bevel)

 Corner Radius

 Overprint border

Fill

 Color: Choose a color from the drop-down list. Choosing Custom activates 
the Edit button. Click the Edit button to create a new color using the color 
sliders.
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 Overprint fill

Drop Shadow

 Opacity

 Color: Choose a color from the drop-down list. Choosing Custom activates 
the Edit button. Click the Edit button to create a new color using the color 
sliders.

 X, Y

 Blur

Opacity

Blend Mode

 Normal

 Multiply

 Darken

 Difference

 Hardlight

 Lighten

 Overlay

 Screen

Inset (left, right, top, bottom)

The insets inside a text or image frame.

Barcodes Tab  Click the Barcode tool in the toolbar and place a new barcode frame, or select 
an existing barcode frame to display the following Barcode settings:

Type Choose one of the following barcode types:

 Code 128 A, Code 128 B, Code 128C: used in logistics for ordering, distri-
bution and transportation
StoreFront User’s Guide



 

10 ONLINE EDITOR 449
 Code 39 & Code 39 Extended: the ancestor of code 128, mainly used in 
the automotive industry

 DataMatrix: 2D barcode

 EAN 8 & EAN 13: mainly used on consumer products outside of the 
United States

 QR Code: Quick Response (QR) codes are used on printed media to 
quickly read information into mobile devices for example.

 UPC-A & UPC-E: mainly used on consumer products in the United States

 Code 25, Code 25 Interleaved

 Datamatrix

 GS1-128

 GS1 DataBar Expanded

 GS1 DataBar Expanded Stacked

 ISBN

 ITF-14

 PDF417

 Pharmacode 1-bar

Variable If you already created variables for this form, you will see them in this drop-
down list. Otherwise the list is empty. Choose a variable that you want to 
generate in the barcode or leave blank if you want to enter code with or without 
variables in the Value box. When a shopper enters a value in the form input 
fields, this variable information is generated in the barcode.

Anchor Positions the barcode within the frame. Choose a position from the drop-down 
list.

Scale Scales the barcode within the frame. The value can be higher or lower than the 
initial value (100).

Colors Choose a background color, the color for the barcode and a color for the barcode 
text.
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Value Enter the code for the barcode. For example, if you selected QR Code as type, you 
can enter code to create a QR Code with vCard, URL, geolocation or other infor-
mation. You can include one or more variables in this code so the shopper can 
use form input fields and this variable information is generated automatically in 
the barcode.

Related topics: • “Generate a QR code in a barcode frame” on page 395

Warnings Tab The Online Editor has its own preflight engine to validate documents before they 
are saved by you or the shopper.

The behavior is controlled in the Warnings tab which consists of the following 
panels:

Preflight Settings

In this panel you can set the parameters for validating the document while you 
are editing and when it’s saved in the Online Editor by yourself or the shopper. 
You can set the severity (Ignore, Warning, Error) or values to be checked. The 
actual results of the preflighting are shown in the Preflight Results panel. You 
can also prevent saving and PDF creation if your document has errors, and also 
show warnings before saving.

Frame outside page Frames positioned outside the page will not appear on the printed document.

Text overflow When text is too long to fit in its frame, part of the text will not be printed.

Figure 10.103: On a storefront, potential warnings and errors are displayed when a shopper 
saves a document.
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Missing characters The user can use accents or non-Latin characters in a frame, then alter the 
typeface and accidentally select a font in which some of those characters are not 
supported. The missing characters might appear as spaces or small rectangles.

Img output resolution The resolution of images must be high enough to avoid pixilation.

Img resize Some companies do not want their logo to appear too small on documents.

Empty variable In a document using the Forms or Expert workspace you may want to ensure that 
the user fills in all the fields. Only applies for “required” variables, so make sure 
the “Required check box is selected if you want this option to take effect.

Min. Output Res The threshold value for ‘Img output resolution’

Check resolution on Defines if the resolution is checked on bitmap or vector images or both

Min. Resize % The lower threshold value for ‘Img resize’

Max. Resize % The upper threshold value for ‘Img resize’

Check resize on Defines if image resizing is checked on bitmap or vector images or both

Preflight Results

This panel provides a list of errors and warnings generated according to the 
Preflight Settings. Errors are indicated with a red error icon and warnings have 
a yellow icon.

Prevent save on errors Forces the shopper to fix errors before the publication can be saved.

Prevent PDF generation on
errors

It is recommended to clear this check box. Only applies for generating PDFs in 
the StoreCenter Online Editor, not on the storefront.

Show warnings on save Informs the user explicitly about potential issues. Shoppers can however ignore 
warnings, close the window and order the product.
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Import Warnings

This panel provides log information relating to the original STOREFRONT package 
created by the Converter. See “Preflight Report” on page 347 for more informa-
tion. This panel is only visible for administrators in the StoreCenter.

Document Tab The Document tab consists of the following panels:

Document Settings

Here you can choose a language for the check spelling feature.

Package Output

Here you can create a STOREFRONT package from your document.

 Click the Create Package button to create a package of the document and all 
its assets.

The STOREFRONT package can be used when creating other customizable 
products.
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Tips and Tricks

The following tips and tricks are useful for advanced users of the Online Editor:

 Version Handling

 Automating Similar Forms-Based Products

 Testing Customizable Products

Version Handling When a customizable product needs to be modified, this has an impact on 
documents that have already been created using that product. Take the example 
of a business card that shoppers can edit and order:

 The card was initially added to a store as a forms-based customizable 
product.

 A number of users ordered their customized version of that card.

 The layout of that card now needs to be adapted: a different logo is used or 
users need to be able to add their Twitter account to the business card or 
some other change is needed.

There are several ways in which the new card can be created. Each approach has 
its advantages:

1 The company removes the old product from the store and creates a new 
product from scratch. 

 The admin who creates the new business card has to do all the product 
creation work again, such as defining access restrictions and setting up a 
form in the Online Editor.

 When users try to reorder previously customized business cards, STORE-
FRONT is aware that the product their order is based on is no longer 
available. The software will not allow users to reorder cards with the old 
layout. They will have to create a new business card using the new 
product.

2 The company edits the existing card in the Online Editor. 

 The administrator who creates the new product only needs to update the 
layout in the Online Editor - a lot of product setup work is reused.
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 The new layout is only available in STOREFRONT. If the modifications also 
need to be applied to an InDesign template, this needs to be done 
separately.

 When users try to reorder previously customized business cards, they can 
do so and get cards that do not use the new layout. This remains true if 
they still do some last minute modifications.

3 The company duplicates the existing product, removes the old card from the 
store, updates the layout of the copy in the Online Editor and puts that new 
copy in the store. 

 The admin who creates the new product only needs to update the layout 
in the Online Editor – a lot of product setup work is reused.

 The new layout is only available in STOREFRONT. If the modifications also 
need to be applied to an InDesign template, this needs to be done 
separately.

 When users try to reorder previously customized business cards, STORE-
FRONT is aware that the product their order is based on is no longer 
available. The system does not allow users to reorder cards with the old 
layout. They will have to create a new business card using the new 
product.

Automating Similar 
Forms-Based 
Products

If you need to add several versions of a document to a store as customizable 
products, defining all the variables for each document and assigning them to the 
proper frame in the Online Editor involves considerable effort. You can save time 
by adding the form field variables to multiple Adobe InDesign source documents 
so they are imported automatically in the customizable product. This is possible 
with the Data Merge function in Adobe InDesign as explained below.

 Create a data source file for InDesign

The data source file is a tab- or comma-separated text file that contains all the 
variables that will be used in the document. This file is created in a text editor on 
a Windows or Macintosh computer.

1 Open the text editor and type all the variables on the first line of the 
document with each variable separated by a TAB.

2 Copy the first line and paste it on the second line.

3 Save this document as a .txt file.
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 Add variables to the InDesign document

1 Open your layout file in Adobe InDesign.

2 Choose Window > Utilities > Data Merge to open the Data Merge panel.

3 In this panel, choose the Data Source menu option to import your data 
source .txt file.

4 The Data Merge panel now displays all the variables. Insert them all at the 
correct location in the document.

For example, the imported data can be inserted into the layout of a business 
card:

5 Export the document as a STOREFRONT Package. See “Create a package with 
the Converter plug-in (up to InDesign CS6)” on page 339.

6 Repeat this procedure for each version of your document, reusing the data 
source file.

 Finish the documents in the Online Editor

1 Create a new customizable product using the exported STOREFRONT Package.

2 Edit the product in the Online Editor.

All the variables are present and linked. The frames containing a variable are 
already marked as Selected frame contains variables.

All the imported variables are of the type Short text. All you need to do is give 
each variable a suitable Display Name.

3 Select each variable and click the pencil icon to edit the Display Name.

You may also still want to change the order of the variables and give them 
proper default values.

4 Repeat this procedure for each version of your document.
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Testing Custom-
izable Products

After creating a new Customizable Product, it is recommended that you check 
that shoppers can customize the text, images, forms, etc., and order the product 
as expected. You should create a test order on the storefront to be sure.

Testing on the storefront is also essential for Variable Data Products. See also 
“Troubleshooting the variable data upload” on page 393.

 Step 1: Create a test order

Add the product to a store, log in as a user and order the product.

 Step 2: Test layout editing

Open the product in the Online Editor and perform some basic checks:

 If a form is used for data entry, fill the fields with long words or sentences 
to check if sufficient space was foreseen or the copyfitting settings are 
configured properly.

 With forms you should also check if the layout is OK when fields are left 
blank.

 If the 'Basic' or 'Advanced' workspace is used, check if all the locked layers 
are also locked within the layout. You do not want shoppers to acciden-
tally move locked content.

 Check all of the other constraints that were configured to make sure the 
shopper is limited to making only those changes that are allowed. This 
applies to the use of fonts and styles and to the user's ability to modify or 
move all of the frames in the layout.

 Check if the image libraries are configured correctly and the shopper has 
access to all the artwork he or she is meant to have access to.

 For Variable Data Products, check that the variable data is merged as 
expected in final documents.

Personalize the customizable product and add it to your shopping cart.

 Step 3: Check the softproof (PDF Preview)

Click the PDF Preview link of the product in the shopping cart to validate that 
the softproof that users can access matches the print-ready PDF file. Keep in 
mind that PDF preview files are different from print-ready PDF files in a 
number of ways. In preview files:
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 the high resolution images are downsampled to minimize the file size and 
speed up access.

 PDF security settings and a watermark are added depending on the 
settings in Advanced > Production Settings > PDF Preview.

 non-printing layers are included while these are excluded in the print-
ready PDF.

 no bleed is added while print-ready PDF files have a 12 mm (0.47 inch) 
border for bleed and crop marks.

There are some exceptional cases in which a softproof might look different 
from the print-ready PDF. This can confuse the shopper and cause him or her 
to cancel the order. Artifacts in PDF preview files are typically caused by 
transparency getting processed differently in the STOREFRONT web environ-
ment. If this occurs, you will have to rework the InDesign source file and 
recreate the product. Many issues can be resolved by replacing complex 
InDesign objects by easier to process bitmap files. For example: if a logo with 
a drop shadow on a gradient background is too complex to process and the 
background gradient disappears on the PDF preview, then replacing that 
gradient in InDesign by an identical bitmap gradient may resolve the 
problem.

 Step 4: Process the order item (optional)

Processing the order item in the prepress workflow system assures that the 
base layout is correct and does not cause any problem because of low-res 
images, incorrect color spaces, not enough bleed, etc. This step is recom-
mended if the InDesign source file was created by an external agency or 
designer.
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Variable Actions

Variable Actions are snippets of code that you can assign to your variables. They 
add automation to documents and give you more control. They also enable 
shoppers to work more effectively when editing customizable products.

Variables primarily represent fields on a form and they are generally set to visible 
so they are actually displayed as field labels with an input box or drop-down list. 
However, variables can also be defined for use in the background, for example 
to calculate values, without being visible for the shopper on the form.

See the code samples in “Variable Actions Samples” on page 465 to get started 
immediately.

NOTE: You cannot use Variable Actions in a Variable Data Product.

Related topics: • See “Form Field Variables” on page 373.
• Variable Actions Samples on page 465

Action Types If you have the Online Editor Actions license, you will see an extra Actions tab in 
the Variable Settings Dialog.

This tab displays the different types of actions:
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Value

The Value action is only displayed for the Calculated Field action type.

This action is triggered when the value of another variable is changed.

On Change

This is the most common action and it is used to change something in the 
document:

 set values of other variables

 show/hide multiple layers

 modify color, font and other properties of text

 show/hide variables on the input form

Validate

This action returns a warning in a tooltip if the condition is not fulfilled. 

Visibility

This action returns whether the variable is visible or not.

Action Editor A special Action editor is provided to help you create the code for your variable 
actions. You create the code by adding lines and then selecting commands and 
parameters from drop-down lists. This is a wizard-type editor that only shows 
objects which are relevant for the preceding object.
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Action Basics

The Action Editor is designed for non-programmers but it is useful to know some 
basic concepts.

Command Statements

The first drop-down on a line of code contains commands (scroll down to see 
them all):

 set: sets properties inside the document model

 declare: declares local variables

 execute: executes a function

 if/else/else if/end if 

 AND

 OR

 return: returns a value

 comment: adds comments to your actions

Although all the commands are always available, some commands are only 
relevant on certain lines and for certain action types. For example, you cannot 
start an On Change action with a return statement on line 1. If the command is 
not relevant, you cannot continue to write the line. 
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Objects and Properties

Commands affect objects (frame, page, layer, etc.) and properties that you can 
also select in drop-down lists.

Execute Functions

Typical functions as used in the examples in this section are:

 selectItemName

 applyFromColor

 replaceRegExp

Hover over the drop-down lists to see an explanation in the tooltip.

Conditional Statements

Conditional statements are used to control when a specified function is 
executed. They can also help you create actions with less code lines. 

 if, else, else if, end if (to close if statement).

These statements are combined with the following operators: 
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 is, is not, contains, starts with, ends with, <, <= , >, >=

 & (to concatenate (join) strings), +, -, /, * 

You will typically have a series of statements and one of these statements is 
executed if the condition is met.

Local Variables

Local variables are used for more complex calculations or if a calculation is used 
multiple times in the action code. First you need to declare the local variable and 
then you can start reusing in other variables.

You can see how local variables are declared and use in the following examples:

 “Example 2: Footer combining variables with function” on page 482

 “Example 3: Footer combining variables with regular expression” on 
page 484

Action Editor Toolbar

Toolbar Tools

Advanced Tools

Hold down the CTRL (Windows)/CMD (Mac) key while clicking the toolbar 
icons to display a dialog where you can perform advanced copying, deleting and 
moving, as explained in the Toolbar Tools table.

Creates a new line of code for the variable action. Hold down CTRL/CMD to add multiple 
empty lines below the current line.

Deletes the selected code line. Hold down CTRL/CMD to delete multiple empty lines below 
the current line.

Moves the code line up in the action editor. Hold down CTRL/CMD to move a line: one up, 
one down; to the top, bottom; x times up relative to the current position; to a specified line 
number.

Moves the code line down in the action editor. Hold down CTRL/CMD to move a line: one up, 
one down; to the top, bottom; x times down relative to the current position; to a specified line 
number.

Creates a duplicate of the selected code line immediately under the selected line. Hold down 
CTRL/CMD to duplicate one or multiple lines: one up, one down; to the top, bottom; x times 
down relative to the current position; to a specified line number.
StoreFront User’s Guide



 

10 ONLINE EDITOR 463
You can also copy a specified number of lines to the Document’s Action clipboard 
for reuse in the same action or in a different action of the same document.

NOTE: The contents of the clipboard is emptied when you close the document.

 Copy action code to clipboard for reuse

If you want to use the same action for multiple variables in the same document, 
you can copy the code to the clipboard and reuse it.

NOTE: You can only duplicate an action within the same document.

1 Press CTRL/CMD and click the Copy icon.

The Copy Lines dialog is displayed.

2 Enter the number of lines you want to copy to the clipboard.

3 In the Move drop-down list, select Document’s Action clipboard.

4 In the Name field, enter a name for this piece of code.

5 Click OK.
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6 The new piece of code is added to the Paste Scrap list in the toolbar.

7 To add a saved piece of code to your action, select the name of the code in the 
drop-down list and click Paste Scrap.

The specified piece of code is added below the current line.

Regular Expressions

Some of the examples in this section use regular expressions. See “Form Valida-
tion” on page 488 for code samples.

The following table gives an overview of the basic syntax for regular expressions.

Read this article on Wikipedia for more information about regular expressions or 
visit regex101 for a complete reference guide.

Unsupported 
Actions

To preserve the integrity of the STOREFRONT application, you must not create 
actions that do one of the following:

 add or delete one or multiple pages

 change the page size

 replace a spot color with a process color or vice versa, as this will affect your 
pricing

^ matches the beginning of a string

$ matches the end of the string

[0-9] any digit from 0 to 9

X{m,n} m to n occurrences of X

X* matches 0 to more occurrences of X

X+ matches 1 to more occurrences of X

X|Y matches X or Y

() groups the expression

/X/gi the gi modifier does a global case insensitive search of all occurrences of X
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Variable Actions Samples

This section provides several examples with sample code that you can re-use and 
tweak for your own variable actions. We recommend that you try out some of 
these examples as this is probably the easiest way to learn about variable actions.

This section describes the following examples of actions:

 Show/Hide Layers

 Change Text Color

 Jump to Page on Input

 Combine Variables

 Form Validation

 Form Validation with Correction

 Strip Formatting

 Clear fields

 Insert MIS ID Profile data

 Moving frames using a variable action

 Removing trailing carriage returns

 Capitalize names

 Generate an E-mail Address

 Change a Font

 Change Typeface for Copy Fitting

 Insert special characters in variables

 Switch between oldstyle and lining typefaces for numerals

 Switch between languages (multilingual form)

 Compare date variables
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Prerequisites
The following are needed for all the examples in this section:

 Online Editor Actions license to work with the Action editor

 Customizable product with the Forms or Expert workspace.

Conventions:

The following conventions are used in the code samples:

 <space>: type a space

 <blank>: leave blank

Related topics: • See “Form Field Variables” on page 373.
• Variable Actions on page 458

Show/Hide Layers In this example you will set up a document to enable the shopper to select one of 
3 layers by simply choosing an item in a drop-down list.

NOTE: Use actions if you want to make multiple layers available. To show/hide 
just a single layer, you can also use a Check box variable. See “Show/hide a layer 
(check box variable)” on page 427.

Summary

 Action type: On Change (In the Actions tab, edit On Change.)

 Variable type: List with 3 items

 Document with 3 layers

 Action code:

1 set layer My_Layer_1 visible = false
2 set layer My_Layer_2 visible = false
3 set layer My_Layer_3 visible = false
4 if variable Change image selectedItemName is string my_item_1
5 set layer My_Layer_1 visible = true
6 else if variable Change image selectedItemName is string my_item_2
7 set layer My_Layer_2 visible = true
8 else if variable Change image selectedItemName is string my_item_3
9 set layer My_Layer_3 visible = true
10 end if
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How it works

Your document has multiple layers. These layers are created in the original 
InDesign document or in the Online Editor, and can contain visual elements 
such as images, transparencies, background fills, etc., that can be switched to 
obtain differentiating effects as chosen by the shopper.

In this example, we have 3 layers, to create 3 variations of the same business 
card. Each layer applies a different color design without affecting the other 
design elements. The layers have the following names:

 My_Layer_1

 My_Layer_2

 My_Layer_3

The shopper can select one of these 3 layers by choosing an item from a drop-
down list. The drop-down list and its items are created in the Online Editor as a 
list type variable. In this example, the list type variable is called Change image 
and the 3 list items have the following names:

 Change image:

 my_item_1

 my_item_2

 my_item_3

Each list item has an On Change action which sets the visibility of a specified 
layer:

 my_item_1 displays My_Layer_1

 my_item_2 displays My_Layer_2

 my_item_3 displays My_Layer_3

In the Action editor, you create lines of code by selecting statements and param-
eters from drop-down lists. You first use the set statement visible = false so 
all the layers are hidden when the shopper opens the document to start editing 
(lines 1 to 3). An if/else conditional statement is then used to show the respec-
tive layers when a list item is selected. Each statement is on its own code line, 
and all of these lines are referred to here as the action code.
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 On Change Action to show/hide layers

This example is for a document with 3 layers, and uses the naming convention 
explained above.

1 Edit a customizable product in the Online Editor.

Before creating the variable, check in the Objects tab > Layers List that your 
document has layers. For this example, we have 3 layers called:

 My_Layer_1

 My_Layer_2

 My_Layer_3

If you have the 3 layers, you will now create a List type variable with 3 list 
items to control which layer is visible.

2 In the Forms tab, click the Add button and then the pencil icon to open the 
New Variable dialog.

3 In the General tab of the New Variable dialog, complete as follows:

 Name: Change image

 Display Name: Change image

 Type: Choose List from the drop-down.

4 In the Type Specific tab, click the Add button and create 3 list items:

 my_item_1

 my_item_2

Figure 10.104: The code lines in the Action editor: an On Change action with statements that 
allow a shopper to switch layers by choosing an item in a drop-down list.
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 my_item_3

TIP: It is recommended to 
close the variable settings 
dialog and save your 
document before you start 
creating the action.

5 Click the Actions tab and then the On Change Edit button to start the Action 
editor.
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The Action editor is opened without any code lines if this is a new variable. If 
you are editing an existing variable with actions, you will see the code lines 
for the variable.

6 In the Code tab, click the Add button to add your first line of code.
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The first line is displayed with a drop-down list. This drop-down list is the 
first step in the code wizard.

7 Click the first drop-down list, and select set to write the first set statement.

A second drop-down list is displayed where you can select the object to be set.
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8 In the second drop-down list, select layer.

TIP: You can select an item 
in the lists by typing the first 
letter once, or multiple 
times if multiple items start 
with the same letter.

A third drop-down list is displayed where you can select one of the 3 layers 
available in your document.

9 In the third drop-down list, select My_Layer_1.

NOTE: These are the names that you have given to the layers in your 
document.

10 Continue the wizard until you have the following statement on line 1:

1 set layer My_Layer_1 visible = false
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11 Click the Add button to add the second line of code and write the second line 
of code using the drop-down lists:

2 set layer My_Layer_2 visible = false

12 Continue the wizard, and add 1 more line so you have the first 3 lines of your 
code.

These are the set statements that initially hide the layers.

TIP: You can use the Delete, 
Move Up, Move Down, Copy 
buttons to work faster when 
creating your code lines.

13 Now continue with the if/else statements. Click the Add button to add line 4 
of your code:

4 if variable Change image SelectedItemName is string my_item_1

14 Complete the action with lines 5 to 10 until you have all code lines as follows:

1 set layer My_Layer_1 visible = false
2 set layer My_Layer_2 visible = false
3 set layer My_Layer_3 visible = false
4 if variable Change image selectedItemName is string my_item_1
5 set layer My_Layer_1 visible = true
6 else if variable Change image selectedItemName is string my_item_2
7 set layer My_Layer_2 visible = true
8 else if variable Change image selectedItemName is string my_item_3
9 set layer My_Layer_3 visible = true
10 end if
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NOTE: The string value for the list item names (my_item_1, etc.) has to be 
typed in the field; they do not appear in a drop-down list. Make sure you 
enter the correct value, otherwise your variable will not work properly.

15 When you have created all the lines of code, click Apply to save your changes.

16 Click Close to finish your variable settings and save the document.

17 In the Step 3: Initialize Form Variables panel, you can check that your 
variable is working as expected and emulate the shopper experience.

The Change Image variable has three items in the drop-down list. The 
shopper can select a different layer for the document by choosing one of the 
items in the list.

Figure 10.105: The first item in the list makes My_Layer_1 visible and hides the other layers.

Figure 10.106: The second item in the list makes My_Layer_2 visible.
StoreFront User’s Guide



 

10 ONLINE EDITOR 475
18 If the action works as expected, save your document. If the action does not 
work as expected, go back to the Step 1: Create Variables panel, and edit the 
actions in the variable. In the Action editor, check that you:

 selected the correct statement parameters in the various drop-down lists.

 entered the correct values for the list items: the string values must be 
identical to the list item names you created in the Type Specific tab.

19 Close the Online Editor and add your newly created, customizable product 
with On Change action to a store.

Change Text Color In this example you will set up a document to enable the shopper to change the 
color of the text throughout the document by simply choosing an item in a drop-
down list.

NOTE: You should not create actions that change process colors to spot colors or 
vice versa because the changes are not taken into account in your pricing.

Summary

 Action type: On Change (In the Actions tab, edit On Change.)

 Variable type: List with 3 items: my_color_1, my_color_2, my_color_3

 Document with the following colors:

 My_Default_Color: Apply this color to the text that you want to change 
with the action

Figure 10.107: The third item in the list makes My_Layer_3 visible.
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 My_Blue, My_ Green, My_Red: colors applied to the text formatted with 
My_Default_Color, depending on the selected list item

 Action code:

 On Change Action to change text color

NOTE: This procedure is similar to the one for creating an action to switch layers 
in a document. Refer to “On Change Action to show/hide layers” on page 468 for 
more details on creating the action, but replace the action code as specified 
below.

1 Edit your document in the Online Editor and check in the Text tab that the 
text frame contains the colors that you want to use in your variable action:

 My_Default_Color

 My_Blue

 My_ Green

 My_Red

In Edit Text mode, select the text and open the Character Settings panel.

1 if variable Change text Color selectedItemName is string my_color_1
2 set color My_Default_Color applyFromColor = color My_Red id
3 else if variable Change text color selectedItemName is string my_color_2
4 set color My_Default_Color applyFromColor = color My_Green id
5 else if variable Change text color selectedItemName is string my_color_3
6 set color My_Default_Color applyFromColor = color My_Blue id
7 end if
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It is recommended to create your colors in the original InDesign document. 
However, you can also create these colors at this stage, in the Online Editor, 
by renaming and overwriting colors in the list which are not being used in the 
document: select a color in the drop-down list, and click the color patch to 
open the Color editor.

2 Assign My_Default_Color to the text you want to modify with the action.

NOTE: Do not assign dedicated InDesign colors such as [Black] and [White] 
to the text you want to modify. These colors cannot be modified by the 
variable action and will generate errors when you try to save your document.

3 Save the document and go to the Forms tab, to create the variable with 
actions.

4 In the Forms tab, click the Add button and then the pencil icon to open the 
New Variable dialog.
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5 In the General tab of the New Variable dialog, complete as follows:

 Name: Change text color

 Display Name: Change text color

 Type: Choose List from the drop-down.

6 In the Type Specific tab, click the Add button and create 3 list items:

 my_color_1

 my_color_2

 my_color_3

7 Click the Actions tab and then the On Change Edit button to start the Action 
editor.

The Action editor is opened without any code lines.

8 In the Code tab, add the following lines of code.

NOTE: The values after string must be typed in the fields.

NOTE: Instead of switching color swatches, it’s also possible to specify color 
values. In this case the code is:
set color My_Default_Color colorValue = colorvalue cmyk 20 100 
90 0

9 When you have created all the lines of code, click Apply to save your changes.

10 Click Close to finish your variable settings and save the document.

11 In the Step 3: Initialize Form Variables panel, you can check that your 
variable is working as expected and emulate the shopper experience.

1 if variable Change text color selectedItemName is string my_color_1
2 set color My_Default_Color applyFromColor = color My_Red id
3 else if variable Change text color selectedItemName is string my_color_2
4 set color My_Default_Color applyFromColor = color My_Green id
5 else if variable Change text color selectedItemName is string my_color_3
6 set color My_Default_Color applyFromColor = color My_Blue id
7 end if
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The Change text color variable has three items in the drop-down list. The 
shopper can select a text color for the text frame by choosing one of the items 
in the list.

Jump to Page on 
Input

When a shopper opens a document and enters information in a form field, he 
may not see anything happen if the variable is placed on a page which is not 
visible in the current view. This example uses an action to jump to the page 
where the form field input appears when the shopper begins to type in the field.
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Summary

Use this single-line action to jump to the page where the variable in question is 
placed.

 Action type: On Change (In the Actions tab, edit On Change.)

 Variable type: all

 Action code: to jump to page 2 of the document:

Figure 10.108: The variable for this form field is placed on page 2 of this document and is 
initially not visible.

Figure 10.109: The relevant page is displayed when the shopper starts entering input in the 
form field.
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 Action code: to jump to page 1 of the document:

Combine Variables The following examples put multiple variables of a form on a single line with the 
necessary separators or special formatting. This is typically used for letterhead 
footers, business cards, special price formatting, etc.

NOTE: This procedure is similar to the one for creating an action to switch layers 
in a document. Refer to “On Change Action to show/hide layers” on page 468 for 
more details on creating the variable with an action, but replace the action code 
as specified below.

Example 1: Footer with simple combination

This example inserts different separators, commas, spaces, dashes, depending 
on the variable.

The code for this action is one line with a statement that returns as many 
variables as you want. The variables are joined in the actions code by selecting 
the “&” operator. All the variables that will be combined must be set to Required 
in the General tab of the Variable Settings dialog, otherwise the separators will 
not make sense if a field remains empty.

Summary

 Action type: Value (In the Actions tab, edit Value.)

 Variable type: Calculated Field

1 execute page 2 select

1 execute page 1 select

Figure 10.110: Multiple variables are combined in an variable action to create a single line.
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 Document with multiple variables (all variables are set to Required):

 First_Name

 Last_Name

 Street

 City

 Country

 Email

 Action code for new variable:

Example 2: Footer combining variables with function

This example is the same as Example 1, but with only one separator, a dash. 
Logic has been added to remove the separators if one or more form fields are not 
filled in by the shopper. This means the variables that will be combined must not 
necessarily be set to Required.

1 return variable First_Name value & string <space>
& variable Last_Name value & string <space>-<space>
& variable Street value & string ,<space>
& variable City value & string ,<space>
& variable Country value & string <space>-<space>email:<space>
& variable Email value

Figure 10.111: All the combined variables have a value and separator.
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Summary

 Action type: Value (In the Actions tab, edit Value.)

 Variable type: Calculated Field

 Document with multiple variables:

 Company

 Address

 Phone

 Tax_No

 Bank_Account

 Action code: for new variable Footer:

The code starts with 2 lines that each declare a local variable (localStrTemp 
and localBlnAddHyphen) which are subsequently used in the rest of the 
code. Lines 3 to 9 are a conditional statement that checks whether a variable 
is filled with a string value or not, and then sets the dash separator or leaves 
it out. These 7 lines can be repeated for as many variables that you want to 
include in the new combined variable. Use CTRL Copy and add the 7 lines to 
the clipboard, and then paste these lines and change the variable name.

Figure 10.112: The separator is omitted if a variable has no value entered.
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Example 3: Footer combining variables with regular expression

This example is the same as Example 2, but uses regular expressions for the dash 
separator, and one declare statement. The result is the same, but you use less 
code than for example 2.

In this example we add <space>-<space> to each variable and concatenate all 
of them into one single local and temporary variable "localStrTemp". This means 

1 declare string localStrTemp = string
2 declare boolean localBlnAddHyphen = false

3 if variable Company value is not string
4 if local localBlnAddHyphen is true
5 set local localStrTemp = local localStrTemp & string <space>-<space>
6 end if
7 set local localStrTemp = local localStrTemp & variable Company value
8 set local localBlnAddHyphen = true
9 end if

10 if variable Address value is not string
11 if local localBlnAddHyphen is true
12 set local localStrTemp = local localStrTemp & string <space>-<space>
13 end if
14 set local localStrTemp = local localStrTemp & variable Address value
15 set local localBlnAddHyphen = true
16 end if

17  if variable Phone value is not string
18 if local localBlnAddHyphen is true
19 set local localStrTemp = local localStrTemp & string <space>-<space>
20 end if
21 set local localStrTemp = local localStrTemp & variable Phone value
22 set local localBlnAddHyphen = true
23 end if

24 if variable Tax_No value is not string
25 if local localBlnAddHyphen is true
26 set local localStrTemp = local localStrTemp & string <space>-<space>
27 end if
28 set local localStrTemp = local localStrTemp & variable Tax_No value
29 set local localBlnAddHyphen = true
30 end if

31 if variable Bank_Account value is not string
32 if local localBlnAddHyphen is true
33 set local localStrTemp = local localStrTemp & string <space>-<space>
34 end if
35 set local localStrTemp = local localStrTemp & variable Bank_Account value
36 set local localBlnAddHyphen = true
37 end if

38 return local localStrTemp
StoreFront User’s Guide



 

10 ONLINE EDITOR 485
that in case not all variables are filled in we might end up with multiple 
<space>-<space> values after each other, or in front or behind the final string. 

To solve this, we create two regular expressions:

 one to replace the double occurrences of <space>-<space> (at least 2 and 
maximum 10 occurrences in this example) with just one occurrence.

 one to remove the <space>-<space> in the beginning or at the end of the 
result by replacing it with a <blank> string.

Summary

 Action code:

Example 4: Price formatting with smaller decimals

This example creates a price with 2 decimals which are smaller and aligned with 
the top of the number before the decimal point. The visible price is a combina-
tion of two variables which are not visible on the form but only visible in the 
document.

1 declare string localStrTemp = string

2 set local localStrTemp = local localStrTemp & variable Company value & string <space>-<space>
3 set local localStrTemp = local localStrTemp & variable Address value & string <space>-<space>
4 set local localStrTemp = local localStrTemp & variable Phone value & string <space>-<space>
5 set local localStrTemp = local localStrTemp & variable Tax_No value & string <space>-<space>
6 set local localStrTemp = local localStrTemp & variable Bank_Account value

7 set local localStrTemp = stringFunctions replaceRegExp
string: local localStrTemp
regexp: string /( <space>-<space> ){2,10}/g
replace: string <space>-<space>

8 set local localStrTemp = stringFunctions replaceRegExp
string: local localStrTemp
regexp: string /^ <space>-<space> | <space>-<space> $/g
replace: string <blank>

9 return local localStrTemp
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Summary

 Action type: On Change (In the Actions tab, edit On Change.)

 Variable type: Number

 Document with multiple variables

First create these two variables:

 A1: digits before the decimal point

 A2: digits after the decimal point

Then use these two variables in a third variable with an action

 Price: new variable with action

 Action code for the Price variable:

 Price with smaller, top-aligned decimals

1 In your document, create the following 3 variables in the Forms tab:

Figure 10.113: Two variables, which are not visible, are combined to create a price variable 
with small decimals which are aligned along the top and without the decimal 
point

1 set variable A1 value = stringFunctions subString string: variable Price displayValue
startIndex: number 0
length: stringFunctions indexOf string: variable Price displayValue
find: string .
caseSensitive: false

2 set variable A2 value = stringFunctions subString string: variable Price displayValue
startIndex: stringFunctions indexOf string: variable Price displayValue <blank> + 
number 1
find: string .
caseSensitive: false
length: number 2
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 A1: the digits before the decimal point; a variable of type Short Text; not 
visible on the form

 A2: the digits after the decimal point; a variable of type Short Text; not 
visible

 Price: the price label which is visible on the form and to which the action 
code is applied; this is a variable of type Number; set the Snap Interval, 
Decimal Separator, Precision and Rounding as follows:

In the Actions tab, create the code as follows:

The screenshot below gives you an idea of how this code actually looks in the 
editor:

1 set variable A1 value = stringFunctions subString string: variable Price displayValue
startIndex: number 0
length: stringFunctions indexOf string: variable Price displayValue
find: string .
caseSensitive: false

2 set variable A2 value = stringFunctions subString string: variable Price displayValue
startIndex: stringFunctions indexOf string: variable Price displayValue <blank> + 
number 1
find: string .
caseSensitive: false
length: number 2
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2 Insert variables A1 and A2 in the document.

Format these two variables in the Text Tab; set the Font Size of variable A2 
so it’s smaller than A1 and increase the base line of A2 so it aligns with the top 
of A1.

3 Save the document and go back to the Forms tab and check that the Price 
variable works as expected.

Form Validation This example checks the syntax of the value entered by a shopper and creates a 
yellow icon with a warning in the tooltip.
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Summary

The action code uses a regular expression to validate the shopper’s input on the 
form. Several action code samples are given below to validate an e-mail address, 
a car license plate and a bank account number.

 Action type: Validate (In the Actions tab, edit Validate.)

 Variable type: Short Text

 Document with variables defined and set to Visible

 Regular expressions used in the action code for the regexp string:

 an e-mail address: e.g. john.doe@mycompany.com

^([a-zA-Z0-9.\-]+)@([a-zA-Z0-9.\-]+)$

 a license plate: e.g. 1 ABC 234

^(([0-9]{0,1}[ ]*[A-Z]{3}[ ]*[0-9]{3})|([0-9]{3}[ ]*[A-Z]{3}))$

 a bank account number: e.g. 123-4567891-23

^[0-9]{3}-[0-9]{7}-[0-9]{2}$

 a phone number: e.g. 123 45 678

^[0-9]{3}[ ][0-9]{2}[ ][0-9]{3}$

 Action code:
to validate an e-mail address: 

 Action code: to validate a license plate: 

Figure 10.114: A Validate action checks the syntax of an e-mail address and generates a 
warning icon with tooltip.

1 if stringFunctions matchesRegExp string: variable My_Email value is not true
regexp: string ^([a-zA-Z0-9.\-]+)@([a-zA-Z0-9.\-]+)$

2 return string The e-mail you entered is not correct.
3 end if
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 Action code: to validate a bank account number: 

 Action code: to validate a phone number (with return long string to 
create a tooltip with multiple lines):

Form Validation 
with Correction

This example uses two variables to check the format of the value entered by a 
shopper for a phone number, corrects the input and generates warnings until the 
number is entered according to the correct format.

1 if stringFunctions matchesRegExp string: variable My_License value is not true
regexp: string ^(([0-9]{0,1}[ ]*[A-Z]{3}[ ]*[0-9]{3})|([0-9]{3}[ ]*[A-Z]{3}))$

2 return string The license plate you entered is not correct.
3 end if

1 if stringFunctions matchesRegExp string: variable My_Account value is not true
regexp: string ^[0-9]{3}-[0-9]{7}-[0-9]{2}$

2 return string The account you entered is not correct.
3 end if

1 if stringFunctions matchesRegExp string: variable My_Phone value is not true
regexp: string \d\d\d <space> \d\d <space> \d\d\d

2 return long string This phone number is not formatted correctly. The expected format 
is: 123 45 678

3 end if

Figure 10.115: Return long string creates a validation tooltip with multiple lines.
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Summary

A phone number must have the following format:

 (123) 456-7890

You want to cope with the following examples of incorrect input:

 1234567890

 123-456.7890

 123/456_7890

 (123) 456 7890

Two variables are required to accomplish the validation and correction. One 
visible variable that validates the input of the user and another hidden variable 
that corrects the input of the first variable to the expected format. Only the 
hidden variable is used in the source code of the text frame in the document.

variable 1: Phone number_input

If the user types fewer or more than 10 digits, a warning is displayed. The action 
also displays a warning if the user enters a character which is not a digit, a space, 
a hyphen or round brackets. In addition to the warning, the action automatically 
omits the unsupported characters. This input variable is visible on the form.

 Action type: Validate (In the Actions tab, edit Validate.)

Figure 10.116: Actions insert brackets, spaces and dashes for a phone number and generates 
warnings until the input is correct.
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 Variable type: Short Text

 Set to Visible

 Regular expressions used in the action code for the regexp string:

 /[^\d]/gi

 /[^\d\-\/\(\)\. ]/gi

 Action code: see screenshot

variable 2: Phone number_normalized

A second variable, in this example called Phone number_normalized, has a Value 
action type. This variable is used in the first variable but is not visible on the 
form.

 Action type: Value (In the Actions tab, edit Value.)

 Variable type: Calculated Field

 Visible not selected

 Regular expressions used in the action code for the regexp string:

 /[^\d]/gi

 Action code: see screenshot
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Strip Formatting Formatted Text type variables are variables that a shopper can format (for 
example, change the font type, color, size, etc.) and these need to be stripped of 
their formatting if you want to use them in another variable which is not in a text 
frame. This is because all variables are enclosed in XML formatting that can 
interfere with the new variable. A typical example of this is the re-use of variable 
values in barcodes. The formatting is stripped using a Calculated Field type 
variable with an action that includes a regular expression to strip the formatting 
and only return the value of the variable. Your form can be set up so that the 
shopper does not see the calculated form fields.

Summary

In the following example, a QR code is generated which includes a company URL 
that the shopper can format for its original position on a business card. This text 
variable is called Company_URL and the shopper can change the color and font 
size as required, for example to make it larger if the URL text is short, or change 
the color so it stands out. To insert this URL in a QR code, a new calculated field 
variable, called Company URL_TXT is created. This variable is based on the first 
variable and set up so it is not visible on the form.

 Action type: Value calculation (In the Actions tab, edit Value calculation.)

 Variable type: Calculated Field

 Document with Formatted Text variable set to Visible: Company_URL

 Regular expressions used in the action code for the regexp string to strip 
formatting:

/<[^>]*>/gi

 Action code for Company_URL_TXT:
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 Strip formatting from text for use in QR code

1 In the Forms tab, check that your document has the following variable 
defined:

 Name: Company_URL

 Display Name: Company URL

 Type: Formatted Text; in the Type Specific tab, enable Font, Font Size, 
Color, Alignment, so the shopper can modify the formatting.

 Visible check box selected

This variable is used in the document.

The intention is to re-use this variable in a QR code, but first we need to 
create a calculated field version of this variable.

2 In the Forms tab, create a new variable with the following settings:

 Name: Company_URL_TXT

 Display Name: Company URL TXT

 Type: Calculated Field

 Visible check box cleared

3 In the Actions tab, click Value: Edit to open the Action Editor, and add a 
code line.

4 Specify the code line as follows:

1 return stringFunctions replaceRegExp string variable Company_URL value
regexp: string /<[^>]*>/gi
replace string
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NOTE: The values after string must be typed in the fields.

5 Click Apply to save your changes.

6 Click Close to finish your variable settings and save the document.

7 Go to the Barcodes tab and add a barcodes frame to the document.

8 In the Type drop-down list, choose QR Code.

9 In the Variable drop-down list, choose your calculated variable: Compa-
ny_URL_TXT, not the formatted text variable.

10 Specify the settings for the QR code as desired and click Apply.

1 return stringFunctions replaceRegExp string variable Company_URL value
regexp: string /<[^>]*>/gi
replace string
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The QR barcode is placed on the document and includes the URL without 
formatting to ensure that the URL functions correctly when scanned.

If you selected the unstripped version of the variable, Company_URL, you 
would see the following code in the value field:

The frame for the QR barcode remains empty because the QR code cannot be 
generated with this formatted variable.

Clear fields A variable can be used to clear the fields of a form each time the document is 
opened for editing.

 Action type: Validate (In the Actions tab, edit Validate.)

 Variable type: any type set to Visible

 Action code:

NOTE: Make sure that the 'Visible' check box is activated whenever you save your 
product. 

Insert MIS ID 
Profile data

Data from a user profile, such as the first name and last name, can automatically 
be inserted into customizable documents using Autofill Forms, which is limited 
to the fields that are available in the user’s profile. But say you want to retrieve 
other data, such as a person’s job title and personnel ID code, to use in a business 
card. These could be stored in the MIS ID field: the data is separated with a 
colon.
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 Insert MIS ID profile data

1 Create a business card using the Online Editor.

2 Add two variables 'title' and 'id' and mark these as hidden so they do not show 
up in the form that the user needs to fill in.

3 Insert these two variables in the layout.

4 Create a variable called ASF_USERMISID and set it to be visible. This variable 
is used to retrieve the data from the MIS ID field of the user profile, so its 
name must be ASF_USERMISID.

5 Create an additional variable of any type called dofirst which is set to visible. 
This variable will contain the action that does all the work.

6 Add a Validate action for the dofirst variable. Its syntax is:

Figure 10.117: Additional profile data in the MIS ID field

1 if variable dofirst visible is true
2 set variable dofirst visible = false
3 set variable title value = stringFunctions substring string variable ASF_USERMISID displayValue
4 startindex number 0
5 length stringFunctions indexOf string variable ASF_USERMISID displayValue
6 find string :
7 caseSensitive false
8 set variable id value = stringFunctions substring string variable ASF_USERMISID displayValue
9 startindex stringFunctions indexOf string variable ASF_USERMISID displayValue + number 1
10 find string :
11 caseSensitive false
12 length number 6
13 set variable ASF_USERMISID visible = false
14 end if
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How it works

The dofirst and ASF_USERMISID variables initially need to be visible because 
otherwise the action does not work. Since they should not be visible to the user, 
the script hides them.

The bulk of the code is for pulling apart ASF_USERMISID and putting the data 
in the title and id variables. In this script it is done using the 'substring' function. 
For more complex sets of data you can use regular expressions.

The following restrictions apply:

 The MIS ID field is limited to 255 characters.

 If you change the MIS ID field of a user while that user is logged in, the old 
values remain in use while that user customizes the document.

 Whenever you tweak this document in StoreCenter using the Online Editor, 
you need to make sure that the dofirst and ASF_USERMISID variables are 
visible in the form when you save the customizable document. If they are 
hidden, the script will not work when a user attempts to edit a business card.

Insert current date A variable action can be used to automatically insert the current date into a 
customizable document. Within that action, JavaScript is used to retrieve the 
date and format it properly.

Summary

 Action type: Validate (In the Actions tab, edit Validate.)

 Variable: Short text and set to visible

 Action code:

How it works

Create a short text variable called InsertDate. Make sure it is visible each time 
you save the document.

Create a Validate action that contains the action code above.

In the action, this is the code you could use for 'JavaScript code':

1 if variable InsertDate visible is true
2 set variable InsertDate visible is false
3 set variable InsertDate value = JavaScript eval long string 'JavaScript code
4 end if
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    var d = new Date();

    var day = ("0" + d.getDate()).slice(-2);

    var month = ("0" + (d.getMonth() + 1)).slice(-2);

    var year = d.getFullYear();

    return year + "-" + month + "-" + day;

Or this JavaScript code which only adds the month and year:

return [01,02,03,04,05,06,07,08,09,10,11,12]

[(new Date()).getMonth()] + '-' + (new Date()).getFullYear();

Moving frames 
using a variable 
action

A variable action can be used to move a specific text or image frame on a page in 
a customizable document. This is done by tagging the frame and then changing 
the x or y coordinate of the frame with that tag:

Select the frame in the document layout. Give it a name using the 'Tag' field in 
the Objects > Object Location pane.

Here are two examples for changing the x and y coordinates of this frame, based 
on either the value of a variable or a fixed value:

    set frame 'frame name' x variable 'var name' value

    set frame y number 'value'

Removing trailing 
carriage returns

An invitation card can contain the address of the event and additional data such 
as the start and end date. If all of this data is inserted in the same frame and for 
the address a 'long text' variable is used, you may run into the following 
problem: if the user enters the street name, number, postal code and city in the 
address field and presses the ENTER button after typing the city name, the 
invitation has a blank line of text between the city and the start date of the event.

A variable action can be used to remove such trailing carriage return(s) and 
other unwanted content. This is done by using the original variable for data 
entry, copying a cleaned-up version of the content to the second variable and 
using that second variable in the document:

Assuming 'address' is the name of the forms variable, create a second 'Long Text' 
variable called 'address_final'.

Make this variable invisible and insert it in the text frame in the layout.
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Add an 'On change' action in the original 'address' variable to replace undesired 
returns and full stops by a blank string. 

 Action code: to remove trailing carriage returns

 Action code: to remove trailing carriage returns, other unwanted returns and 
full stops

Capitalize names If the company style guide states that the first character of first and last names 
must be uppercase, then a variable action can automatically correct users who 
are unaware of this rule.

Two variables are required to accomplish the validation and correction. One 
visible variable that validates the input of the user and another hidden variable 
that corrects the input of the first variable to the expected format. Only the 
hidden variable is used in the source code of the text frame in the document.

variable 1: firstname_input

 Action type: On change

 Action code:

variable 2: firstname

 Set to “hidden”

1 set variable address_final value = stringFunctions replaceRegExp string: variable 
address value

2 regexp: string [\r\n]+$
3 replace string <blank>

1 set variable address_final value = stringFunctions replaceRegExp string: variable 
address value

2 regexp: string ^[\r\n]+|\.|[\r\n]+$
3 replace string <blank>

1 declare string temp = stringFunctions toUpperCase string StringFunctions substring 
string variable firstname_input value

2 startIndex number 0
3 length number 1
4 set local temp = local temp & stringFunctions substring string variable firstname_input 

value
5 startIndex number 1
6 length stringFunctions length string variable firstname_input value
7 set variable firstname value = local temp
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Generate an E-mail 
Address

When ordering an ID card, users need to fill in their first name and last name. 
These are stored in the variables firstname and lastname. The e-mail address 
needs to be created automatically using these two variables. It consists of the 
first digit of the first name, a period and then the last name. The '@domain' part 
of the e-mail address is added using a suffix. All characters must be lower case. 
If the last name contains spaces these must be converted to a period.

On the ID card, a variable named email is used with type set to 'Calculated 
Field'. The 'Value' action below is used for this email variable. It creates a tempo-
rary variable named tmpEmail, copies the first digit of firstname and appends 
it with a period and the lastname variable. Next, all spaces in tmpEmail are 
replaced by periods and all characters are converted to lower case. The result is 
then returned to the email variable.

 Action type: Value

 Variable type: Calculated Field

 Action code:

Change a Font In a forms-based document users may need to stylize text by selecting a font 
from a drop-down menu. Such a menu can be created using a list variable that 
contains a list of all the fonts you offer to users. It is essential that these fonts are 
embedded in the original InDesign document that was used to create the 
customizable product. Below is the code of an action that alternates the font for 
the paragraph style 'Subtitle' between Arial and Myriad, depending on the 
choice made in a list variable called 'font'.

 Action type: On Change

 Variable type: List

 Action code:

1 declare string tmpEmail =
2 set local tmpEmail = stringFunctions subString string variable firstname value 

startIndex number 0
length number 1

3 set local tmpEmail = local tempEmail & string . & variable lastname value
4 set local tmpEmail = stringFunctions replace string local tmpEmail

find string <space>
replace string .
caseSensitive false

5 set local tmpEmail = stringFunctions toLowerCase string local tmpEmail
6 return local tmpEmail
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Change Typeface 
for Copy Fitting

Fitting text in a frame (see “Copy Fitting Styles and Style Settings” on page 418) 
by simply scaling text is not always desirable. An alternative solution is to apply 
a narrow typeface when a line becomes too long. This switching between a 
regular and a narrow typeface as the user types the text can be automated with 
the following action.

For the example below, two fonts are available in the document: Micron-Regular 
and Micron-Narrow. The text uses a character style called 'Title' and the action 
changes the typeface of this character style if the user enters more than 25 
characters in a variable called 'City'. The 'On Change' action is applied to this 
variable.

 Action type: On Change

 Action code:

Insert special 
characters in 
variables

You must use an action to insert special characters such as a non-breaking space, 
a tab, a carriage return, etc. in a variable.

For the example below, the user must fill in two fields, var1 and var2. You want 
to combine both variables in a third variable, var3, with a non-breaking space 
between var1 and var2. Var3 is defined as a calculated field type of variable. Use 
the following 'Value' action to combine the variables:

 Action type: Value

 Variable type: Calculated Field

 Action code:

1 if variable font selectedItemName is string Arial
2 set paragraphStyle Subtitle font = font Arial Regular id
3 else if variable font selectedItemName is string Myriad
4 set paragraphStyle Subtitle font = font Myriad Web Pro Regular id
5 end if

1 set characterStyle Title font = font Micron-Regular id
2 if stringFunctions length string variable City value > string 25
3 set characterStyle Title font = font Micron-Narrow id
4 end if
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In line 2 return String.fromCharCode(160) needs to be entered in the 
empty field for defining the JavaScript string. '160' refers to the UTF-8 code for 
a non-breaking space. There are other codes that might be useful: use 9 for a 
horizontal tab, 13 for a carriage return and 173 for a soft hyphen.

Switch between 
oldstyle and lining 
typefaces for 
numerals

Some typefaces include two different styles for numerals: oldstyle and lining. 
You choose the style by typing either upper case or lower case numbers. If the 
regular lower case numbers are used, oldstyle numbers are displayed. If upper 
case numbers are used, then the numbers are lined.

The action below explains how you can make sure the address on a business card 
uses both upper and lower case characters for the street name but only upper 
case characters for all numbers.

 Create two variables for handling the address. The first variable is a long 
string type variable. In the script below it is called fcmaddress_INPUT. This 
variable is to enter an address in the form. The second variable is called 
fcmaddress and it is of the type Calculated Field. This variable is set to be 
invisible in the form because it is used to insert the correctly styled address in 
the business card.

 Define a Value Action for the fcmaddress variable.

 Action code:

1 declare string total = long string
2 set local total = variable var1 value & JavaScript eval script: long string return 

String.fromCharCode(160)
3 set local total = local total & variable var2 value
4 return local total
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Switch between 
languages (multi-
lingual form)

In a multilingual form you can use a variable to switch to the language of the 
store so the shopper sees the form labels in his own language.

 Create a variable named translation_keep_visible. Its type is not 
important, leave it set to 'Short Text'. Make sure the variable is visible.

 Add an action of the 'Validate' type that contains the code below. In this 
example it is assumed there are two variables firstname and lastname that 
need their display name or label translated to French and German
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 Action code:

Compare date 
variables

You can compare a date variable with other date variables or string variables 
formatted as YYYY/MM/DD.

Shortcuts

1 if variable translation_keep_visible visible is true
2 set variable translation_keep_visible visible = false
3 declare string language = document languageName
4 if local language is string FR
5 set variable firstname displayName = string Prénom
6 set variable lastname displayName = string Nom
7 end if
8 if local language is string DE
9 set variable firstname displayName = string Vorname
10 set variable lastname displayName = string Familienname
11 end if
12 end if

To Press

Select a frame that is hidden by another frame (cycle through stacked 
layers)

CTRL + click

Undo the last change CTRL + Z

Redo the last change CTRL + Y

Copy selected frame, text CTRL + C

Paste selected frame, text CTRL + V
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Use an Excel file for Autofill

In products like business cards or promotional posters, shoppers may want to fill 
in data that are already available elsewhere, for example, a list of employees 
with their name, job title and contact details. The autofill feature allows you to 
link a spreadsheet containing data to a customizable product. This way shoppers 
only need to select a record and the details are inserted automatically. This 
feature can also be used to automatically insert product specifications and prices 
in a sales document or populate data sheets, saving time, reducing the risk of 
errors, and eliminating typos. This is done by uploading an Excel file, which 
works together with the uploaded STOREFRONT package, when you create your 
customizable product.

 Link a file with data for autofill

1 Start the wizard to create a customizable product. See “Creating Products” 
on page 157.

2 In the Uploaded Files window, go to the Data panel and download one of two 
Excel templates:

 without Identifier column: shoppers will see the data present in the first 
column of the Excel file

 with Identifier column: shoppers will see the data present in the 
ASF_IDENTIFIER column

3 Enter the data in one of the above templates (in Excel).

NOTE: Sheets with up to 1000 rows are supported.

4 Upload the populated file using the Choose File button and click the 
Validate File button to check that the file has been completed correctly.

Shoppers can now use the data when ordering the customizable product.

Clicking Search displays the entire list which can be filtered using the Search 
box.
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Customizable Product with User-Definable Size

A shopper may want to use the Online Editor to create documents from scratch 
and not use a predefined size.This is possible for products that use the Unbound 
flat - Variable Size template base type, e.g. for posters, signs and cards. You can 
add content to the document and make it scale or move with the applied 
document size by using the Dynamic Layout settings (see “Dynamic Layout 
Function Formulas” on page 398).

 Create a Customizable Product with user-definable size

1 Create an InDesign document that contains a single blank page. Ideally the 
page size matches the most popular size shoppers will order, but this is not a 
requirement.

2 Add a text frame that uses all the fonts that you want to make available in the 
Online Editor and for which you have a license that allows online use. Put this 
text frame on a hidden layer.

3 Create color swatches if you that you want to make these available in the 
Online Editor. Users will not be able to add their own swatches in the Online 
Editor.

4 You can add content such as images or text frames that will be retained in the 
Online Editor. Keep in mind that STOREFRONT uses the top-left corner of the 
document as the point of origin when the source document is cropped or 
enlarged to the dimensions defined by the user. Use Dynamic Layout 
Function Formulas to make the content move or scale to the document size.

5 Export the InDesign document to a STOREFRONT package. Clear the option to 
include hidden layers. All the fonts you added to a hidden layer will still be 
maintained.

6 Create a product template with base type ‘Unbound – Flat – Variable Size’.

7 To avoid shoppers seeing a blank white rectangle if your document does not 
contain any image content, create a preview image that shows the shopper 
what he is buying.
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8 Create a customizable product using the above-mentioned product template.

9 Upload the STOREFRONT Package and Preview Image you created.

10 Set the workspace to ‘Advanced’ or ‘Expert’ so that shoppers have the creative 
freedom to personalize the document.

NOTE: Maximum recommended dimensions: 508 x 508 cm.
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CHAPTER
11 Multilingual Storefronts 

NOTE: Some of the procedures in this section are for the Printer Administrator 
only.

The default design components of the storefront are already translated in several 
languages. However, the actual content of the storefront needs to be translated 
separately.

 Overview ....................................................................................................................512
 Supported Languages ...........................................................................................513
 Translating Your Content ....................................................................................515
511



512 OVERVIEW
Overview

A multilingual storefront requires that the following components are translated:

 Storefront Pages, including Custom Footer, Shipping Services, Shipping 
Regions, Payment Methods, Invoice if custom layout is used

 Product Templates (including options and media sizes)

 Categories

 Products

1 Default design components (already translated)
2 Page content including links
3 Product name and category name
4 Product template options in the Place Order box
5 Product specifications
6 Product description

Figure 11.118: Components of a multilingual storefront
StoreFront User’s Guide



 

11 MULTILINGUAL STOREFRONTS 513
Supported Languages

The following languages are currently provided for storefronts:

 Chinese - Simplified

 Chinese - Traditional

 Czech

 Danish

 Dutch

 English (US and British English)

 Faroese

 Finnish

 French

 German

 Italian

 Japanese

 Korean

 Norwegian

 Polish

 Portuguese

 Portuguese (Brazil)

 Russian

 Spanish

 Swedish
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Before setting up a multilingual storefront, check that the extra languages you 
want are supported in the store. The Printer Administrator may need to set the 
extra languages for the company so they are available for the store.

 Are extra languages supported for the Company?

The Printer Administrator must check that extra languages have been assigned 
to a Company.

1 On the menu bar, choose Company and select a company in the list.

2 Click the Languages tab.

The Supported Languages for the Company are in the right column and these 
are the available languages for the stores of this Company.

 Are extra languages available for the store?

The Company Administrator can check whether extra languages have been 
assigned to his store.

1 On the menu bar, choose Stores and select the store in the list.

2 Click the Languages tab.

The Available Languages column lists the languages supported by the 
Company. The Supported Languages for the store are in the right column.

If the language you need is not in the Available Languages list, ask your 
Printer Administrator to add this language to your Company.
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Translating Your Content

If your store supports other languages, the default storefront design components 
will be translated. However, the content specific to your store needs to be trans-
lated separately.

 Translate Pages, Categories, Products, Custom Footer and Custom Invoice

Page content, category names, product descriptions, store name, etc. are trans-
lated in Store Translations.

1 On the menu bar, choose Stores. 

2 Select the store you want to translate.

3 At the bottom of the Store list, click the Translations button.

OR, for Administrators

On the menu bar, choose Advanced > Translations > Store Translation.

The Store Translation dialog is displayed with a tree structure for each store.

TIP: Click the Snap Back 
button  to navigate from 
the translation sub-tab to 
the overview of stores.

4 Click the store you want to translate and choose the language you want to 
translate into (target language) in the drop-down list in the StoreFront 
Translation pane.

NOTE: The languages available in the drop-down list depend on the Store set-
up.

5 Enter your translation for Display Name, Fixed Delivery Address Label, and 
Additional Fee Labels.
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6 Click Save to confirm your changes for the Store Translations.

TIP: Click the Copy from 
Source Language (arrow) 
button to copy the source 
text to the target box and 
edit the translation.

This is the name of your storefront that appears in the browser title bar and 
tabs, on the logon page and in e-mail communications.

7 Expand the Store by clicking the + icon to reveal the Pages and Categories of 
the selected store.

8 Select Pages in the tree structure to display an overview of the Store Pages 
available for translation and then select a Page, e.g. Page 1, in the Store Pages 
list.

The translation pane is displayed under the Store Pages list.
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9 Choose the language you want to translate into (target language) in the 
drop-down list at the top of the right column.

The default translations for the chosen target language appear in the right 
column. 

10 Click in the fields to overtype the default translations or click the Copy from 
Source Language button if you want to keep the original text in these fields.

11 Click the Edit button to open the HTML WYSIWYG Editor where you can type 
your translation of the actual content. You can also add images specifically 
for this language.

TIP: Clear all the target 
translation fields by clicking 
Cancel.

12 If you want the same Banner to appear on the translated page, click the Copy 
from Source Language button; if you want to use an alternative image for 
the Banners, click the Edit button and browse to the location of the alterna-
tive image.

13 You can also use the Copy all from Source Language button at the top of the 
columns to copy all the information from the source language to the target 
language column.

CAUTION: Clicking the Copy all from Source Language button replaces any 
translations you may have already typed in the target language column.

14 Click Save to confirm your translations for the selected page and repeat for 
all pages.

1 Source language 
2 Target language 
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15 When the translation of the Pages is completed, select Categories in the 
Stores tree structure.

The list of categories is displayed on the right

16 Select each Category in the list to display the translation pane and translate 
the following field in the required languages:

 Name: the name of the category as used for the title of the storefront 
Category page and the name of the category on the home page

NOTE: The Category Image is the same for all languages and cannot be set per 
language.

17 Expand Categories and click one of the Categories to display all its Products.

18 Select a Product in the list to display the translation pane and translate the 
following fields in the required languages:

 Name: the name of the product as used for the title of the storefront 
Product page and the name of the product on the Category page

 Description

 Detailed description

 Tags: Tags must be translated to be effective. Try to use consistent trans-
lations for the various products.

You can type your translation in the various fields or copy the source text to 
the target fields as described for the pages.

19 Click Save to confirm your translations for the Product and repeat for all 
languages and all Products.

Figure 11.119: Translated product name and description on the Category page
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In the lists of products and categories, the blue Translated icon is displayed 
in the corresponding language columns. The gray icon indicates that the 
translation has not been started.

NOTE: Ensure that all fields are translated. The blue Translated icon only 
indicates that at least one of the fields is translated.

 Translate Product Options

Printer Administrator only

Product options are visible in the storefront when visitors view the specifications 
of a product they may want to order, e.g. the media type, etc.

1 On the menu bar, choose Product Templates. 

2 Select the Product Template you want to translate.

3 At the bottom of the Product Template list, click the Translate button.

TIP: Click the Snap Back 
button  to navigate from 
the translation sub-tab to 
the overview of Product 
Templates.

OR

On the menu bar, choose Advanced > Translations > Options 
Translation.

The Option Names sub-tab is displayed with the translatable options for the 
selected Product Template.

4 Choose the language you want to translate into (target language) in the 
drop-down list at the top of the right column.
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NOTE: The languages you see here in the drop-down list are all the languages 
available in STOREFRONT. 

The option fields for the chosen target language in the right column are 
empty. 

5 Click in the fields to type the translations or click the Copy from Source 
Language button if you want to re-use or overtype the original text in these 
fields.

6 You can also use the Copy all from Source Language button at the top of the 
columns to copy all the information from the source language to the target 
language column.

CAUTION: Clicking the Copy all from Source Language button replaces any 
translations you may have already typed in the target language column.

7 Click Save to confirm your translations for the options and repeat for all 
languages and all Product Templates.

 Translate Media Sizes, Shipping Services and Regions, Payment Methods, 
Custom User Attributes

Printer Administrator only

1 Source language 
2 Target language 
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 On the menu bar, choose Advanced > Translations > Media Size 
Translation/Shipping Services Translation/Shipping Regions 
Translation/Payment Methods Translation/Customer User Attributes 
Translation.

The rest of this procedure is the same as for translating Product Options.

Related topics: • Edit a Company on page 47
• Languages Tab on page 214
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APPENDIX
A Icons and Buttons 
Overview

This section gives an overview of the icons and buttons used in StoreCenter.

 Product Types ..........................................................................................................524
 Product Status (Product tab) ..............................................................................525
 Order Status .............................................................................................................526
 Orders Toolbar Buttons ........................................................................................527
 Shipping (Orders tab) ............................................................................................529
 Payment Status ......................................................................................................530
 Translation Status ..................................................................................................531
 Online Editor ............................................................................................................532
523



524 PRODUCT TYPES
Product Types

Customizable product

Variable data product

Uploadable product

On-Demand product

Printed stock product

Non-printed product

Digital product

Product Kit
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Product Status (Product tab)

Unassigned (not in use by a store)

Price list is not complete

Stock alarm level is reached

Product is out of stock

Free shipping: for product with free shipping enabled or for a digital product (shipping does 
not apply)

The product will become available (scheduling is applied)

The product will become unavailable (scheduling is applied)

Expired: the product is no longer available (scheduling is applied)
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Order Status

Order or order item to be approved (approval tab)

Order has been approved and continued to production (approval tab)

Order item has been rejected

Order item has been approved

Awaiting inventory for Printed Stock or Non-Printed products ordered in backorder

Created: incoming but not yet prepared by the system for downloading (Pending tab)

Prepared: incoming and all data has been prepared by the system for downloading

In production: the item has been downloaded and is being processed (prepress, printing, fin-
ishing)

To be shipped, i.e. available (stock and non-print products are assigned this status immedi-
ately); Product Kit order items with Prepared status

Shipped: the order has been shipped to the shopper

Order or order item returned

Completed: the order has been shipped and requires no further action

Canceled: the order or order item has been canceled by an administrator and requires no fur-
ther action

The order item has a comment made by the shopper

The order item has workflow feedback information; click the icon to open the workflow feed-
back

The order or order item has encountered a problem that prevents the order from being ful-
filled. The issue will be fixed by the STOREFRONT team. Contact your ECO3 Service support or 
dealer if the issue is not resolved automatically.

An order cannot be downloaded to the workflow system or uploaded to the specified FTP 
server.
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Orders Toolbar Buttons

Refresh the list of orders

Continue with the selected order to production (send from the Approval tab to the Pending 
tab)

Display the order package slip

Display the payment history for the selected order

Display details of the selected order or order item

Display packing instructions

Download the shipping instructions file

Generate/Regenerate the invoice (e.g. after modifying the Store invoice presets)

Update the payment by bank transfer status

Mark the order as completed

Mark pending orders as completed (with date range)

Mark the order as shipped

Cancel the selected order or order items

Return the order or order item

Approve the selected order item

Reject the selected order item
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Retry order item upload to FTP (upload to FTP failed)

Download the selected order items

Mark the order or order item as to be shipped (available)

Put the order items in a new, separate shipment (splitting an order)

Resubmit: Reverts the order item status to Prepared so it can be submitted again to the work-
flow. (Apogee Prepress/Asanti)

Order item customization (order item flags)

Edit the order item in the online editor (for customizable or variable data products)

Download a preview PDF

Download the Variable Data Processing file attached to an order item (Excel file)

Display workflow information (Apogee Prepress/Asanti)

View order list with order items in separate panel

View order items list
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Shipping (Orders tab)

All media needs a weight and thickness definition for this service to work

A file with the shipping instructions can be downloaded

An invoice can be downloaded
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Payment Status

Online payment required (to be captured); only displayed for deferred payments

Online payment in progress (capturing)

The order is paid (captured)

Payment failed

Refunding order

The order is to be refunded

The order is refunded

Payment by bank transfer required: the order is on hold until the status is changed to pay-
ment complete

Payment by bank transfer is complete: the payment has been received and the status 
changed; the order can now be processed

Payment by bank transfer is not required to continue with the order
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Translation Status

Translated

Language supported but content not translated
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Online Editor

Workspace Edit Tools

Add a text frame

Insert a table

Add an image frame

Add a barcode

Add a shape

Add a rectangle

Add a circle

Add a line

* An asterisk indicates that the document has been modified

Pointer: to select a frame

Create a linked text frame

Break linked test frames

Copy the selected text or frame

Paste the selected text or frame

Check the spelling

Save the document

Revert to the last saved version of the document

Browse to the image directories for image variables
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Text Frame

Cursor States

Inline Toolbar

Indicates any possible preflight warning or error in a text or image frame. Clicking this icon in 
the frame will open the list of preflight warnings/errors.

Indicates that you can move a selected frame.

Indicates that you can rotate a frame.

Indicates that you can resize a frame.

Hides the inline toolbar.

Edit text mode.

Edit frame mode.

Crops an image.

Flips the object back to its original orientation.

Flips horizontally.

Flips vertically.

Flips horizontally and vertically.

Brings the frame to the front.

Brings the frame forward.

Sends the frame back.
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Workspace Navigation and View

Create Variables Tools

Sends the frame to the back.

Deletes the frame.

If the inline toolbar is hidden, click the Show Inline Toolbar button in the top left corner of the 
workspace.

Creates a low-resolution PDF of the document for previewing purposes.

Shows/hides bleed and margins.

Show/hides the Help layer (if created for the current document).

View the document as a flipbook.

Rotate document counter-clockwise (preview only).

Rotate document clockwise (preview only).

Show/hide source of all text frames

Zoom the document so it fits the workspace width.

Zoom the document so it fits the workspace height.

Zoom to fit the document in the workspace window.

Creates a new variable and adds it to the Variables list.

Deletes the selected variable from the Variables list.

Moves the variable up in the Variables list.
StoreFront User’s Guide



 

 ICONS AND BUTTONS OVERVIEW 535
Action Editor Tools

Edit Path Toolbar (Shapes)

Layers List - Status

Moves the variable down in the Variables list.

Creates a duplicate of the selected variable and adds it to the Variables list.

Opens the Variables Settings editor.

Creates a new line of code for the variable action. Hold down CTRL/CMD to add multiple 
empty lines below the current line.

Deletes the selected code line. Hold down CTRL/CMD to delete multiple empty lines below 
the current line.

Moves the code line up in the action editor. Hold down CTRL/CMD to move a line: one up, 
one down; to the top, bottom; x times up relative to the current position; to a specified line 
number.

Moves the code line down in the action editor. Hold down CTRL/CMD to move a line: one up, 
one down; to the top, bottom; x times down relative to the current position; to a specified line 
number.

Creates a duplicate of the selected code line immediately under the selected line. Hold down 
CTRL/CMD to duplicate one or multiple lines: one up, one down; to the top, bottom; x times 
down relative to the current position; to a specified line number.

Select an anchor point to move it.

Add an anchor point: Position the cursor on the path and click to add a new anchor point.

Remove an anchor point: Position the cursor on an anchor point and click to remove it.

Convert an anchor point: Position the cursor on an anchor point and drag it to add a Bézier 
handle. Double-clicking an anchor point that already has Bézier handles converts it into a 
regular anchor point.

Help layer
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Locked layer

Opens the Layer Settings editor.
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APPENDIX
B Troubleshooting 

The purpose of this section is to help you troubleshoot issues that arise when 
working in StoreCenter or when a shopper places orders on the storefronts.
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538 CONVERTER ISSUES
Converter Issues

These issues are related to using the STOREFRONT Converter plug-in.

 Error message: 'The extension 'Apogee StoreFront Converter' does not 
contain valid signature'

This message may appear during the installation of the STOREFRONT Converter 
plug-in. Two causes are possible:

 The Adobe Extension Manager may be outdated. Go to https://
www.adobe.com/exchange/em_download/ to download the most recent 
version of the Extension Manager and install it. Take into account that some 
plug-ins block the auto-updater of Adobe. A manual update may be the only 
way of making sure you have the latest version of the Adobe Extension 
Manager installed.

 You may be trying to install an outdated version of the Apogee StoreFront 
Converter plug-in. Download the most recent version in StoreCenter, by 
clicking the Download Plug-in link in the left part of StoreCenter navigation 
bar.

 'Error #1009' message when exporting an InDesign document

When exporting an InDesign document to a StoreFront Package, the process 
stops with a '1009' error message if there are missing fonts in either the InDesign 
document or any of its embedded files. To avoid this notification, make sure all 
fonts are loaded and export the document again.

 Fonts shown in the Online Editor are not the same as those of the original 
InDesign document

To solve this problem you must make sure the computer on which InDesign is 
running has full access to all the fonts used in the document. Sometimes the 
STOREFRONT Converter doesn't have the same access rights as InDesign.

Add the fonts to the InDesign Fonts folder inside the InDesign application folder. 
Now create an InDesign package and check if all the fonts are present in the 
Fonts folder included in this package. If so, use this InDesign package to create 
the STOREFRONT package.

If this doesn’t remedy the problem, try installing the fonts in your operating 
system and create a STOREFRONT package again.
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Converter Preflight Messages

The preflight engine which is incorporated in the Apogee StoreFront Converter 
plug-in for Adobe InDesign checks if a document uses functions that are not 
supported by the Online Editor. Below is a list of possible warnings and errors 
that it can report. There are two types of messages:

 Warnings: These can be ignored if you are willing to accept that the layout in 
the Online Editor will be different from that of the original InDesign 
document. It is recommended however to cancel the export process, adapt 
the layout of the InDesign document and then export the file again to create 
a StoreFront Package.

 Errors: These need to be solved first before you can create the StoreFront 
Package.

Related topics: • STOREFRONT Live Preflight on page 343

Table B.3 Preflight Messages in InDesign CC Converter

ItemName Type Text Description Tip Fix

align_to_base-
line_grid

warning TextFrame with align 
to baseline grid and 
no top justification

The Editor only sup-
ports BaseLine Grid 
Alignment for text 
frames with a verti-
cal justification set 
to top.

cap_to_small_cap warning Small caps used Small caps is used 
in the text. The Edi-
tor only supports 
uppercase or lower-
case letters only.

Use All Caps instead. "Remove the small caps for-
matting. The text will result in 
uppercase and lowercase let-
ters, depending on how you 
typed it. This fix preserve the 
original text digits and format-
ting.Simulate small caps with 
caps letters reduced by a per-
centage. The percentage used 
is defined in the InDesign pref-
erences. This fix tries to pre-
serve the appearance of the 
text, but will change some for-
matting parameters."
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cell_fillTint warning Cell tint A cell is filled with a 
color tint (less than 
100%). Only 100% 
tint is supported for 
cells.

Set the tint to 100% 
or create a specific 
color for this cell.

Set the fill of the cell to 100%. 
The appearance of the cell will 
change. No other colors will 
be modified in the docu-
ment.Calculate a specific color 
for this cell. The appearance of 
the cell is preserved. In some 
cases a new Swatch could be 
created.

cell_textRotation warning Text Rotation in cell The text of the cell 
is rotated using the 
Text Rotation option. 
This is not supported 
by the StoreFront 
Editor.

Set the Text Rota-
tion to 0? in the Cell 
Options window.

Set the Text Rotation to 0?

character_kerning warning Custom kerning "A custom kerning 
value is used 
between letters. 
Custom kerning is 
not supported in the 
online editor, and 
will be ignored 
during the conver-
sion."

"Set the kerning to 
Metric, or try to 
achieve the same 
result using track-
ing."

"Remove any custom kerning 
value. The spacing between 
letters will be reset to the 
default value. This is the 
cleanest way, as any other for-
matting values will be 
untouched.Try to reproduce 
the same result using kerning 
instead of tracking. This will 
preserve the appearance of the 
text, but a lot of local tracking 
formatting will be applied, 
resulting in a less manageable 
text."

color_too_many warning Too many swatches "There are %0% 
swatches. A large 
amount of swatches 
has negative impact 
on the performance 
of the online editor. 
Usually this is 
caused by a large 
color library loaded 
in the document, 
which aren't really 
used. Removing 
unused colors can 
make a difference 
for performance."

"In the Swatches 
panel menu, exe-
cute the 'Select All 
Unused' command, 
then delete those 
unused swatches."

Remove the unused swatches 
from the document.

Table B.3 Preflight Messages in InDesign CC Converter

ItemName Type Text Description Tip Fix
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color_wrong_space error Unsupported color 
space (%0%): %1%

"Only CMYK, RGB 
and Lab colors are 
supported"

corner_mismatch warning Different corners The frame has differ-
ent corner radius: 
the top left corner 
radius will be used 
during the conver-
sion. The corner 
radius should be the 
same for every cor-
ner.

Set the same corner 
radius the Corner 
options panel from 
the Object menu.

"Apply the same radius to 
every corner, using the value 
from the top left corner. This 
solution is the safest and will 
preserve the geometry of the 
object.Convert the item to out-
lines. This will preserve the 
design, but will transform the 
object to shape with loss of 
layout flexibility."

diagonal_Lines warning Diagonal lines in 
cell

The Diagonal line 
formatting is used in 
the cell. Diagonal 
lines cells will be 
ignored by Store-
Front.

Remove the diago-
nal line from the 
cell.

Remove the diagonal line from 
the cell.

different_borders warning Table cell with dif-
ferent borders

The cell has differ-
ent borders setting. 
The online editor 
only supports a sin-
gle border setting 
for table cells. 
Adobe InDesign 
tables and Store-
Front Editor tables 
uses different tech-
nologies: a perfect 
conversion is possi-
ble with a little 
compromise.

"Use the same set-
tings for every bor-
der of the cell. A 
well designed table 
for optimal Store-
Front conversion 
should have only 
one kind of border. If 
you need more 
refined design, 
please consider to 
draw the table in 
background and cre-
ate standard text 
frame on top."

"Set the same border to any 
side of the cell, using the for-
matting of the TOP border.Set 
the same border to any side of 
the cell, using the formatting 
of the RIGHT border.Set the 
same border to any side of the 
cell, using the formatting of 
the BOTTOM border.Set the 
same border to any side of the 
cell, using the formatting of 
the LEFT border."

different_tabLeader warning Tab leader charac-
ters

A paragraph con-
tains different tab 
leader characters. 
The same tab leader 
character can be 
used over the para-
graph.

Please review the 
tab leader charac-
ters and use the 
same character for 
all the tab stops.

Set the same tab leader char-
acter for tab stop in the para-
graph (when a tab leader 
character is specified). The first 
tab leader character will be 
used.

Table B.3 Preflight Messages in InDesign CC Converter
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document_fonts warning Document fonts This document is 
using the Docu-
ment fonts folder. 
Document fonts 
activated directly by 
Adobe InDesign can 
give unexpected 
results during con-
version.

Remove or rename 
the Document fonts 
folder you find next 
to the document 
file. Install the fonts 
in your system or in 
your font manager.

facing_pages warning Facing pages Facing pages is set 
to false but there are 
more than one 
pages on spread.

Use only single 
pages in this docu-
ment.

file_without_exten-
sion

error File without 
extension: %0%

"The linked image 
file has no exten-
sion. It is probably 
from an old work-
flow on Mac use 
files without an 
extension (.jpg, .eps). 
These cannot be 
uploaded to the 
Windows Server."

Rename the file and 
include the proper 
extension.

first_line_alignment warning First Line Only align-
ment

The paragraph has 
the Align to Grid set 
to First Line Only. 
The paragraph will 
be fully aligned to 
the baseline grid.

Use the All lines 
alignment option.

firstBaselineOffset warning First baseline offset The offset of the first 
baseline of the 
frame is not Ascent. 
Only Ascent is sup-
ported as by the 
StoreFront Editor.

Set the offset to 
Ascent using the 
panel 'Text Frame 
option' from the 
Object menu. An 
adjustment of the 
layout could be 
required.

Set the first baseline offset to 
Ascent.

Table B.3 Preflight Messages in InDesign CC Converter
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flip_inLine warning Flipped inline image An image anchored 
in the text is flipped 
horizontally or verti-
cally. The flipped 
image content may 
not be exported cor-
rectly. Please check 
after uploading.

"Check after upload-
ing to StoreFront 
Editor. To avoid 
problems remove 
the flipping attri-
bute, and flip the 
content of the 
image using Apple 
Preview, Adobe Pho-
toshop or any other 
image editor."

Remove any flip attribute. The 
aspect of the image content 
will change.

font_missing error Missing font: '%0%' The font %0% is 
used in the docu-
ment but is not 
installed on your 
system.

"Make sure that all 
fonts are available 
to InDesign when 
attempting to 
import a document. 
You can find the 
missing fonts using 
the 'Find font' panel 
in the Type menu. 
Missing fonts are 
highlighted there, 
and should be 
installed either on 
the System or within 
the InDesign Fonts 
directory. Alterna-
tively, you may use 
the same panel to 
replace the missing 
fonts with a version 
which is available."

Table B.3 Preflight Messages in InDesign CC Converter
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font_not_available error Font not available: 
'%0%'

The font %0% is 
used in the docu-
ment but is not cor-
rectly installed on 
your system.

"Make sure that all 
fonts are available 
to InDesign when 
attempting to 
import a document. 
You can manage 
fonts using the 'Find 
font' panel in the 
Type menu. Missing 
or corrupted fonts 
are highlighted 
there, and should be 
installed either on 
the System or within 
the InDesign Fonts 
directory. Alterna-
tively, you may use 
the same panel to 
replace the fonts 
with a version which 
is available."

font_not_supported error Font not supported: 
'%0%'

The font %0% is a 
%1% format and it's 
not supported. Only 
OpenType or True-
Type original fonts 
are supported in the 
StoreFront Editor.

Replace the font 
with either a True-
Type or OpenType 
version. You can 
manage fonts using 
the 'Find font' panel 
in the Type menu. 
The quality of the 
font is highly 
important for the 
conversion result.

font_without_exten-
sion

error Font without exten-
sion: %0%

"The source file of 
the font %0% has no 
extension. Certain 
older workflows on 
Mac still use fonts 
without an exten-
sion ('.otf', '.ttf', ...). 
These cannot be 
uploaded to the 
Windows Server."

You should either 
provide an extension 
for the font or 
replace it with an 
OpenType or True-
Type alternative. 
You can manage 
fonts using the 'Find 
font' panel in the 
Type menu. The 
quality of the font is 
highly important for 
the conversion 
result.
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frame_content_ef-
fects

warning Content Unsup-
ported effects

One or more content 
unsupported effects 
are applied to this 
frame. Only Drop 
shadow is sup-
ported in the Store-
Front Editor. 
Unsupported effects 
will be ignored 
during the conver-
sion process.

Disable the content 
unsupported effects. 
You can manage the 
effects applied to a 
frame selecting 
'Effects' in the 
Object menu.

Remove all the unsupported 
effects. The aspect of the 
image content will change. 
Any other attribute will be pre-
served.

frame_effects warning Unsupported effects One or more unsup-
ported effects are 
applied to this 
frame. Only Drop 
shadow is sup-
ported in the Store-
Front Editor. 
Unsupported effects 
will be ignored 
during the conver-
sion process.

Disable the unsup-
ported effects. You 
can manage the 
effects applied to a 
frame selecting 
'Effects' in the 
Object menu.

Remove all the unsupported 
effects effect. The aspect of 
the image content will 
change. Any other attribute 
will be preserved.

frame_fill_effects warning Fill Unsupported 
effects

One or more fill 
unsupported effects 
are applied to this 
frame. Only Drop 
shadow is sup-
ported in the Store-
Front Editor. 
Unsupported effects 
will be ignored 
during the conver-
sion process.

Disable the fill 
unsupported effects. 
You can manage the 
effects applied to a 
frame selecting 
'Effects' in the 
Object menu.

Remove all the unsupported 
effects. The aspect of the 
frame content will change. 
Any other attribute will be pre-
served.

frame_scaled warning Frame scaled The frame is scaled 
to a percentage dif-
ferent from 100%. 
Scaling of frames is 
not supported in the 
StoreFront Editor.

Use 'Redefine Scal-
ing As 100%' from 
the Transform or 
Control panel to 
reset the scaling 
percentages to 
100%. You may also 
set 'Adjust Scaling 
Percentage' to off in 
the General Prefer-
ences of Adobe 
InDesign.

"Redefine scaling to 100% for 
this object. The aspect, size 
and geometry of the object 
will be preserved.Redefine 
scaling to 100% for this object 
and for any nested object 
(shapes anchored in the text, 
shapes pasted into the object, 
etc.). The aspect, size and 
geometry of all objects will be 
preserved."

Table B.3 Preflight Messages in InDesign CC Converter
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frame_sheared warning Frame with shear "Shearing is applied 
to the frame, and is 
not supported by the 
StoreFront Editor."

Set the shear value 
to 0 or design the 
object from scratch.

"Remove the shear effect by 
setting the shear value to 0. 
This solution will preserve the 
native the original structure of 
the object.Convert the item to 
outlines. This will preserve the 
design, but will transform the 
object to shape with loss of 
layout flexibility. Conversion to 
outline is not available when 
the object is grouped, nested 
or anchored in text."

frame_stroke_ef-
fects

warning Stroke Unsupported 
effects

One or more stroke 
unsupported effects 
are applied to this 
frame. Only Drop 
shadow is sup-
ported in the Store-
Front Editor. 
Unsupported effects 
will be ignored 
during the conver-
sion process.

Disable the stroke 
unsupported effects. 
You can manage the 
effects applied to a 
frame selecting 
'Effects' in the 
Object menu.

Remove all the unsupported 
effects. The aspect of the 
image content will change. 
Any other attribute will be pre-
served.

gradient_multi-
ple_stops

warning Too many gradient 
stops in %0%

The swatch %0% has 
%1% gradient stops. 
Only two gradient 
stops are supported 
in the StoreFront 
Editor.

Edit the gradient 
and remove any gra-
dient stop except 
the first and the last.

Remove the incompatible gra-
dient stops. Only the first and 
the last gradient stops will be 
preserved

gradient_stroke warning Gradient stroke 
color

The frame has a gra-
dient applied to the 
stroke. Stroke color 
cannot be gradients 
in the StoreFront 
Editor. This color will 
be converted to 
black during import.

Apply a solid color 
to the stroke.

Set the stroke color to 
[Black]Set the stroke color to 
[None]

gradient_text_fill warning Text with gradient 
fill

A gradient is applied 
to the text fill. Only 
solid colors can be 
used for texts.

Use a solid color for 
the text fill.

Set the fill color to [Black]

halfTone_Effect warning Halftone effect An halftone effect is 
applied to the 
image. Halftone is 
not supported in the 
StoreFront Editor.

Remove halftone 
effect by applying 
the [Black] color to 
the content of the 
image.

Remove the halftone effect 
and set the content color to 
[Black]
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hasNoNormalBlend-
Mode

warning Blend mode on Text 
Frame

A blend mode differ-
ent from Normal is 
applied on a Text-
Frame. This can give 
unexpected results 
and will be reset to 
Normal during the 
conversion.

"To preserve the 
blend effect, create 
a separate rectan-
gle for the back-
ground."

Set the Blend Mode to Nor-
malGenerate a separate rect-
angle on the background. This 
solution will visually simulate 
the blend mode on the Text 
frame: please check the result 
before convert the document 
to StoreFront.

hasNoNormalBlend-
Mode

warning Blend mode on text 
frame

The text frame has 
blend mode differ-
ent from Normal. 
Blend modes on a 
text frame can give 
unexpected results.

"Set the blend mode 
to Normal. To pre-
serve the blend 
effect, please create 
a separate rectan-
gle for the back-
ground."

"Set the blend mode of the 
text frame to Normal, and cre-
ate a separate frame for the 
background. The layout 
appearance will be pre-
served.Set the blend mode of 
the text frame to Normal. The 
layout appearance could 
change."

image_embedded warning Embedded link. A link is embedded 
into the document. 
All the images 
should be linked to 
an external resource 
to be uploaded to 
the StoreFront Editor 
Server.

Link the image to an 
external file.

Unembed the image and save 
it to a temporary location.

image_scaled warning Image scaled The image is scaled 
to a percentage dif-
ferent from 100%. 
Scaling of frames is 
not supported in the 
StoreFront Editor.

Use 'Redefine Scal-
ing As 100%' from 
the Transform or 
Control panel to 
reset the scaling 
percentages to 
100%. You may also 
set 'Adjust Scaling 
Percentage' to off in 
the General Prefer-
ences of Adobe 
InDesign.

"Redefine scaling to 100% for 
this object. The aspect, size 
and geometry of the object 
will be preserved.Redefine 
scaling to 100% for this object 
and for any nested object 
(shapes anchored in the text, 
shapes pasted into the object, 
etc.). The aspect, size and 
geometry of all objects will be 
preserved."

inLineObject_posi-
tion

warning Unsupported inline 
settings

invalid_end_of_line warning Unsupported stroke 
end or start

The Start or End type 
of the stroke is 
unsupported. Only 
plain ends are sup-
ported by the Store-
Front Editor.

Set stroke End and 
Start of line to None

Convert the end or start of line 
to None.

Table B.3 Preflight Messages in InDesign CC Converter

ItemName Type Text Description Tip Fix
StoreFront User’s Guide



548 CONVERTER PREFLIGHT MESSAGES
invalid_para-
graph_alignment

warning Binding side align-
ment

The paragraph align-
ment is relative to 
the binding side. 
Only absolute align-
ment are supported 
in the StoreFront 
Editor.

"Use an absolute 
alignment: Left, 
Right, Center, Justi-
fied"

Set an absolute alignment (left 
or right) depending on page 
facing. This will preserve the 
aspect of the layout.Align to 
left.Align to right.

invalid_strike-
through

warning Unsupported strike-
through

"The text has unsup-
ported strike-
through properties. 
Some strikethrough 
properties will be 
ignored. Supported 
strikethrough prop-
erties are: solid 
stroke type, auto-
matic offset, auto-
matic color."

invalid_stroke warning Unsupported stroke 
type: '%0%'

The frame has 
unsupported stroke 
type. Only solid 
strokes are sup-
ported in the online 
Editor. The stroke 
type will be ignored 
and converted to 
solid type.

Set the stroke type 
to Solid.

Convert the stroke type to 
solid. Any other attribute (like 
size or color) will be preserved.

invalid_undeline warning Unsupported under-
line

"The text has unsup-
ported underline 
properties. Some 
underline properties 
will be ignored. Sup-
ported underline 
properties are: solid 
stroke type, auto-
matic offset, auto-
matic color."

kerning_method warning Kerning The text has custom 
or Optical kerning. 
Only Metric kerning 
is supported by the 
StoreFront Editor.

Set the kerning 
method to Metrics.

Set the kerning method to 
Metrics.
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max_errors error Too many errors The InDesign docu-
ment contains %0% 
or more errors. This 
document can't be 
converted to a 
StoreFront docu-
ment. Only the first 
%0% errors are 
listed.

Please start to fix 
some errors before 
continuing.

max_warnings warning Too many warnings The InDesign docu-
ment contains %0% 
or more warnings. 
This could result in a 
bad conversion. Only 
the first %0% warn-
ings are listed.

Please consider to 
fix some warnings 
before the conver-
sion.

missing_link error Missing link: %0% The original linked 
file '%0%' is miss-
ing. All links must 
be available to InDe-
sign before export-
ing the document.

Update or replace 
the missing file 
using the Links 
panel from the Win-
dow menu. Missing 
links are high-
lighted in the panel.

multiple_page_sizes warning Multiple page sizes Pages with different 
sizes are found in 
the document. The 
size in Document 
Setup is used for all 
pages.

Remove or resize 
the pages that dif-
fers from the base 
document size.

nested_frames warning Nested frames "The object con-
tains nested frames, 
pasted into it. 
Nested frames may 
not import cor-
rectly."

Create simple object 
without nested 
frames. The Path-
finder panel can 
help to transform 
the shapes.
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nested_Style warning Nested styles in 
'%0%'

Nested style are 
used in the Para-
graph style '%0%'. 
This can give unex-
pected results in the 
conversion.

Use character styles 
instead as well as 
local text format-
ting.

"Replace nested styles with 
plain Character styles. This will 
parse all the paragraphs using 
this Paragraph style. The 
appearance of the text will be 
preserved, but please check 
the result after this fix. Nested 
style instruction will also be 
removed from the Paragraph 
style. This is one of the most 
intelligent fix, enjoy it! Just 
remove the nested style 
instruction from the Para-
graph style. The Paragraph 
style will be clean, but the text 
appearance on the page will 
change."

overload info Overload The objects you 
selected are too 
much for a fast live 
preflight. The pre-
flight has stopped.

paragraph_with_-
dropcaps

warning Paragraph with 
dropcap

A dropcap is used in 
this paragraph. 
Dropcaps are not 
supported in the 
StoreFront Editor.

"Use a separate 
frame for the drop-
cap, and format it 
with local format-
ting."

"Replace the drop cap with a 
separate text frame. The 
appearance of the text will be 
preserved, but please check 
the result after this fix. Drop-
cap instruction will also be 
removed from the paragraph 
settings.Just remove the drop 
cap instruction from the para-
graph. The paragraph will be 
clean, but the text appearance 
on the page will change."

paragraphStyle_-
dropCast

warning Drop cap used in 
Paragraph Style 
%0%

The paragraph style 
'%0%' uses drop 
caps. Drop caps are 
not supported by the 
StoreFront Editor 
and can give unex-
pected results.

"Use a separate 
frame for the drop-
cap, and format it 
with local format-
ting"

"Just remove the drop cap 
instruction from the Para-
graph style. The Paragraph 
style will be clean, but the text 
appearance on the page will 
change."
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pasted_image_data error Pasted image The image has been 
pasted directly in 
InDesign and has no 
link. Pasted images 
can't be extracted 
and can't be 
imported in Store-
Front.

Find the original 
image file and link it 
using File > Place

Remove the image.Select the 
original image file and link it 
to the document. This will 
replace the image.

paths_too_many warning Large amount of 
shapes/paths (%0%).

A large amount of 
shapes/complex 
paths may have a 
negative impact on 
online performance.

In many cases these 
paths are not 
required to be edit-
able objects. You 
can move these 
items to a locked 
layer.

right_to_left_para-
graph

warning Right to left text 
direction

The paragraph is for-
matted with Right to 
left text direction. 
This can give unex-
pected result as the 
StoreFront Editor 
supports only west-
ern languages.

Use the Left to right 
direction for texts.

"Set the text direction to Left 
to right. The appearance of the 
text on the page may change, 
please review it"

stroke_nonStroke-
Combination

warning Combination of text 
with and without 
stroke

"In a single text 
frame, only one kind 
of stroke is admit-
ted."

Use a single setting 
for text stroke 
throughout the 
entire text frame

"Unify the text stroke for this 
frame, using the aspect of the 
first occurrence.Remove text 
stroke for the entire text 
frame"

table_and_cell_-
style

warning Table or Cell with 
style %0% applied

"Style %0% is 
applied to the Table 
or Cell, and is not 
supported by the 
StoreFront Editor."

table_header_and_-
footer

warning Table with header or 
footer rows

"%0% %1% rows is 
applied to the Table, 
and is not sup-
ported by the Store-
Front Editor."

table_not_align_to_
left

warning Table with align-
ment different from 
left align

Apply to table left 
align
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table_on_multiple_-
frame

warning Table overlapping 
frames or columns

A table should be 
entirely contained in 
a single column. 
Table flowing 
between columns 
(or frames) can give 
unexpected result in 
the StoreFront Edi-
tor.

"Put the table inside 
a single column, or 
break the table in 
two or more parts."

text_on_a_path warning Type on a Path Type on a Path 
requires a complex 
conversion process 
to be reproduced in 
the StoreFront Edi-
tor. The conversion 
of some properties is 
not guaranteed.

Please check the 
appearance of the 
text in the Store-
Front Editor after 
conversion.

text_rotated warning Text with rotation The text has rotation 
applied to individ-
ual characters. This 
is not supported in 
the StoreFront Edi-
tor.

Can't be fixed manu-
ally. Please use the 
'Fix it for me' func-
tion

Set text rotation to 0?

text_scaled warning Text with scaling The text is scaled in 
width and/or height. 
Scaled text is not 
supported in the 
StoreFront Editor.

Set the text scaling 
to 100%.

"Set text scale to 100%. The 
appearance of the text will 
change.Convert the frame to 
outlines. This solution must be 
used only on very short texts 
with a little amount of letters. 
The appearance is preserved, 
but the text will not be edit-
able in StoreFront Editor."

text_skewed warning Text with skewing The text is skewed. 
Skewed text is not 
supported in the 
StoreFront Editor.

Set the text skew to 
0?.

"Set text skew to 0?. The 
appearance of the text will 
change.Convert the frame to 
outlines. This solution must be 
used only on very short texts 
with a little amount of letters. 
The appearance is preserved, 
but the text will not be edit-
able in StoreFront Editor."
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text_stroke warning Text with stroke "While texts with 
stroke can be 
imported, this is per-
formed for the entire 
text frame, rather 
than for individual 
text ranges. The first 
character of the text 
frame in InDesign is 
used for this"

textframe_overflows warning Text overflow The text frame has 
text in overflow

"Enlarge the text 
frame, or add new 
frames to the text 
frame sequence. You 
can also use 'Fit 
Frame to content' in 
the Object menu."

Fit the text frame to the text 
contained

textframe_spacing warning Low margins on text 
frame

Small differences in 
text spacing 
between InDesign 
and the Editor may 
result in a text frame 
being placed in 
overflow in the Edi-
tor even though the 
text may be visible 
in InDesign. You 
may want to enlarge 
the text frame so 
that there is less 
chance of this hap-
pening

textframe_verti-
cal_align

warning Vertical alignment The text frame has 
the Vertical align-
ment not set to 
'top'. It may render 
differently in the 
Editor.

Set the Vertical 
alignment to 'Top'. 
You may have to 
adjust the frame 
position to preserve 
the layout.

"Set the vertical alignment to 
'Top' and try to adjust the 
frame position in order to pre-
serve the layout appearance. If 
the vertical alignment is set to 
'Justify', this could give unex-
pected results.Set the vertical 
alignment to 'Top'. This will 
preserve the object geometry, 
but the text will probably flow 
differently."
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too_many_frames warning Too many frames The document con-
tains too many 
frames. This can 
affect the user expe-
rience online and 
the conversion 
speed.

"Reduce the number 
of objects, for exam-
ple using links for 
complex graphics."

unsupported_blend-
mode

warning Blend mode: %0% "The object uses the 
%0% blend mode, 
which is unsup-
ported. Supported 
types are: Normal, 
Multiply, Darken, 
Difference, Hard-
light, Lighten, Over-
lay, Screen."

Set the blend mode 
to one of the sup-
ported modes.

Set to NormalSet to Multiply-
Set to DarkenSet to Differenc-
eSet to HardlightSet to 
LightenSet to OverlaySet to 
Screen

unsupported_char-
acter

warning Unsupported charac-
ter

The text contains an 
unsupported charac-
ter. The character 
could be out of the 
UTF scope.

Use a character sup-
ported by the UTF 
encoding.

unsupported_con-
tent_blendmode

warning Content blend 
mode: %0%

"The object uses the 
%0% content blend 
mode, which is 
unsupported."

Set to Normal

unsupported_corner warning Corner type The object use spe-
cial corner effect. 
Only round and 
square corners are 
supported.

You can view the 
corner options 
applied to a frame 
using the 
Object>Corner 
Options menu.

"Remove the special corners 
and set them to square corner. 
This solution is the safest and 
will preserve the geometry of 
the object.Convert the item to 
outlines. This will preserve the 
design, but will transform the 
object to shape with loss of 
layout flexibility."

unsupported_file_-
type

warning Unsupported file 
type

The placed file has 
format '%0%'. This 
file cannot be con-
verted to online pre-
views.

"Please convert the 
image to one of the 
supported formats: 
TIFF, JPEG, Adobe 
Illustrator, PSD, PDF, 
PNG, GIF."

unsupported_-
fill_blendmode

warning Fill blend mode: 
%0%

"The object uses the 
%0% fill blend 
mode, which is 
unsupported."

Set to Normal
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unsupported_fon-
tsize

warning Font size The font is outside 
the supported size 
range (1-720 pt).

Change the font size 
up to 1 point or 
down to 720 points

"Change the font size to the 
supported values. Small text 
will be set to 1 point, big text 
will be set top 720 points. Text 
appearance could change, and 
long text could reflow in the 
sequences."

unsupport-
ed_stroke_blend-
mode

warning Stroke blend mode: 
%0%

"The object uses the 
%0% stroke blend 
mode, which is 
unsupported."

Set to Normal

unsupported_wrap warning Unsupported text 
wrap

The frame has text 
wrap set to %0%. 
Only bounding box 
wrap is supported at 
this time. You can 
view the wrap set-
tings applied to a 
frame using the Text 
wrap panel from the 
Window menu.

Set the text wrap to 
Bounding box using 
the Text Wrap panel 
in the Window 
menu.

Change the text wrap setting 
to Bounding box. The layout 
appearance could change.
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Table B.4 Preflight Messages in InDesign CS6 and earlier Converter

ItemName Message Text Help

align_to_baseline_grid Text Frame with align to baseline grid 
and no top justification

The Editor only supports BaseLine Grid Alignment for text 
frames with a vertical justification set to top.

cap_to_small_cap Text with ‘OpenType All Small Caps’ 
option used

The Editor only supports uppercase or lowercase caps set-
tings

cell_fillTint Table cell’s fill tint not supported Fill color will be 100%

character_kerning Characters found with custom kerning Kerning is not supported in the online editor

color_too_many Large amount of colors. Try removing 
unused to increase online performance

”A large amount of colors has negative impact on the per-
formance of an online editor. Usually this is caused by a 
large color library loaded in the document, which aren’t 
really used. Removing unused colors can make a differ-
ence for performance. You can do this by going to the 
Swatches panel, executing the ‘Select All Unused’ com-
mand, and deleting those from the document.”

color_wrong_space Unsupported color space Only CMYK, RGB and LAB colors are supported

corner_mismatch Frame with different settings for corners ”Only a single corner radius is supported in the Editor. This 
setting is applied from the top left corner in the document 
which is imported. You can view the corner options 
applied to a frame using the Object>Corner Options 
menu.”

diagonal_Lines Table with unsupported diagonal lines Diagonal lines in table cells will currently be ignored

different_borders Table cell with different border settings The online editor only supports a single border setting for 
table cells (which can be toggled on/off for the four sides 
separately)

different_tabLeader Different tab leader characters in para-
graph

Only a single tab leader character can be configured for a 
paragraph in the online editor

file_without_extension File without extension Certain older workflows on Mac still use files without an 
extension (‘.jpg’, ‘.eps’, …). These cannot be uploaded to 
the Windows Server. You should rename the file and 
include the proper extension.

firstBaselineOffset First baseline offset is not Ascent Only Ascent is supported as the first baseline offset option

flip_inLine Flipped Inline Image frame The flipped image content may not be exported correctly. 
Please check after uploading!

font_missing Missing Font ”Make sure that all fonts are available to InDesign when 
attempting to import a document. You can find the miss-
ing fonts using the Type>Find Font menu item. Missing 
fonts are highlighted there, and should be installed either 
on the System or within the InDesign Fonts directory. 
Alternatively, you may use the same panel to replace the 
missing fonts with a version which is available.”
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font_not_available Font not available ”Make sure that all fonts are available to InDesign when 
attempting to import a document. You can find the miss-
ing fonts using the Type>Find Font menu item. Missing 
fonts are highlighted there, and should be installed either 
on the System or within the InDesign Fonts directory. 
Alternatively, you may use the same panel to replace the 
missing fonts with a version which is available.”

font_not_supported Font type not supported Only OpenType or TrueType fonts are supported in the Edi-
tor.

font_without_extension Font without extension Certain older workflows on Mac still use fonts without an 
extension (‘.otf’, ‘.ttf’, …). These cannot be uploaded to the 
Windows Server. You should either provide an extension 
for the font or replace it with an OpenType or TrueType 
alternative.

frame_effects Frame with unsupported applied 
effect(s)

”Frame effects other than BlendMode are not supported 
at this time. You can view the effects applied to a frame 
using the Object>Effects menu.”

frame_scaled Frame with scaling Scaling of frames is not supported at this time

frame_sheared Frame with shear Shearing of frames is not supported at this time

gradient_multiple_stops Gradient has too many gradient stops Only two gradient stops are supported in the Editor

gradient_stroke Frame with gradient stroke color Stroke color cannot be gradients. This color will be con-
verted to black during import

gradient_text_fill Text with gradient fill Only solid colors can be used for texts

halfTone_Effect Halftone effect applied to image Remove halftone effect

hasNoNormalBlendMode Blend modes on a TextFrame can give 
unexpected results and will be reset to 
Normal

To preserve the blend effect, please create a separate 
rectangle for the background

inLineObject_position Inline Frame will be on the same line of 
text

invalid_paragraph_alignment Paragraphs with unsupported alignment Alignment to spine is not supported in the online Editor

invalid_stroke Frame with unsupported stroke type Only solid strokes are supported in the online Editor

max_results Stopped checking for: maximum results 
encountered

More occasions of this warning/error may have occurred, 
but they are not reported to keep a reasonable overview 
in the preflight report.

missing_link Missing Link ”All links must be available to InDesign before exporting 
the document. You can find the list of links using the Win-
dow>Links menu item. Missing links are highlighted in 
the panel. These should either be replaced by a new file, 
or updated so they point to the right location.”

multiple_page_sizes Multiple page sizes found in document While the editor also supports multiple page sizes, these 
are not imported from the InDesign document. The size in 
Document Setup is used for all pages

nested_frames Nested frames may not import correctly Nested frames may not import correctly
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nested_Style Paragraph Style Nested styles can give 
unexpected results

Use character styles (or local formatting) instead

paragraph_with_dropcaps Paragraph with dropcap settings Dropcaps are not supported in the online Editor

paragraphStyle_dropCast Paragraph Style drop cap can give unex-
pected results

paths_too_many Large amount of shapes/paths. A large amount of shapes/complex paths may have a 
negative impact on online performance. In many cases 
these paths are not required to be editable objects, so 
moving these items to a locked layer may be a good idea.

right_to_left_paragraph Right to left paragraph direction can 
have unexpected behavior

Use the same text direction for character and paragraph

ruleAboveOverPrint Overprint on rules is not support by the 
editor at this moment, this option will 
be ignored

ruleBelowOverPrint Overprint on rules is not support by the 
editor at this moment, this option will 
be ignored

stroke_nonStrokeCombina-
tion

Combination of text with and without 
stroke in a text frame

Use a single setting for text stroke throughout the entire 
text frame

table_on_multiple_frame Table overlapping frames or columns

table_used Table used A table was used in a textframe. These are not yet sup-
ported (although they are pretty high on the feature list, 
and will definitely be added in the future).

text_on_path Text on a complex path Only text inside textframes is supported

text_rotated Text with rotation Text rotation on individual characters is not supported in 
the online Editor

text_scaled Text with scaling Text scaling is not supported in the online Editor.

text_skewed Text with skewing Text cannot be skewed in the online editor

text_stroke Text with stroke While texts with stroke can be imported, this is performed 
for the entire text frame, rather than for individual text 
ranges. The first character of the text frame in InDesign is 
used for this

textframe_inline_elements Text Frame with inline elements Inline elements are not supported at this time, and will be 
ignored when exporting the document

textframe_overflows Text frame in overflow A text frame was found which has text in overflow (in the 
InDesign document)

textframe_spacing Low margins around text frame ”Small differences in text spacing between InDesign and 
the Editor may result in a text frame being placed in over-
flow in the Editor even though the text may be visible in 
InDesign. You may want to enlarge the text frame so that 
there is less chance of this happening”
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Shopper Issues

Storefront shoppers may encounter the following errors when using a 
storefront.

 Error message: 'The content type is not supported'

This message is displayed when a shopper uploads a file for an uploadable 
product. Two causes are possible:

 The shopper overlooked the drop-down menu at the top of the upload 
window and attempts to upload a TIFF or JPEG file even though the menu is 
set for uploading a PDF file.

 The shopper is trying to upload an unsupported file format. An example of 
this is attempting to upload a JPEG2000 file even though this is not a 
supported file format.

 Error validating a variable data product

See “Troubleshooting the variable data upload” on page 393.

 Troubleshooting orders

See “Troubleshooting Orders” on page 334.

textframe_vertical_align Frame with vertical alignment not set to 
‘top’

Text frames with vertical alignment which isn’t ‘top’ may 
render slighly differently in the Editor

unsupported_blendmode Unsupported blend mode Supported types are: normal, multiply, darken, difference, 
hardlight, lighten, overlay, screen.

unsupported_corner Frame with unsupported corner type ”Only round and square corners are supported at this 
time. You can view the corner options applied to a frame 
using the Object>Corner Options menu.”

unsupported_file_type Unsupported file placed This file cannot be converted to online previews at this 
time

unsupported_fontsize Font size outside of supported range (1-
720 pt)

Flash does not support font sizes outside of the range 
between 1 and 720 points

unsupported_wrap Frame with unsupported text wrap set-
tings

”Only wrap on the frame’s bounding box is supported at 
this time. You can view the wrap settings applied to a 
frame using the Window>Text Wrap menu.”
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E-mail Issues

 Avoid spam issues with Sender Policy Framework

STOREFRONT sends e-mails to users and administrators on behalf of the print 
service provider or the company that uses a store. To avoid that such e-mails are 
incorrectly identified as spam, the print service provider or company may want 
to use Sender Policy Framework (SPF).

SPF is an e-mail validation mechanism that allows administrators to specify 
which hosts are allowed to send e-mail from a given domain. This is done by 
creating a specific SPF record in the Domain Name System (DNS).

The following entry should be used for SPF:

 include:spf-a.agfa.com 

Read this internet article to learn more about SPF.

To check the SPF record for your domain, you can use this tool:

https://mxtoolbox.com/spf.aspx
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Service Status

Printer administrators receive notifications in advance about maintenance activ-
ities on the STOREFRONT server. 
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APPENDIX
C Configuring Payment 
Gateways 

The security of online payments is ensured by payment gateway services 
integrated in STOREFRONT. The supported gateway services depend on your 
location and include Ingenico (Worldline brand), PayPal, Mercado Pago, Stripe, 
Bambora and Inicis. These systems handle all payment aspects and do not 
require that credit card data is stored on the STOREFRONT web servers.

You can download the document Configuring Payment Gateways which has the 
latest information on setting up these services. Always check that you have the 
latest version of this document.
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APPENDIX
D Third-Party Web Services

This section provides information on useful third-party web services that can be 
integrated with STOREFRONT and help you improve the efficiency of your 
storefronts.

 TaxCloud Integration ............................................................................................566
 Google Analytics ....................................................................................................569
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TaxCloud Integration

Print service providers located in the United States can integrate the online 
TaxCloud service into their storefronts. This service immediately calculates the 
sales tax for orders, based on the shipping location (nexus) and the location of 
the shopper, and the TaxCloud Taxability Information Code (TIC).

You can set a default TaxCloud Taxability Information Code (TIC) for all 
products in a store and if necessary specify a different code when creating your 
products.

A shopper who is not required to pay sales tax select the Tax Exempted check 
box when checking out the order. Selecting this check box displays a window 
where the shopper can enter an exemption certification ID.

Prerequisites

 Your place of business is located in the United States of America. Otherwise 
you will not see the TaxCloud integration panel. See “Payment Methods and 
Tax” on page 81

 When creating a store, select the Use TaxCloud for US sales tax calculation 
check box. See “General Tab” on page 196.

 TaxCloud registration and account set-up

Follow these steps to implement the TaxCloud integration for your stores. It is 
recommended that you also read the TaxCloud merchant guide for more details 
about TaxCloud registration and setting up your account.

CAUTION: Setting up TaxCloud is easy but requires that you fulfill a number of 
registration conditions. Please visit https://taxcloud.com/ for more information 
about the TaxCloud service.

1 Go to https://taxcloud.com/ to register for TaxCloud.

2 Click the Register Now button and complete your details, including:

 your Website Address: Enter the URL of one of your storefronts.

 Online Marketplace/Commerce Platform: Choose Other from the drop-
down list.
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3 Click Register and follow the instructions you receive by e-mail to confirm 
your account and log on to TaxCloud.

4 Go to the Locations section and click the Add Location button to add a 
physical location. Follow the instructions to let TaxCloud look up the 
address.

This physical location is the nexus state where you must collect the tax. This 
location is used for calculating the tax.

5 Click Locations again and highlight your storefront in the table.

At the bottom of the window you’ll see that the online service has generated 
an API ID and an API Key.

NOTE: There is no need to select the Default TIC code here.

6 Click the Manage Tax States button to display a map of the United States 
and add nexus states (i.e. states where you have offices or are located and 
you are required by law to collect sales tax) and SSUTA states (i.e. states that 
have adopted the Streamlined Sales and Use Tax Agreement). Read section 
1.5 Where You Want to Collect Sales Tax in the TaxCloud user guide for more 
information.

7 Click the Bank Information button to add your bank account. Read section 
1.6 Add a Bank Account (Optional) in the TaxCloud user guide for more 
information.

NOTE: You bank account must be provided if you selected SSUTA states in the 
previous step.

This is all the information you need to provide to get started with the 
TaxCloud service in STOREFRONT. Setting up Address Verification as 
described in section 1.8 of the TaxCloud merchant guide is not necessary 
because STOREFRONT uses the US Postal service for address verification.

 Integrate Your TaxCloud Account in STOREFRONT

1 In StoreCenter, choose Advanced > Payment Methods and 
Tax > TaxCloud Integration.

NOTE: The TaxCloud Integration button is only visible if your location is set 
to United States (mandatory). Choose Advanced > Production 
Settings > Production Center to check your location. You need to sign out 
and sign back in for this change to take effect.
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2 Enter or copy/paste the API ID and an API Key which were generated on the 
TaxCloud website.

3 Click Save to confirm your changes.

Now you can enter the Default TIC code.

4 Choose General Goods and Services as the default TIC and click Save to 
confirm your changes.

The TIC code is now displayed next to the TIC category.

5 Choose Stores and select a store. In the General tab, select the Use 
TaxCloud for US sales tax calculation to enable sales tax calculation for 
your store. 

NOTE: Repeat for all stores.

6 Click Save to confirm your changes.

The default TIC code will be used to calculate the sales tax for all items 
ordered through this store.

If you want to set a different TIC code for a specific product, edit the product 
in question and select a different TIC code in the product description.

7 Now you’ve activated TaxCloud on your storefront, run a test by actually 
buying an item.

Once the purchase is finished, the transaction appears:

 on the Transactions page on the TaxCloud website

 at the storefront checkout, in the Secure Payment tab

8 If the test was successful, go back to the Websites page and click the Go Live! 
button to promote your test account to a real account which is tracked by the 
TaxCloud service. TaxCloud now calculates sales tax for orders made on your 
storefront.

Related topics: • Payment Methods and Tax on page 81
• Creating Products on page 157
• General Tab on page 196
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Google Analytics

NOTE: This documentation describes the procedures for Google’s Universal 
Analytics which will be replaced in the short term by Google Analytics 4. 
Standard Universal Analytics properties will stop processing new hits on July 1, 
2023. If you still use Universal Analytics, we recommend that you prepare to 
switch to Google Analytics 4 going forward.

Google Analytics is a free web service that allows website owners to monitor 
traffic on their websites. You can also use Google Analytics with STOREFRONT to 
track the activities of your storefront visitors. For example:

 How did your visitors find your website?

 Which products are popular?

 How many visits are converted to sales?

 When did a shopper decide to abort a purchase?

If you are serious about your web-to-print activity with public or private store-
fronts, we recommend that you sign up for an account on the Google Analytics 
website. This is where you generate an Analytics ID that needs to be added to 
your storefront. Once you have this ID, you can easily insert it on all the pages of 
your storefront with a single setting in StoreCenter.

Step 1: Create an Analytics ID

Visit the Analytics Help Center for detailed information on setting up Google 
Analytics.

1 Navigate to the Google Analytics website.

2 Sign in to Google Analytics if you have a Google account, or create a Google 
account first.

3 Click the Sign Up button to create a new Analytics account.

NOTE: If you already have an Analytics account, click Admin, select an 
account, and set up a new property in the existing account.

4 Complete the New Account form.
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 track a Website

 Google Analytics 4

5 In the Setting up your account section, enter an account name.

6 In the Setting up your property section, set up a new property for this 
account:

 Enter a Website Name; this is a name used in Google Analytics to refer to 
your website.

 Enter a Website URL: choose http:// in the drop-down list, and then 
copy the domain name of your storefront in the adjacent field; you can 
find the domain name in the General tab: this will be something like 
mystore.apogeestorefront.com/storefront if you are using the 
default URL, or mystore.com if you are using your own domain name.

 Choose an Industry Category and Reporting Time Zone from the drop-
down lists.

7 Click the Get Tracking ID button.

Your tracking ID is displayed, for example UA-12345678-00.

8 Copy the tracking ID.

Step 2: Set the Analytics ID in StoreCenter

1 In StoreCenter, choose the store you want to monitor and click the General 
tab.

2 Click the Edit button in the Analytics ID field and paste the ID you obtained 
on the Google Analytics website in the dialog.

3 Navigate back to your Analytics account to add the URL of your storefront to 
the Referral Exclusion List: choose Admin > Tracking Info > Referral List, 
and enter the domain name or names listed in the StoreCenter dialog (e.g. 
mystore.apogeestorefront.com). You can read why this is important in the 
information on the Analytics Help Center.

4 Save your changes to the store in StoreCenter.

Your storefront is now published with the Analytics ID on every page of the 
storefront.
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NOTE: If you change any of these details for this store (Site ID, Custom 
Domain Name, Payment Method), you must update the Referral Exclusion 
List in Google Analytics.

Step 3: Tracking

Once the Analytics ID has been added to your storefront, you are ready to track 
your visitors on the Google Analytics website. Read the information on the 
Analytics Help Center for getting started with Google Analytics and consulting 
your traffic statistics. The data provided by STOREFRONT allows you to set up 
Goals (basic analytics) and Funnels (advanced analytics).

The analytics data refer to the URLs of your storefront. These URLs can be quite 
complex and consist of programming parameters which are appended to the 
domain name. The following tables can help you decipher the URLs.

URL parts

The following URL parts help you track the actions of a shopper. For example, 
the receipt parameter in the URL indicates that an order has actually been 
placed.

URL part Description

/billing-and-review.ep The second step in the checkout. If a payment gateway is used 
this is also the third step in the checkout before being redi-
rected to the payment gateway.

/customers/impersonate Impersonate user page is viewed.

/customers/login Login page is viewed.

/customers/new Registration page of public store is viewed.

/order-details.ep An order’s details were viewed via a user’s account page.

/shipping.ep The first step in the checkout.

/view-cart.ep Cart is viewed. The user can arrive here via several paths, for 
example by adding a product to his cart or by clicking the cart 
link at the top-right.

c.*-p1.html Category page is viewed.

cancel= This parameter is appended to billing-and-review.ep when a 
checkout is canceled by the user and he is redirected back to 
billing-and-review.ep.

error= This parameter is appended to bill ling-and-review.ep when a 
checkout fails and the user is redirected back to billing-and-
review.ep.
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Example: The shopper has put an item in her shopping cart and proceeds to checkout:

https://mystore.apogeestorefront/storefront/view-cart.ep

The shopper has placed and finalized the order with ID 1900363:

https://mystore.apogeestorefront/storefront/order-
details.ep?oID=1900363&receipt=nopaymentCheckout

Online Editor Events

User interaction in the Online Editor can also be monitored.

NOTE: In Google Analytics 4, the STOREFRONT categories and actions in the table 
below can be used as Event Tracking Parameters in Tag Configuration of Google 
Analytics Tag Manager.

product-view.ep|prod.*\.html Product page is viewed

receipt= This parameter is appended to order-details.ep when a checkout 
is completed and the order details are shown.

URL part Description

Description Category Action Label Value

Start Editing is clicked on product page 
(data-tid=”product-content-addToCart-
Cmd”. If the editor and document are 
successfully loaded an editorLoaded 
event followed by a documentLoaded 
event will be logged after this event.

product-content addToCartCmd

Editor has loaded. A documentLoaded 
event will be logged next.

product-chili editorLoaded product name time (millisec) to 
launch the Editor

Document has loaded in the editor. The 
workspace will be loaded next (not 
tracked because Chili does not send an 
event for this).

product-chili documentLoaded product name time (millisec) to 
launch Editor & 
load document

Save button is clicked in the editor. 
When the document has been success-
fully saved the documentSaved event 
will be logged.

product-chili documentSaveCmd product name

Document has been saved. product-chili documentSaved product name

Editor was closed by clicking a bread-
crumbs link, back navigation, or closing 
the window/tab. Unless a docu-
mentSaved event was previously 
logged, the document was not saved 
before closing the editor.

product-chili editorClosed product name
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Example: A shopper has a customizable product in the cart and decides she wants to edit 
it before proceeding to checkout; this is indicated in the URL with the 
editDocument action:

https://mystore.apogeestorefront/storefront/a/shoppingItems/4829947/
editDocument

UTM parameters (customized)

You can use UTM parameters to see how a visitor found a URL, and typically to 
monitor the hit rate of e-mail campaigns. Different types of UTM parameters 
(utm_source, utm_medium, utm_campaign, etc.) can be added to the URL of 
links, and these parameters are also visible in Google Analytics. URLs with UTM 
parameters can easily be created with a tool like Google Campaign URL Builder.

Example: A potential customer clicked a link to your storefront which was sent to her in a 
newsletter e-mail. The link not only points to a product on the storefront, but 
also includes 3 UTM parameters which identify the source, medium and 
campaign name:

https://mystore.apogeestorefront/storefront/catalogs/mycatalog/
prod0D0078F7_2CDF_7B76_1FC7_52DC94F085B0.html?utm_source=Newslet-

ter_02_2014&utm_medium=email&utm_campaign=teaser

UTM parameters (system)

The STOREFRONT system also uses UTM parameters in the e-mails it generates. 
You can also monitor this traffic once you have set up Google Analytics.

The following parameters are used:

 utm_medium=email

Go to Shopping Cart button clicked in 
editor. This closes the editor, prompting 
the user to save the document if it has 
not been saved. If the user saves the 
document, a documentSaved event will 
be logged after this event. Once the 
editor is closed an editorClosed event 
will be logged.

product-chili editorCloseAnd GoTo-
CartCmd

product name

Edit... link of a product clicked in the 
shopping cart (data-tid=”cart-shopping-
Item-editDocumentCmd”. If the editor 
and document are successfully loaded, 
an editorLoaded event followed by a 
documentLoaded event will be logged 
after this event.

cart-shopping
Item

editDocumentCmd

Description Category Action Label Value
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 utm_source= identifies the type of e-mail, e.g. orderConfirmation

 utm_campaign= identifies the object, e.g. order ID, store, printer account

Example: https://mynewprivatestore.apogeestaging.local/storefront/order-
details.ep?oID=1900679&utm_source=orderConfHtml&utm_me-

dium=email&utm_campaign=02014-
MyStore&cdt=0fM6HlRBPzqdu6QV8GrLZM6dCA7XiJ1tqg0e3zSa

Step 4: Setting Goals and Funnels

Google Analytics allows you to define goals. The primary goal of any store is to 
convert visitors to buyers, so defining the conversion rate as a goal in Google 
Analytics is very useful. When defining such a goal:

 Set the goal type to 'Destination'

 The goal destination should be a regular expression that matches this syntax: 
/storefront/order-details.{1,}receipt=.{1,}

 Defining a funnel also makes sense. The suggested setup is:

 Step 1 has the name 'Cart'. The Screen/Page field is set to '/storefront/
view-cart.ep'. It is not required.

 Step 2 has the name 'Checkout - Shipping'. The Screen/Page field is set to 
'/storefront/shipping.ep'.

 Step 3 has the name 'Checkout - Review'. The Screen/Page field is set to '/
storefront/billing-and-review.ep'.

Related topics: • General Tab on page 196
• Search Engine Optimization (SEO) on page 33
• Legal Considerations on page 37
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APPENDIX
E Glossary

This glossary explains key terms and abbreviations used in this documentation.

Apogee/Asanti STOREFRONT ECO3’ 
web-to-print solution for printers 
and print service providers.

Approver The role with rights to 
approve and rejects orders placed by 
users of the same approval group.

Breadcrumb A navigation aid that 
helps shoppers keep track of their 
location on the storefront website.

Capture The submission of a credit 
card transaction for processing and 
settling a payment whereby funds 
are moved from the bank account of 
the shopper into that of the 
merchant.

Company A customer or business 
relation of the Printer or Print 
Service Provider for whom stores are 
created in STOREFRONT.

Company Administrator The role in a 
Company with the rights to perform 
certain actions in the StoreCenter. 
These actions mainly involve 
approving and rejecting the orders.

Constraints Restrictions defined in 
the Online Editor to control the 
extent to which shoppers can 
customize a customizable product.

Dashboard The Dashboard is a page 
in the StoreCenter that displays 
statistics for all the stores. The 

Dashboard is also the landing page 
when you log on to StoreCenter.

Deferred payment When a shopper 
uses a credit card for a purchase on a 
storefront with deferred payment 
method, the payment is postponed 
until all the order items are shipped.

Direct payment When a shopper uses 
a credit or debit card for a purchase 
on a storefront with direct payment 
method, the payment is charged 
immediately.

Favicon A favicon is a small image 
which appears in the address bar, 
tabs and favorites bar of the 
browser.

GDPR General Data Protection 
Regulation: see “GDPR” on page 39.

Grammage Weight in grams of a 
quantity of paper cut to sheets that 
measure one square meter. 
Expressed in grams per square meter 
(g/m²).

JDF Job Definition Format (JDF) is 
an extensible, XML-based format 
that can be used to create job tickets 
in Apogee Prepress.

Merchant The owner of an e-
commerce website (payment 
gateway parlance).
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MIS Management Information 
System.

MJD Mime packaged job definition 
format file.

Online Editor The editing environ-
ment which is opened in 
StoreCenter and on the storefront to 
edit customizable products.

Price List A price list ideally contains 
all the prices for all product 
templates and consequently for all 
the products of a store.

Printer Administrator The role at a 
Printer or Print Service Provider 
with the most rights to perform 
actions in the StoreCenter.

Printer Operator The role at a Printer 
or Print Service Provider with 
limited rights to perform certain 
tasks in the StoreCenter (e.g. 
monitoring and processing orders).

Printer, Print Service Provider An 
organization that uses STOREFRONT 
to set up stores for themselves or 
other organizations.

Resources Common settings that 
need to be defined before you can 
create stores: Product Templates 
and settings in the Advanced menu.

SaaS Software as a Service.

Shopper A person who visits a 
private or public storefront and 
proceeds to checkout to order items.

SKU Stock Keeping Unit

Snippet A document placed inside 
another document in the Online 
Editor.

Store A store in STOREFRONT consists 
of the web-to-print website and 
back-end functionality set up by an 
Administrator in the StoreCenter.

StoreCenter The back-end applica-
tion of STOREFRONT where the stores 
are created and managed.

Storefront A storefront is the front-
end, web-to-print website with a 
dedicated URL where shoppers can 
order items.

StoreFront Converter A STOREFRONT 
plug-in for Adobe InDesign used to 
create ZXP packages.

StoreFront package A ZIP package 
that contains the template for a 
customizable product and which 
can be edited in the Online Editor. 
The package is created with the 
STOREFRONT Converter plug-in from 
Adobe InDesign documents.

System Administrator The adminis-
trator of the STOREFRONT system.

Trim size The final size of a page 
after all excess paper and bleed 
areas have been trimmed off. This is 
indicated by the trim box in a PDF.

User A person who is granted access 
to a private storefront and who can 
order items. A person who visits a 
public storefront and identifies 
himself at checkout.

VDP Variable Data Processing.
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Visitor A person who visits a public 
storefront.

ZXP StoreFront Converter package 
file format. See StoreFront 
Converter.
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